# Contents

Copyright Information & Notices .................................................. 1  
Registering Kurzweil 1000 ......................................................... 1  

## Getting Started ................................................................. 7  
Where to Start ........................................................................... 8  
What is Kurzweil 1000? .............................................................. 9  
Important Concepts for New Users .............................................. 11  
Kurzweil 1000 Basics ................................................................. 17  
Kurzweil 1000 Extras and Diags Folders .................................... 21  
Starting and Shutting Down Kurzweil 1000 ............................... 22  
If You Need Technical Support ................................................... 22  
Kurzweil 1000 Listserv Signup ................................................... 23  

## Kurzweil 1000 Menus and Dialog Boxes ................................. 25  
The Menu System ....................................................................... 26  
Types of Menu Items .................................................................. 28  
Dialog Boxes ............................................................................. 29  
Lists in Dialogs .......................................................................... 30  
Text Boxes in Dialogs ................................................................ 34  
Grid Views in Dialogs ................................................................ 35  

## Reading ..................................................................................... 37  
Reading in Kurzweil 1000 .......................................................... 38  
Accessing Reading Commands .................................................. 40  
Basic Reading Functions ............................................................ 41  
Reading Navigation Tools .......................................................... 43  
Reading Shortcut Keys ............................................................... 45  
Reading Newly Recognized Pages ............................................. 47  
Reading Tables ........................................................................... 47  
Displaying and Reading Images .................................................. 51  

## Exploring Documents ............................................................. 53  
Document Overview Methods .................................................... 54  
Browsing in a Document ............................................................. 54  
Summarizing a Document .......................................................... 55  
Exploring Document Layout ...................................................... 56  
Document Overview Shortcut Keys .......................................... 59
**Navigating in Documents** ................................................................. 61
   Document Navigation Methods ....................................................... 62
   Accessing Document Navigation Commands ...................................... 62
   Page Navigation .................................................................................. 63
   Cursor Navigation ............................................................................... 66
   Bookmarks ......................................................................................... 66
   Bookmark Navigation ......................................................................... 71
   Links .................................................................................................... 76
   Document Navigation Shortcut Keys .................................................. 78

**Reference Tools** .............................................................................. 81
   Accessing Reference Tools ............................................................... 82
   Dictionary, Thesaurus and Spelling Lookup ......................................... 83
   Using an Encyclopedia ....................................................................... 91
   Getting a Translation ........................................................................ 93
   Reference Tools Shortcut Keys .......................................................... 94

**Annotations, Outlines and Other Study Tools** ................................. 95
   Types of Annotations and Study Tools .............................................. 96
   Working with Notes .......................................................................... 98
   Using the Summarize Feature ........................................................... 100
   Building Topic Lists ......................................................................... 101

**Scanning and Recognition** ............................................................. 103
   Scanning in Kurzweil 1000 ............................................................... 104
   Accessing Scanning Commands ....................................................... 109
   Basic Scanning Functions .................................................................. 110
   Using a Document Feeder ................................................................ 113
   Recognizing Currency ...................................................................... 114
   Scanning and Creating a Signature File ........................................... 118
   Tips for Scanning ............................................................................ 119
   Fine-Tuning and Optimizing Scanning ............................................ 121
   Optimizing Scanner Settings ............................................................ 121
   Optimizing Recognition ................................................................... 127
   Looking at Recognition Statistics .................................................... 128
   Batch Scanning ................................................................................ 132
   KOCRUtil for Automatic File Recognition ...................................... 134
   Scanning Shortcut Keys .................................................................... 137
   Defining Hot Keys for Scanning ...................................................... 138
   Configuring Scanner Buttons ........................................................... 139
   Scanning from Microsoft Word ....................................................... 140
Contents

Editing Text and Formatting .................................................. 141
  Overview ................................................................. 142
  Accessing Editing Commands ........................................... 142
  Moving Through Text .................................................... 143
  Selecting Text .......................................................... 145
  Using Editing Keys ....................................................... 148
  Cutting, Copying and Pasting ........................................... 149
  Editing Formatting ....................................................... 152
  Paragraph Formatting ................................................... 155
  Undoing Edits ............................................................ 159
  Searching for Text and Tables ........................................ 160
  Replacing Text .......................................................... 165
  Using the Spell Checker ................................................ 167
  Editing Your Spell Checker List ..................................... 173
  Using Ranked Spelling .................................................. 174
  Changing a Word’s Pronunciation ..................................... 180
  Editing the Pronunciation List ....................................... 181
  Applying Corrections Throughout a Document .................... 182
  Editing Your Corrections List ....................................... 184
  Inserting a Signature File ............................................. 185
  Shortcut Keys for Editing ............................................... 186

Working with Forms ........................................................ 189
  Scanning and Recognizing Forms ..................................... 190
  Reading and Navigating in a Form Document ....................... 191
  Filling Out a Form ...................................................... 191
  Adding a Signature File to a Form ................................... 192
  Printing and Saving a Form ............................................ 193

Working with Tables ....................................................... 195
  Creating and Editing Tables .......................................... 196
  Table Creation Commands ............................................. 196
  Table Creation Procedures .......................................... 198

Working with Settings ..................................................... 201
  Kurzweil 1000 Settings ................................................ 202
  Accessing Settings ..................................................... 204
  Voices Settings ........................................................ 207
  Scanning Settings ....................................................... 209
  Recognition Settings .................................................. 215
  Reading Settings ...................................................... 221
  General Settings ........................................................ 228
## Display Settings
- Display Settings: How Do They Work? (236)

## Scanner Margins Settings
- Scanner Margins Settings (235)

## Auto Size Margins
- Auto Size Margins: How Do They Work? (236)

## Configuration Settings
- Configuration Settings (237)

## Verbosity Settings
- Verbosity Settings (242)

## Conversion Settings
- Conversion Settings (248)

## Default Settings
- Default Settings (251)

## Linking Documents and Settings
- Linking Documents and Settings (255)

## Saving and Working with Settings Files
- Saving and Working with Settings Files (255)

## Settings Status
- Settings Status (260)

## Files and Folders
- Files and Folders (263)
- Working with Files and Folders (264)
- File Management Tasks (265)
- File and Folder Names (266)
- Types of File Formats (267)
- Accessing File and Folder Commands (271)
- The File Dialog (272)
- Basic File Management (278)
- Advanced File Management (297)
- Shortcut Keys for File Management (304)
- Working with More Than One Document (305)
- Changing the Default Folder (306)
- Working with File Utilities (306)
- Restoring a File (312)
- Working with ZIP Files (312)
- Writing Files to a CD (313)

## File Portability
- File Portability (315)
- Overview (316)
- Creating and Playing Audio Files (317)
- Sending Documents to Other Devices (322)
- Devices the Send To Feature Supports (325)
- Setting Up a User Device to Send To (325)
- Sending Documents to an E-mail Recipient (334)
- Printing to a Braille Embosser (338)
- Command Line Support for File Names (341)

## Online Material
- Online Material (343)
- Kurzweil 1000 Online Features (344)
- Accessing Kurzweil 1000 Online Features (346)
- General Search and Download Process (347)
CONTENTS

Managing Downloaded Files ..................................................... 349
Searching for and Downloading Books ........................................ 351
Looking Through Online Bookshelves ........................................ 356
Searching for and Downloading Magazines .................................. 358
Searching the Classic Literature CD .......................................... 359
Obtaining News from KESI ......................................................... 361
Obtaining Kurzweil Product Updates .......................................... 362

A: Kurzweil 1000 Applications ................................................. 363
   Applications from the Launch Menu ........................................ 364
   Launching and Exiting Applications ....................................... 364
   Help in Applications .......................................................... 365
   Navigating in Applications .................................................. 365
   Appointment Calendar Application ........................................ 366
   Calculator Application ........................................................ 372
   Photocopier Application ...................................................... 383
   Fax Application .................................................................... 386
   Managing Your Applications with the Launch Menu ...................... 395
   Working with Applications You’ve Added ................................. 399

B: Speech Engines and Devices .................................................. 401
   Software Speech Engines ..................................................... 402
   Hardware Speech Synthesizers .............................................. 402

C: Searchable Web Sites .......................................................... 405
   Introduction ......................................................................... 406
   Search for Books .................................................................. 406
   Search for Magazines .......................................................... 407

D: Command Line Options ....................................................... 409
   Command Line Options ....................................................... 410

E: Using the Keypad .............................................................. 411
   About the Keypad ............................................................... 412
   Finding Your Way Around the Keypad .................................... 413
   Keypad Layers ..................................................................... 414
   Types of Keypad Commands ................................................ 415
   Keys in the Keypad ............................................................. 417
   The Reading Keypad ............................................................ 417
   The File Management Keypad .............................................. 420
   The Settings Keypad ............................................................ 422
Registering Kurzweil 1000

When you first install Kurzweil 1000, it is in Demonstration mode. In this mode, all features will be available, but each session is limited to two hours. After 30 days, the product expires. To use the full product right away, it’s important that you register.

Before you register, here are a few things you must do and know:

1. Consider how you want to register. You can register Online through the software if your system has an Internet connection, or by telephone.

2. Also have the serial number ready. We provide this in both print and Braille in the following places: on your Certificate of Ownership card enclosed with the documentation packaging, (this is a square card with the upper-right-corner cut away), on the outside of the product box, and on the CD holder.

   If you are upgrading from Version 7 or later, you should use the same serial number with which you registered previously, and the system will remember that number for you.

   If you are upgrading from an earlier version than Version 7, you will receive a new serial number.

   If you purchased multiple Kurzweil 1000 licenses, the serial number for the set is the same.

   During the registration process, you can type or scan the serial number from any of the sources mentioned above.

3. Note the Kurzweil 1000 Customer Service contact information. In the U.S. and Canada use 1-800-894-5374. For international calls use +781-276-0600. Each one of the registration methods is straight-forward, but, if after repeated unsuccessful attempts, you still need assistance, please call us.
Preliminary Registration Steps

1. In Kurzweil 1000, open the Help menu. You can use ALT+H. Then press G to select Register.

   The first of multiple Registration dialogs opens. Some of the dialogs you'll use during the registration procedure have the Next and Back commands. Press ALT+N or the ENTER key to go to the next dialog and ALT+B or ESCAPE to go back to the previous one. To get from one item to another, press the TAB key. In the first dialog, your cursor is in the Serial Number box.

2. Type in or scan the serial number.

   If you've registered before, the Serial Number box already contains the number.

   Otherwise, to scan the serial number, place the Certificate of Ownership card, product box, or CD holder, face down in the top-left corner of a flatbed scanner or face up in the top-right corner of a document camera's target area. Press the TAB key until you hear "Scan." Press ENTER. Kurzweil 1000 scans the serial number directly into the Serial Number box in this dialog.

3. Press TAB then press ENTER to open the next dialog box.

   Kurzweil 1000 asks you to select the registration method you want to use. Your cursor is in a list box and the options include:

   Online or Telephone. The Online option is the default.

   Use the UP or DOWN ARROW to select the desired option.

4. Press ENTER to open the next dialog. Skip to the instructions for the registration method you selected.
Online Registration

Registering Online

To use this method, your system must have an Internet connection. If you have a firewall, it must be configured to accept Internet access requests from Kurzweil 1000. Otherwise, you will receive messages from the firewall indicating that an unauthorized application is attempting to use the Internet. You will need a screen reader or an assistant to configure the firewall, or you may call Kurzweil 1000 Technical Support. The numbers are: 1-888-995-9905 or 1-800-894-5374. Please listen for and press the Kurzweil 1000 Technical Support extension number.

1. After selecting online registration, one of two things can occur:
   • If you have an existing serial number, and it is associated with only one account, Kurzweil 1000 congratulates you and tells you that you have been automatically registered. It then asks if you want to update your account information. If you answer Yes, Kurzweil 1000 automatically fills in your account information in subsequent Registration screens. Make the desired changes and press ENTER to complete registration.
   • Otherwise, a dialog opens with the cursor in the Account Type box.

2. If a dialog opens, you can select New or Existing in the Account Type box.
   Select New if you are registering for the first time or with a new serial number. Then go to step 3.
   Select Existing if you've registered before. Go to step 3.
   Select Existing - Request Information if you've registered before, but have forgotten your password. Press ENTER.
When Kurzweil 1000 finds your information, it sends the details to your e-mail account. Check your e-mail for the information, then begin the online registration process again. This time, select Existing in the Account Type box.

If Kurzweil 1000 is unable to find your information, you may have to call Kurzweil Educational Systems Customer Service at 781-276-0600 or toll-free at 800-894-5374 in the U.S. and Canada.

3. In the Account name text box, type your account name. Then TAB to type your password in the Password box.

If you are creating a new account, pick a unique name that's easy to remember such as your e-mail address. After typing your password, TAB to retype it in the Confirm Password box.

**Note:** It's a good idea to note this information for future reference, as when you upgrade to the next version.

4. Press ENTER to connect to the Kurzweil Educational Systems Online Registration page.

The system verifies that you are online, the server is up, the account exists, and that the password is correct. If it finds information that is incorrect or incomplete, it prompts you to make the necessary changes.

Your cursor is in the first of a few online registration dialog boxes. The system prompts for information that is mandatory.

5. Provide or change information. Press ENTER to proceed through these dialog boxes.

6. Press ENTER when you are done.

If registration is successful, Kurzweil 1000 congratulates you. The full Kurzweil 1000 product is now activated.
Registering by Phone

Two notes regarding phone registration:

- If you are installing and registering Kurzweil 1000 on multiple machines, then we recommend using the Systems Code Worksheet at the end of the Guide. You can note the systems codes, serial numbers and unlock codes, which can greatly expedite the registration process.

- Customer Service representatives are available to take your registration between 8:00 a.m. and 4:00 p.m. Eastern Time. The Customer Service telephone numbers are: 1-800-894-5374 in the U.S. and Canada; +781-276-0600 for international calls.

The phone registration process follows:

1. Type the unlock code number.
2. Press ENTER.
3. If registration is successful, Kurzweil 1000 congratulates you. Your Kurzweil 1000 product is now activated.

If You Need Assistance

While the registration process is straight-forward, you may encounter certain messages such as "Invalid Serial Number."

Try re-entering or re-scanning. After repeated unsuccessful attempts, call Kurzweil 1000 Customer Service at: 1-800-894-5374 in the U.S. and Canada; +781-276-0600 international. Please listen for and press the extension number for registering the product.

Help About

The About option from the Help menu (mnemonic ALT+H, then letter A) provides you with information about the installed Kurzweil
1000 product. It tells you if the product is registered or not, and if registered, it tells you the following information. You can use the associated mnemonic keys where available.

- Product Name and Version Number (ALT+P).
- Client Name (ALT+C).
- Serial Number (ALT+R).
- Legal Notice of licensed technology.
1 Getting Started

This chapter contains the following topics:

Where to Start.
What is Kurzweil 1000?
Important Concepts for New Users.
Kurzweil 1000 Basics.
Kurzweil 1000 Extras and Diags Folders.
Starting and Shutting Down Kurzweil 1000.
If You Need Technical Support.
Kurzweil 1000 Listserv Signup.
Where to Start

If you are an experienced user, go to the *Installation and New Features Guide* or select the desired version of the New Features Guide from the Help menu, **ALT+H**, then **N**.

If you are a new user, go over this chapter, reading the sections that you need. For example, if you are completely new to computers you may want to start with the *Important Concepts* section. If you are already familiar with your computer, go to *Kurzweil 1000 Basics*.

In addition there are two more sources for new users:

- A *Quick Tour* in various file formats in the Documentation folder of the product CD.

- The New User Wizard topics included in the product. The Wizard appears upon Kurzweil 1000 startup, however, you can also access it by pressing the following key combination: **Alt+H+W**.

**About the New User Wizard**

The New User Wizard topics included in the product appear upon Kurzweil 1000 startup. The topics introduce new users to a number of important Kurzweil 1000 concepts and features.

Each topic has a checkbox. Once you have read through a topic, Kurzweil 1000 checks the box to indicate that you have read it.

By default, Kurzweil 1000 selects the first unchecked topic for reading, press Enter to begin. A dialog opens with the topic text and Kurzweil 1000 begins reading. You can use some reading and navigation functions in these topic dialogs.

At the end of some of these topics, you may be given the opportunity to explore the topic further or to set up your preferences.
When you have gone through the list of topics or if you feel confident using Kurzweil 1000 without the topics to guide your exploration, you may want to disable the Wizard topics from showing whenever you run Kurzweil 1000.

To disable the New User Wizard, in the topics list, Tab to the option, "Show this option when Kurzweil 1000 is run," and select Disabled, then press Enter.

If you should ever want to peruse the topics again, you can find New User Wizard from the Help menu by pressing Alt+H+W

What is Kurzweil 1000?

Kurzweil 1000 is a Windows-based software application that makes printed and electronic material accessible to people who are blind or have limited vision. This product is easy to use for beginners, yet powerful and flexible enough for advanced users.

Kurzweil 1000 converts the printed or electronic word into speech. You can scan in books, articles, currency, bills, and advertisements – almost anything that fits on a scanner or under a document camera. The system uses optical character recognition (OCR) to create a version of the page that Kurzweil 1000 can read aloud.

You can open and read almost any file that contains text and tables, as well as download and read material and books directly from World Wide Web sites such as Bookshare.org.

You can create and edit documents. Kurzweil 1000 is well-suited for use in academic settings. A variety of tools assist in study tasks: you can look up information from the dictionary and thesaurus, as well as from online encyclopedias. Annotation and navigation features such as multi-level bookmarks and links, along with document
summarization, enable you to easily create study documents, some with quick access to related information.

In addition, Kurzweil 1000 provides the convenience of document portability: you can convert text files into audio files, convert audio files into DAISY 2.02 files, send files to devices, such as Book Port™, or place them on your iTunes or Windows Media Player playlist. You can also convert text files to EPUB or PDF files and transfer them to an e-reader or other portable device.

Kurzweil 1000 is highly customizable, allowing you to set a wide range of preferences from reading speed and voice to verbosity, that is, how much audio assistance you want from the program.

An expanding set of office applications, such as Fax, Photocopier and Calculators, are available to help with daily tasks.

What Kurzweil 1000 is not. It’s not a screen reader, so it doesn’t read the contents of other applications on your PC. It also does not interpret graphic images, nor does it replace a full word processor.

Someone with moderate computer experience should be able to install, configure, and use Kurzweil 1000. If you are new to computers, however, you may require some initial training.
Important Concepts for New Users

If you are new to computers and scanning, read this section. It will help you use Kurzweil 1000 more effectively.

Your Computer System

Let's start with your computer system. It's made up of hardware, including scanners, document cameras, and printers, and requires an operating system and software programs such as Kurzweil 1000 that help you process information and get your work done.

The Hardware Components

Your computer system has several main pieces of hardware: the computer, the keyboard and/or keypad, speakers and a scanner or document camera. You may also add a monitor and a printer.

The computer has a hard drive, and compact disk (CD) drive. You install Kurzweil 1000 to the hard drive. All of the documents you scan in or create are stored on the hard drive, and you can save your documents to it. The hard drive can store a large amount of data.

The CD drive enables you to install software products, such as Kurzweil 1000, or to load stored files onto your computer.

The scanner is the piece of equipment that transfers an image of a printed page to your computer. To scan a page, lift the scanner lid and place the page, print side down, flat on the scanner glass. Fit a corner of the page to a corner of the scanner glass. If you are scanning a bound book, you may need to press along the binding to get the book as flat as possible.

A light bar moves under the scanner glass to obtain an image of the page. You may be able to tell when a scan is finished by listening to
the light bar. When a scan is complete, the light bar returns to its home position, which is its original starting place.

A document camera can be used instead of a scanner to transfer the image of a printed page to your computer. To capture an image using a document camera, place the page print side up under the camera and aligned in the camera’s target area. Depending on the model of the camera, you may have a mat or other surface with alignment guides. If you are capturing a bound book, you may need to hold or weight the outer edges of the pages to make sure they stay flat. (Overall, you may find you prefer using a camera rather than a scanner to capture a bound book.)

Other hardware equipment you may find useful include portable devices, such as a ZIP drive for storing large amount of data on ZIP disks. You may also want to use a hardware speech synthesizer. If you want to use the Internet, you will need a modem.

**The Operating System**

Every computer system has an operating system. Kurzweil 1000 works under the Microsoft® Windows™ operating system, meaning it presents its functions according to the standard ways in which Windows presents and organizes information and functions.

In a nutshell, the operating system acts as a middleman between you and your computer system. It provides a user interface to help you access, work with and manage hardware resources and software programs, as well as the files and documents in Kurzweil 1000. Review your Windows documentation to learn more.

The subsection, About Files and Folders, provides more details about working with the Windows user interface within the Kurzweil 1000 program.
**Scanning and OCR**

When you scan a document, the scanner makes an image of the printed page (similar to a snapshot) and sends that image to the computer. The Optical Character Recognition (OCR) software tries to make sense of the image by identifying characters. The text that the software has recognized then appears in the Kurzweil 1000 window as a page of your scanned document.

Because OCR technology largely works by recognizing letter shape, certain kinds of documents produce better results than others. Go to the subsection, *Getting the Best Scanning Results* in Chapter 8, *Scanning and Recognition*, for details.

The most important thing to remember is that OCR technology works best when documents use a clear, standard typeface, not ornate or script-style fonts, or handwriting. While most publication-quality books or typed documents scan well, something like a wedding invitation may not.

**Synthetic Speech**

When Kurzweil 1000 reads to you, you are hearing *synthetic speech* that is generated by the computer. This technology uses a dictionary, as well as built-in knowledge about phonetics and grammar, to figure out how to pronounce each word.

If this is the first time you are working with synthetic speech, there are two main points to keep in mind:

- Unlike pre-recorded digitized speech, synthetic speech allows you to read any printed material. Because it can make intelligent decisions and learn new pronunciations, a synthetic speech engine is not limited to recorded material.
Because synthetic speech is not a human voice, you may need to get used to its “mechanical” sound.

State-of-the-Art Speech Options

Clear, natural-sounding VoiceText™ voices from Neo Speech and ETI-Eloquence™ voices from Nuance deliver the highest quality text-to-speech (TTS).

Kurzweil 1000 Version 13 includes support for the Microsoft Speech Platform Runtime 11 voices. Microsoft Speech Platform delivers access to more than a dozen additional voices in a variety of languages. You can choose and adjust the many voice options to suit your individual preference. Microsoft Speech Platform is included on the Kurzweil 1000 DVD in a folder named “MicrosoftSpeech”. A setup program is provided by Microsoft which handles the installation. Note: These voices are not supported by Windows XP, but can be used with Windows Vista and Windows 7.

Files and Folders

This section provides an overview of how files and folders work under the Windows operating systems. Chapter 13, Files and Folder, describes in detail how to name, create, and organize files and folders.

As you use Kurzweil 1000, you’ll want to organize your work. For example, some of the items you scan may be novels that you want to listen to for enjoyment. You might also scan legal documents and bills, newspaper articles, and menus from take-out restaurants. If you create numerous scanned documents without establishing a way of organizing them, it can be difficult to locate your files.
Files and folders help you organize your documents. A file is the electronic form of a scanned or typed document. Each file has a name, so you can easily recognize its contents. For example, you might scan in several pages of a local newspaper and name the file "news.kes", where "news" is the name of the file and "kes" is the extension (go to the subsection, File Extensions to learn more).

Folders help you organize the files. Think of them as large envelopes with labels on them. You could give a folder a name like "Novels," then place files of scanned novels inside it. Kurzweil 1000 includes a number of folders with names like "Articles" and "Magazines" to help you get started.

File/Folder Hierarchy in Windows

One key to learning the Windows file system is to understand that it is a hierarchy. Files go inside folders, and folders can go inside other folders. Folders within folders are described as "nested." All of the files and folders that you keep on the system generally reside on the hard drive. The default hard drive for a system is usually named C:, where the colon is part of the name.

To keep track of each file's place in this hierarchy, Windows uses path names. A path shows the drive or device where the file is located and all of the folders you must access to find the file.

To put together a Windows path, you'd begin with the drive name. List all nested folders in descending order, with a backslash (\) between folder names, and the file name at the end of the path.

For example, assume that there is a file on your system that can be described as follows:

- The file "Report1.txt" is in a folder named "September."
- "September" is in another folder called "Monthly."
• The "Monthly" folder is on drive C: with many other folders.

The path for "Report1.txt" would then be:

C:\Monthly\September\Report1.txt

**File Extensions**

You may have noticed that the file names used in our examples consist of two parts: a file name Report1 followed by a dot and the letters txt. This is the *extension* that tells you the file’s format.

The *format* of the file consists of a special set of attributes that tells the computer how to work with the file. It usually indicates what kind of application created the file, whether the file contains text or graphics, and if the text uses fonts or styles.

When you create a file in an application, that application usually has a default format. In Kurzweil 1000, the default format for scanned files is the KES format, which uses the .KES extension.

**Screen Readers**

Screen readers are special applications designed to make the entire computer screen accessible to people with visual impairments. Screen readers speak any item you select on the desktop and in an application, as well as characters you enter.

Kurzweil 1000 is not a screen reader. It does not read in other applications, or on the desktop. If you have a screen reader on your system, you may want to put it into *sleep mode*, if available, when using Kurzweil 1000 to prevent speech conflicts. Or, if you prefer, you can disable the Kurzweil 1000 speech engine and use a screen reader within Kurzweil 1000.

Bear in mind that the keypad assignments in Kurzweil 1000 are not necessarily the same as those in the screen reader. If you are using
a screen reader within Kurzweil 1000, you can disable the Kurzweil 1000 keypad assignments so the screen reader can take over. Chapter 12, *Working with Settings*, describes this in more detail.

It’s important that you fully understand both the screen reader and Kurzweil 1000 in order to get the best results from both products. Review the screen reader’s documentation or Help system to learn how it interacts with other speech applications.

**Kurzweil 1000 Basics**

This section provides an overview of the two ways of using Kurzweil 1000: the keypad and the menus. It explains how to locate important features, and how to get help as you work.

The menu system provides access to the complete Kurzweil 1000 feature set, while the keypad provides a subset of the features. Keep this in mind as you decide which method you want to use. Many users opt to learn both as in a number of instances, it is faster to use the keypad.

**The Keypad**

You can operate Kurzweil 1000 through the numeric keypad on the right-most side of a standard Windows keyboard.

The keypad has five rows of keys. The top row has four small keys; the next three rows have three small keys; and the bottom row has one long horizontal key and one small key. The right side of the keypad has two long vertical keys below the first square key in the upper-right corner.

If you have a laptop computer, you can also use equivalent functionality on the keyboard. The keys you use may differ from
system to system, so check your system’s documentation for details.

**Note:** For detailed information about using the keypad, you can either download the document *Using the Keypad to Access Kurzweil 1000* from the Kurzweil Educational Systems website—www.kurzweiledu.com, or refer to Appendix E, *Using the Keypad to Access Kurzweil 1000* in the Online Manual.

### The Menu System and Dialog Boxes

The menu system is the second way you can work with Kurzweil 1000. You can access all of the Kurzweil 1000 features and settings from menus by using a standard keyboard. The menu system provides auditory feedback.

Some menu items open *dialog boxes*. These are special screens that present a feature’s options, also called "controls" throughout Kurzweil 1000. You know that a menu item has a dialog box when the system says, “Opens a dialog.”

Go to Chapter 2, *Kurzweil 1000 Menus and Dialog Boxes* for detailed information about navigating in menus and dialogs and working with the different types of controls, such as list boxes, combo boxes, and tree views.

### Shortcut Keys and Mnemonics

Shortcut keys and mnemonics provide access to menu items using simple keyboard conventions. For a complete list any time you are in Kurzweil 1000, use the *Quick Reference* from the Help menu (ALT+H, then Q).

*Shortcut keys* are one or two keys that you press to perform an action. For example, **CONTROL+X** is the shortcut for the **Cut** menu
item. When using two-key shortcuts, hold down the first key while pressing the second key, then release both. The system tells you the shortcuts as you move through a menu.

Other shortcut keys exist for features that are not readily accessible from a menu.

*Mnemonics* are letters that represent menu names or items. To use mnemonics, first press the **ALT** key to go to the menu bar. You do not need to press **ENTER** after using a mnemonic. For example, **ALT+F+C** is the mnemonic for the **File** menu. The letter **C** is the mnemonic for the **Close** item on this menu.

**Keyboard Layout**

This section describes the keyboard layout for a standard Windows-compatible keyboard. If you are using a different type of keyboard, your layout may be different.

There is a single row of keys across the top of the keyboard. From left to right, the keys are laid out in this order:

ESCAPE, F1, F2, F3, F4, F5, F6, F7, F8, F9, F10, F11, F12, Print Screen, Scroll Lock, Pause.

Immediately below this row, there is a large bank of keys, with 15 keys across the top and five keys down the left side. This bank contains the alphanumerical and editing keys. The top row contains:

- Left single quote (‘), SHIFT for tilde (~)
- Number 1, SHIFT for exclamation point (!)
- Number 2, SHIFT for at sign (@)
- Number 3, SHIFT for number sign (#)
- Number 4, SHIFT for dollar sign ($)
- Number 5, SHIFT for percent sign (%)
- Number 6, SHIFT for caret (^)
Number 7, SHIFT for ampersand (&)
Number 8, SHIFT for asterisk (*)
Number 9, SHIFT for open parenthesis, (  
Number 0, SHIFT for close parenthesis, )
Dash (-), SHIFT for underscore (_)  
Equal sign (=), SHIFT for plus sign (+)
Back slash (\), SHIFT for vertical bar (|)
BACKSPACE.

Across the second row, this bank contains:
Tab (Backtab when shifted), 
Q, W, E, R, T, Y, U, I, O, P,  
open bracket ([), SHIFT for open curly brace ({),
close bracket (]), SHIFT for close curly brace (}).

Across the third row, the bank contains:
Caps Lock,  
A, S, D, F, G, H, J, K, L, 
semicolon (;), SHIFT for colon (:),  
right single quote ('), SHIFT for double quote ("),  
ENTER key.

Across the fourth row, this bank contains:
SHIFT, Z, X, C, V, B, N, M,  
comma (,) SHIFT for Less Than sign (<),  
period (.), SHIFT for Greater Than sign (>),  
slash (/), SHIFT for question mark (?),  
SHIFT.

Across the fifth row, this bank contains:
CONTROL, Start menu, ALT, SPACEBAR,  
ALT, Start menu, Context menu, CONTROL.
To the right of this large bank of keys, there are two smaller sets of keys. The top set consists of six keys arranged in two rows of three:

INSERT, HOME, PAGE UP,
DELETE, END, PAGE DOWN.

Below this set of keys is a group of four keys. The top key is the up arrow; beneath it are the left, down, and right arrows.

**Kurzweil 1000 Extras and Diags Folders**

The Kurzweil 1000 product CD also includes some utilities, diagnostic programs, and speech engines.

- The "Extras" folder contains games and utilities. The "ReadMe.Txt" file in the folder lists the contents and a brief description of each item. Some of the items in the "Extras" folder are shareware. If you like an application, please register it according to the instructions provided.

  **Note:** Kurzweil Educational Systems does not support the applications in this folder.

- The "Diags" folder contains several utilities that help with system maintenance and Kurzweil 1000 diagnostics. Its "ReadMe.Txt" file provides an overview of the contents. To avoid unexpected results, use these utilities only as directed by Kurzweil 1000 support personnel.

  **Note:** During installation, Kurzweil 1000 copies these diagnostic programs to your hard disk to "Program Files\Kurzweil Educational Systems\Diags".
Starting and Shutting Down Kurzweil 1000

Before you begin working with Kurzweil 1000, here are three helpful procedures to know.

**To start Kurzweil 1000:** Press **CONTROL+ALT+K** from the keyboard if Kurzweil 1000 is not set up to start automatically.

**To shut down Kurzweil 1000 using menu mnemonics:** Press the **ALT+F, then Q**.

**To power off your computer using the keypad:** Press the **Cancel** key three times, followed by the **Accept** key.

If You Need Technical Support

For technical support by phone, use 888-995-9905. Please have the following information ready when you call:

- Your name and phone number.
- The product serial number and version number.
- A description of the problem, including the following:
  - What you were doing right before the problem occurred. For example, were you scanning, reading, or saving a file?
  - Whether the problem seems to be with our software, the Windows operating system, or the scanner software.
- Your hardware configuration. Are you using a laptop?
- The system hardware. Does your system meet these requirements?
  - 500 MHz Pentium III processor or faster. For VoiceText, a minimum of 700 MHz is required.
  - 128MB of RAM; 256MB if you're using VoiceText.
Chapter 1. Getting Started

At least 500MB of available hard disk space; and an additional 625MB for VoiceText.

A supported TWAIN scanner or document camera.

- Type of speech engine you are using (ETI-Eloquence, DECTalk, VoiceText or an alternate engine).

**Kurzweil 1000 Listserv Signup**

A good way to find help is through fellow users. You can do this by signing up for the Kurzweil 1000 e-mail listserv at http://www.kurzweiledu.com/listservSignup.php.
This chapter contains the following topics:

The Menu System.
Types of Menu Items.
Dialog Boxes.
Lists in Dialogs.
Text Boxes in Dialogs.
Grid Views in Dialogs.
The Menu System

You can access all of the Kurzweil 1000 features and settings from menus by using a standard keyboard. The menu system provides auditory feedback.

Note: You can also access many Kurzweil 1000 commands from the keypad. For detailed information, you can either download the document, Using the Keypad to Access Kurzweil 1000, from the Kurzweil Educational Systems website—www.kurzweiledu.com—or refer to Appendix E, Using the Keypad to Access Kurzweil 1000 in the Online Manual.

Kurzweil 1000 Menus

As in all Windows-based systems, Kurzweil 1000 displays a menu bar at the top of the Kurzweil 1000 application window.

When you first start Kurzweil 1000, there are seven menus laid out in the following order from left to right:

File, Folder, Scan, Settings, Tools, Online, and Help.

When you open a document, several additional menus appear. The order from left to right is as follows:

File, Edit, Folder, Scan, Read, Navigation, Settings, Tools, Online, Window, and Help.

Finding Your Way Around the Menus

To access the menu bar, press the ALT key. (The F10 key also performs this function, however, you’ll find that ALT is the more convenient of the two.)
To move from menu to menu, use the LEFT and RIGHT ARROW keys. As you reach each menu, you’ll hear its name.

To obtain a list of a menu’s items, use either the DOWN ARROW or the ENTER key when you reach the desired menu name.

To access the individual menu items, press the UP and DOWN ARROW keys until you hear the desired name.

To select a menu item, press the ENTER key when you hear its name.

To hear a menu item name spelled aloud, press CONTROL+L or CONTROL+SHIFT+L.

To close the current menu and go to the previous level in the menu system, press the ESCAPE key. For example, if you open the File menu and then choose Launch, the system announces the first item in the Launch submenu, which is Add. If you then press ESCAPE, it takes you back to the Launch menu item. Pressing ESCAPE again takes you back to the File menu.

To leave the menu system from any level within it, press the ALT or F10 key.

Finding Your Way Around Dialog Boxes

Some menu items open dialog boxes. These are special screens that present a feature’s options, also called "controls" throughout Kurzweil 1000. You know that a menu item has a dialog box when the system says, “Opens a dialog.”

You make selections and choose settings in dialogs by using lists and commands, and by entering text.

To move forward through the options press the TAB key. The SHIFT+TAB key combination takes you backward through the
options. The system announces the name of the control and its current setting as it reaches each one.

To get Help about the specific option at your cursor position, press the F1 key.

To accept changes you’ve made and close the dialog, press the ENTER key. To cancel changes and close the dialog press ESCAPE.

To accept changes you’ve made but leave the dialog open, press ALT+ENTER.

Types of Menu Items

There are three types of menu items:

• Menu items that are commands.

Selecting one of these items makes the Kurzweil 1000 perform a function like scanning a document or initiating reading. For example, choosing Start New Scan from the Scan menu causes the system to scan a page on the scanner or under the document camera.

• Menu items that open a submenu.

For example, the Launch item on the File menu has its own submenu.

To access a menu item, use the UP or DOWN ARROW key. If a menu item has a submenu, Kurzweil 1000 tells you so. To access the submenu, press the RIGHT ARROW key. Then use the UP or DOWN ARROW key to go through the items on the submenu. To select a menu item, press the ENTER key.

You can also use mnemonics to access submenu items.
Chapter 2. Menus and Dialog Boxes

- Menu items that open dialogs.

Recall that a dialog box is a special screen that lets you make selections, choose settings using lists and command buttons, and enter text. If a menu item lets you access a dialog, you’ll hear the words, “Opens a dialog.”

Dialog Boxes

Dialog boxes contain options, also known as "controls," that are presented in a number of ways: as command buttons, regular lists, checkbox lists, tree lists, text boxes, combo boxes, or grids. For example, when you choose **Search for Books** from the **Online** menu, you get a dialog that contains **Combo boxes** that let you type text as well as select from a list, **Check boxes** that let you activate or deactivate an option, and command buttons that allow you to perform an action.

Moving Among Dialog Controls

There are a few ways to move among the controls in a dialog:

- Use the **TAB** key to move forward through the controls, or **SHIFT+TAB** to move backward.

- Each control in a dialog has a mnemonic letter, just as each menu item does. Press **ALT** and the mnemonic for a control to go to that control. In the Settings tab page, you can press just the mnemonic without pressing ALT.

- In most dialogs, the last two buttons are **OK** and **Cancel**. **OK** accepts all of the changes you’ve made and closes the dialog. **Cancel** closes the dialog without accepting your changes. In most cases, pressing **ENTER** on the keyboard is the same as...
activating the OK button, and pressing ESCAPE is the same as activating Cancel.

Many dialogs also contain an **Apply** button, which is located after the **Cancel** button. Apply directs Kurzweil 1000 to implement any changes you specified, but to leave the dialog open. Pressing **ALT+ENTER** activates the Apply button.

### Getting Help in Dialogs

To get Help in dialogs, press **F1**. When you press **F1** the first time, you get specific information about the current control. Press **F1** again to get general information about the type of control.

### Using Command Buttons

A *command button* performs a specified function. To activate a command, press the **TAB** key until you hear the button name, then press **ENTER**.

### Lists in Dialogs

**Lists** contain one or more items. In some lists, those items are sorted alphabetically, in others they are not.

### List Navigation

To cycle through the list, use the **UP** and **DOWN ARROW** keys. To go to the first list item whose name begins with a desired letter, type the first letter of the item. To move through all the items that begin with a desired letter, tap that letter repeatedly.
To go to the first item in a list, press the HOME key.

To go to the last item in a list, press the END key.

To move through the list one screen at a time, use the PAGE UP or PAGE DOWN key.

To hear the current list item, press F7. This sometimes provides additional information about the item.

To hear the current list item spelled aloud, press CONTROL+L.

To hear the current list item spelled aloud using a word alphabet (alpha, bravo, and so on), press CONTROL+SHIFT+L.

List Views

A list view is almost exactly like a standard list, except that you may be able to select more than one item, and you can get to a particular item by typing.

To read down a list, press the F5 key. Press any key to stop.

To move through the list view, use the list navigation tips.

To select more than one item, use CONTROL and the UP or DOWN ARROW to move from one item to another, and the SPACEBAR to add or remove an item from the selection.

To add a contiguous block of items to a selection, press the SHIFT key and an arrow key.

To go to an item, type its name. Suppose you are editing pronunciation changes, for example, you could find the pronunciation change for the word "Kurzweil" by typing in the letters K, then U, then R, until the appropriate word is selected.

To hear the items that are currently selected, press CONTROL+Y.
To copy the list to the clipboard, press CONTROL+C. The contents of the list is ready for pasting in any file in or outside of the Kurzweil 1000 program.

Checkbox Lists

It is possible for list views to contain a check box for each item in the list. When this occurs, selection is done differently. You can get to an item in the same manner as in any list box. Kurzweil 1000 tells you if the box is "checked," selected, or "unchecked," not selected.

To check or uncheck an item press the SPACEBAR. Unlike a standard list view, moving away from an item does not automatically deselect it.

There are very few instances of check boxes in Kurzweil 1000, but one example is the Languages list in the Recognition Settings.

Tree View Lists

A tree view is hierarchical, presenting multiple levels of list items. Two prime places in Kurzweil 1000 where you'll find tree views are in the File Open and Folder Change dialogs, and in the Bookmarks dialog.

To read down through the hierarchy of a tree view list, press the F5 key. Press any key to stop.

To move from one item to another in the same level, use the UP or DOWN ARROW.

To go to the level down, use the RIGHT ARROW.

To go back to the level above, use the LEFT ARROW.

To go to the first item at the same level, use HOME.
To go to the last item at the same level, use **END**.
To go to the first item in the tree view, use **CONTROL+HOME**.
To go to the last item in the tree view, use **CONTROL+END**.
To select an item, stop pressing the key when you hear the desired name.

To copy the list to the clipboard, press **CONTROL+C**. The contents of the list is ready for pasting in any file in or outside of the Kurzweil 1000 program.

**Searching Lists in Dialogs**

The following dialog boxes provide a search function in their list boxes: Ranked Spelling, Find and Open, Online Search (for books, magazines, and the Classic Literature CD), and all Kurzweil 1000 File dialogs.

To Search a list:

1. In a list that supports searches, press **CONTROL+F**.
   
   A **Find** dialog opens with the cursor in the entry text box.

2. Type in a word or partial word, then press **ENTER** to search the list. Kurzweil 1000 reads the first item it finds.

3. Press **F3** to search forward in the list for another match, and **SHIFT+F3** to search backwards.
Text Boxes in Dialogs

*Text boxes* let you type and edit characters. In text boxes, you can do the following:

**To select text**, hold down the **SHIFT** key on the keyboard and use the arrow keys to move over the characters you want to select.

**To spell the selected text**, or the current word if no text is selected, press **CONTROL+L**.

**To spell text mnemonically**, press **CONTROL+SHIFT+L**.

**To hear the contents of the text box**, press **F7**.

**To move forward or backward by one character**, press the **RIGHT ARROW** or **LEFT ARROW**, respectively.

**To move to the end or beginning of a text box**, press the **END** or **HOME** key, respectively.

**To delete the character to the left or right of the cursor**, use the **BACKSPACE** key and the **DELETE** key, respectively.

**To hear the last word in a text box**, press **CONTROL+END**.

For text boxes that use numeric values, like speech speed and speech volume, you can type a number or use the **UP/DOWN ARROW** keys to make the current value larger or smaller, respectively. To change a numeric value by a larger amount, press **SHIFT** and the **UP** or **DOWN ARROW**.

Some text boxes are read only, and are not editable.

**Combo Boxes**

*Combo boxes* are text boxes combined with a list to give you two ways to select an option. Like a text box, you can type and edit characters. Like a list, you can use the **UP/DOWN ARROWS**.
Grid Views in Dialogs

Grids show tables of data. Like all tables, data is organized in rows and columns. The Explore Layout dialog is an example of a grid.

- To move from row to row, use the UP/DOWN ARROW keys.
- To place your cursor in the left-most or the right-most column of the current row, press the HOME or END key, respectively.
- To go to the first or last cell in the table, CONTROL+HOME or CONTROL+END, respectively.
- To hear the contents of the current cell, press F7.
- To hear the contents of the first cell in the current row, press SHIFT+F7.
3 Reading

This chapter contains the following topics:
Reading in Kurzweil 1000.
Accessing Reading Commands.
Basic Reading Functions.
Reading Navigation Tools.
Reading Shortcut Keys.
Reading Newly Recognized Pages.
Reading Tables.
Displaying and Reading Images.
Reading in Kurzweil 1000

There are all types of material you can have Kurzweil 1000 read:

• Print documents that you’ve scanned in. For information on scanning, go to Chapter 8, *Scanning and Recognition*.

• Electronic documents that you’ve imported or opened using the KESI Virtual Printer from another application. For information on importing files or opening files using the KESI Virtual Printer, go to Chapter 13, *Files and Folders*.

• Electronic documents that you’ve downloaded from an online source. For information on online files go to Chapter 15, *Online Material*.

• Or documents that you’ve created in Kurzweil 1000. For information on creating documents in Kurzweil 1000, go to Chapter 9, *Editing Text and Formatting*.

As soon as you scan or open a document, Kurzweil 1000 begins reading.

Kurzweil 1000 uses the *Reading Voice* to read most of the text in a document. However, it switches to the *Message Voice* when announcing, for example, menus and menu commands. Additionally, Kurzweil 1000 uses an *emphasis method* when reading "emphasized" text, such as italic, bold, or underline, or when announcing your position within a table. The emphasis method may be either a different voice, or a change in pitch of the current reading voice. You can disable these features to have Kurzweil 1000 read all text using just the reading voice. Go to Chapter 12, *Working with Settings*, for more information.
In addition to simply reading through a document, you can use a variety of tools related to the reading function:

- **Reading navigation tools** such as the *Rewind* and *Forward* functions. For additional detail, go to the section, *Using Reading Navigation Tools*, in this chapter.

- **Document navigation methods**, such as *Bookmarks*, *Links* and *Go To Page*, enable you to go to specific places in the document. For more information, go to Chapter 5, *Document Navigation Tools and Methods*.

- **Document overview methods**, such as *Layout Exploration*, which quickly tells you the different regions on a scanned page, *Browsing*, which lets you hear the first and/or last sentence in each paragraph, and *Summarization*, which creates an overview of a document based on key words or bookmarks. For more information, go to Chapter 4, *Exploring Documents*. Summarization is also useful as a study tool, go to Chapter 7, *Annotations, Outlines and Other Study Tools* for more information.

- **Reference tools** let you look up the definition or synonyms of a word, as you read. You can also hear words spelled letter-by-letter, or with a word alphabet (alpha, bravo, and so on). In addition, you can obtain background or related information from online encyclopedias. For more information, go to Chapter 6, *Reference Tools*.

Numerous reading settings provide options for enhancing your reading ability and enjoyment. These include reading by units and avoiding headers, as well as Word Spacing, which increases the space between words. These features are available from the **Reading Settings** tab page. You can find more information on Reading settings in Chapter 12, *Working with Settings*.
At any time during reading, you can hear the reading status, which includes:

- The names of the current reading and scanning documents.
- The page number in the current file.
- The reading speed and unit.
- The status of a number of reading settings, such as column identification and white on black recognition. For details about Reading settings go to Chapter 12, Working with Settings.
- The software version number and information about how to reach technical support.

**Accessing Reading Commands**

Reading commands are available from the Read menu, and by using shortcut keys.

You can also access many reading commands from the keypad. For more information, you can either download the document, *Using the Keypad to Access Kurzweil 1000*, from the Kurzweil Educational Systems website—www.kurzweiledu.com, or refer to Appendix E, *Using the Keypad to Access Kurzweil 1000* in the Online Manual.

**The Read Menu**

The Read menu is located to the right of the Scan menu when a document is open.

As with all menus, each menu item has a corresponding mnemonic and some have keyboard shortcuts.
To open the Read Menu:

Use one of the following methods:

- Press **ALT**, then the **RIGHT ARROW** key until you hear the name of the menu.
- To use mnemonics, press **ALT+R**.

To hear the menu items, use the **UP/DOWN ARROW** keys.

**Basic Reading Functions**

This section provides menu-based instructions for basic reading operations.

**Starting and Stopping Reading**

Use one of the following methods to start or stop reading:

- Open the **Read** menu and choose **Start** or **Stop Reading**.
- Or press **ALT+R +S**.
- Or press **F5**.

Another way to stop reading is to press any key on the keyboard.

**Notes:** Be careful not to press any other key if you are using the **CONTROL** key. Also, pressing **CONTROL** does not resume reading.

**Adjusting Reading Speed**

Use one of the following methods to change the reading speed:

- Open the **Read** menu and choose **Increase Reading Speed** or **Decrease Reading Speed**.
• Or press ALT+R, then N for increasing reading speed; ALT+R, then E for decreasing speed.

• Or press F12 for increasing reading speed; F11 for decreasing reading speed.

The Increase Reading Speed and Decrease Reading Speed menu items change the speed of both the reading and message voices. To specify speeds for each voice separately, use the Voices Settings dialog. For more information, go to Chapter 12, Working with Settings.

**Reading Selected Text**

1. Select the text you want by placing your cursor at the starting point for the selection. Then, hold down the SHIFT key on the keyboard and use the ARROW keys to move over the text.

2. Do one of the following:
   • Open the Read menu and choose Say Selection.
   • Or press ALT+R +Y.
   • Or press CONTROL+Y.

**Notes:** You can also use CONTROL+Y to speak selected text in text boxes and lists in dialogs. To hear the spelling, press CONTROL+SHIFT+Y.
Hearing the Time and Date

To hear the time:
Open the Tools menu and choose What Time Is It? or press CONTROL+T.

To hear the date:
Press CONTROL+T twice.

To insert the current time and/or date into your document:
Listen to the time and/or date, then use CONTROL+C and CONTROL+V.

Obtaining Reading Status

To hear status information about reading, open the Help menu and choose Reading Status (ALT+H, then R). To quit status information, press ESCAPE.

Reading Navigation Tools

This section describes how to access menu items for finding your current place in a document and for moving around in a document using reading units.

Determining Your Place in a Document

It’s often helpful to determine where your cursor is located.

To find out the current line number, the page number, and the document name, press SHIFT+F1 on the keyboard. If your page
has layout information, you can find out the location of the current word in the original scanned document by pressing CONTROL+F1.

Moving by Reading Unit

To read by unit, do one of the following:

• Open the Read menu and choose Rewind by Unit (ALT+R, then R) or Forward by Unit (ALT+R, then F).
• Or press F6 for Rewind by Unit; F8 for Forward by Unit.

Reading begins automatically at the new location.

You can also skip forward or backward one unit when reading continuously: To skip forward, tap the right SHIFT key or use the F8 key. To skip backward, use the left SHIFT key or F6.

To read the current unit, do one of the following:

• Open the Read menu and choose Read Current Unit, (ALT+R, then C).
• Or press F7.

Kurzweil 1000 remembers the original layout of a scanned page, although lines may wrap differently on screen, depending on the value of the Line Endings setting in the Reading Settings tab.

When you choose Line as the reading unit, Kurzweil 1000 uses the lines in the original document.

Selecting a Reading Unit

1. Open the Settings menu and choose Reading.

   The Reading Settings dialog opens with your cursor in the Reading Unit list. You’ll hear the current unit setting.
2. Use the **UP/DOWN ARROW** keys to select the desired unit:
   
   You can opt for **Line**, **Sentence**, or **Paragraph**.

3. When you hear the unit you want, press **ENTER** to accept your selection and close the dialog.

**Reading by Alternate Reading Unit**

Kurzweil 1000 provides an **alternate reading unit**. You might want to use the alternate unit as a navigational tool that allows you to move backward or forward more quickly through documents.

When the **Reading Unit** option in the **Reading Settings** tab is set to anything other than By Paragraph, the alternate unit is By Paragraph. When the reading unit is set to By Paragraph the alternate unit is By Sentence.

Use **ALT+F6** to rewind by the alternate unit, use **ALT+F7** to reread the current alternate unit, and use **ALT+F8** to move forward using the alternate unit.

**Moving by Region**

If the page you are reading has layout information, you can move forward or backward by region. **SHIFT+F6** moves the cursor back to the beginning of the previous region. **SHIFT+F8** moves the cursor forward to the beginning of the next region.

**Reading Shortcut Keys**

To change the volume, press Shift+F11 to decrease volume, press Shift+F12 to increase volume.
There are keyboard shortcuts that you can use to hear contextual text. Your cursor position does not change when you use these shortcuts.

**CONTROL+SHIFT+U** reads the previous line.

**CONTROL+SHIFT+I** reads the current line.

**CONTROL+SHIFT+P** reads the next line.

Holding down the **CONTROL** and **SHIFT** keys while pressing any of the following word keys twice lets you hear the word spelled out. Press a sequence three times to hear the word spelled mnemonically. For instance, for the word "go" you would hear, "go, golf, oscar."

**CONTROL+SHIFT+J** reads the previous word.

**CONTROL+SHIFT+K** reads the current word.

**CONTROL+SHIFT+Semicolon (;)** reads the next word.

Holding down the **CONTROL** and **SHIFT** keys while pressing any of the following character keys sequences twice lets you hear the character in mnemonics. For instance, for the character "g" you would hear, "g, golf." Press a sequence three times to hear the decimal value of the character. For instance, for letter c, you'd hear the number 99.

**CONTROL+SHIFT+M** reads the previous character.

**CONTROL+SHIFT+Comma (,)** reads the current character.

**CONTROL+SHIFT+Period (.)** reads the next character.

The lines here are the lines in the document window. This differs from the reading unit definition, which uses the line breaks in the original scanned document.
Reading Newly Recognized Pages

It's often helpful to be able to listen to pages as you scan, for example when you are sorting through the mail or when trying to get a quick idea of the contents of multi-page material.

To set Kurzweil 1000 in this mode, go to the General Settings tab, ALT+T, then G. In the General Settings tab, press ALT+R to go to Read Newly Recognized Pages and use the DOWN ARROW to Enable the setting.

If this is a feature you would use often, consider saving the setting. For information on Saving Settings, go to Chapter 12, Working with Settings.

Reading Tables

Many kinds of printed material contain tables. The Table Reading feature enables you to read tables, although it assumes that the tables have a certain format, that is, the cell at row 1, column 1 is empty, and subsequent cells across row 1 contain column headings. Similarly, all the cells in column 1, except the first cell, contain row headings. Each body cell in the table would then represent the intersection of a row and column.

Suppose you have a table with the column headings “Books” and “Cards” across the first row. Now let the headings down the first column read “January,” “February,” and “March.” Each body cell of the table could then represents the number of books or cards sold in a given month.

In this format, row 1, column 1 is empty. Row 1, column 2 contains the heading “Books,” and Row 1, column 3 contains the heading “Cards.” Row 2, column 1 has the first month heading “January.” Row 2, column 2 contains the number of books sold in January, and...
row 2, column 3 contains the number of cards sold for the month. Row 3 has similar information for February, row 4 for March, and so on.

In reading this table, Kurzweil 1000 would start with row 2, column 2 (the number of books sold in January). You would then hear the row heading for that information, “January,” followed by the column heading “Books,” then the number again. Kurzweil 1000 reads across the row, speaking the column heading followed by the cell contents. When it moves to the next row, it will speak the row heading, then each column heading and the cell contents.

Be sure that the Table Reading option is enabled in the Reading Settings tab. Go to Chapter 12, Working with Settings for instructions on changing these settings.

Also, you should specify an Emphasis Method in the Voices Settings tab. Kurzweil uses the emphasis method to announce the presence of tables and your cursor’s position in them. You can set the emphasis method so that it either causes Kurzweil 1000 to switch to a different reading voice or to change the pitch of the current reading voice.

General Table Reading Functions

To read a table row by row, press F5.

To read a table column by column, press SHIFT+F5.

To read the first row of a table without changing the cursor position, press ALT+Grave Accent. This is helpful for reading the header row when you are deep in a table.

To read a table row without changing the cursor position, press CONTROL+SHIFT+W.
To move the cursor up to the previous row and read, press **CONTROL+ALT+UP ARROW**. The cursor stays in the current column.

To move the cursor down to the next row and read, press **CONTROL+ALT+DOWN ARROW**. The cursor stays in the current column.

To read a table column without changing the cursor position, press **CONTROL+SHIFT+C**.

To obtain Help information while working in tables, be sure the cursor is in the table, then press **F1**.

To hear the contents of the current cell, preceded by the row and column number, press **SHIFT+F1**.

To find out the size of the table, press **SHIFT+F1** twice.

To reread the contents of the current cell, press **F7**.

To skip past a table, press **CONTROL+SHIFT+Right Square Bracket**.

To move just above a table you are in, press **CONTROL+SHIFT+Left Square Bracket**.

**Note:** You can search for tables in a document by choosing **Find** from the **Edit** menu (**ALT+E**, then **F**), and choosing **Tables** from the **Find** dialog’s **Format** list box.
Hearing Specific Cells Without Moving the Cursor

To hear the contents of the first cell in the current row, press ALT+LEFT ARROW.

To hear the contents of the last cell in the current row, press ALT+RIGHT ARROW.

To hear the contents of the first cell in the current column, press ALT+UP ARROW.

To hear the contents of the last cell in the current column, press ALT+DOWN ARROW.

Navigating and Reading Individual Cells

When Kurzweil 1000 reaches a table, you can do the following:

Move to and hear the next cell in a row, press F8 or to also hear the associated heading, press TAB.

Move to and hear the previous cell in a row, press F6 or to also hear the associated heading, press SHIFT+TAB.

Move to and hear the next or previous cell in the same column, press DOWN or UP ARROW.

Read the table continuously by row, press F5.

Read the table continuously by column, from left to right, press SHIFT+F5.

The assumed format does not apply to every table. If you are reading tables with a different format, such as a table with no headings at all, you may get unexpected results. In this case, it may be better to use the TAB key, SHIFT+TAB, and the ARROW keys to read each cell individually.
Displaying and Reading Images

It is often useful to refer to an image of the original scanned page. This can be handy for diagnosing recognition problems, and for inspecting diagrams, charts, equations, and pictures.

To keep the original image, enable the **Keep Images** option in the **General Settings** tab before doing recognition. Images are kept only in KES file format. If you save your file in any other format, that file will no longer contain images. Go to Chapter 12, *Working with Settings* for instructions on setting this option.

To see an image of the current page, do one of the following:

- Choose **Show Image** from the **Tools Display Image** submenu.
- Or press **ALT+O+Y**, then **W**.
- Or press **CONTROL+W**.

Kurzweil 1000 opens a full page dialog, showing the image of the page. The image of the current word is highlighted. You can press any of the following:

- **F1** Help
- **F5** Stop or Start Reading
- **F6** Go Back One Reading Unit
- **F7** Go to Start of Current Reading Unit
- **F8** Go Forward One Reading Unit
- **SHIFT+F6** Go to the Previous Region
- **SHIFT+F8** Go to the Next Region
- **CONTROL+I** Invert colors
- **CONTROL+UP ARROW** Zoom In
CONTROL+Plus Sign Zoom In
CONTROL+DOWN Zoom Out
CONTROL+Minus Sign Zoom Out
CONTROL+L Spell the Current Word
CONTROL+SHIFT+L Spell the Current Word Mnemonically
ESCAPE Return to the editor
Left or Right ARROW Move backward or forward by a word
Home or End Move to the first or last word on a line
CONTROL Home/End Move to the first or last word on a page

Additional tips on reading images:

• Use the UP or DOWN ARROW to move to the nearest word of the previous or next line. This can be handy if you are trying to read a table that was not well identified as a table, since only one word will be read when you press up or down arrow.

• Sometimes it is handy to move the image around on the screen without reference to text. For example, much of the page may contain a picture with no text, and, at a high magnification level, you may need to scroll the image around in order to inspect all of it. To move the image without moving the text cursor, press the Scroll Lock key, and then press HOME, END, or the ARROW keys. HOME moves the image to the left edge, END moves it to the right edge. CONTROL+HOME moves it to the top, CONTROL+END to the bottom.

• The state of the color inversion, as well as the magnification level, is kept from one use of show images to another, and can be saved in a settings file. When you return to the editor with the ESCAPE key, your cursor is positioned on the same word that was highlighted in this dialog.
4 Exploring Documents

This chapter contains the following topics:

- Document Overview Methods.
- Browsing a Document.
- Summarizing a Document.
- Document Overview Shortcut Keys.
Document Overview Methods

Document overview methods enable you to explore a document’s contents or layout.

**Browsing**, for instance, lets you hear key sentences, so you can quickly skim a document.

**Summarization** creates an overview of the main ideas in a document. This makes summarization an ideal study tool. For more information on using this feature as a study tool, go to Chapter 7, *Annotations, Outlines, and Other Study Tools.*

**Layout exploration** helps you determine what regions are on a page. For instance, it can tell you that there is a column on the left, an image at the top of the page, and a header half-way down the page.

**Browsing in a Document**

Browsing in a document lets you hear the first, last or both sentence(s) in every paragraph. By default, Kurzweil 1000 browses by the first sentence. To change this setting, use the **Reading Settings** page. For more information on settings, go to Chapter 12, *Working with Settings.*

**To start and stop browsing:**

Do one of the following:

- Open the **Read** menu, and choose **Start Browsing**.
- Press **ALT+R**, then **W**.
- Or use the browsing shortcut, **SHIFT+F5**.
To stop browsing, you can also use the F5 key.

**Summarizing a Document**

You can use the Summarize tool to create a new document that contains a summary of the original document. For the summary document, Kurzweil 1000 automatically appends the word "summary" to the end of the original document’s name. You can save the file with another name by using the **Save As** command as described in Chapter 13, *Files and Folders*.

If you have bookmarks in the original document, you can use them to create the summary document. In addition, you can opt to include the page number of each bookmark. By doing this, the resulting summary document can become a useful study tool or table of contents. For more information on using Summarize and Bookmarks as study tools, go to Chapter 7, *Annotations, Outlines and Other Study Tools*. For more on Bookmarks, go to Chapter 5, *Document Navigation Tools and Methods*.

**To summarize a document containing no Bookmarks:**

1. Open the **File** menu and choose **Summarize**, or press ALT+F+M.
   
   A dialog opens and Kurzweil 1000 asks you to type the subject.

2. Type the subject, then press ENTER, or just press ENTER to let the system summarize automatically.

**To summarize a document containing Bookmarks:**

1. Open the **File** menu and choose **Summarize**, or press ALT+, then M.

   Kurzweil 1000 asks if you would like to use the Bookmarks.
2. Press letter N for No or Y for Yes.

3. Type the subject, then press ENTER, or just press ENTER to let the system summarize automatically.

Exploring Document Layout

Kurzweil 1000 enables you to retain information about the layout, that is, the location and size of each word and rectangular section, known as "region." A region can be any type of text block, such as table, header, footer, caption, title, etc., or image on a scanned page.

You can use the Explore Layout feature to find out how your page is segmented into regions, and potentially to reorder those regions.

You can also use the Extract command in the Explore Layout dialog to extract an image into a TIFF file.

To explore layout:

1. Be sure the Keep Layout Information setting is enabled in the General Settings tab. Go to Chapter 12, Working with Settings, for details.

2. With a file open on the page that contains page layout, choose Explore Layout from the Tools menu, or press ALT+O, then L.

The Explore Layout dialog opens containing a read-only text box, a grid, and six command buttons. The text box and grid have no mnemonics but the commands do. They are UP (ALT+U), DOWN (ALT+D), Select (ALT+S), Extract (ALT+E), OK (ALT+O), and Cancel (ALT+C). If your cursor is in the text box or the grid, you can press the ENTER key for OK or the ESCAPE key to cancel.
The text box contains a brief summary of the page, indicating how many text and image regions it contains. Press the **TAB** key to get past that to the grid control.

A grid control shows a table of data. Like all tables, the data is contained in cells, and the cells are organized both by rows and by columns. You move from one line to another with the **UP/DOWN ARROW** keys. You move from one column to another with the **LEFT/RIGHT ARROW** keys. The **HOME** key takes you to the left-most column in the current row, **END** takes you to the right-most column in the current row. **CONTROL+HOME** takes you to the first cell in the table, while **CONTROL+END** takes you to the last cell in the table. **F7** reads the contents of the current cell. **SHIFT+F7** tells you the contents of the first cell in the current row (presuming you aren't in that cell), then tells you the contents of the current cell.

Each row describes a region. All of the text regions are shown in reading order. They are followed by pictures. The columns, from left to right, contain the region type and number, the number of lines in the region, what region or picture is immediately above the current region, what region or picture is immediately to the left of the current region, the first several words in the region, and then the top, bottom, left, and right edges of the region. Those edges are described in hundredths of an inch, or in centimeters, depending upon the value of the unit of measure setting. It should be noted that the number expresses the distance from the top edge of the image (for top and bottom), or from the left edge of the image (for left and right). If the top left edge of the page (after rotation), is not against a scanner corner, those measurements won't help you figure out the absolute position of the region on the page. Otherwise, they will.

You can move around the grid with the arrow keys, as described above. The current region, from the perspective of the command
buttons, is the one described by the currently selected row in the grid.

The **UP** command swaps the contents of the current row in the grid with the row above it. The **DOWN** command swaps the contents of the current row in the grid with the row below it. When you get out of the dialog box with either **Select** or **OK**, the changes in the grid order are used to move text around in the current page, so that the reading order of the text reflects the order you have established in the grid. While the current control is the grid, you can use **CONTROL+D** to move the current row down, and **CONTROL+U** to move the current row up.

The **OK** command closes the dialog box, and positions your cursor at the beginning of the currently selected region.

The **Select** command closes the dialog and selects all of the text in the current region. This is particularly handy for deleting a region.

The **Extract** command extracts an image or picture region into a separate TIFF file. If your cursor is in the grid in the Explore Layout dialog, you can use **CONTROL+E** to activate this command, otherwise, you can use **ALT+E** from elsewhere in the dialog.

Layout information is useful in other ways. You can navigate from one region to another in a document by using **SHIFT+F8**, which advances the cursor to the beginning of the next text region, or **SHIFT+F6**, which takes the cursor to the beginning of the previous text region. **CONTROL+F1** reports the position of the current word.
Document Overview Shortcut Keys

**SHIFT+F5** starts browsing.

The following shortcuts are for Layout Exploration. They are also applicable to table formats elsewhere in Kurzweil 1000.

**UP** or **DOWN ARROW** moves the cursor one line up or one line down in the current cell or in the cell above or below, respectively.

**LEFT** or **RIGHT ARROW** moves the cursor from one column to another.

**HOME** moves the cursor to the left-most column in the current row.

**END** moves the cursor to the right-most column in the current row.

**CONTROL+HOME** moves the cursor to the first cell in the table.

**CONTROL+END** moves the cursor to the last cell in the table.

**F7** reads the contents of the current cell.

**SHIFT+F7** tells you the contents of the first cell in the current row from anywhere else in the row.
5 Navigating in Documents

This chapter contains the following topics:

Accessing Navigation Commands.
Page Navigation.
Cursor Navigation.
Bookmarks.
Bookmark Navigation.
Links.
Document Navigation Methods

Kurzweil 1000 provides multiple document navigation methods:

**Going to a Specific Page** lets you type in the exact number of the page to which you want to go.

**Going to the Last (cursor) Position** allows you to backtrack to 20 of the previous positions where your cursor had been.

**Going to Bookmarks** lets you go to bookmarked text.

**Links** enables you to go to another place in the current document or opens a related file or Web page.

In this chapter, we cover navigating a document using the features listed above, as well as their creation or setup.

Accessing Document Navigation Commands

Navigation commands are available from the Navigation menu. You can also use mnemonics or shortcut keys, if available. For the Go to Page command, there is a Reading Keypad key.

**Note:** For more information, you can either download the document *Using the Keypad to Access Kurzweil 1000* from the Kurzweil Educational Systems website—www.kurzweiledu.com—or refer to Appendix E, *Using the Keypad to Access Kurzweil 1000* in the Online Manual.
Chapter 5. Navigating in Documents

The Navigation Menu

The Navigation menu is located after the Read menu and before the Settings menu when a document is open.

To open the Navigation Menu:

Use one of the following methods:

• Press ALT, then the RIGHT ARROW key until you hear the name of the menu.

• To use mnemonics, press ALT+V.

Page Navigation

This section presents information about the Set and Unset User Page Number features, as well as the Go to Page navigation function.

Setting and Unsetting User Page Numbers

By default, Kurzweil 1000 numbers the first page in a scanned or any other KES document as page 1, the next as page 2, and so forth, even if you begin scanning at page 50 of a book. Also by default, it does not take into account different numbering schemes such as those typically used for tables of contents, for example.

The Set User Page Number feature lets you assign page numbers. This is helpful for keeping the Kurzweil 1000 document page numbers synchronized with the actual document page numbers.

When you set a page number, the system checks to make sure that the new page number does not conflict with other page numbers you have set. These user-defined page numbers must be in ascending order from the beginning to the end of a document. For example, you can change page 10 of a document to page 5, but
cannot then change page 5 to page 10. In addition, there must be enough document pages between one user-defined page number and the next to allow for the page numbers. If you’ve made a mistake and want to remove a user page number, use **Unset Page Number**.

Once you’ve set your own page numbers, Kurzweil 1000 uses them to report location. (The exception is when the system uses page numbers to let you know how far along a process has progressed, such as the Spell and Find operations.) It also uses your page numbers when you use the **Go To Page** command.

Kurzweil 1000 reports these user-defined page numbers only if you have the **Page Numbers** set to **Operator defined** in the **General Settings** tab. Go to Chapter 12, *Working with Settings* for details.

**To set the user page number:**

1. Open the **Navigation** menu and choose **Set User Page Number**.

   The **Set Page Number** dialog opens with the cursor in the **New Page Number** text box.

2. Type a new page number for the current page, then press **ENTER**.

   Kurzweil 1000 reports the current page number followed by the changed page number.

   This establishes a starting page number for a section of pages. The section ends with the next page for which you define a page number.
To unset the user page number:

Open the Navigation menu and choose Unset User Page Number.

Kurzweil 1000 announces that the operator-defined page number was deleted.

**Specifying Preliminary Page(s)**

Once you have set user-defined pages, you can go directly to any preliminary pages by specifying the letter P. This feature works in any control that accepts a page number. Suppose you are in a document that has front matter pages, a Foreword section perhaps, for which you have set a different page numbering scheme from the rest of the document, and that section has 15 pages. To go to the section’s page 9, and not to the main page 9, type the letter P followed by the desired page number Page dialog.

**Going to a Specific Page**

1. Open the Go To Page dialog by doing one of the following:
   - Open the Navigation menu and choose Go to Page.
   - Or Press CONTROL+G.

   The Go To Page dialog opens with your cursor in a text box.

2. Type a page number, then press ENTER.

   If you set page numbers in a document, it is possible to have a series of pages that begin before what you have established as page one. To go to these pages, precede the page number with the letter P in this text box.

   Kurzweil 1000 goes to the page, says the page number, and begins reading.
Cursor Navigation

Kurzweil 1000 tracks up to 20 of your last cursor positions in a document. By using the Go to Last Position feature, you can return to those cursor positions.

Each time you use the function, Kurzweil 1000 returns your cursor to the previous position in sequential, descending order until it goes through the entire list.

At each returned position, Kurzweil 1000 tells you the line number, and page number, if the page has changed.

**Going to the Last Cursor Position:**

Do one of the following:

- Open the Navigation menu and choose Go to Last Position.
- Press ALT+N+P.
- Or CONTROL+F5.

Bookmarks

Like its physical counterpart, the electronic bookmark remembers a specific place in a document. With Kurzweil 1000 electronic bookmarks, however, you can do much more:

- Get the page number and a description associated with each bookmark.
- Mark documents that are hundreds of pages long for quick and easy reference.
- Use unlimited bookmarks on a page or in a document.
- Generate bookmarks from key words in documents.
Create simple single-level bookmarks.

Create multiple-level bookmarks to reflect complex information and organization. This feature make bookmarks an ideal tool for creating tables of contents and outlines, and for studying.

Navigate to desired topics in a file; even when you use the File Open command, if the file contains bookmarks, you can open directly to a bookmark.

When you create a bookmark, Kurzweil 1000 creates a description based on the current sentence or selected text.

If no text is selected, the default bookmark description is the sentence in which your cursor is positioned.

If text is selected, the default bookmark description is the currently selected text.

You can later scroll through a list of bookmark descriptions to return to the corresponding document locations.

The description is anchored to nearby text. When you edit the page, as long as the text associated with a bookmark had not been removed, the bookmark will point to the correct text.

There are two ways in which you can create bookmarks:

Insert them and specify an associated description.

Or generate them from key words in your document.

After you create bookmarks, you can view and edit their properties, and delete them from documents.

Notes:

Kurzweil 1000 preserves bookmarks when you save the document in any format, consequently, you can, for example, save bookmarks in a Word document. Wherever you left off...
when you closed the document is where your cursor will be when you reopen it.

You can lose bookmarks in documents that are not in the KES or DAISY .OPF formats when you move the file to another computer or alter it in any way outside of Kurzweil 1000.

Kurzweil 1000 supports PDF bookmarks for non-encrypted PDF files. When you open the file, Kurzweil 1000 collects the bookmarks. If the bookmark description matches text on the page, Kurzweil 1000 opens to the first instance.

**Accessing Bookmark Commands**

Bookmark commands are available from the **Navigation** menu. You can use associated mnemonic keys or shortcut keys.

Certain Bookmark-related commands are also available from the keypad. For more information about using the keypad to work with Bookmarks you can either download the document *Using the Keypad to Access Kurzweil 1000* from the Kurzweil Educational Systems website—www.kurzweiledu.com, or refer to Appendix E, *Using the Keypad to Access Kurzweil 1000* in the Online Manual.

**Creating Single-Level Bookmarks**

1. Position the cursor in the sentence where you would like to insert the bookmark, or select the text you want to use as a bookmark description.

2. Open the **Navigation** menu and choose **Create Bookmark** (**ALT+V+K**) or press the shortcut **CONTROL+B**.
Chapter 5. Navigating in Documents

Generating Bookmarks from Key Words

1. Open the Tools menu and choose Generate Bookmarks (ALT+O+B).

   A dialog appears and your cursor is in a text box.

2. Type one or more words to serve as keys, separated by spaces.

   These key words are words that exist in the document. Each time the system finds one of these words, it inserts a bookmark at the sentence where the word occurs.

Creating Multi-Level Bookmarks

You can insert up to six levels of bookmarks in a book. Once you create multi-level bookmarks, you can use them in conjunction with the Summarize feature or the Extract command to create study tools such as outlines and topic lists. Larger level numbers indicate deeper levels in a hierarchy. Use, for example, Level 1 for Chapter titles, Level 2 for Sections, Level 3 for Subsections, and so on.

To create multi-level bookmarks:

1. In the document, position your cursor where you want to place the bookmark or select text that you want as the bookmark’s description.

2. Press CONTROL+B twice to open the Multi-Level Bookmark dialog.

   Your cursor is in the Description text box.

3. Modify the description for this bookmark if you want.

4. If you want the chime for this bookmark, TAB to the Chime list box, and use the UP/DOWN ARROW key to select Enable.
5. **TAB** to the bookmark **Level** box. Use the **UP/DOWN ARROW** keys to select the desired bookmark level number for this bookmark. You can also type the number.

The default level is the number 1 if this is the first bookmark you are using in Kurzweil 1000. Once you create bookmarks, the default level is the level of the last bookmark you edited.

**The Go to Bookmark Dialog**

The **Go to Bookmark** dialog not only lets you select the bookmark you want to go to, but it also enables you to sort and edit your bookmarks. This dialog has five components, along with the **Delete** and the usual **OK** and **Cancel** command buttons. The components are:

- The **Select a bookmark** box, which by default, displays the bookmarks in hierarchical order. Your cursor is in this box whenever you open this dialog. The exact location of your cursor in this dialog corresponds to the position of your cursor in the document. For instance, if your cursor is in the text of a Level 3 bookmark, your cursor in the tree-view box is in the corresponding Level 3 bookmark.

- The **Description** text box (mnemonics **ALT+P**) where you can edit the description of the selected bookmark. You can also use the mnemonic **ALT+D** to access this box from elsewhere in the **Go to Bookmark** dialog.

- The **Sort** options list follows (**ALT+S**). Here you can select one of three ways to view bookmarks: by **Subject**, **Page Number** or by **Page Number and Level**.

- Next is the **Chime** list (**ALT+C**) from which you can enable or disable a chime for the selected bookmark.
The Level list box (ALT+L) follows. You can type or use the UP/DOWN ARROW keys to select the level number you want for the selected bookmark.

At the bottom are the Delete, OK, and Cancel commands.

In the next subsections, you'll find more information about and procedures for using the Go to Bookmark dialog to sort and edit bookmark entries.

**Bookmark Navigation**

You can go directly to a bookmark by selecting its description from the Go to Bookmark dialog. For long bookmark lists, you can search for words in the description.

In addition, when you use the File Open (Control+O) command, you can directly open the file to a bookmarked page. Note also that Kurzweil 1000 supports PDF bookmarks for non-encrypted PDF files.

**Going to a Bookmark When Opening a File**

1. Press Control+O to access the File Open dialog.
2. Navigate to the desired directory in the Folder list.
3. Tab to the File list and find the file you want to open.
4. Press the Right Arrow key to determine if the file contains bookmarks or not.
   
   If the file has bookmarks, a second window with the Bookmark List opens.
5. In the Bookmarks List, you can use the Up/Down arrow keys to move through the bookmark descriptions.
6. When you hear the one you want, press Enter to open the file to the selected bookmark.

**Notes:**
To return to the File List from the Bookmark List without selecting a bookmark, press the Left arrow key.
Unlike the Go to Bookmarks dialog, Search and Sort Bookmark features are not available in the Bookmark List.
Pressing the Escape key while in the Bookmark List closes both the Bookmark List and the File Open dialogs.

**Going to a Bookmark**

1. Choose **Go to Bookmark** from the **Navigation** menu (ALT+V+B) or press **CONTROL+R**.

   The **Go to Bookmark** dialog appears and your cursor is in the **Select a Bookmark** list and positioned on the bookmark description which will bring you to the next bookmark in the document.

2. Use the **UP/DOWN ARROW** keys to move through the bookmarks list.

3. When you hear the desired description, press **ENTER**.

   To leave the dialog without selecting a bookmark, press **ESCAPE**.

**Searching for Text within Bookmark Descriptions**

1. In the **Go to Bookmark** dialog, with your cursor in the **Bookmarks** list, press **CONTROL+F**.
Your cursor is now in a text box. Kurzweil 1000 asks you to enter a word or phrase.

2. Type in the text you want to find and press ENTER.

Your cursor is now in the first Bookmark whose description contains text that matches your search.

3. To go to the next Bookmark description that matches your search text, press F3. To search backwards, press SHIFT+F3.

4. When you hear the desired Bookmark, press ENTER.

To leave the dialog without selecting a Bookmark, press ESCAPE.

**Sorting Bookmarks**

When you have a large list of bookmarks, finding the one you want can be easier if you sort the bookmarks first. There are three ways to sort bookmark lists:

- **By Page Number,** where the bookmark descriptions are presented in a one-level list in reading order. If you have multi-level bookmarks, they all appear as if they are at the top level.

- **By Subject,** where the list is presented in alphabetical order by the first word in the description. If you have multi-level bookmarks, they all appear as if they are at the top level.

- **By Page Number and Level,** where the bookmarks are in reading order and presented in indented tree view format. This is the system default.

**To change the sorting option:**

1. In the Go to Bookmarks dialog, press CONTROL+S to go to the Sort options list.
2. Use the **UP/DOWN ARROW** keys to select **Page Number**, **Subject**, or **Page Number and Level**.

3. To return your cursor to the **Select a Bookmark** list, press **SHIFT+TAB** several times. You can continue to select a bookmark.

**Navigating Bookmark Descriptions**

To navigate descriptions sorted by **Subject** or **Page Number**:

- Use the **UP/DOWN ARROW** keys.

To navigate descriptions sorted by **Page Number** and **Level**:

- Use the **UP/DOWN** and the **LEFT/RIGHT ARROW** keys. Up and down arrow keys place your cursor in entries of the same level, within the same parent Bookmark. Left and right arrow keys place your cursor in entries one level up or down.

**Editing Bookmark Properties**

To edit properties for a Bookmark you just created, press **CONTROL+R**, or you can use the **Go To Bookmark** dialog as described below.

1. Choose **Go to Bookmark** from the **Navigation** menu (mnemonics **ALT+V**, then **B**) to open the **Go to Bookmark** dialog.

   Your cursor is in the **Select a bookmark** list.

2. Use the **UP/DOWN ARROW** keys (and the **LEFT/RIGHT ARROW** keys in a multi-level list) to move through this list.

3. Stop when you hear the Bookmark you want. This selects it.
• To change the description, press tab again to go to the Description text box, and use typical editing functions to modify that description.

• To change the level of the bookmark, go to the level property (ALT+L) and type in an appropriate level, or hold down the shift key and press the LEFT ARROW to decrease the level number by one, the RIGHT ARROW to increase it by one.

  Note: Lowering and raising a bookmark’s level affects its associated bookmarks. Suppose you have a level 3 bookmark with level 4 bookmarks associated with it. If you raise its level to a 2, its associated bookmarks then become level 3 bookmarks. In reverse, if you lower its level and it becomes a level 4 bookmark, its associated bookmarks then become level 5 bookmarks.

• To delete the bookmark, use ALT+D or tab to the delete button and activate it by pressing space, or simply press the delete key on the keyboard.

  Note: you can select multiple bookmarks and change all of their level numbers at once or delete them. Bookmarks are selected when they are checked. To check the current bookmark, press the space bar. That will check an unchecked bookmark, or uncheck a checked one. To check all of the bookmarks at once, use CONTROL+A. To check a bookmark and any bookmarks that are immediately to its right (subchapters of the current chapter, for example) press CONTROL+SPACE. Once you have multiple bookmarks checked, you can change their levels in the same manner described above, or you can delete them.
• To cancel the change, press **ALT+C** or the **ESCAPE** key. This will cause the dialog to close without making any changes.

• To save the editing, use the **APPLY** button to keep the editing changes and leave the dialog open (without going to the selected bookmark),

or

Use the **ENTER** button to apply the changes, close the dialog, and go to the position indicated by the bookmark.

### Links

As you read a document or article that contains links, Kurzweil 1000, by default, plays a chime upon reaching each link. You can follow these links to other places in the current document, also known as *internal links*. When reading encyclopedia articles, you can follow internal as well as *article links* that open related articles or *external links* that open related Web sites.

There are two ways to follow a link. Select it from the **Select a Link** dialog, or **Activate** the one nearest to the cursor position. Once selected or activated, Kurzweil 1000 takes you to the destination text and begins reading.

While in the **Select a Link** dialog, it’s possible to edit link descriptions, sort them by **Page Number** or **Subject**, or to **Delete** links.

There are two additional things you can do: Create internal links in the current document and if you don’t want links to chime, you can disable the setting in the **Verbosity Settings** dialog. For more information, go to Chapter 12, *Working with Settings*. 

76
Creating an Internal Link

In creating a link, Kurzweil 1000 requires two pieces of information: The destination, text to which a link should go, and the location of the link. You can either start with the Create a Link command, telling Kurzweil 1000 where you want to place the link, then use the Mark a Position command to specify the destination text. Or you can mark the destination text first, then go to the place where you want to create the link. The following steps present the first method.

1. Place your cursor where you want the link and do one of the following:
   - Open the Navigation menu and choose Create a Link.
   - Or press ALT+V+I.
   - Or press CONTROL+SHIFT+F7.
   Kurzweil 1000 prompts you to move to the destination text.

2. Place your cursor at the location of the destination text, and choose Mark a Position from the Edit menu or use the shortcut CONTROL+M.
   Kurzweil 1000 automatically selects the sentence in which you’ve placed the cursor.

Selecting a Link

1. Do one of the following:
   - Choose Select a Link from the Navigation menu.
   - Press ALT+V+L.
   - Or press CONTROL+F7.
   The Select a Link dialog opens and the link you stopped at in the document is currently selected in the list.
2. Press ENTER to go to the internal, article or external link and begin reading.

Notes:
• To peruse the other links, use the UP/DOWN ARROW keys.
• If you want to know what type of link the current selected link is, press F7.

Activating a Link
If you are near a link, you can choose Activate a Link from the Navigation menu or press ALT+V+A or SHIFT+ENTER. Kurzweil 1000 announces the link.

Working with Link Descriptions
1. Open the Select a Link dialog by pressing CONTROL +F7, then do any of the following:

   To edit a link, select it from the Select a link list, then press ALT+P or the TAB key to go to the Description box. Begin editing.

   To sort links, press ALT+S to go to the Sort links list, and select Page Number or Subject. Kurzweil 1000 sorts the links in the Select a link list.

   To delete a link, select it from the Select a link list, then press ALT+D.

2. When you’re done, press ESCAPE to exit the dialog.

Document Navigation Shortcut Keys
CONTROL+G to go to a specific page.
CONTROL+F5 to go to the last cursor position.

The following shortcuts are for bookmarks:

**CONTROL+B** to create a bookmark at the cursor location.

**CONTROL+B twice** to create multi-level bookmarks.

**CONTROL+R** to go to a bookmark.

**CONTROL+F**, while in the **Go to Bookmark** dialog, to search for a specific bookmark description.

**F3**, while in the **Go to Bookmark** dialog, to go to the next bookmark description that matches your search.

**SHIFT+F3**, while in the **Go to Bookmark** dialog, to search backwards for the next bookmark description that matches your search.

**CONTROL+S**, while in the **Go to Bookmarks** dialog, to go to the **Sort** options list.

The following shortcuts pertain to links:

**CONTROL+M** to mark the destination text to which you want an internal link to go.

**SHIFT+CONTROL+F7** to create an internal link.

**CONTROL+F7** to open the Link dialog and select a link to go to.

**F7**, in the Link list, to find out the selected link’s type.

**SHIFT+ENTER** to activate a link and go to the destination text.
6 Reference Tools

This chapter contains the following topics:
Accessing Reference Tools.
Dictionary, Thesaurus and Spelling Lookup.
Using an Encyclopedia.
Getting a Translation.
Reference Tools Shortcut Keys.
Accessing Reference Tools

As you read for leisure, school or for work, you can look up words in the dictionary and thesaurus, as well as find online encyclopedia articles about your topic.

You can also hear words spelled letter-by-letter, or with a word alphabet (alpha, bravo, and so on).

When using the dictionary dialog, you can opt to hear a human voice pronounce the word as well as find anagrams for the word.

You can find reference tools in the following menus:

• The Read menu contains Spell (a word).

• The Tools menu contains: Define a Word and Use the Thesaurus.

• The Online menu contains Use an Encyclopedia.

If you are a keypad user, both the Kurzweil 1000 and the Screen Reader Reading Keypad Layers provide you with access to dictionary lookup. There is no keypad function for encyclopedia searches and bilingual dictionaries. For more information on using the keypad, you can either download the document, Using the Keypad to Access Kurzweil 1000, from the Kurzweil Educational Systems website—www.kurzweiledu.com—or refer to Appendix E, Using the Keypad to Access Kurzweil 1000 in the Online Manual.
Dictionary, Thesaurus and Spelling Lookup

Kurzweil 1000 lookup tools let you look up a selected or typed word in the system dictionary or thesaurus, or hear a word spelled aloud. When using the Dictionary lookup, you can select a single word or multiple words, such as, "mother-of-pearl."

The Lookup Dialog

From the Tools menu, choose the Define Word or Use the Thesaurus options to access the Lookup dialog. Both options use the same dialog, except that the Replace function is only available with the Use the Thesaurus option. The Lookup dialog opens with the following components:

- **Word To Be Defined** combo box (ALT+W). When the Lookup dialog first opens, your cursor is in this combo box, and you hear the current word. To return to this combo box, press ALT+W.
  
  You can also choose words from the combo box list. The list contains the last five words you looked up.

- **Part of Speech** list box (ALT+S). Its dozen options allow you to return results based on a variety of parts of speech, such as Slang in the American Heritage Dictionary, as well as a word’s etymology or idiom usage.

- **Dictionary Source** list box (ALT+I) or Thesaurus Source (ALT+T). If you are looking up a definition, the list contains all installed dictionaries, including bilingual dictionaries. If you are looking up a synonym, it contains all installed thesauruses.

- **Entry** text box (read only) contains a definition or entry for the current word. You can move in this box character-by-character or word-by-word, and can select text.

- **Next** button (ALT+N) takes you to the next definition or synonym.
• **Previous** button (**ALT+P**) takes you to the previous definition or synonym.

• **Pronounce** button (**Alt+O**) plays a recording of a person speaking the word you are looking up. Note: this feature requires the optional installation of the American Heritage Dictionary pronunciation WAV files on the product CD, and is available only for dictionary lookup.

• **Anagrams** button (**Alt+A**) presents all the anagrams for the word you are looking up. If anagrams exist, the Anagrams dialog opens and Kurzweil 1000 tells you the number of matches found. Press Tab to go to the Anagram list. Use the Up/Down arrow keys to hear the list. If you press Enter to select an anagram, the dictionary dialog now presents the definition of the selected anagram. Note: this feature requires the optional installation of the American Heritage Dictionary pronunciation WAV files on the product CD, and is available only for dictionary lookup.

• **Replace** button (**ALT+R**) replaces a word in the document with a synonym selected in the Lookup dialog.

• **Done** button (**ALT+D**) closes the dialog.

**Using Lookup Tools**

You can use the lookup command for a word while reading or select it first then use the lookup command.

**To find the definition of a word, words or phrase:**

1. From the **Tools** menu, choose **Define a Word**, or press **ALT+O+D**.
If there is a document open, the **Word Lookup** dialog opens with the current word placed in the **Word to be Defined** combo box, and you hear the word to be defined.

You can also choose words from the combo box list. The list contains previously searched words. You can type a different word into the combo box as well.

2. To find definitions based on a word’s grammatical or etymological usage, press **TAB** to go to the **Part of Speech** list and select the desired option.

**Note:** You cannot use wildcards in conjunction with the Part of Speech option.

3. Press **ENTER**.

Kurzweil 1000 returns the results and begins reading the first definition. You’ll hear the entry number, followed by the definition.

**Notes:** When the Dictionary is unable to find the word you specified, it will suggest another one based on words that have a similar spelling. For instance, if you look up the word, "braile" using only one "l," the dictionary will ask if you mean the word, "braille," containing two l’s. Once you have the definition, you can press CONTROL+W to copy the entire definition to the clipboard and paste it into any document, even one in another application.

4. To go to the **Next** definition, press **ALT+N** or **ENTER**, which works only when you are in the Entry text box. Other shortcuts for Next definition are **PAGE DOWN** and **F8**.

5. To go to the **Previous** definition, press **ALT+P**. Shortcuts for Previous definition are **PAGE UP** and **F6**.
You can also use CONTROL+HOME to hear the first definition for a word, or CONTROL+END to hear the last definition.

6. When you are done, press ALT+D for Done or press ESCAPE.

To find the synonyms for a word:
1. From the Tools menu, choose Use the Thesaurus (ALT+O+U), or use the shortcut SHIFT+F7.

   The Word Lookup dialog opens. If there is a document open, the Word Lookup dialog opens with the current word placed in the Word to be Defined text box, and you hear the word for which synonyms will be found. If you look up a word as you read, Kurzweil 1000 uses the word after the cursor.

2. To find definitions based on a word’s grammatical or etymological usage, press TAB to go to the Part of Speech list and select the desired option.

   Note: You cannot use wildcards in conjunction with the Part of Speech option.

3. Press ENTER.

   Kurzweil 1000 returns the results and reads the entry number, followed by the synonym.

4. To go to the Next synonym, press ALT+N or the ENTER key, which works only when you are in the Entry text box. Other shortcuts for Next synonym are PAGE DOWN and F8.

5. To go to the Previous synonym, press ALT+P. Shortcuts for Previous synonym are PAGE UP and F6.

6. When you are done, press ALT+D for Done or press ESCAPE.

To look up a typed word:
1. Do one of the following:
To look up a definition:

From the **Tools** menu, choose **Define a Word (ALT+O +D)**, or use the shortcut **CONTROL+D**.

To look up a synonym:

From the **Tools** menu, choose **Use the Thesaurus (ALT+O+U)**, or use the shortcut **SHIFT+F7**.

The **Word Lookup** dialog opens with your cursor in the **Word to be Defined** combo box. If there is a word from a previous search, Kurzweil 1000 reports it.

2. Type the desired word to look up, then press **ENTER**.

You can also choose words from the combo box list. The list contains the last five words you looked up.

3. When you are done, press **ALT+D** for Done or press **ESCAPE**.

**Note:** You can continue to look up other words by returning to the **Word to be Defined** text box (**ALT+W**), then typing a new word.

**Finding Anagrams for a Word**

When defining a word (**Alt+O+D**), you can look up anagrams for the word by pressing **Alt+A** in the dialog. Note: this feature requires the optional installation of the American Heritage Dictionary pronunciation WAV files on the product CD, and is available only for dictionary lookup.

**Hearing a Word’s Pronunciation**

When defining a word (**Alt+O+D**), you hear a person pronouncing the word by pressing **Alt+O** in the dialog. Note: this feature requires the optional installation of the American Heritage Dictionary
pronunciation WAV files on the product CD, and is available only for
dictionary lookup.

**Using Wildcard Characters in Your Lookup**

When working with computers, wildcard characters can save time
and help you broaden or narrow searches. You can use the
question mark as a wildcard for one letter character, or an asterisk
for multiple letters when typing the word to be defined or the word
for which you want the synonyms in the lookup dialog.

Using wildcard characters can help you spell words. Suppose you
want to find the correct spelling for the word "image," but are not
sure which second vowel to use. In the Dictionary lookup dialog,
you could specify an i, an m, a question mark, then g and e for your
search. Kurzweil 1000 responds with the word "image."

Suppose you want to find words that begin with i and m and end
with t, i, o, n. Type an i, an m, an asterisk, then t, i, o, n. Kurzweil
1000 tells you the number of matches found. Press TAB to go to the
list of words, and the UP and DOWN ARROW keys to go through
the list. In this example, the list includes the words "imagination"
and "imitation." Press ENTER when you hear the word you want.
Kurzweil 1000 then responds with the definition or synonym.

**Note:** If there are more than 500 matches, Kurzweil 1000 asks you
to refine your search.
Switching Between Definitions and Synonyms

There may be times when you want to look up a word’s definition, and then its synonym, or vice versa. While you have one type of Lookup dialog open, you can specify the other type.

To look up the synonym of a word while in the definition dialog, press \textbf{SHIFT+F7}.

To hear the definition of a word while in the synonym dialog, press \textbf{CONTROL+D}.

\textbf{Note:} The Lookup functions work for the current word, so be sure the cursor is within the desired word or immediately before it.

Placing Lookup Entries into Your Document

To place a synonym into your document:

1. Position the cursor within or just before the word for which you want to find a synonym.

2. Open the \textbf{Tools} menu and choose \textbf{Use the Thesaurus} or press \textbf{ALT+O+U}.
   
   The \textbf{Synonym Lookup} dialog opens.

3. To hear the first synonym press \textbf{ENTER}.

4. Continue to press \textbf{ENTER} to hear the list of synonyms. Press \textbf{Page Up} to move backwards in the list.

5. When you hear the desired synonym, press \textbf{ALT+R} for Replace to make the replacement and close the dialog. This action does not include the synonym number.

   If you decide not to replace the word, press \textbf{ALT+D} for \textbf{Done} or \textbf{ESC} to close the dialog without making a change.
Note: The Thesaurus Replace function does not take into account the form of the word in the document. If the original word is plural, for example, the replacement synonym could be singular.

To paste a given definition into the current document:

1. Position the cursor within or just before the word for which you want to define.
2. Open the Tools menu and choose Define a Word or press ALT+O+D.
3. To hear the first definition, press ENTER.
4. Continue to press ENTER or ALT+N to hear the list of definitions. Press ALT+P to hear a previous definition.
5. Press CONTROL+C on the keyboard when you hear the entry you want. This action does not copy the definition number.
6. Press ALT+D or ESC to close the Lookup dialog, and return to the document.
7. Position the cursor at the location where you want to paste the entry, then press CONTROL+V.

Hearing a Word’s Spelling

Find the word you want to spell, then open the Read menu and choose Spell, or press ALT+R +L. You must manually restart reading.

Normally the shortcut for Spell is CONTROL+L. If, however, you chose to use shortcuts that emphasize format editing, the shortcut is CONTROL+F12. You can also use CONTROL+L to hear Kurzweil 1000 spell the contents of text boxes and lists. Use SHIFT+CONTROL+L to hear the word spelled using a word alphabet.
Using an Encyclopedia

In addition to dictionary and thesaurus searches, you can look up information from online encyclopedias.

Encyclopedia articles are actually one-page document files. You can read them, edit them, or save them. They may also contain links, which you can follow to find related information elsewhere in the document or to open other articles and Web sites. For information about working with links, go to Chapter 5, Document Navigation Tools and Methods.

The Use Encyclopedia item on the Online menu enables you to access articles from the following online encyclopedias.

- Wikipedia (English and German), a free Web encyclopedia
- Encyclopaedia Britannica ($)
- Encyclopaedia Britannica Student ($)
- Bartlett’s, Columbia, Simpson’s, and Respectfully Quoted Quotations
- Merriam Webster’s Medical Dictionary

**Note:** A dollar sign at the end of a name indicates that access to that encyclopedia requires a subscription and may require a user name and password. If you use the subscription-based references often, you can save the user name and password in a settings file. For more information on settings, go to Chapter 12, Working with Settings.
To find an encyclopedia article:

1. Open the **Online** menu and choose **Use an Encyclopedia** or press **ALT+N+E**.
   
The Encyclopedia dialog opens with the cursor in the Keywords combo box.

2. Type the keyword or phrase you want to look up.
   
   You can also choose keywords from the combo box list. The list contains search terms from up to your last ten searches.

3. Press **TAB** or **ALT+E** to go to the Encyclopedia list and select the encyclopedia you want to search.

4. Press **ENTER** to begin the search.
   
   Kurzweil 1000 opens the related article and begins reading. If there are multiple articles, Kurzweil 1000 presents the titles from which you can make a selection. You can select multiple articles from the list. Kurzweil 1000 downloads and opens each article as a separate document.

   If Kurzweil 1000 is unable to find an article for your topic or if there are problems with the encyclopedia Web site, it returns an error message.
Getting a Translation

Kurzweil 1000 enables you to translate passages in one language to another by providing quick access to the Google translation engine.

In order to use this feature, you must have Internet access from your computer. The feature is accessible from the Online menu and is available whether or not you have a document open.

To translate a passage:

1. Go to the Online menu and choose Translation by pressing Alt+N+T.

2. In the Translation dialog that opens, select the source language of the passage in the From list. If you do not know what the original is, leave the option on Detect Language, otherwise, use the Up or Down Arrow to select a language from the list of languages that are supported by the speech engine on your system. The mnemonic for the From language list is Alt+F.

3. Press Tab to go to the text box. Type the passage you want translated.

   Note: You can edit, navigate and use speech functions in the text box.

4. Press Tab or Alt+T to go to the language to translate To list. Select a language from the list of languages that are supported by the speech engine on your system.

5. Press Tab again to initiate the translation process and go to the text box in which the translated text will appear. When the process is complete, Kurzweil 1000 begins reading the translated text.
6. To end the translation session, press Alt+D for Done, or Tab to the Done button, then press Enter.

Reference Tools Shortcut Keys

The following shortcuts are for definitions, synonyms and spelling.

**CONTROL+D** finds the definition of a word or phrase. This keystroke is also usable in a Synonyms lookup to switch from thesaurus to dictionary.

**SHIFT+F7** finds the synonyms for a word. This keystroke is also usable in a Definitions lookup to switch from dictionary to thesaurus.

**CONTROL+L** spells a word. If, however, you chose to use shortcuts that emphasize format editing, use **CONTROL+F12**.

**SHIFT+CONTROL+L** spells the word using a word alphabet.

The following shortcuts pertain to links:

**CONTROL+F7** to select a link.

**SHIFT+ENTER** to activate a nearby link.
7 Annotations, Outlines and Other Study Tools

This chapter contains the following topics:

Types of Annotations and Study Tools.
Working with Notes.
Using the Summarize Feature.
Building Topic Lists.
Types ofAnnotations and Study Tools

There are a number of Kurzweil 1000 features that are ideal study tools. The primary features are listed below:

**Bookmarks.** Using bookmarks to mark places in text where there are key points helps you return quickly and easily to the information you need. In addition, you can use multi-level bookmarks to organize the information, for example, into section headers, main ideas, and supporting details. Later, you can use CONTROL+R to read through the bookmark descriptions, or use the Summarize command to create an outline or study document containing the bookmark descriptions. Kurzweil 1000 preserves your Bookmarks regardless of the file format in which you save your document. Go to *Working with Bookmarks* in Chapter 5, *Document Navigation Tools and Methods*, for more details.

**Notes.** Whether or not you are a student, there may be times when it’s useful to annotate material with which you are working. You can add notes, thoughts, even additional reference or background information at the appropriate location in text. By using the **Summarize** feature, you can extract the notes into a study document. Like Bookmarks, Notes are preserved in Kurzweil 1000 regardless of the file format in which you save your document.

**Summarize Command.** Once you add bookmarks and/or notes, it’s possible to extract their descriptions and contents into a new document. You may find this function helpful in creating study documents, outlines, and table of contents. For more information on using the Summarize command, go to the section, *Using the Summarize Feature*, in this chapter.
Chapter 7. Annotations, Outlines and Study Tools

**Links.** There are two possible ways to use links as a study tool. First, you can add multi-level bookmarks in a document, then save the document in HTML format. This converts the bookmarks into links which you can select to go directly to the information you want. For more information about saving a file in the HTML format, go to Chapter 13, *Files and Folders*.

Second, you can create internal links that take you to related information within the same file. For more information about creating and working with links, go to *Working with Links* in Chapter 5, *Document Navigation Tools and Methods*.

In addition to Bookmarks, multi-level Bookmarks, Notes, Links and Summarize, you can use the following methods as you pre-read, read and review material:

**Browsing:** reads the first or last sentence or both of each paragraph. **SHIFT+F5** starts browsing. For details on the Browse feature, go to *Browsing a Document* in Chapter 4, *Exploring Documents*.

**Skimming:** while reading, use the **RIGHT SHIFT** key to advance quickly from one reading unit to another. This method works best if you have Reading Unit in the Reading Settings set to Paragraph. **LEFT SHIFT** key takes you backwards by Reading Unit.

**Repeating what you’ve read** by pressing **F7**.

**Using Format to browse or find information.** Use the Find dialog (**CONTROL+F**) and specify the **Format** you want Kurzweil 1000 to find.
Working with Notes

Bookmarks and Notes in Kurzweil 1000 have some similarities. Both allow you to mark places in a document for quick access later and to add annotations.

Notes, however, accommodate expanded annotations while bookmarks accommodate brief descriptions. When used together, that is, if you place notes near related bookmarks and you later Summarize the document, the Notes provide the details while the bookmark descriptions act as subject headers.

You can create, read, edit, save and manage Notes in Kurzweil 1000 .KES, as well as in the DAISY .OPF file formats. In addition, you can use the Summarize feature to extract notes into a new document. For more information on the Summarize command, go to Using the Summarize Feature in this chapter.

As you read a document containing Notes, Kurzweil 1000 chimes when it reaches each Note. If you prefer not to hear the chime, you may change the setting in the Verbosity Settings dialog. For more information about the Reading Past a Note setting, go to Verbosity Settings in Chapter 12, Working with Settings.

To create a Note:

1. Place the cursor near the text where you want to attach the note.

2. Do one of the following:
   - Choose Create a Note from the Edit menu or press ALT+E+E.
   - Or use the shortcut keys CONTROL+SHIFT+Q.
To read, edit or delete a note:

1. Open the Note dialog by choosing Read a Note from the Read menu or by pressing ALT+R+N.
   Kurzweil 1000 reads the current note from the Select a Note list.

2. Do one of the following:
   • To hear the notes in the list, use the UP or DOWN ARROW.
   • To edit a note, select it from the list, press TAB or ALT+P to go to the Edit box, then begin editing.
   • Or to delete a note, select it, then press the DELETE key or ALT+D.

3. When you’re done, press ENTER to OK the changes.

To change the sort order in the Notes list:

   By default, Kurzweil 1000 presents the notes in the Note dialog in Page Number order. However, you can sort them in alphabetical order by Subject. In the Note dialog, press CONTROL+S.

   Whatever sort order you select is the sort order Kurzweil 1000 uses the next time you use the Note dialog.

To search Note descriptions:

   CONTROL+F lets you search through the Note descriptions. F3 lets you search again forward; SHIFT+F3 searches again backward.

To convert Bookmarks into Notes:

   If you have a document created before Kurzweil 1000 Version 9, and you want to convert its level-one bookmarks into Notes, you can do so.
First, ensure that the Bookmark Chimes are enabled in the Verbosity Settings tab.

Open the File menu, select Utilities, then choose Convert Bookmarks to Notes or press ALT+F+U+V.

Using the Summarize Feature

When you use bookmarks and Notes in conjunction with the Summarize feature, you can extract important ideas from your documents, create outlines or tables of contents.

1. First create all the bookmarks you want in the document. For outlines and tables of contents, use multi-level bookmarks.

2. Open the File menu and choose Summarize (ALT+F+M).
   A dialog appears and the system asks if you want to use bookmarks to create the summary.

3. Press letter Y or the ENTER key to confirm.
   The system asks if you want to keep page numbers in the summary.

4. Press letter Y or the ENTER key to confirm. Or press N for No or C to Cancel.

The summary document opens, and Kurzweil 1000 begins reading it. The document is in outline form. Each bookmark is a line and is prefaced with a number, such as 1 or 1.1 or 2.1.3, indicating its hierarchical level. The page number for the bookmark follows the description in parentheses if you had requested to keep page numbers. Notes follow the bookmark and are preceded by asterisks.
Building Topic Lists

To capture important points in a document using bookmarks:

1. Go through the document and select text you want to add to the list of topics.
2. Make each section of selected text a bookmark. The points you want to keep become the description for the bookmark.

To read the selected passages:

1. Open the Go to Bookmarks dialog box.
   Each entry in the bookmark list is one of the captured text passages.
2. Press the UP/DOWN ARROW keys to move through the list.
8 Scanning and Recognition

This chapter contains the following topics:
Scanning in Kurzweil 1000.
Accessing Scanning Commands.
Basic Scanning Functions.
Using a Document Feeder.
Recognizing Currency.
Scanning and Creating a Signature File
Tips for Scanning.
Fine-Tuning and Optimizing Scanning.
Optimizing Recognition.
Looking at Recognition Statistics.
Batch Scanning.
KOCRUtil for Automatic File Recognition.
Scanning Shortcut Keys.
Defining Hot Keys for Scanning.
Configuring Scanner Buttons.
Scanning from Microsoft Word.
Scanning in Kurzweil 1000

You can scan any printed document. Kurzweil 1000 provides a comprehensive list of features that make scanning as easy as possible. These features include scanning optimization, rescanning and inserting pages, rerecognizing pages, repeated scanning, and flipping sides.

You can use a document camera instead of a scanner to capture an image of any printed document. You may find capturing images with a camera to be faster and easier than scanning, especially with bound books. The camera may also produce a more accurate image of bound pages, as it can better handle the curved page edge near the binding.

An extensive list of scanning options, such as page orientation, thresholding and grayscale recognition, as well as color scanning, are also included for fine-tuning scanning. These options apply to image capture with a document camera as well as scanning. Kurzweil 1000 provides some additional camera-specific features in the Scan menu. All scanning and camera image capture features are available from the **Scanning Settings** tab. Find more information in Chapter 12, *Working with Settings*.

Here’s how scanning works. Place the document face down on the scanner, close the scanner lid, and start the scan. You’ll hear progress messages as Kurzweil 1000 scans, orients the printed material, and recognizes the scanned words. If you don’t hear the messages, the message setting may be disabled. For more information, go to Chapter 12, *Working with Settings*.

As soon as the scan is complete, you can scan another page. It’s not necessary to wait for the recognition process to complete.

Kurzweil 1000 automatically adds each page you scan to the end of the current scanning document. You don’t have to move to the end
of the file to append pages. To begin scanning a separate
document, close the current file or choose a different scanning
document.

Kurzweil 1000 suggests a name for each file you scan. You can
accept the suggested name or use your own when you save the file.
You can stop a scan in progress. If the scanner already scanned a
page when you tried to cancel, the page will appear in the
document. You can cut this unwanted page.

Capturing Images with a Document Camera

This section provides general instructions for using a document
camera with Kurzweil 1000. Be sure to also follow setup and use
instructions provided by the manufacturer of your camera.

1. Make any adjustments to workspace, lighting, possible
   obstructions, and set up material with mat and/or bumper
guides, if provided with your camera.

2. Have the device ready with its camera arm extended, USB
cable connected from the device to the computer, and with it
placed inside the camera guides on the mat, if provided with
your camera.

3. You should hear a message about found hardware.

4. Launch Kurzweil 1000.

5. Place the material based on the guides on the mat and/or from
   results of your experimentation.

6. In Kurzweil 1000, go to Scan Settings. Set Scanner source to
   USB Video Device. Set page mode to 1 or 2 page. Keep the
default resolution setting. Press Enter.
7. For sighted helpers, you can use the Preview function as well as magnify to aid in further adjustments.

8. Press the Scan key.
   
   You should hear a camera sound.  
   
   The recognized text will appear in a Kurzweil 1000 window, with proper pagination.

**Active and Scanning Documents**

You can have any number of open documents in Kurzweil 1000, but only one at a time is available for reading or editing. This is the *active document*. You can change the active document by opening another, or by using the next or previous document command.

When you scan a page, Kurzweil 1000 adds it to the end of an open document - but which one? If it is the first page you have scanned since you started Kurzweil 1000, it adds the page to the end of your active document. However, if you have already scanned into a document, and if that document is still open, Kurzweil 1000 adds the page to the back of that document. This is what we call the *scanning document*.

The active document and the scanning document can be the same document, but they don't have to be. This allows you to scan and read in other documents at the same time.

There are two ways to change your scanning document. First, you can save and close it, then make the desired document your active document, and start scanning.

Or, you can use the **Rescan Page** or the **Insert Page** command. These commands, since they are always relative to the current page number of your active document, always cause the active document to become the scanning document.
Chapter 8. Scanning and Recognition

Rescanning Page, Inserting Page, and Deleting Page

After scanning a document, you can rescan or insert pages to correct errors because of a mixed-up original or bad scan settings.

These operations always take place with reference to the current page. So, if you rescan, the newly scanned page replaces the current page; if you insert a scan, the new scan is inserted immediately before your current page. When you insert a page, Kurzweil 1000 renumbers the pages to reflect the additional page.

If you decide not to finish an insert or rescan operation, you can cancel before the scan is complete.

To delete a page you do not need or want, use Cut Page from the Edit menu, or press Alt+E+G.

Rerecognizing One or Multiple Pages

Kurzweil 1000 has two different scanning engines, and a number of settings that affect the quality of the recognized text. You may find that you want to change a recognition setting and then redo the recognition. There are two rerecognition options on the Scan menu.

Rerecognize Page (mnemonic C) lets you redo the recognition of the current page.

Rerecognize Multiple Pages (mnemonic U) saves you considerable time and effort because you don’t have to rescan the entire document. A Range dialog opens in which you can specify a range of Pages to rerecognize.

The Rerecognize commands are available only through the Scan menu.

To use either feature, you must enable the Keep Images option in the General Settings tab page. Find more information about Scanning settings in Chapter 12, Working with Settings.
Scanning Repeatedly

If you want to scan more than one page at a time, you can enable Repeated Scanning mode. In this mode, the scanner repeatedly scans, delaying a certain number of seconds between each scan. This mode is ideal for scanning long documents because you do not need to manually start a scan for each page.

You can scan and recognize in this mode, or you can scan to image files. Scanning to an image file is a faster input method since it initially skips the recognition step.

Repeated Scanning mode and the Scan Delay setting are available only through the menu system from the Scanning Settings tab.

Note: If you want to use an automatic document feeder, be sure to not have the Repeated Scanning mode selected.

Keeping Kurzweil 1000 in the Foreground While Scanning

By default, Kurzweil 1000 continually shifts focus back to itself during a scanning session. Suppose, however, that you prefer to use Kurzweil 1000 as a background application, scanning with a document feeder or using the scanning hot key. You can opt to suppress this feature by changing the setting labeled, Keep Kurzweil in Foreground option to Never. This setting is in the ScanConf application, which is located in the directory, Program Files\Kurzweil Educational Systems\Diags.
Accessing Scanning Commands

You can access scanning commands by using menus, mnemonics, where available, shortcut keys.

Notes:

• You can also access many scanning commands from the keypad. For more information, you can either download the document, *Using the Keypad to Access Kurzweil 1000*, from the Kurzweil Educational Systems website—www.kurzweiledu.com—or refer to Appendix E, *Using the Keypad to Access Kurzweil 1000* in the Online Manual, ALT+H, then O.

• You can set a button on your scanner to directly scan. For details, go to the section entitled, *Configuring Scanner Buttons*.

The Scan Menu

The Scan menu is located to the right of the Folder menu.

To open the Scan menu:

1. Use one of the following methods:
   
   Press ALT, then the RIGHT ARROW key until you hear the name of the menu.
   
   To use mnemonics, press ALT+S.

2. Use the UP/DOWN ARROW keys to hear each menu item’s name.

Each menu item has a corresponding mnemonic, and some have shortcut keys.
Basic Scanning Functions

Starting and Stopping Scanning

Use one of the following methods to start scanning or to cancel a scan in progress:

- Open the Scan menu and choose Start New Scan or Cancel Scan.
- Or press ALT+S+S.
- Or press F9.

Note: Canceling a scan when using Repeated Scan mode also cancels that mode.

Rescanning a Page

1. Place the new page face down on the scanner and close the scanner lid.
2. Open the Scan menu and choose Rescan Page, or press ALT+S+R.

If you are using Two-Page mode, rescanning replaces both the current page and the page after it.
Chapter 8. Scanning and Recognition

Inserting a New Scanned Page Before the Current Page

1. Place the new page face down on the scanner and close the scanner lid.

2. Open the **Scan** menu and choose **Insert Page**, or press **ALT+S+I**.

   If you are using Two-Page mode, inserting a page inserts the two pages before the current page.

Rerecognizing a Page

Open the **Scan** menu and choose **Rerecognize Page**, or press **ALT+S+C**.

   **Note:** You can use this feature only if there is an image associated with the page. Refer to the **Keep Images** setting in Chapter 12, *Working with Settings*.

Rerecognizing All Pages

Open the **Scan** menu and choose **Rerecognize All Pages**, or press **ALT+S+A**.

   **Note:** The program only rerecognizes those pages that have images. Refer to the **Keep Images** setting in Chapter 12, *Working with Settings*. 
Scanning Repeatedly

Do one of the following:

• Open the Scan menu and choose Scan Repeatedly.
• Or press ALT+S+P.
• Or press CONTROL+F9.

You can set the interval or delay between scans by using the Scanning Settings tab as described in Chapter 12, Working with Settings.

Flipping Sides

When pages are double sided, or when you are scanning a large book, it is sometimes convenient to scan one side at a time, then flip sides, and scan the other side. This is necessary when you are using an automatic document feeder to scan double-sided pages. Each time you add more pages to the feeder and scan, you can instruct the system as to whether or not you are flipping sides.

Even when you are not using a document feeder, you can select the Flip Sides menu option to indicate that you are changing from, say, the front side to the back side of a stack of paper, or from right facing pages to left-facing pages in a book.

In both cases, you need to scan odd numbered pages (that’s the right hand side in a book) first, in an ascending sequence. You can then flip sides, and scan the matching even numbered pages, beginning with the page immediately following the last odd numbered page scanned. You should then continue with even numbered pages in a descending sequence until you have scanned enough pages to match the odd numbered pages that have already been scanned.
As Kurzweil 1000 completes recognition, it automatically inserts the pages into their appropriate places in the document. When you have scanned a matching number of even numbered pages, you may begin with the next group of odd numbered pages.

**Note:** You can use this feature when the scanning mode is *Scan and Recognize*, or *Image Scanning Only*.

**Using a Document Feeder**

1. Place the stack of pages on the feeder.
2. Open the *Scan* menu and choose *Start New Scan*, or press **F9**, to scan the first side of each page.
   - Do not use the Scan Repeatedly feature.
3. When you are done scanning the stack, turn it over to scan the opposite side, or put the next stack on the feeder.
4. Press **F9**.
   - A dialog opens and you’ll hear the options.
5. Press **TAB** until you hear the desired function. **Continue** continues scanning in single-sided mode. **Flip** scans and collates in double-sided mode.
6. Press **ENTER** to OK your choice, or press **ESCAPE** to stop scanning.
Recognizing Currency

By default, Kurzweil 1000 recognizes and speaks the denomination of any United States bill. In addition, if you have a color scanner, you can use Kurzweil 1000 to recognize Euros, British Pounds and Canadian Dollars.

Notes:

• It’s important to place your bill in a location where Kurzweil 1000 can find it. If Kurzweil 1000 cannot find or identify a bill, you’ll hear an error message.

• You can also recognize multiple bills per session.

• If you use a particular type of currency more often, you can select it from the Recognize Currency dialog, then save the setting in a Settings file. Go to the Settings chapter for information on saving settings.

To place a bill so that Kurzweil 1000 can find it:

The object is to place one of the bill’s corners in a specific corner of the scanner glass. Because every make of scanner is different, the trick is to find the correct corner. Once you have determined that information the first time, placing bills thereafter should be second nature.

1. First orient yourself so that you are parallel to and on the opposite side of the scanner’s hinges. You should be able to lift the lid up and away from you.

2. Next, find the light bar’s home position. If you’re not familiar with the light bar, you can run the Scan command and listen for where scanning begins on the scanner.
If the hinges are on the short side of the scanner, the light bar’s home position is typically along that side. On scanners whose hinges are along the long side of the scanner, the home position may be along the left or right, short side of the scanner.

3. Determine the right corner of the light bar’s home position.

For a scanner whose hinges are on the short side of the scanner, and whose light bar’s home position is along the hinged edge, the corner to use is the top right one, assuming you are still opposite the hinged edge. You should be able to feel the hinged edge.

On a scanner whose hinges are on the long side of the scanner, and whose light bar’s home position is on the scanner’s left, short side, the corner to use is the top left of the scanner, assuming you are still opposite the hinged edge. You should be able to feel the hinged edge.

On a scanner whose hinges are on the long side of the scanner, and whose light bar’s home position is on the scanner’s right, short side, the corner to use is the bottom right of the scanner. You should NOT be able to feel the hinged edge in this case.

4. Place the bill with its long side parallel to the light bar. Then slide it toward the corner you determined in the previous step.

For a scanner whose hinges are on the short side of the scanner, and whose light bar’s home position is along the hinged edge, the long side of the bill would also be parallel to the hinged edge. And you would slide it right until you reach the corner.

On a scanner whose hinges are on the long side of the scanner, and whose light bar’s home position is on the scanner’s left, short side, the long side of the bill would be parallel to the left edge of the scanner. And you would slide it up until you reach the corner.
On a scanner whose hinges are on the long side of the scanner, and whose light bar’s home position is on the scanner’s right, short side, the long side of the bill would be parallel to the right edge of the scanner. And you would slide it down until you reach the corner.

**To identify one or more bills:**

1. Place the bill on the scanner.
   
   **Note:** If you haven’t determined the correct location to place the bill, follow the instructions in the preceding section titled, *To place a bill so that Kurzweil 1000 can find it.*

2. Do one of the following:
   
   - Open the **Tools** menu and choose **Recognize Currency**.
   - Or press **ALT+O+R**.
   - Or press **SHIFT F9**.

   Kurzweil 1000 scans the bill and identifies it.

   The **Recognize Currency** dialog opens with your cursor at the **Scan Again** (mnemonic **ALT+S**) command button.

3. If you want to identify another bill, place it on the scanner, and press **ENTER**.

4. Press **ESCAPE** when you are done.
To identify another country’s currency:

1. Place the bill on the scanner.
   
   Note: If you haven’t determined the correct location to place the bill, follow the instructions in the section titled, *To place a bill so that Kurzweil 1000 can find it.*

2. Do one of the following:
   
   - Open the **Tools** menu and choose **Recognize Currency**.
   - Or press **ALT+O+R**.
   - Or press **SHIFT F9**.

   Kurzweil 1000 scans and opens the **Recognize Currency** dialog. If the currency type does not match, Kurzweil 1000 will not recognize the bill.

3. **TAB** to or press **ALT+R** to go to the **Currency** list.

4. Press the **UP/DOWN ARROW** keys to select the desired currency type: **British**, **Canadian**, **European**, or **United States**.

5. Press **SHIFT+TAB** to go to the **Scan Again** button, and press **ENTER** to scan and recognize the bill.

   Note: You can save your Currency setting in a Settings file. Go to Chapter 12, *Working with Settings* for information on saving settings.
Scanning and Creating a Signature File

Signature files enable you to insert a scanned image of your signature into a document. You can also add a signature into any form field that is a text box. For details on inserting a signature file, go to the Editing chapter. For details on adding a signature to a form, go to Working with Forms.

Signature files are saved in TIFF format in a folder called "Signatures" in the Kurzweil Educational Systems/Images directory.

To scan and create a signature file:

1. First, write your signature in the upper left portion of a blank piece of paper, making sure it is not too close to the edges, and that there is not too much spacing between the different parts of the name.

2. Next select Create a Signature File from the Scan menu. (ALT+S+C).

3. Place the paper on the scanner following directions from Kurzweil 1000, and press ENTER.

4. A dialog appears displaying the signature. You can increase or decrease magnification in this dialog by using CONTROL+UP arrow and CONTROL+DOWN arrow, respectively. If you are satisfied with the current signature, you can accept it by pressing ENTER or ALT+O for OK. To discard the current signature, press ESCAPE or ALT+C for Cancel.

5. After accepting a signature, another dialog appears asking you to enter the name you want for the signature file. If you would rather overwrite an existing signature file, use the UP/DOWN arrow keys to select the desired one.
Tips for Scanning

In some cases, a document's print or layout characteristics can affect recognition quality. To get the best results:

- Use documents that are clean and free from wrinkles.
- If the paper feels thin when you rub a sheet between your fingers, place a sheet of construction paper behind it during scanning. This keeps print on the opposite side of the sheet from interfering with recognition, a situation known as bleed through.
- When scanning a hardbound book, it may be helpful to remove its jacket cover. The inside cover often contains text that the scanner can pick up.
- If text is distorted or missing in a regular pattern (for example, you have a problem every ten words or so), you are probably not pressing the center of the book flat enough on the scanner. The paper curls upward away from the scanner near the binding, darkening the image and foreshortening the text. For some books, it can take a fair amount of effort to flatten the center sufficiently.
- Make sure the scanner glass is clean.
**Speeding Up the Scanning Process**

If you can consistently scan a book using the same position and orientation for every page, these steps will help you scan it as quickly as possible:

1. If you are not sure of the page orientation, change the **Page Orientation** setting in the **Scanning** tab to **Set Once per Document**. This allows for faster scanning than automatic page orientation. To access the **Scanning** tab page, open the **Settings** menu and select **Scanning**.

2. Enable **Auto Size** in the **Scanner Margins** tab. To access this tab page, open the **Settings** menu and select **Scanner Margins**.

3. If you want to read while scanning, disable tracking through the **Display** tab page. To access this tab page, open the **Settings** menu and select **Display**.

4. If you are happy with a default or manually selected brightness value, disable thresholding in the **Scanning** tab page. This will also speed up the scanning process.
Chapter 8. Scanning and Recognition

Fine-Tuning and Optimizing Scanning

Kurzweil 1000 offers a number of ways to fine-tune scanning to obtain the best results:

• Scanner settings optimization automatically selects the appropriate scanner settings for the document you are scanning.

• Brightness and Thresholding settings let you tweak the settings yourself.

• Recognition statistics let you find specific problem areas to help you decide what settings to adjust.

Optimizing Scanner Settings

There are a lot of different settings that can improve recognition results. You can experiment with scanning settings such as Brightness and Thresholding or you can opt to have Kurzweil 1000 optimize scanning automatically. This is particularly convenient if you are about to scan and recognize a large number of pages that you have reason to expect will have consistent characteristics.

Kurzweil 1000 can automatically optimize thresholding, brightness, resolution, speckle removal, text quality, and the choice of recognition engines based on the information it receives from the document you are scanning to produce the best results possible. It begins with your existing values for each of those settings, and lets you control which of those values should be optimized.

To optimize scanner settings:

1. Open the Scan menu and choose Optimize Scanning.
The Optimize Scanning dialog opens. Each of the controls in the dialog is a list box, and, with the exception of Text Quality and Engine, each is set to Optimize by default. Each list box shows the current value of the setting, as well as an indicator as to whether or not it should be optimized.

2. Select the settings you wish to optimize.

If you want the system to experiment with the results of other possible values for the setting, choose to Optimize the setting. If you do not want the system to change the current setting, choose the option that ends with the words Do not optimize.

3. Once you have reviewed the various settings, press the ENTER key to begin scanning.

Depending on the number of settings being optimized, Kurzweil 1000 may scan a number of times.

Kurzweil 1000 produces the best results and retains them, as well as the settings that created them. When the process concludes, you can keep these best settings by pressing ENTER again.

You can interrupt the process at any time using the cancel button or the escape key. If you do so, you will still have the choice of keeping or rejecting the best settings found.

**Settings You Can Optimize**

**Thresholding.** If you choose to optimize this setting, Kurzweil 1000 will choose either static, dynamic or grayscale thresholding. Note that it will not chose color. Also note that the brightness setting cannot be optimized if you do not optimize thresholding, unless the thresholding setting is set to static.

**Brightness.** Optimizing the brightness setting is the most time consuming, but also the most important, function of this dialog. You
can accelerate this process somewhat by choosing a minimum and maximum value for the brightness optimization process. These values are available in two text boxes, immediately after this list box.

**Resolution.** Kurzweil 1000 will determine the smallest font size found on your page. Based on that information, it might choose to lower or increase the resolution setting. The choice of a higher resolution will, of course, slow down the scanning process.

**Speckle Removal.** Depending on the nature of the material being scanned, removal of speckle can enhance or damage recognition results. Enabling optimization of this setting will let the system determine whether or not it should be used.

**Text Quality.** Optimization of this setting will allow the Kurzweil 1000 to choose between Normal, Dot Matrix, and Degraded.

**Engine** list box. It is difficult for Kurzweil 1000 to automatically determine which engine is better for a page, as it relies on the engines themselves for information about recognition accuracy. When optimization is enabled for this setting, both engines will be attempted, and the results will be analyzed using statistics from a spelling check.

**Finding the Best Brightness Setting**

The *Brightness* setting determines if the scanned image is dark or light. The best setting depends on your scanner and the type of material you are scanning. You can set the brightness value to a number from 0 to 100. Lower values result in darker images and higher values in lighter images. Try several settings to find one that works best. You can also obtain detailed information about recognition by inspecting the results. Listen for the following as they are indications that your brightness setting may be too high:
• b misrecognized as h
• e misrecognized as c
• h misrecognized as li
• m misrecognized as characters like rn, nn, or nii
• u misrecognized as ii
• w misrecognized as characters like iu, ui, or vi
• g misrecognized as o
• y misrecognized as v

Indications that the brightness setting may be too low are:
• Characters that don’t seem to be part of a word, especially at the beginning or end of a page.
• Characters misrecognized in groups, such as no misrecognized as ma, in misrecognized as m, or ci misrecognized as d.

The best brightness setting varies from book to book, and sometimes from page to page in the same book. With inexpensive paperbacks, for example, the ink density varies from page to page. For these cases, Dynamic or Grayscale thresholding may work best.

Finding the Best Thresholding Setting

The sensors in a modern scanner don’t actually see in black and white, or dark and light. Each spot on a page, called a pixel, is a shade of gray. Most scanners can differentiate 256 different shades of gray. What Kurzweil 1000 does with those shades depends upon your thresholding setting.

There are three thresholding options: Static, Dynamic, Grayscale, and Color. Thresholding options are in the Scanning Settings tab.
For more information, go to *Scanning Settings* in Chapter 12, *Working with Settings*.

**Static Thresholding Setting**

Each pixel is a shade of gray having a value between 0 and 255. A pixel whose value is zero is completely white. The higher the number, the darker the pixel. With **Static** thresholding, Kurzweil 1000 simplifies that number into one of two states: zero for white, and one for black. The resulting pixel, or the image made up of those pixels, becomes a *binary image*. All shades of gray higher than a particular number, called the threshold, Kurzweil 1000 considers black. Shades below or equal to the threshold are white.

When you use Static thresholding with the brightness setting, the higher the brightness value the more gray values convert into white pixels, so the resulting image is brighter.

Static thresholding has its advantages. It gives you the greatest possible control over the brightness of the final image. It is also very fast because a binary image is smaller than a grayscale one.

**Dynamic Thresholding Setting**

**Dynamic** thresholding, the second approach, breaks up each page into regions, and then tries to decide what would be the best threshold for each region. One page can end up with several different thresholds, which reduces the control you have over the brightness of the final image.

This setting is particularly well-suited for multi-colored pages. However, because more data has to go from the scanner to the software, this setting can slow down the scan process.
Grayscale Setting

The Grayscale option does away with thresholding altogether. The full grayscale image is sent to the character recognition engine. This option increases the size of the file when you save the full grayscale image. You can also expect that this will be the slowest approach to scanning and recognition. When you use the Grayscale setting with the latest version of the FineReader Engine, however, you can improve recognition of difficult documents.

Color Setting

Select color scanning if you want the image to be viewable in color or to create a color TIFF format file. In color scanning, Kurzweil 1000 uses black and white mode, while retaining the color data. This can greatly reduce the speed of the process.

This option also affects the resolution of the resulting color image, which displays at one half the resolution of the original scanned image. For example, if you scan at 300 DPI, the resulting image is at 150 DPI.

Interrupting and Saving Recognition

When opening a multi-page image or PDF file, Kurzweil1000 tells you how many pages the file contains. At any time during recognition, you can press Escape to interrupt the process. To resume recognition, press F9 or Start New Scan.

If however, you want to resume recognition at a later time, you can save the recognition.

To save recognition:

1. During recognition, press Escape to interrupt the process.
2. Use **File Save (Alt+F+S)** to save the file. It is a good idea to check to make sure you know where this file will be saved and under what name as you will need that information to find and open it when you are ready to resume recognition.

3. **Close** the file.

4. When you re-open the file, Kurzweil 1000 tells you how many pages remain to be recognized and asks if you want to continue recognition. Select Yes to continue at the point where you left off. If you select No, recognition does not take place and you can continue to read the document as is.

**Optimizing Recognition**

Like Optimize Scanning, Optimize Recognition directs Kurzweil 1000 to automatically find the best settings for producing optimal OCR results for an open page. Accessible from the **Scan** menu, this command opens a dialog containing two settings: **Text Quality** and **Engine**; both are set by default to Optimize.

When Kurzweil 1000 completes the recognition, you can opt to keep the newly recognized page by pressing the **ENTER** key or discard it by pressing the **CANCEL** or **ESCAPE** key.

A few notes about this feature:

- Because this feature works with a page image, the Keep Images setting in General Settings must be enabled when scanning the page.

- Optimize Recognition is not savable to a Settings file.

- If you opt to Not Optimize in one session, Kurzweil 1000 does not keep that setting for the next session, instead it resets the setting to the Optimize default.
Looking at Recognition Statistics

An important tool for choosing the appropriate scanning settings, such as brightness, is a recognition statistics report.

There are three types of reports that give you information about the performance of the character recognition engine:

- **Last Page** provides statistics about the last page that was recognized.
- **Cumulative** provides statistics about all the pages the system has recognized.
- **Poorly Recognized** gives you a list of those pages in the current document whose Confidence level fall below a threshold that you set.

**To view Recognition Statistics:**

Choose Recognition Statistics from the Tools menu or use the mnemonics ALT+O+O.

If you do not have a file open, the Cumulative dialog opens.

If you have a file open, use the UP or DOWN ARROW key to select Last Page, Cumulative, or Poorly Recognized, or press their mnemonic, L, C, or P, respectively, then press the ENTER key.

**Recognition Statistics for the Last Page**

The Last Page dialog contains the following indicators:

- **Scan Time** (ALT+N) tells you the time elapsed, in seconds, between the press of the Scan button and scanning complete.
- **Speed** (ALT+S) at which the page was recognized.
• **Confidence** level (ALT+C) tells you how confident the system is about the recognition process. The higher the number, the more confident Kurzweil 1000 is about the accuracy of the process.

• **Spelling Accuracy** (ALT+L) tells you the percentage of words on the last recognized page that were spelled correctly.

• **Character Count** (ALT+H) is the number of characters recognized.

• **Illegible Characters** (ALT+I) are counted when a recognition engine thinks that a particular blob on the page is probably a character, but it has no idea what that character is.

• **Questionable Characters** (ALT+Q) are counted when a recognition engine thinks that it has recognized a character, but is not particularly certain of its recognition.

• **Touching Characters** (ALT+T) and **Broken Characters** (ALT+B) are useful in determining what brightness setting to use. A high count of touching characters is an indication that your brightness setting may be too low. A high count of broken characters is an indication that your brightness setting is too high. These two statistics are available only for the RTK engine.

• **Elapsed Time** (ALT+E) is measured in seconds, and only includes the time it took to do automatic orientation, despeckling, column finding, and recognition. It does not include scanning time.

• **Automatic Corrections** (ALT+A) indicates the number of errors Kurzweil 1000 corrected.

• The number of **Images Remaining** (ALT+R) is available if you are doing batch recognition, and indicates how many page images remain to be recognized.
Cumulative Recognition Statistics

The Cumulative dialog contains all the controls in the Last Page dialog, except for Touching Characters and Broken Characters. It presents statistics for all recognized pages since recognition began on your system. A Clear button allows you to reset values to zero.

Poorly Recognized Pages

By default, the Poorly Recognized Pages list (ALT+P), in the Poorly Recognized Pages dialog, lists pages in the current document whose Confidence level falls below a certain threshold. The pages are sorted by ascending Confidence level, so the topmost page is likely to be the most poorly recognized. You can, however, sort by a number of other parameters available from the Sort by list, and you can group the pages within the list using the Group by options. The controls in this dialog are:

• Sort by list (ALT+S). Select Confidence Level, Page Number with the confidence threshold, Spelling Percentage, and Page Number with the spelling threshold.

If you are in the Poorly Recognized Pages (ALT+P) list, you can use CTRL+S to cycle through the Sort by options, thereby changing the pages included on the list and their ordering. A page’s presence on the list is based on either it’s Confidence or Spelling Threshold value, and the list order is either by ascending page number or threshold value. The order is also affected by the option selected in the Group by list.

When you exit Kurzweil 1000, the system does not save this selection.

• Group by list (ALT+G).

You can select:
Nothing to leave the pages ungrouped.

Image State to group the pages so that those with images are presented first, followed by those without images. **Note:** Pages only have images when the Keep Images option in the General settings is enabled during recognition.

Edit State to group pages so that those that have not been marked as "edited" are presented first, followed by those that have been edited.

Both Image State and Edit Status to split the list into four groups: unedited pages with images, unedited pages without images, edited pages with images, and edited pages without images.

- **Confidence Threshold** text box (ALT+T). Enter a threshold from 0 to 100.
- **Spelling Threshold** text box (ALT+L). Enter a threshold from 0 to 100.
- **Toggle Edit Status** button (ALT+E). Mark the page as edited.
  You can also toggle a page’s Edit Status by pressing **CTRL+E** when you are positioned in the list of poorly recognized pages.
- **Apply** button (ALT+ENTER) Allows you to change the Confidence Threshold, Spelling Threshold, Group and Sort settings without leaving the dialog box by choosing **OK**.
To open and edit a poorly recognized page:

1. Select the page you want from the list and press the ENTER key.

2. In the page, you might change some recognition parameters, rerecognize (if the page has an image), and/or rescan the page. During recognition, if the Confidence level falls below the threshold, the system immediately announces the threshold level value, which indicates a poorly recognized page.

3. After you have finished working on the page, press ESCAPE to return to the Poorly Recognized Page dialog to continue editing additional pages. Don’t forget to mark the pages you’ve edited by using CTRL+E.

Batch Scanning

Batch scanning lets you scan a number of pages at once without recognizing or reading them. Instead, you can store them as image files, which are like snapshots of the original document, then perform the recognition process later.

Batch scanning saves time during the actual scanning process, as the system does not recognize each page as it is scanned. Since the recognition process is completely automated, Kurzweil 1000 can perform this step while the system is unattended.

To perform a batch scan using menus:

1. Open the Settings menu and choose Scanning. In the tab page that appears, press TAB to go to the Mode option. Use the arrow keys to choose Image Scanning Only, then press ENTER.
2. Place your document on the scanner. Open the Scan menu and choose Start New Scan, or press the F9 key. Instead of scanning to documents that you can read, the system scans to image files.

3. When you have finished scanning to image files, you can perform any other tasks that you wish. You can change settings, read documents, and even leave the Kurzweil 1000 altogether. However, you cannot read the image files until the system has recognized them, as described in the next step.

4. Open the Settings menu and choose Scanning. On the Scanning tab page, press TAB to go to the Mode option. Use the arrow keys to choose Recognize Image Files, then press ENTER.

5. Open the Scan menu and choose Start New Scan, or press the F9 key. The system starts recognizing the image files in the Images folder, one after another. As each image file is recognized, it is deleted. Choose Start New Scan or press F9 again at any time to stop recognition.

   If you stop recognizing at any point, you should save the current file. You can later reopen the saved file, return to Recognize Image File mode, and begin recognizing again from that point.
KOCRUtil for Automatic File Recognition

If you have a multi-core processor on your machine, you can use KOCRUtil to recognize files and files in folders automatically and silently.

If the OCR engine can keep the recognized data for the entire document and then convert it, it will attempt to unify its formatting decisions so that the final document is more consistent.

Before using KOCRUtil, however, consider the trade offs. Corrections, for example, will not be applied to each page. You won't be able to edit or read the document as it is recognized. Bookmarks will not be captured for PDF files. And the resulting document won't be in KES format (though most of the choices will produce output that can be converted to KES by opening them within Kurzweil 1000).

To run KOCRUtil:

1. Select a file, a list of files, or a folder in Windows Explorer.

2. Bring up the context menu, and select the appropriate menu item. For a folder, that menu item would be "Recognize Images with Kurzweil." For image files (either TIFF, PDF, or JPEG), you can pick either "Recognize Images with Kurzweil Automatically", or "Recognize Images with Kurzweil Interactively".

When you recognize images automatically, KOCRUtil.exe will run without bringing up a window. It will use current default settings to recognize the selected image files, or to recognize all of the image files found within the selected folder, and then exit. When it exits, you will hear a wave file "KOCRUtil.wav," if that file exists.
If you selected a folder and then activated the "Recognize Images with Kurzweil" menu item, KOCRUtil would look for all image files within that folder (but not, note within sub folders). These files would be organized into one or more group. Files are in the same group if their file names are identical except for digits. So, for example, "Image001.tif", "Image2.tif", and "Image43.tif" are all in the same group, but "Imagea3" is not. Groups of image files are sorted by their name, recognized together, and output into one resulting document.

Output file names are based on the name of the first image file in a group of image files, along with an extension that is appropriate for the output format. Depending upon settings, the output files can be in the same folder as the image files, or can be sent to a specified folder.

The default is for KOCRUtil to use FineReader Engine with English as the only recognition language, creating an RTF file that will be placed in the same folder as the image file or files.

**To exit KOCRUtil:**

press Escape or TAB to the Exit button and press Enter.

**To change KOCRUtil settings:**

Either run KOCRUtil.exe without command line arguments, or use the "Recognize Images with Kurzweil Interactively" context menu. This will bring up KOCRUtil, which has a single dialog.

The dialog controls are described below in tab order. Where applicable, the mnemonic follows.

**Image Files** group has a text box, ALT+I, where you can specify one or more image files, separated by semicolons. There is also a
Browse button which brings up a file open dialog so you can select the desired image files from your system.

**Output File** group has a text box, ALT+O and a Browse button. In the text box you specify the output file. Note that it can be blank, in which case the output file name is constructed using the first image file name. If no path is specified, the source folder will be used, or the default destination folder will be used, depending on that setting (see below). You can also click the Browse button to bring up a file save dialog in which you can specify the output file.

**Format** list box, ALT+O, lets you choose the format of the output file. The list of possible formats changes depending on the recognition engine used.

**Details** button, Alt+D brings up the Format Details dialog in which you can change format settings. The dialog contains: a Layout list (Alt+L) where you can opt to Retain Layout, Formatted Text, or Plain Text. Next is the Paper Size list (Alt+P); choose Automatic, A3, A4, A5, Letter, or Legal. The third list is labeled Pictures (Alt+C); choose to Remove Pictures, Low Resolution (for Web), Medium Resolution (for screen), High Resolution (for printing). Four check boxes follow the lists. You can opt to Keep Page Breaks (Alt+G), Keep Line Breaks (Alt+N), Keep Text Color (Alt+T), and Keep Headers and Footers (Alt+H). By default, Kurzweil 1000 keeps Formatted Text for the layout, uses Automatic paper size selection, Removes Pictures, Keeps Page Breaks, Text Color, and Headers and Footers, but does not Keep Line Breaks. These Format Details settings are retained for future sessions until you change them again.

**Recognition Engine** list box, ALT+R. Choose the recognition engine (FineReader Engine or ScanSoft Engine).
Chapter 8. Scanning and Recognition

**Recognition Languages** list view, ALT+L. Check one or more of the recognition languages. The list changes depending on the recognition engine.

**Start Recognition** button, ALT+S. Use it to start recognition if everything else is set up properly.

The next three controls are in a group box labeled Default Destination.

**Use Source Folder** check box, ALT+U. If set, the folder of the image file will be used to specify the default destination folder (i.e., the folder used if none is specified explicitly along with the output file name).

**Unlabeled** text box. This is disabled if Use Source Folder is checked. Otherwise, it allows you to specify a default destination folder.

**Browse** button which will bring up a dialog that allows you to select a default destination folder.

**Save Defaults** button, ALT+V. Use it to save your current settings as default settings. Once you have done this, these are the settings that will be used when you choose to recognize a file or folder automatically.

**Status**, ALT+S is a read-only text box that tells you when recognition of a page is completed and will include recognition hints if you are using FineReader.

**Scanning Shortcut Keys**

- **F9** to start and stop scanning.
- **CONTROL+F9** to scan repeatedly.
- **SHIFT+F9** to recognize currency.
Defining Hot Keys for Scanning

By default, the hot keys for scanning are: CONTROL+ALT+S, but you can define another key combination that must include either the CONTROL or the ALT key. Avoid using common shortcut key combinations for these hot keys. For example, if you specify the combination CONTROL+S, you will be unable to use it to save files in any other program while Kurzweil 1000 is running.

To define a hot key combination for scanning:

1. Open the Settings menu and select Configuration, or press ALT+T+F.
2. Press TAB until you hear “Hot key for scanning,” or press ALT+H.
   
   Your cursor is in the Hot Key for Scanning text box.
3. Press the key combination you want to use. Then press ENTER.

To scan a document using a hot key:

1. Start Kurzweil 1000 if you have not already done so.
2. Switch to another application.
   
   If you need to use the same device for speech in your other application, minimize Kurzweil 1000 by pressing ALT+LEFT ARROW, then ENTER, then letter N.
3. Place a page face down on the scanner and close the scanner lid.
4. Press the hot key combination you have defined or use the default CONTROL+ALT+S.
Configuring Scanner Buttons

Some scanners come with one or more buttons. You can now assign those buttons to functions within Kurzweil 1000, such as starting a scan, starting Kurzweil 1000 Photocopier or FAX applications. Note that this works only if the scanner manufacturer supplied software conforms to certain Microsoft specifications; not all of them do. To configure Kurzweil 1000 Scan, press the desired scanner button; select Scan with Kurzweil. If you have both Kurzweil 1000 and Kurzweil 3000 applications on your system, and both are currently running or neither are running, you will have to specify with which of the two you want the Scan function associated.

To set the next button for either Scan and Print or Scan and Fax, press the desired button and select the desired option.

Once configured, you can press the button to perform the designated function. For Scan, Kurzweil 1000 begins scanning and its window opens if it isn't already. For Scan and Print, the Kurzweil 1000 Photocopier application window opens and you can specify the number of copies and complete the Make Copies process. For Scan and Fax, the Kurzweil 1000 Fax application window opens and you can specify a recipient and complete the Send process. If you want to reconfigure the buttons, use the ScanConf application in the Diags folder in the Kurzweil Educational Systems folder in your Program Files.
Scanning from Microsoft Word

You can use Kurzweil 1000 to scan a page while in a Microsoft Word document. Kurzweil Scan and Recognize is on the Insert menu. To choose a scanner from Microsoft Word, open the Tools menu.
9 Editing Text and Formatting

This chapter contains the following topics:

Overview.
Accessing Editing Commands.
Moving Through Text.
Selecting Text.
Using Editing Keys.
Cutting, Copying and Pasting.
Editing Formatting.
Undoing Edits.
Proofreading.
Searching for Text or Tables.
Replacing Text.
Using the Spell Checker.
Editing Your Spell Checker List.
Using Ranked Spelling.
Changing a Word’s Pronunciation.
Editing the Pronunciation List.
Applying Corrections Throughout a Document.
Editing Your Corrections List.
Inserting a Signature File.
Shortcut Keys for Editing.
Overview

You can create a new document, open an existing Kurzweil 1000 file or open one from another software program for editing in the Kurzweil 1000 program.

This chapter only presents information on creating and saving new files in Kurzweil 1000. For detailed information on opening, saving and managing all types of files, go to Chapter 13, Files and Folders.

Once you create a new file or open an existing one in Kurzweil 1000, you can type using the alphanumeric and editing keys on the keyboard (including Delete, Backspace, and arrow keys).

Kurzweil 1000 reads as you type and edit, and provides a variety of Reading features to help you proofread your writing.

In addition, you can do a fair amount of formatting, including font changes for characters and paragraph alignment.

Accessing Editing Commands

You can access editing commands through the menu bar or keyboard shortcut keys. Many people find it convenient to use just the shortcut keys for editing text. Kurzweil 1000 uses the same shortcut keys as do most word processing programs.

The only editing tasks you can access from the keypad are the cut and paste page operations. For more information about using the keypad to edit documents, you can either download the document, Using the Keypad to Access Kurzweil 1000, from the Kurzweil Educational Systems website—www.kurzweiledu.com—or refer to Appendix E in the Online Help manual.
To create a new file and start editing:

1. Open the **File** menu and select **New**, or press **ALT+F+N**.

   The **Edit** menu is now part of the Kurzweil 1000 menu bar, and is located to the right of the **File** menu.

2. Begin typing or editing.

   To access the **Edit** menu, you can use the mnemonics **ALT+E**.

### Moving Through Text

If you are familiar with other word processors, you can move through text in Kurzweil 1000 using the standard keyboard keys such as ARROW, PAGE UP, HOME and END keys to move by character, word, line, paragraph, page screen, or top and bottom of the document.

#### To move by character:

Press the **LEFT ARROW** key to place the cursor to the left of, or *before*, a character. Press **RIGHT ARROW** to place the cursor to the right of, or *after*, a character. If Kurzweil 1000 is reading when you press one of these keys, it stops reading and speaks each character as you move.

You can resume continuous reading by using the Read menu.

#### To move by word:

Press **CONTROL+LEFT ARROW** to move to the word before the cursor, or **CONTROL+RIGHT ARROW** to move to the word after the cursor. If the cursor is in the middle of the word, the cursor position moves to the beginning or end of the word.
To move by line:

Press **UP ARROW** to move to the line above the cursor or **DOWN ARROW** to move to the line below the cursor. Both UP and DOWN arrows cross page boundaries. Kurzweil 1000 automatically reads the new line. Press **HOME** or **END** to move to the beginning or end of the current line.

To move by paragraph:

Press **CONTROL+UP ARROW** to move to the beginning of the previous paragraph, or **CONTROL+DOWN ARROW** to move to the beginning of the next paragraph.

To move by region:

Press **SHIFT+F6** to move to the beginning of the previous region, and **SHIFT+F8** to move to the beginning of the next region. This feature only works if layout information has been retained for the current page.

To move by page:

**PAGE UP** places your cursor at the top of the previous page; **PAGE DOWN** places it at the top of the next page.

You can also go to the top of the current page by pressing **SHIFT+PAGE UP**, or to the bottom of the current page by pressing **SHIFT+PAGE DOWN**.

To go to the beginning or end of the document:

Use **CONTROL+HOME** to move to the top of the document, or **CONTROL+END** to move to the bottom of the document.
To move by screen:

Press **CONTROL+PAGE UP** to move up by one screen, or **CONTROL+PAGE DOWN** to move down by one screen.

**Selecting Text**

Before you can cut or copy text, you must select it. Selection defines the starting and ending points for a text string. Use the keyboard to select text by character, word, line, paragraph, or page.

**To select a character:**

Hold down the **SHIFT** key and press **LEFT ARROW** to select the character before the cursor, or **RIGHT ARROW** to select the character after the cursor.

**To select a word:**

Hold down the **SHIFT** key and press **CONTROL+LEFT ARROW** to select the word before the cursor, or **CONTROL+RIGHT ARROW** to select the word after the cursor. If the cursor is in the middle of the word, the text from the cursor position to the beginning or end of the word is selected.

**To select a line:**

Hold down the **SHIFT** key and press **UP ARROW** to select from the current line position to the same position in the line above the cursor. Hold down the **SHIFT** key and press **DOWN ARROW** to select from the current line position to the same position in the line below the cursor. **SHIFT HOME** selects to the beginning of the current line. **SHIFT END** selects to the end of the current line.
To select by paragraph:

Hold down the SHIFT key and press CONTROL+UP ARROW to select to the beginning of the current paragraph, or CONTROL+DOWN ARROW to select to the beginning of the next paragraph.

To hear selected text

Open the Read menu, choose Say Selection, or press CONTROL+Y.

Hot Keys for Modifying Selections

You can use hot keys to change the amount of text you have selected. CONTROL+F8 and CONTROL+SHIFT+F8 expand and contract a selection, respectively. The amount by which the selection changes depends on how much text was originally selected.

When expanding a selection:

• If nothing is selected, CONTROL+F8 selects the current word.
• If a word is selected, CONTROL+F8 selects the current sentence.
• If a sentence is selected, CONTROL+F8 selects the current paragraph.
• If a paragraph is selected, CONTROL+F8 selects the current page.

When contracting a selection:

• If a page is selected, CONTROL+SHIFT+F8 selects the first paragraph of the page.
Chapter 9. Editing Text and Formatting

- If a paragraph is selected, CONTROL+SHIFT+F8 selects the first sentence of the paragraph.
- If a sentence is selected, CONTROL+SHIFT+F8 selects the first word of the sentence.
- If a word is selected, CONTROL+SHIFT+F8 returns the cursor to the beginning of the word, with nothing selected.

Selecting Text Across Multiple Pages

1. Position the cursor at the point where you’d like the selection to start.
2. Do one of the following:
   - Open the **Edit** menu and choose **Mark a Position**.
   - Or press **ALT+E+M**.
   - Or press **CONTROL+M**.
3. Move the cursor to the ending position for the selection. This can be before or after the starting point.

   **Note:** This kind of selection is useful only for cutting or copying text, or for applying format changes.

Selecting the Entire Document

Open the **Edit** menu and choose **Select All**. You can also press **ALT+E+A** or **CONTROL+A**.

This Select All differs from the same function in many word processors. After the Select All operation, the only valid operations are Cut, Copy, or format editing. Most other operations (such as Delete or typing a single letter to replace the selected text) apply only to the text on the last page of the document. That is, if you select the entire document and then type the letter “B,” you replace
all of the text on the last page with the letter “B” while the rest of the
document remains unchanged.

Additionally, you cannot undo operations performed before the
Select All.

Using Editing Keys

Many of the editing keys you use in your word processor or editing
program also work in Kurzweil 1000. While editing text, you can
use:

• The BACKSPACE key on the keyboard to erase the character to
  the left of the cursor, or any text you have selected.

• The DELETE key on the keyboard. Delete erases the character
to the right of the cursor, or any text you have selected.

• The INSERT key on your keyboard lets you switch between
  Insert and Overtype modes. In Insert mode, any words you type
  appear at the cursor position. Your typing does not affect the
  words already in the document. If you select text and then begin
typing, however, your typing replaces the selected text. In
  Overtype mode, your typing replaces existing words. Each
  character you type replaces a character already in the
document, starting at the current cursor position and moving to
  the right.

Other keys and combinations that work:

• CAPS LOCK.

• CONTROL+ENTER to insert a page break.

• SHIFT+CONTROL+ENTER to delete the first page break before
  the cursor.
A convenient option is to have Kurzweil 1000 echo the words or characters as you type. The Echo setting is located in the Reading Settings tab, and is accessible through the Settings menu. Go to Chapter 12, Working with Settings for details.

Cutting, Copying and Pasting

You can cut, copy, and paste text as well as images in a document:

- Cutting removes the object, whether selected text or image, from its current location. You can then paste it into another place in the document or into another document.

- Copying the object leaves it in its current location, but you can paste its copy into another place in the document or into another document.

- Pasting the object places it at your current cursor location in the document.

You can copy, cut and paste entire pages within a document or across different documents.

Before you can cut or copy, you must first select a block of text or an image. A block of text can consist of a single character or multiple pages.

To select a block of text using the marker:

1. Position the cursor at the point where you’d like to start.
2. Do one of the following:
   - Open the Edit menu and choose Mark a Position.
   - Or press ALT+E+M.
   - Or press CONTROL+M.
3. Move to the position where you’d like to end the selection. This position can be either before or after the mark.

To copy an object:
Do one of the following before or after the marker you placed:
• Open the Edit menu and choose Copy or press ALT+E+C.
• Or press CONTROL+C.

To cut an object:
Do one of the following before or after the marker you placed:
• Open the Edit menu and choose Cut or press ALT+E+T.
• Or press CONTROL+X.

To paste an object:
Do one of the following:
• Open the Edit menu and choose Paste or press ALT+E+P.
• Or press CONTROL+V.

You can paste the text into a Kurzweil 1000 document or into another Windows application.

Additional Editing Shortcut Keys
• CONTROL+A selects all text.
• CONTROL+DELETE removes the word to the right of the cursor.

You’ll hear the new current word. If the cursor is in the middle of a word, the system deletes the part of the word to the right of the cursor, along with any spaces that follow the word. If the cursor
is immediately to the right of a word, the system deletes any
spaces following the word. If the cursor is immediately to the left
of a word, the system deletes it and any spaces following it.

- **CONTROL+BACKSPACE** removes the word to the left of the
cursor.

You’ll hear the new current word. If the cursor is in the middle of
a word, the system deletes the part of the word to the left of the
cursor. If the cursor is immediately to the right of a word, the
system deletes the word and any spaces preceding it. If the
cursor is immediately to the left of a word, the system deletes the
spaces as well as the word to its left.

**Cutting, Copying, and Pasting Pages**

When you cut a page, your cursor is positioned at the following
page, unless you cut the last page of a document. When you paste
a page, it appears before the current page. You can paste the page
multiple times.

**To cut the current page and paste it using the menu:**

1. Place the cursor in the page you want to cut.
2. Choose **Cut Page** from the **Edit** menu or press **ALT+E+G**.
3. Go to the location where you want to insert the page before the
current page.
4. Choose **Paste Page** from the **Edit** menu or press **ALT+E+S**.

**To copy the current page and paste it using the menu:**

1. Place the cursor in the page you want to copy.
2. Choose **Copy Page** from the **Edit** menu or press **ALT+Y**.
3. Go to the location where you want to insert the page before the current page.

4. Choose **Paste Page** from the **Edit** menu or press **ALT+E+S**.

**Editing Formatting**

When you scan in a document, Kurzweil 1000 recognizes the document’s formatting information, along with the text. You can keep that formatting, correct it, or replace it entirely with choices of your own.

If you are creating a document in Kurzweil 1000, it’s a good idea to think ahead about the different formatting you may want and need, then apply these styles consistently throughout. Consider using standard conventions such as putting book titles in italic characters, or using left and right aligned paragraph format for full quotes.

Kurzweil 1000 provides both character and paragraph formatting.

**Font Formatting**

Each character in a document is displayed and printed using a font, which is a named collection of shapes for characters. Each character has a style, used to emphasize particular words or phrases. Styles can be regular, bold, italic, both bold and italic, or underlined.

Each character also has a size, expressed in English points (there are roughly 72 points to an inch, and the point size describes the height of an average character in a font).

When you are typing, the editor uses the system default character format, or the format of the last character before the cursor, or a format you specified specifically for the current text you are typing.
For scanned documents, Kurzweil 1000 normally displays the character font as it exists in the underlying document, but you can modify that formatting. You should be careful not to enable the Single Font setting when you want to modify character formats.

**Changing Font Formatting**

You can change font formatting properties for selected text or for text you will type at the cursor. The font formatting features are in the Font dialog, accessible from the Edit Format submenu.

1. Open the Edit menu, select Format, then select Font from the Format submenu, or use the mnemonics **ALT+E+O+F**.
   
   The Font Format dialog opens with your cursor in the Font Name box. The system tells you the font name of the selected text.

2. In the dialog, press the **TAB** key, or the mnemonics to go to any of the following controls:

   **Font (ALT+F).** Use the UP/DOWN ARROW key, or type the first letter of the desired font style to make a selection from the list.

   **Bold (ALT+L).** Use the UP/DOWN ARROW key to select Enabled or Disabled.

   **Italic (ALT+I).** Use the UP/DOWN ARROW key to select Enabled or Disabled.

   **Size (ALT+S).** Use the UP/DOWN ARROW key to make a selection from the list, or type the desired size.

   **Underline (ALT+U).** Use the UP/DOWN ARROW key to select Enabled or Disabled.
Note: Any of these lists may contain an item called Mixed if you have text selection that contains a mix of font, styles, and/or sizes.

To change font options:

1. With your cursor in the desired location or with text selected, open the Font dialog (ALT+E+O+F).
2. Go to the desired control by using its mnemonics or TAB.
3. Press the UP/DOWN ARROW keys to make your selections or type the first character of the desired selection.
4. Press ENTER.

The font for the selected text changes to your new specification. Or, if you don’t have text selected, the new font selection applies to text you type beginning at the cursor position.

Note: You can apply format changes across multiple pages, using either CONTROL+M for multipage selections, or CONTROL+A to apply font properties across an entire document.

To change font style:

Press CONTROL+SHIFT+F to hear a description of the format. You’ll hear only unusual attributes, not defaults, such as a regular font style.

Press CONTROL+I to switch between italic and regular text.

Press CONTROL+SHIFT+B to switch between bold and regular text. This is the same as CONTROL+B in other word processors. Kurzweil 1000 uses CONTROL+B for the Insert Bookmarks function. If you prefer to use CONTROL+B for bolding text, change the Shortcuts setting in the Reading Settings tab. Refer to Chapter 12, Working with Settings for details.
Press **CONTROL+Left Bracket** to make the font size one point smaller. Press **CONTROL+Right Bracket** to make the font size one point larger.

Press **CONTROL+U** to switch between underline and regular text.

**Paragraph Formatting**

Paragraphs have their own format properties. These include indentations and text alignment. By applying these properties you can convey and communicate different types of information, and make it easier for someone with sight to read and understand your work.

Whenever you press the ENTER key while typing, you are ending one paragraph and beginning another. By default, the system applies the properties of the previous paragraph for this new paragraph.

**Indentations**

There are three types of indentations: one for the left, one for the right, and one for the first line. All of these are distances, expressed as numbers in either inches or centimeters.

The left indent specifies the distance inward from the left margin of the page at which text should begin for each line in the paragraph.

The right indent specifies the distance inward from the right margin of the page at which text should end for each line in the paragraph.

The first line indent is a distance added to the normal left indent for the paragraph.

Indentations are used in many different paragraph styles.
• The most common paragraph style is one where the first line has an indent.
• Another common style uses no indentations at all, but provides an extra horizontal blank line to indicate a break between one paragraph and another.
• Paragraphs consisting entirely of quotes typically have an equal but non-zero left and right indent, making it obvious that the paragraph is special in some way.
• Another special style is a hanging indent, commonly used for a list of items and their multi-line descriptions. This is the most complicated style to format. You specify a left indent, and then a first line indent which is the same as the left indent, except that it is a negative number. Those two indentations cancel out, so that the first line begins at the left margin, and the subsequent lines are indented.

Alignment

The other paragraph property is alignment. A paragraph can be aligned to the left, to the right, to both the left and the right, or to the center of the page.

• Left alignment is where a paragraph has a straight edge on the left side and a ragged edge on the right.
• Justified is where a paragraph has a straight edge both on the left and on the right sides, except for the last line, which is usually shorter than the others.
• Centered text is mostly used for headings.
• Right aligned text is uncommon, but is often used for page numbers or dates at the top of a document.
If you intend to examine or change paragraph properties, you should be careful to not have the **Line Endings** setting value set to **Respected**. You will find this setting in the **Reading Settings** tab. Go to Chapter 12, *Working with Settings* for details.

**Changing Paragraph Formatting**

You can change paragraph formatting properties for a selected paragraph or paragraphs, or for text you will type at the cursor by using the **Paragraph** dialog, accessible from the **Edit Format** submenu.

**To open the Format Paragraph dialog:**

Open the **Edit** menu, select **Format**, then select **Paragraph** from the **Format** submenu, or use the mnemonics **ALT+E+O+P**.

The dialog opens with your cursor in the **Indentation** box. The system tells you the left indentation value.

**To hear the current paragraph format:**

In the dialog, press the **TAB** key, or the mnemonics to go to each of the controls:

- **Left** (**ALT+L**).
- **Right** (**ALT+R**).
- **First Line** (**ALT+F**).
- **Alignment** (**ALT+A**).

Notes: These controls might contain the entry "mixed" if you’ve selected conflicting attributes. Indentation units are in inches or centimeters to tenths of a unit. The first line indentation is relative to the specified left indent, so it can be a negative number.
To change paragraph options:

1. With your cursor in the desired location or paragraph, or with multiple paragraphs selected, open the Paragraph dialog (ALT+E+O+P).

2. Go to the desired control. Left, Right and First Line Indentations are text boxes, while Alignment is a combo box.

3. Type or select the desired options.

4. Press ENTER.

   The formatting for the paragraph changes to your new specification. Or, if you don’t have a paragraph selected, the new paragraph options apply to text you type.

   **Note:** You can apply format changes across multiple pages, using either CONTROL+M for multipage selections, or CONTROL+A to apply font properties across an entire document.

To change paragraph style:

If you do not need to have precise settings, the easiest and fastest way to format paragraphs is to use the shortcut keys:

- **CONTROL+E** centers a paragraph.
- **CONTROL+J** justifies a paragraph.
- **CONTROL+F12** aligns a paragraph to the left.
- **CONTROL+SHIFT+R** aligns it to the right.

The last two shortcuts are different from **CONTROL+L** and **CONTROL+R** used by most word processors. Kurzweil 1000 uses CONTROL+L and CONTROL+R as shortcuts for spelling and going to a bookmark. To use the word processing shortcuts for paragraph alignment, change the **Shortcuts** setting in the **Reading Settings** tab. Go to Chapter 12, *Working with Settings* for details.
Chapter 9. Editing Text and Formatting

Undoing Edits

If you change your mind about the last editing change you made, you can return the text to its previous state.

To undo your last edit:

Use one of the following methods:

- Open the **Edit** menu and choose **Undo**.
- Or press **ALT+E+U**.
- Or press **CONTROL+Z**.

**Note:** When you change pages, for example, you are no longer able to undo edits you made on the previous page.

Proofreading

Kurzweil 1000 provides special keystrokes which enable you to hear how text is punctuated and capitalized. These keystrokes are particularly useful for proofreading documents, and other specialized text, such as computer code, in which exact punctuation is essential. For capitalized words, Kurzweil 1000 says "all caps" when it comes to a word that is in all capitals. For words in which only the first letter is capitalized, Kurzweil 1000 says "cap."

You can also proofread, and select each word.

To proofread word by word, press **ALT+CONTROL+RIGHT ARROW**.

To proofread backward press **ALT+CONTROL+LEFT ARROW**.

To proofread forward word by word, and select each word, press **SHIFT+ALT+CONTROL+RIGHT ARROW**.
To proofread backward, and deselect selected words, press \texttt{SHIFT+ALT+CONTROL+LEFT ARROW}.

**Searching for Text and Tables**

You can search for any text string in a document. If the search is successful, Kurzweil 1000 selects the string's first occurrence. You can replace the string with the text of your choice, or you can continue searching.

You can also search for tables in a document by selecting \texttt{Tables} from the \texttt{Find} dialog's \texttt{Format} list.

If you are familiar with regular expressions, you can use them to find and replace text and characters.

Press any key during the search to hear the number of the page currently being searched. You can cancel the search by pressing the \texttt{ESCAPE} key on the keyboard.

**To open the Find dialog:**

Use one of the following methods:

- Open the \texttt{Edit} menu and choose \texttt{Find}.
- Or press \texttt{ALT+E+F}.
- Or press the shortcut keys for Find: \texttt{CONTROL+F}.

The dialog opens. Kurzweil 1000 tells you the current word.

**To search for a text string:**

1. Open the \texttt{Find} dialog.

   Your cursor is in the Find combo box.
2. Type the text for which you want to search. By default, the box contains the word your cursor was in when you accessed the dialog.

The box also contains a list of up to the last ten words or phrases used in previous searches. Use the UP/DOWN ARROWs to retrieve a word or phrase from the list.

3. Specify additional search criteria: Match Whole Word (ALT+W) or Case Sensitivity (ALT+S).

4. Specify the direction of the search:
   • Find Next (ALT+N) for forward search. Because this is the default you can press ENTER instead.
     When Kurzweil 1000 reaches the end of the document, it does not resume searching at the beginning.
   • Find Previous (ALT+V) for backward search.
     When Kurzweil 1000 reaches the beginning of the document, it does not resume searching.
   • Start at Top (ALT+T) of the document.

5. Press ENTER.

To specify the direction of the search:

Once you have specified the desired text in the Find dialog, you can choose one of the following options:

• Find Next by pressing ALT+N in the Find dialog. If you do not have the Find dialog open or are continuing a search, press ALT+E+N or press F3.

• Find Previous by pressing ALT+V in the Find dialog. If you do not have the Find dialog open or are continuing a search, press ALT+E+P or press SHIFT+F3.
Start at Top by pressing ALT+N in the Find dialog. Note: Start at Top does not have a shortcut key nor is it available from the Edit menu.

To search for text by formatting or to search for tables:

In the Find dialog, press ALT+O to go to the Format list box.

Select the format you want to find by pressing the UP/DOWN ARROW key until you hear the desired selection:

- Text in regular font format.
- Bold text.
- Italic text.
- Underlined text.
- Character Format Change.
- Centered.
- Right Justified.
- Paragraph Format Change.
- Tables.

To search for whole-word match:

In the Find dialog, press ALT+W to go to the Match Whole Word list box. Use the UP/DOWN ARROW keys to choose Enable or Disable.

If you enable this option, Kurzweil 1000 finds the whole word match for the search text, and not part of another word. For example, if the Find text box contains the word "book" and Match Whole Word is enabled, Kurzweil 1000 finds the word "book" but not the characters "book" in the word bookcase.
Note: If the Match Whole Word feature is enabled, the Find text box cannot contain any spaces.

To search for case-sensitive match:
In the Find dialog, press ALT+S to go to the Case Sensitivity list. Use the UP/DOWN ARROW keys to choose Enable or Disable.
An example of a case-sensitive search: suppose you specify the word "hospital" with a lowercase "h" and you request a case-sensitive search, Kurzweil 1000 finds hospital with a lower case h, but not Hospital with a capital H.

To hear the context of the found text:
In the Find dialog, press Read Context (ALT+X).

To find and replace the word:
In the Find dialog, press ALT+R to open the Replace dialog.

Searching Using Regular Expressions
A regular expression is a pattern that describes a certain amount of characters. Regular expressions can be a concise, flexible and expedient way of finding exact or approximate text and of making global changes in a file.
A regular expression can be as simple as the text itself such as "kurzweil," so a search for that pattern would result in finding matches of the word "kurzweil" in the file. A more complex search and replace might be to find all dollar signs that are followed by white space and then a digit, and remove the white space. The regular expression would be "\$\s+\d" where the "\$" tells the system to find dollar signs. But because the dollar sign is a special character used in regular expressions to indicate end of string, the
backslash is added to indicate that we're looking for actual dollar signs. The next pattern, "\s" tells the system to look for white space, which could be a space, a tab, or a new line character. The plus sign tells the system to match one or more occurrences of the previous combination. In "(d)" the parentheses tell the system that the next expression should be in a group, and the text that matches that group is in the replace string. The "d" indicates that we want to match any digit. The replace string of "$\1" indicates that the white space should be eliminated.

For more information about regular expressions, refer to tutorials on the Web.

**To use regular expressions in a Kurzweil 1000 search and replace:**

1. Open either the **Find** (Control+F) or **Replace** (Control+H) dialog.
2. Press Tab to go to **Use Regular Expressions**, then press the Down Arrow key to Enable the feature.
3. In the **Find** and/or **Replace With** text box, enter your regular expression, and press Enter.

**Searching for Special Characters**

In the **Find** text box (ALT+F) in the **Find** dialog, you can type the following to search for special characters:

- \t finds horizontal tabs.
- \n finds a new line. A new line exists only at the end of a paragraph or on a blank line.
- \ finds backslashes.
- \p finds text at the beginning or end of a page. For example, -\p would find pages whose last character is a hyphen, and \p-
would find pages whose first character is a hyphen. Be aware that searches using this wildcard may fail due to the presence of headers and footers.

**Searching for Blank Pages**

You can find blank pages, that is pages that contain no displayable text. Note, though, that a blank page may have spaces, tab and new line characters.

In the Format list (ALT+O) in the Find dialog, type the letter B until you hear "Blank Pages." You can use ALT+N to search forward or ALT+V to search backward.

**Replacing Text**

There are two ways to replace text: by specifying text and choosing Replace in the Find dialog, or by choosing Replace directly from the Edit menu.

In either case, the Find and Replace dialog opens and lets you search for any text string and replace it with a text string you specify.

**About the Find and Replace Dialog**

The Find and Replace dialog box is similar to the Find dialog, but it contains three additional options: a Replace With text box, and the Replace All and Replace Permanently commands.

When you first access the Find and Replace dialog, the cursor is in the Find combo box. If you opened this dialog from the Find dialog, the text you specified for the search is in this text box.

The Find combo box also contains a list of up to the last ten words or phrases used in previous searches. Use the UP/DOWN ARROWS to retrieve a word or phrase from the list.
To open the Find and Replace dialog:

Use one of the following methods:

- Open the Edit menu and choose Replace or press ALT+E+R.
- Or press the Replace shortcut key CONTROL+H.
- Or choose the Replace command (ALT+R) in the Find dialog box.

To replace text:

You can find and replace text or have specific text in the document already selected.

1. In the Find and Replace dialog, press TAB to go to the Replace With text box or press ALT+H.
2. Type the replacement text.
3. Press ALT+R.

If you have text selected in the document, the text in the Replace With text box takes the place of the selected text.

To specify replacement options:

In the Find and Replace dialog, you can select any of the following options: Match Whole Word, Case Sensitivity, or Read Context. You can find descriptions for these options in the previous section, Searching for Text.

To specify the directions of your search and replacement:

In the Find and Replace dialog, you can select any of the following options: Find Next, Find Previous, or Start at Top. You can find descriptions for these options in the previous section, Searching for Text.
To replace text throughout the entire document:

1. In the Find and Replace dialog, press ALT+H to go to the Replace With text box.
2. Type the replacement text.
3. Press ALT+A.

This replaces all occurrences of the Find string from the current position to the end of the document. When the replacement is complete, the cursor is at the position from which you accessed the dialog. Kurzweil 1000 tells you the number of replacements made.

To permanently replace text throughout Kurzweil 1000:

In the Find and Replace dialog box, press ALT+P.

The Replace Permanently command behaves like Replace All, but it also adds the correction to the current corrections list. Only Whole Word matches can be used as permanent corrections.

Using the Spell Checker

The spell checker helps with proofreading by going through a document, checking each word against the system dictionary. Spell checking is done through the Spell Checker dialog.

About the Spell Checker Dialog

When the Spell Checker dialog first opens, your cursor is in the Replacement box which lists possible replacements for the unknown word. In some cases, there may not be any suggested replacements.
In addition to the replacement box, this dialog contains nine commands: Replace, Replace All, Read Context, Spell Word, Ignore, Ignore All, Add to Word List, Properties, and Cancel.

To start and stop the Spell Checker:

You can spell check an entire document or a selected portion of text.

Use one of the following methods:

• Open the Tools menu and choose Check Spelling.
• Or press ALT+O+K.
• Or use the shortcut CONTROL+K.

Spell checking begins at the current position of your cursor, or at the beginning of the selected text. You can press any key to hear what page the spell checker is on.

Whenever the spell checker encounters an unknown or misspelled word, it pauses and opens the Spell Checker dialog box.

To cancel or end spell checking, press ESCAPE on the keyboard.

To replace the current instance of a word:

In the Spell Checker dialog,

1. Press the UP/DOWN ARROW keys until you hear the replacement you want. Or, type a replacement.

2. When you are done, press ALT+R to Replace the word.

   The system replaces just this particular instance of the word. If the replacement box is empty, this button has no effect.
To replace the word throughout the entire document:

In the **Spell Checker** dialog,

1. Press **TAB** to go to the Replacement text/list box, if your cursor is not there already.
2. Select the replacement you want from the list or type one in.
3. Press **ALT+A**.

   The substitution takes place regardless of case, and the replacement takes place on each page as the Spell Checker advances to that page.

   The system also adds the word and its correction to the current corrections list. (The section, *About Corrections Lists* later in this chapter provides details on selecting a corrections list.)

To hear the context of the word:

In the **Spell Checker** dialog, press **ALT+X**.

To ignore the word:

In the **Spell Checker** dialog, press **ALT+I**. The spell check continues from this point. Because **Ignore** is the default in the Spell Checker, you can simply press **ENTER**.
To hear the word spelled out:

There are two options for Kurzweil 1000 to spell out the word; by alphabet or by word alphabet.

In the Spell Checker dialog, press **ALT+S** to go to the spell command button.

To hear the word spelled by word alphabet, press **ALT+S**, then press **SHIFT** or **CONTROL**, and then **ENTER**.

To ignore all instances of a misspelled word in a document:

In the Spell Checker dialog, press **ALT+L** to **Ignore All**.

**Note:** If you save a document in the .KES format, Kurzweil 1000 saves a list of these words, making it easier to spell check the document over multiple sessions.

To add the word to the Kurzweil 1000 Spell Checker Word List:

In the Spell Checker dialog, press **ALT+D**.

When you add a word to this list, Kurzweil 1000 ignores it in all documents throughout the system.

When you permanently add a word to the Spell Checker list, the system also adds it to a list of “hints” used during optical character recognition. This list rebuilds each time you start Kurzweil 1000, so additions will take effect after you close and restart.

**Note:** Adding a word to the Spell Checker list also affects the results in Ranked Spelling.
Setting Spell Check Properties

The Spell Check Properties dialog contains options that control the way Kurzweil 1000 handles prefixes and suffixes, words with special capitalization, and words that contain numeric characters. To access the dialog, first choose Check Spelling from the Tools menu (ALT+O+K) to open the Spell Checker dialog, and then press ALT+P to open the Spell Check Properties dialog.

Note: The Properties dialog is also used by the Ranked Spelling feature. Kurzweil 1000 uses any Properties options you set for the Spell Checker for Ranked Spelling, and vice versa.

To ignore special words:

1. In the Spell Checker dialog, press ALT+P to open the Properties dialog.
   The dialog opens with the Capitalized list selected.
2. Use the UP/DOWN ARROW to choose Ignore for the following types of words:
   Capitalized (ALT+Z) for words with initial capitalization.
   All Caps (ALT+P) for words composed of all capital letters.
   Partial Numbers (ALT+N) for words with both alpha and numeric characters.

By default, Kurzweil 1000 checks all words of these types.
To ignore user-specified prefixes and suffixes:

You can direct the Spell Checker to ignore prefixes and suffixes that you specify.

1. In the Spell Checker dialog, press ALT+P to open the Properties dialog.

2. Press ALT+X to go to the Prefixes text box, or press ALT+S to go to the Suffixes text box.

3. Type a prefix or suffix you want the Spell Checker to ignore.

   You might want to add a prefix such as "http:" to the list. For suffixes, you might want to add ".com".

4. Press CONTROL+ENTER to add the prefix or suffix to its list, and leave the dialog open so you can continue adding additional prefixes and suffixes.

5. When you’re done, press ENTER to close the Properties dialog.

Your selections for all of the Properties dialog options apply throughout your current Kurzweil 1000 session, but revert to the defaults once you exit the program. You can have these settings apply automatically whenever you use Kurzweil 1000 by saving them to a settings file. For information on saving settings, go to Chapter 12, Working with Settings.
Editing Your Spell Checker List

When you spell check a document, you can add words to the spell checker list using the Add to Word List command. You can view, edit and later delete words from the list, or add new words to the list using the list editing feature.

Note: Your custom spell checker list is in your user Settings folder on your system.

To edit your Spell Checker Word List:

Open the Tools menu and choose Edit Spell Checker Word List (mnemonics ALT+O+S).

A dialog box opens containing:

• A list view box with all the words in the Spell Checker Word List. This list is not in alphabetical order; rather, it is in the order in which the words were added. When you first access the dialog, your cursor is positioned in this list box.

• Four commands: Add, Delete, OK and Cancel.

To cancel or end the editing session press ALT+C or ESCAPE.

To move through the Word list:

There are several ways to navigate through this list: Use the UP/DOWN ARROW keys, PAGE UP/PAGE DOWN keys, and Home and End keys. Press a keyboard key to jump to the first entry beginning with that character. Or type more than one character to get to a particular item.

The mnemonic for the list view box is ALT+F.
To hear the current word in the list spelled out:
   In the **Edit Spell Checker List** dialog, press **CONTROL+L** on the keyboard.

To delete the current word:
1. Press **ALT+D** or use the **DELETE** key on the keyboard.
   Kurzweil 1000 provides spoken feedback if you delete an item from the list.
2. Press **TAB** to move to the **OK** command or press **ENTER**.

To add a new word to your Word list:
1. Press **ALT+A** to choose the Add command.
   A dialog opens with your cursor in a text box.
2. Type in the word you want to add, press **ENTER**.
   This takes you back to the **Edit** dialog box with your cursor in the first entry of the list.

Using Ranked Spelling

Accessible from the **Tools** menu, **Ranked Spelling** provides useful statistics such as the percentage of correctly spelled words in a file and the number of words misspelled. It lists misspelled words by the frequency of their occurrence and provides the commands for correcting them in the same dialog box.

Ranked Spelling is an ideal tool for quickly assessing how much of a file, particularly a large book, is correctly spelled, and prioritizing the corrections you want to make. As you correct errors, Kurzweil 1000 continues to update the statistics, enabling you to make further assessments.
Here’s an example of how you might use Ranked Spelling. Let’s say you start out with a file that has 95 percent of its words spelled correctly, and you’d like to improve that rate to a respectable 98 percent. By using Ranked Spelling, you find that only three misspelled words have the highest number of occurrences, and therefore are causing the greatest number of errors. With the Replace All command for each of these three misspellings, you could significantly, and quickly, improve the file’s accuracy rate, without having to go through the file, correcting one misspelled word at a time.

When you use Ranked Spelling in conjunction with the Automatic Corrections feature, you can also improve the accuracy of the documents you scan.

To edit and add Ranked Spelling words to the corrections list:

1. Select Ranked Spelling from the Tools menu.

   The Ranked Spelling dialog box opens, and you’ll hear the percentage of the words in the file that are spelled correctly and the number of misspelled words.

2. Press the TAB key after the message to place your cursor in the first word of the list of misspelled words.

Kurzweil 1000 presents the list in descending order of occurrences, so the first misspelled word in this list occurs most frequently in the document.

Note: By default Kurzweil 1000 spell checks capitalized words, words composed of all capitals and words composed of numbers and letters. Depending on your document, this may cause words that are spelled correctly, for example acronyms, to be included on the list. You can use the options available in the Properties dialog (ALT+P) from the Ranked Spelling dialog to
direct Kurzweil 1000 to disregard one or more of these "special" types of words.

3. Press **TAB** after a misspelled word to place your cursor in the correction box. You can either type in a replacement word or select one from the list of suggestions by using the **UP/DOWN ARROW** keys.

4. To queue the replacement and remain in the correction box, press **CONTROL+R**. Use the **DOWN ARROW** key to hear the next or subsequent words in the list.

**To take other actions for a misspelled word:**

With your cursor in the desired word, press:

**CONTROL+X** to **Read Context** for the word.

**CONTROL+L** to **Spell** the word.

**CONTROL+I** to **Ignore** the word.

**CONTROL+G** to **Ignore All** instances of the word.

**CONTROL+A** to **Add to Word List** and your user dictionary.

**CONTROL+R** to **Replace All** instances of the word with the correction.

**To create a list of misspelled words:**

With your cursor in the misspelled words list, press **CONTROL+C**. The contents of the list are copied to the clipboard, ready for you to paste into another document, which could be in another application.

**To apply all pending actions and hear updated statistics:**

Press **ALT+Y**. The system also regenerates the misspelling list with this command.
To exit the Ranked Spelling dialog:

Press **ALT+Y** or **ENTER** if you want to apply all the actions.

Or press **ALT+C** or **ESCAPE** if you want to cancel all actions.

To leave the Ranked Spelling dialog to review and correct misspellings in the document:

Press **ALT+E** or **CONTROL+E** to edit the word in the document.

**Note:** While in this mode, you can use the **F3** or **SHIFT+F3** keys to find the next or previous occurrence of a misspelling, respectively.

To return to the **Ranked Spelling** dialog, press **ESCAPE**.

**Note:** When you return to the dialog, the selected word is either the next misspelled word on the list, or the same word if there are further instances where it is misspelled.

More Tips for Working in the Ranked Spelling Dialog Box:

By pressing **F1** in the list of misspelled words, you can hear what you can do with each word.

**CONTROL+ L** spells the word. **CONTROL+ SHIFT + L** spells the word mnemonically.

**F7** or the **SPACEBAR** repeats the word, the count of the number of times it occurred in the document and the action that is pending for it, if any.

You can search the list of words by pressing **CONTROL+F**. In the find dialog that opens, type in a word or partial word, then press **ENTER** to search the list. Kurzweil 1000 reads the first item it finds. Press **F3** to move to the next matching item, and **SHIFT+F3** to move to the previous match.
Setting Spell Check Properties for Ranked Spelling

The Spell Check Properties dialog contains options that control the way Kurzweil 1000 handles prefixes and suffixes, words with special capitalization, and words that contain numeric characters. To access the dialog, first choose Check Spelling from the Tools menu (ALT+O+K) to open the Spell Checker dialog, and then press ALT+P to open the Spell Check Properties dialog.

**Note:** The Properties dialog is also used by the Spell Check function. Kurzweil 1000 uses any Properties options you set for Ranked Spelling for Spell Check, and vice versa.

To ignore special words:

1. In the Ranked Spelling dialog, press ALT+P to open the Properties dialog.
   
   The dialog opens with the Capitalized list selected.

2. Use the UP/DOWN ARROWS to choose Ignore for the any following types of words you don’t want spell checked:

   - **Capitalized** (ALT+Z) for words with initial capitalization.
   - **All Caps** (ALT+P). for words composed of all capital letters, such as acronyms.
   - **Partial Numbers** (ALT+N) for words with both alpha and numeric characters.

   By default, Kurzweil 1000 checks all words of these types.

3. Press ENTER to close the Properties dialog.

4. After exiting the Properties dialog, press ALT+P to apply the changes, and regenerate the list of misspelled words. This removes any capitalized Properties dialog.
To ignore user-specified prefixes and suffixes:

You can direct the Ranked Spelling to ignore prefixes and suffixes included on lists you create.

1. In the Spell Checker dialog, press ALT+P to open the Properties dialog.

2. Press ALT+X to move the cursor to the Prefixes text box, or press ALT+S to move the cursor to the Suffixes text box.

3. Type a prefix or suffix you want the Spell Checker to ignore.
   
   You might want to add a prefix such as "http:" to the list. For suffixes, you might want to add ".com".

4. Press CONTROL+ENTER to add the prefix or suffix to its list, and leave the dialog open.

5. Press ENTER to add the prefix or suffix, and close the Properties dialog.

6. After exiting the Properties dialog, press ALT+Y to apply the changes, and regenerate the list of misspelled words.
   
   This removes any prefixes or suffixes that you added in the Properties dialog.

Your selections for all of the Properties dialog options apply throughout your current Kurzweil 1000 session, but revert to the defaults once you exit the program. You can have these settings apply automatically whenever you use Kurzweil 1000 by saving them to a settings file. For information on saving settings, go to Chapter 12, Working with Settings.
Changing a Word’s Pronunciation

You may want to or have to change the pronunciation of words, such as proper names and words or phrases that have their origins in other languages. "Filet mignon" for example may be pronounced incorrectly as "filet mig-non." You might use m i n y o h n for "min yohn" as the corrected pronunciation.

Kurzweil 1000 lets you change the pronunciation of any word in the speech engine’s pronunciation dictionary. If you have multiple speech engines installed, there will be one dictionary for each speech engine and language used. The pronunciation dialog boxes always access the dictionary associated with the current reading voice.

Pronunciation changes are global throughout the Kurzweil 1000 program. Each time Kurzweil 1000 encounters the given word, in any file or document, it will use the new pronunciation to read it.

To change the pronunciation of a word:

1. Do one of the following:
   • Open the Tools menu and choose New Pronunciation (ALT+O+N).
   • Or press the shortcut keys SHIFT+CONTROL+N.

   The Pronunciation dialog opens with the cursor in the Word to be Spoken text box. If a file is open, this box contains the current word, but you can type any word into it. You could also select the desired text from the document before opening this dialog.

   The mnemonic for Word to be Spoken is ALT+W.

2. Press ALT+P to go to the Pronunciation text box.

3. Type the pronunciation you want for the word.
4. If you want to enable or disable case sensitivity, press **ALT+S** and use the **UP/DOWN ARROW** key.

   If you enable this feature, the new pronunciation applies to the word only when it has the case shown in the first text box in the dialog. If it is disabled, the new pronunciation applies to the word regardless of the case in which it appears.

5. If you want to hear the pronunciation, press **ALT+T** to choose the **Test** command.

6. When you are done, press **ENTER**.

   The dialog closes and Kurzweil 1000 changes the specified pronunciation.

**To cancel pronunciation changes and close the dialog:**

   Press TAB again to move to the **Cancel** button. The mnemonic for Cancel is **ALT+C**. You can also cancel from this dialog by pressing **ESCAPE**.

**Editing the Pronunciation List**

   You can delete or modify pronunciation changes you’ve made to the speech engine’s dictionary.

**To modify or delete pronunciations:**

   Open the **Tools** menu and choose **Edit Pronunciation**. To use mnemonics, press **ALT+O**, then letter **P**.

   The **Edit Pronunciation** dialog opens.
About the Edit Pronunciation Dialog

The Edit Pronunciation dialog is similar to the New Pronunciation dialog with a few differences and additions:

The Word to be Spoken option is a list view rather than a text box, containing all the words for which you’ve changed the pronunciation. Use this list to choose the word to modify. The mnemonic for Word to be Spoken is ALT+W.

As in the New Pronunciation dialog, you can TAB or press ALT+P to go to the Pronunciation text box to edit the word’s pronunciation.

There’s also the Case Sensitivity list (ALT+S) and three commands:

- Test (ALT+T) to hear the edited pronunciation.
- Delete command (ALT+D) to delete the current word in the Word to be Spoken list.
- Add command (ALT+A) to add a new pronunciation.

To apply changes and close the dialog, press ENTER. To cancel and exit the dialog, press ALT+C or ESCAPE.

Applying Corrections Throughout a Document

Using the Replace Permanently command in the Replace dialog box, or the Replace All command in the Spell Checker dialog box, you can create lists that contain replacements for common scanning errors or misspellings.

You can have a number of corrections lists, each suited to a different kind of document. In applying a corrections list, you must first select one.
To choose or create a new corrections list:

Open the **Tools** menu and choose **Select Corrections File**. To use mnemonics, press **ALT+O**, then letter **F**.

A dialog box opens, containing a list of all existing corrections files. Use the **UP/DOWN ARROW** keys to choose an existing file, or type a new file name to create a new corrections list. When you’re done, press **ENTER**.

All actions related to the corrections list are directed to the current list. For example, if you select **Replace All** during spell checking, the change is added to just the current corrections list. Similarly, when you choose **Edit Corrections List** from the **Tools** menu, the currently selected list is opened for editing. Corrections are always applied from the current list.

**Apply Corrections** goes through your document and replaces all the strings in the current corrections list with the specified replacements. **Apply Corrections** begins at the current cursor position, and continues to the end of the document. Upon completion, you’ll hear the number of corrections the system made.

While **Apply Corrections** is working, you can press any key to hear the number of the page currently being corrected. Cancel the operation by pressing the **ESCAPE** key on the keyboard.

**To apply corrections to the document:**

Open the **Tools** menu and choose **Apply Corrections**. To use mnemonics, press **ALT+O**, then letter **A**.

**Applying Corrections Automatically**

The **Automatic Corrections** feature, accessed through the General settings tab page, automatically applies your permanent
corrections list to each page you scan. For more information, go to the next section.

Editing Your Corrections List

You can modify, delete or add entries in a corrections list.

To edit the Corrections list:

1. Open the Tools menu and choose Edit Corrections. To use mnemonics, press ALT+O, then letter E again.

   The Edit Corrections dialog box opens with your cursor in the Find list view box (mnemonic ALT+F) which contains all the strings in the corrections list, in alphabetical order.

2. Press the UP/DOWN ARROW key until you hear the text you want to correct.

   You cannot change words in the list, but you can delete a word by pressing the Delete key on the keyboard.

3. Press TAB or ALT+H to go to the Replace With text box that contains the replacement word for the current word in the list.

4. Edit the text.

5. If you want the replacement to be case-sensitive, press ALT+S to go to the Case Sensitivity option, use the UP/DOWN ARROW key to enable it.

6. Press ENTER to apply the change and close the dialog.

To delete an entry in the Corrections list:

1. In the Edit Corrections dialog, press ALT+F to go to the Find box.
2. Press the **UP/DOWN ARROW** key until you hear the text you want to delete.

3. Press **Delete** key or **ALT+D**.

4. Press **ENTER** when you are done.

**To add a new entry to the Corrections list:**

1. In the **Edit Corrections** dialog, press **ALT+A** to go to the **Add** command.
   A dialog opens with your cursor in a text box.

2. Type in the word you want to correct, press **ENTER**.
   This takes you back to the **Edit** dialog with your cursor in the first entry of the list.

3. Type the correction for this word, press **ENTER**.

**Inserting a Signature File**

You can insert a signature in any document or in any form field that is a text box containing a variable number of characters. Go to the chapter entitled, Working with Forms, for details on adding a signature to a form field.

**To insert a signature file into a document:**

1. Place the cursor where you want to insert the signature.

2. Choose Insert Signature from the Edit menu (**ALT+E+I**).

3. If you have multiple signature files, use the UP or DOWN ARROW key to select one from the list.

   Note: In a document containing a signature, you can navigate through to find the signature. When Kurzweil 1000 encounters one,
it will announce "signature." You will not hear this announcement, however, when reading continuously; instead Kurzweil 1000 will say the word, "at."

Shortcut Keys for Editing

Moving in Text

LEFT or RIGHT ARROW to place cursor at the previous or next character.

CONTROL+LEFT ARROW to place cursor at the beginning of the current or previous word.

CONTROL+RIGHT ARROW to place cursor at the beginning of the current or next word.

UP or RIGHT ARROW to move to the line above or below.

HOME or END to move to the beginning or end of the current line.

CONTROL+UP or +DOWN ARROW to move to the beginning or next of the previous paragraph.

SHIFT+F6 to move to the beginning of the previous region.

SHIFT+F8 to move to the beginning of the next region.

PAGE UP or PAGE DOWN to place your cursor at the top of the previous page or at the top of the next page.

SHIFT+PAGE UP or +PAGE DOWN to go to the top of or to the bottom of the current page.

CONTROL+HOME or +END to move to the top of or the bottom of the document.
Text Selection

- **SHIFT+LEFT** or **+RIGHT ARROW** to select the character before or after the cursor.
- **SHIFT+CONTROL+LEFT** or **RIGHT ARROW** to select the word before or after the cursor.
- **SHIFT+UP** or **DOWN ARROW** to select from the current line position to the same position in the line above the cursor or in the line below the cursor.
- **SHIFT+HOME** or **+END** to select to the beginning of or to the end of the current line.
- **SHIFT+CONTROL+UP** or **DOWN ARROW** to select to the beginning of the current or to the beginning of the next paragraph.
- **CONTROL+Y** to hear selected text.

Cut, Copy and Paste

- **CONTROL+C** to copy.
- **CONTROL+X** to cut.
- **CONTROL+V** to paste.

Search and Replace

- **CONTROL+F** to open the Find dialog.
- **F3** to find next instance.
- **SHIFT+F3** to find previous instance.
- **CONTROL+H** to open the Replace dialog.
Spell Check and Pronunciation

CTRL+K to begin spell checking.

SHIFT+CTRL+N to change a word’s pronunciation.
10 Working with Forms

This chapter contains the following topics:
Scanning and Recognizing Forms.
Reading and Navigating in a Form Document.
Filling Out a Form.
Adding a Signature File to a Form.
Printing and Saving a Form.
Scanning and Recognizing Forms

Kurzweil 1000 can recognize fields in forms and gives you ways to explore those fields, fill them out and print the results.

Once you have scanned and/or rerecognized a form, it is a good idea to read through the form document at least once to orient yourself and get a general idea of where there might be fields you will need to fill, and the context of those fields. Kurzweil 1000 will tell you how many fields are on a page, and will chime when you read past a field. You can add a signature within a text field, and save the form as a .KES document and/or print it.

You can use Kurzweil 1000 to scan and recognize most types of forms. Kurzweil 1000 automatically uses the ScanSoft engine, keeps an image of the page and presents you with the fields, labels, boxes, text areas, as well as the positions of those items, and in an appropriate reading order. You can read, save, edit, cut and paste in forms, just as you do in any document.

Often, you won’t know that a page is a form until you have recognized and read some of it. If you kept the image, you can rerecognize it as a form.

To scan a form:

Use the **Scan as a Form** command from the **Scan** menu; **ALT+S**, then **M**.

**Note:** scanning a page as a form only affects one page. This is true even if you are using a document feeder. It will be less confusing if you have only one form page at a time in the feeder.
To rerecognize a form:

Be sure you have the desired page open when you use Rerecognize a Form from the Scan menu; ALT+S, then E.

Reading and Navigating in a Form Document

Reading and navigating in form documents is the same as in any document: F5 starts and stops reading, and you can move in the text in the usual manner.

Filling Out a Form

If you plan on reusing the form, be sure to save a copy before filling it out. There are two ways to fill out a form: by using the Form Fill dialog or by using Show Image.

If you have some vision or have an assistant, you can use Show Image from the Tools menu, mnemonics ALT+O, then W, or CONTROL+W to fill out a form. You can magnify the image, invert it, read the recognized text and move among the form fields using TAB and SHIFT+TAB. To return to the form document form the image, press ESCAPE.

To fill out a form:

Choose Fill a field from the Edit menu, ALT+E+L, or use the shortcut CONTROL+F3.

The Form Fill dialog opens such that the field closest to your cursor position is presented first. Each dialog may contain as many as five fields, and there may be a series of dialogs, in which case you can use the Next (ALT+N) and Back (ALT+B) options. Note that both
these actions save any changes you have made in the current dialog.

To move among the fields in the dialogs, use the **TAB** and **SHIFT+TAB** keys. If you want to hear the state of a field, press **F7**. For additional information about the field, such as its type, label, position and size, press **SHIFT+F7**.

If there is a field that contains a check box or a list box, then Kurzweil 1000 announces its status. Use the Up or Down arrow to select the desired choice.

Some text fields may contain multiple lines. Use **CONTROL+ENTER** to end one line and begin another. If you are using Show Image to fill out the form, you may use the **ENTER** key instead.

To save your edits in the **Form Fill** dialog and close the dialog, press the **ENTER** key or **ALT+O** for OK. Your cursor returns to the open document.

To close the dialog without saving edits, press the **ESCAPE** key or **ALT+C**.

**To hear the text surrounding a field:**

You may encounter fields that are unlabeled or uninformative; to hear the recognized text found near the field, press **CONTROL+X**. Press it again to hear additional text.

**Adding a Signature File to a Form**

You can add a signature in any form field that is a text box that contains a variable number of characters.
To add a signature file, ensure that your cursor is in the desired field and that the field is a text box, then press **CONTROL+UP** or **DOWN ARROW** until you reach the desired signature.

**Printing and Saving a Form**

When you have completed filling in a form, use the Save function to save the document. Kurzweil 1000 saves the information you have filled out in the recognized fields, along with the recognized text and image of the form.

To print the image file containing the contents of the fields you have filled out:

1. Use the **Print** function.
2. When the **Print** dialog appears, **TAB** to the **Use Images** option or press **ALT+I** and select **Yes** to enable the setting.
3. Press **OK**.
11 Working with Tables

This chapter contains the following topics:
Creating and Editing Tables.
Table Creation Commands.
Table Creation Procedures.
Creating and Editing Tables

Kurzweil 1000 provides a full set of table creation and editing functions. You can create tables and modify them, using typical editing functions. You can also convert blocks of text into a table and conversely, turn a table into text.

Table Creation Commands

All table selection, conversion, and editing functions are accessible from the Table submenu available from the Edit menu. Pressing ALT+E, then B opens the Table submenu. On that submenu, you’ll find the following items:

Insert a Table (mnemonic I). This opens a dialog box that contains two text boxes in which you specify the number of columns and rows you want for the table.

By default, Kurzweil 1000 creates a five-column, two-row table. The new table is as wide as the page and all the columns have equal widths. Each row is the default line height, but automatically resizes as you enter contents into the cells.

Insert a Row Above (mnemonic A) followed by Insert a Row Below (mnemonic B). Creates a new row above or below the row in which your cursor is located. The new row contains the same number of cells and is the same height as the current row. The cells are empty, and upon insertion, your cursor is located in the first cell.

Insert a Column to the Left (mnemonic L) followed by Insert a Column to the Right (mnemonic R). Creates a new column to the left or right of your current cursor location. The new column contains the same number of cells as the current column. The width of all the columns changes to accommodate the new column, while
maintaining equal widths. The cells are empty, and upon insertion, your cursor is located in the topmost cell in the column.

**Delete Entire Row** (mnemonic O) followed by **Delete Entire Column** (mnemonic C). Deletes the row or column in which your cursor is currently located. Upon deletion of a row, your cursor is located in the first cell of the next row. Upon deletion of a column, your cursor is located in the topmost cell of the next column.

**Delete Entire Table** (mnemonic D). Deletes the entire table.

**Convert to Table** (mnemonic T). Converts fully selected paragraphs into a table. Go to the procedure, **To convert to table**, for details on converting paragraphs into a table.

**Convert to Text** (mnemonic V). Converts the table, in which your cursor is located, into a series of paragraphs. Each paragraph contains blocks of text with tabs for columns.

**Select Entire Table** (mnemonic S). Selects the table in which your cursor is located. Once selected, you can Cut or Copy and Paste it.

You can use **Undo** or **CONTROL+Z** to undo a table editing operation.

**Note:** You can search for tables in a document by choosing **Find** from the **Edit** menu (**ALT+E**, then **F**), and choosing **Tables** from the **Find** dialog’s **Format** list box.

**Changing Table Settings**

There are also settings that you can change for various aspects of a table. You can use the **Format Paragraph** dialog box (**ALT+E**, then **O**, then **P**), from the **Edit** menu, to make the following changes:

**Auto Size Enabled** or **Disabled** for automatic sizing of the row in which your cursor is currently located. When Auto Size is set to
Enabled, the row height grows or shrinks depending upon the space requirements of the contents in the cells in the row.

**Height**, in inches or centimeters, for the row in which your cursor is currently located. To use this setting, you must first select **Disabled** for **Auto Size**. If you have **Auto Size Enabled**, this text box is read-only, that is, you won’t be able to type anything in it.

**Cell Width**, in inches or centimeters, of the cell in which your cursor is currently located. When you press **ENTER** for this dialog box after making a change to **Cell Width**, Kurzweil 1000 asks if you want to apply the change to the width of the entire column or just to the current cell.

**Alignment** for the text in the current cell. Select **Left**, **Right**, **Center** or **Justified**.

### Table Creation Procedures

**To create a table:**

1. In the document, navigate to where you want to insert the table.
2. Select **Table** from the **Edit** menu, or press **ALT+E**, then **B**.
3. Choose **Insert a Table** from the **Table** submenu, or press its mnemonic **I**.
   
   This opens a dialog box. Your cursor is in the **Columns** text box.
4. Type the desired number of columns for your table.
5. **TAB** to go to the **Row** text box and then type the desired number of rows.
6. Press **ENTER**.
Chapter 11. Working with Tables

Kurzweil 1000 creates the new table and your cursor is in the first cell of the table.

7. Use the arrow keys to move around in a cell, and the ENTER key to add lines within a cell.

8. To navigate from cell to cell, use the TAB key.

Kurzweil 1000 announces the location of your cursor in the table whenever you move around. For a detailed list of commands that you can use to move around in a table, refer to Reading Tables in Chapter 3, Reading.

To convert text to a table:

1. In the text version, be sure each row that you want for the resulting table is a separate paragraph, that is, at the end of the text that you want to designate as a row, there is a hard return and Kurzweil 1000 indicates there is a “new line.”

2. Also in the text, be sure to indicate a column by inserting a tab character. Do this for each paragraph. In addition, ensure that each paragraph has the same number of tab characters, as these will enable Kurzweil 1000 to create columns. So, for instance, if you want the table to have three columns, each paragraph in the text version should have two tabs between three blocks of text.

3. Select all the paragraphs you want to include in the table by placing the cursor at the beginning of the selection and holding down the SHIFT key and using the RIGHT and or DOWN arrow keys until you reach the end of the selection. Be sure to get the last line of the selection.

4. From the Edit menu, select Table, then choose Convert to Table (ALT+E, then B, then T).
Kurzweil 1000 creates and announces a new table, and places the cursor in the first cell in the table. The table contains as many rows and columns as there were paragraphs and tab characters in the text version. It is as wide as the page, with columns of equal width, and the height of all the rows are set for auto sizing.

**To convert a table to text:**

1. Move the cursor to any cell in the table you want to convert to text.
2. From the **Edit** menu choose **Table**, then choose **Convert to Text** (ALT+E+B+V).

Kurzweil 1000 converts the table to text.
12 Working with Settings

This chapter contains the following topics:
Kurzweil 1000 Settings.
Accessing Settings.
Voice Settings.
Scanning Settings.
Recognition Settings.
Reading Settings.
General Settings.
Display Settings.
Scanner Margins Settings.
Configuration Settings.
Verbosity Settings.
Conversion Settings.
Default Settings.
Linking Documents and Settings.
Saving and Working with Settings Files.
Settings Status.
Kurzweil 1000 Settings

Kurzweil 1000 settings can affect the following:

The way certain features operate. For example, you can change brightness settings to help the system do a better job scanning and recognizing very light text.

The way Kurzweil 1000 interacts with you. For example, you can choose a reading voice you like, or choose fonts and colors for text display.

You can modify all Kurzweil 1000 settings from the Settings menu. You can also modify settings from keypad’s Reading and Settings layers. For more information, you can either download the document, Using the Keypad to Access Kurzweil 1000, from the Kurzweil Educational Systems website—www.kurzweiledu.com—or refer to Appendix E, Using the Keypad to Access Kurzweil 1000 in the Online Manual.

Additionally, you can save settings you use frequently in default files or user-named files, then load them when desired.

Settings Categories

There are nine settings categories:

**Voices** lets you choose reading and message voices. For the Reading Voice, you can select a Language, Speech Engine, Speaking Voice, and the method by which it reads emphasized text. You can also set Pitch, Speed and Volume for the Reading and Message voices.

**Scanning** settings control how Kurzweil 1000 scans printed material. For example, you can choose a page orientation for pages
on the scanner, adjust the scanning brightness, or choose a scan resolution.

**Recognition** settings control how Kurzweil 1000 recognizes pages it has scanned. For example, you can choose a recognition language, enable the speckle removal filter, or allow the software to recognize white on black text.

**Reading** settings control the way Kurzweil 1000 reads text to you. Reading settings include reading unit, echo mode for typing, and punctuation level.

**General** settings control general Kurzweil 1000 settings including how the system presents progress reports, and how it handles image and layout information in KES files.

**Display** settings control the way text appears on screen. Use these settings to change font and color, enable or disable tracking, and set a magnification value.

**Scanner Margins** settings control the margins for scanned documents. The scanner only recognizes the area of the page inside the specified margins.

**Configuration** settings are settings you do not change often. They include: Scanner Margin Units, Shortcuts, Keypad Commands, Numeric Keypad Layout, Hot Keys for Scanning, Active Speech and Online Cache.

**Verbosity** lets you choose from nearly two dozen Kurzweil 1000 events for which you want prompting, extra auditory assistance, or messaging turned off. Additionally, you can use your own sound files or edit the messages.

There are other kinds of settings as well, usually referenced in property dialogs that are related to specific actions. There are, for example, settings associated with printing, embossing, and with
sending documents to other devices. Like the nine categories of settings described above, you can save these settings to and load them from settings files.

Accessing Settings

You can find settings in the Settings tabs available from the Settings menu.

Settings tabs are a combination of dialog boxes that you can access separately. These tabs allow you to access all the settings categories from one convenient location. You can make changes tab to tab, then apply all the changes at once.

To access a Settings tab page:

1. Open the Settings menu by pressing ALT+T.
2. Use the UP/DOWN ARROW keys or the appropriate mnemonic keys to select any of the settings: Voices, Scanning, Recognition, Reading, General, Display, Margins, Configuration, or Verbosity.

When the Settings tab opens, your cursor is at the first item for the category you selected.

To move through the contents of a Settings tab:

Because tabs are actually dialog, you can use the TAB key on the keyboard to move through the options.

At the bottom are the OK and Cancel command keys.
To get to and move across the tab titles:

1. Press **CONTROL+TAB** until you hear the title of the tab that’s open. This indicates that your cursor is in the tab titles.

2. Use the **LEFT/RIGHT ARROW** keys to move across the titles.

3. When you hear the title you want, press the **TAB** key to move to the first item on that page.

   You can also use **CONTROL+TAB** or **CONTROL+SHIFT+TAB** to move forward or backward, respectively.

To go to a tab page using its mnemonic:

- **Voices** ALT+E.
- **Scanning** ALT+S.
- **Recognition** ALT+C.
- **Reading** ALT+R.
- **General** ALT+G.
- **Display** ALT+D.
- **Margins** ALT+M.
- **Configuration** ALT+F.
- **Verbosity** ALT+Y.

All of these mnemonics work, with or without the **ALT** key, as long as the mnemonic is not used by a control on the current tab, by an item in the current list or list view control, and as long as you are not in a text box. In those circumstances, you must use the **ALT** key.
To modify settings:

You can make changes from one tab to another. Kurzweil 1000 keeps track of them.

Most of the options for the settings are presented in list boxes. Use the UP/DOWN ARROW keys to make selections. Some settings are in checkbox lists. Use the ARROW keys to go through the list, and use the SPACEBAR key to check/uncheck boxes.

There are also alphanumeric boxes. If you attempt to type into a box that does not support alphanumeric characters, the system tries to find an option on the current tab that uses that character as a mnemonic. If found, it positions your cursor at that control. For example, typing X almost anywhere in the Display settings tab positions your cursor at the Text Color list box.

You can go directly to a setting by using its mnemonic key.

To apply changes:

When you are ready to apply the changes you’ve made, press ALT+A to apply the changes and leave the dialog open, or the ENTER key to apply changes and close the dialog.
Voices Settings

Kurzweil 1000 uses the reading voice to read documents and the message voice to speak messages from the program. The Voices tab page contains the following settings:

- **Audio Device** (mnemonic D). If you have multiple working audio output devices on your computer, this feature allows you to choose a device for the selected voice. If you have only one audio device, only "Default" is listed, which is the default output audio device specified in the control panel.

- **Role** list (mnemonic R). Select Reading or Message.

- **Language** list (mnemonic L). Select the language whose Voice settings you want to adjust.

- **Engine** list (mnemonic N). Select a speech engine installed on your system. The engines listed are those that support the language you’ve selected.

- **Voice** list (mnemonic V). The voices listed are those supported by the engine you’ve selected.

Note: When you change the Language or Engine setting, the list of available voices changes. However, it does not immediately cause a change to the voice used to speak in this dialog. The voice will change only when you tab to another control, such as the list of voices.

- **Pitch** combo box (mnemonic P). Type the desired value or use the UP/DOWN ARROW or the PAGE UP/PAGE DOWN keys to select a value. Each time you select a different voice, the Pitch is reset to the default value for that voice.
• **Speech Speed** combo box (mnemonic S). Type the desired value or use the **UP/DOWN ARROW** or the **PAGE UP/PAGE DOWN** keys to select a value.

• **Volume** combo box (mnemonic O). Type a value from 0 to 100 or change the value in small increments by using the **UP/DOWN ARROW** keys or increments of 10 by using the **PAGE UP/PAGE DOWN** keys. You can also adjust volume using the controls on the speakers.

• **Emphasis Method** list (mnemonic M). Select the way you want Kurzweil 1000 to read the emphasized text. Possible selections include **Change the Pitch**, **Switch to another Voice**, **Speak Normally**, and **Built In**. However the available selections will vary depending on the currently selected reading voice.

• **Emphasis Voice** list (mnemonic C). Select a voice to use to read emphasized text. This list is only available when the selected Emphasis Method is **Switch to another Voice**.

• **Emphasis Pitch** list (mnemonic H). Type the desired value or use the **UP/DOWN ARROW** or the **PAGE UP/PAGE DOWN** keys to select a value. Each time you select a different reading voice, the Pitch is reset to the default value for that voice. This option is only available when the selected Emphasis Method is **Change the Pitch**.

There is also a **Test** button (mnemonic T) for testing the voice settings you selected.
Chapter 12. Working with Settings

Scanning Settings

The **Scanning** tab contains the following settings:

- **Mode** list (mnemonic M). Its options include: **Scan and Recognize, Image Scanning Only**, or **Recognize Image Files**.

- **Page Orientation** list (mnemonic O). Select **Automatic Page Orientation**, page placement on the scanner (**Back, Right, Front** or **Left**), and whether or not you want to **Set Once per Document**.

- **Thresholding** list (mnemonic T). Select **Static, Dynamic, Grayscale** or **Color**.

- **Brightness** text box (mnemonic B). Type the desired value, or use the **UP/DOWN ARROW** keys or the **PAGE UP/PAGE DOWN** keys to change the value by ones or by tens, respectively.

- **Delay Between Scans** text box (mnemonic A). Type a value from 0 through 30 inclusive, or use the **UP/DOWN ARROW** keys or the **PAGE UP/PAGE DOWN** keys to change the value by ones or tens, respectively. The system adds two seconds to the value you specify to account for the time it takes the scanner’s light bar to return to its home position.

- **Resolution** list (mnemonic R). Select a scanning resolution of **200, 300, 400**, or **600** dots per inch (dpi). In general, 300 dpi works well. For scanning good quality documents with very small print, try 400 dpi.
• **Scanner Source** list (mnemonic S). Select an image source. The list depends on the kinds of scanners and document cameras attached to your system.

In general, you don’t need to change the contents of this setting. Changing the settings is useful in two situations: If you have more than one image capture device (scanner and/or camera) attached to your system, you can switch between the two. Or if there is a scanning problem, a technical support representative may be able to use the information in this tab page to help diagnose or correct it.

• **Batch Scanning Prefix** text box (mnemonic P). Type the desired prefix characters. It’s possible to use backslashes and colons to specify the name of a folder to store image files or of a source folder containing files to scan. If you specify a folder or subfolder that does not exist, Kurzweil 1000 creates one.

• **Document Feeder** list (mnemonic F). Automatic is the default. In this mode, Kurzweil 1000 uses the document feeder if it contains paper. Choose Enable when there is a feeder and you wish to use it, but Kurzweil 1000 cannot detect paper. Use Disable if there is no feeder.

• **Duplex Scanning** list (mnemonic X). If you have a scanner that supports duplex scanning, you can use this setting, along with your scanner’s document feeder, to scan both sides of the page at the same time. Duplex Scanning is saveable in a settings file.

• **Hold Scanner** list (mnemonic H). Select Default for Kurzweil 1000 to determine whether or not to hold the scanner between scans. This can help accelerate the scanning process. Select Never if subsequent scans fail with other settings. If you determine that holding the scanner works consistently with your scanner, you can select Always to Hold Scanner.
Chapter 12. Working with Settings

• **Brightness Uses Threshold** list (mnemonic U). Some scanners support brightness, others support thresholding. Select Default for Kurzweil 1000 to determine the appropriate settings. Select one of the other options, Enabled and Disabled, if you have a scanner for which Kurzweil 1000 does not have information.

• **Light Source** (mnemonic L). Some cameras do not support a selectable light source.

**More About Scanning Settings**

This subsection provides details on some important scanning settings.

**The Mode Setting**

There are three possible scanning modes:

- **Scan and recognize simultaneously** (default). Once recognition is complete, reading begins automatically.

- **Image Scanning Only.** This saves time during scanning, but you are unable to read the documents until the system performs its recognition process. If you start scanning in this mode, scanned documents are saved in *image files*, which are like snapshots of the scanned documents. The image files are saved in the "Images" folder. The files have a .TIF extension.

- **Recognize Image Files.** In this mode, Kurzweil 1000 does not scan at all. Instead, the system starts recognizing the image files in the "Images" folder, one after another. As each image file is recognized, it is deleted. If you cancel and resume scanning, the system begins recognizing the remaining files.
**Page Orientation Setting**

This setting is defined in terms of the back, front, left, and right of the scanner. The definition of these positions differs from scanner to scanner. *Back* is the end of the scanner that is the home position for the light bar. For some scanners, this is also the end at which the lid is hinged. For other scanners, all positions are reversed and the back lies at the end of the scanner opposite the lid hinges.

**Page Orientation in the Scanning and Recognition Process**

The system rotates a page, if necessary, at different times during scanning and recognition. The exact point at which rotation occurs depends on the system’s scan mode and current page orientation.

If page orientation is **Automatic**, the system performs any necessary rotation during recognition.

If page orientation is **Front, Left, Right, or Back of Scanner**, the system performs any necessary rotation during scanning.

If page orientation is **Front, Left, Right, or Back of Scanner**, and the scan mode is Scan to Image, the system still performs the necessary rotation during scanning. Therefore, if you change the page orientation to one of the other manual settings after scanning the pages but before recognizing them, the orientation change will
have no effect. Automatic orientation, which occurs during recognition, will still work in this case.

**Automatic Page Orientation Per Document**

The Page Orientation setting Set Once per Document performs automatic page orientation for the first page of a document, then uses the result to set the orientation for the remainder of the document.

When you close the current document, or perform an Insert Scan or Rescan on a different document, the system uses automatic page orientation again for a single page. Changing the page orientation to a different setting, then choosing Set Once Per Document again, also resets the feature and causes the system to use automatic page orientation for a single page.

Set Once Per Document is not appropriate for documents with mixed landscape and portrait pages, or if you cannot maintain consistent placement of the document pages. If you choose Set Once Per Document and change the physical page orientation in the middle of scanning, your text will be unrecognizable. However, this setting is useful for consistent material, as it improves recognition speed.

**Brightness and Thresholding Settings**

The *brightness* setting determines if the image captured by the scanner is dark or light. You can specify a brightness setting from 0 to 100 – the best setting depends on your scanner and the type of material you are scanning. Lower values result in darker images and higher values in lighter images. You may have to try several settings before you find one that works best for your material.
For many scanners, you have to use Static thresholding for brightness to take effect. The brightness setting itself is scanner dependent; some scanners do not support it at all.

You can select one of three thresholding options:

**Static**, the system default, creates a *binary* image, where each pixel is either zero for white or one for black, based on a system threshold value.

**Dynamic** allows Kurzweil 1000 to sample the data the scanner sends, region-by-region, then set thresholding for each region, giving you more refined results. This setting is particularly well-suited for multi-colored page. **Note:** because the system uses more data for this process, scanning can slow down somewhat.

**Grayscale** actually doesn’t use a threshold at all. It sends all image data from the scanner directly to the OCR engine. This setting gives you the best recognition the OCR engine can provide. But while it is particularly useful for difficult-to-scan pages, it can slow down scanning and recognition. If you keep grayscale images in KES files, it can increase the size of the files.

**Color** lets you scan color images. Color scanning can be quite slow. Brightness settings will affect recognition, even if you scan in color, though they will not affect the color image itself.

**Notes:** Some complementary color scanning features include: Keep Images, in the General Settings; the Show Image option from the Tools Image Display submenu to display and magnify the page in color; Print Images in the Print dialog to print a color image; and Extract Image from the File Utilities submenu to create a color TIFF file.
**Batch Scanning Prefix**

The Batch Scanning Prefix lets you have more than one batch scan in process at any time. You can initiate one batch scan, interrupt it for another, then resume the first batch scan once the second has completed.

With Batch Scanning Prefix, all image files go into the Images folder. However, the prefix precedes each file name. When you later recognize image files, the prefix in the Batch Scanning Prefix box determines which group of image files is recognized. The default prefix is an empty string.

**To access the Batch Scanning Prefix setting:**

From a Settings tab page, open the **Scanning** tab (ALT+S). Then press P.

**Recognition Settings**

The **Recognition** tab contains the following settings:

- **Identify Columns** list (mnemonic C). Choose **Enabled** or **Disabled**.
- **Two Pages** list (mnemonic T). Select **One Page** or **Two Pages**.
- **Speckle Removal** list (mnemonic K). Choose **Enabled** or **Disabled**.
- **Text Quality** list (mnemonic Q). Select **Normal**, **Degraded**, or **Draft Quality Dot Matrix**.
- **Partial Columns** list (mnemonic P). Select **Kept** or **Ignored**.
- **Suspicious Regions** list (mnemonic S). Select **Kept** or **Ignored**.
• **Blank Pages** list (mnemonic B). Select **Kept** or **Ignored**. If you set Blank Pages to Kept, the system reports each blank page it finds, but the blank page remains in the document. This is useful if it’s important to maintain the page numbers from the original document.

• **Recognition Approach** (mnemonic A). Select **Accuracy** or **Speed** for the engine you are using.

• **Engine** list (mnemonic N) has three options: **FineReader Engine**, **ScanSoft Engine (Fast)** and **ScanSoft Engine (Accurate)**. When you select a recognition engine, the Language list updates to display the languages supported by the selected engine.

• **Language** list (mnemonic L). The available languages depend on the speech recognition engine installed on your system. You can select multiple languages.

• **Table Recognition** (mnemonic R). Select **Enabled** or **Disabled**. When Enabled, tables are recognized so that Kurzweil 1000 can read them correctly. You may want to disable this setting if columns in a file are not being read correctly.

• **Identify Bookmarks** (mnemonic ALT+M). Select **Enabled** or **Disabled**. By default it is enabled. If enabled, bookmarks will be identified as long as Fine Reader is chosen as the recognition engine, and as long as the source is not a PDF file from which bookmarks have already been extracted.

**More About Recognition Settings**

This section explains some important recognition settings. The topics here describe how you can change these settings to suit
different kinds of documents, such as newspapers, white-on-black text, or documents in languages other than English.

**Identify Columns Setting**

Kurzweil 1000 can identify columns in scanned newspaper or magazine articles, allowing the system to read the document correctly. This feature is on by default. It is typically best to leave it on, because Kurzweil 1000 can usually identify either single or multi-column layouts when the feature is enabled. It is sometimes useful to turn it off for reading tables, especially tables of contents, as Kurzweil 1000 might separate the columns.

If you are scanning two single-column pages simultaneously, use two-page mode rather than column identification. The following section describes two-page mode.

**Two Pages Setting**

It's often helpful to scan two pages at once. This is the case, for example, if you are scanning a paperback novel. One way to do this is to recognize each page as a column of text. This approach, however, can cause problems if the material includes tables. To ensure the best recognition for two-page layouts, Kurzweil 1000 provides a two-page scanning mode.

When you scan two-page layouts, Kurzweil 1000 adds each page to the end of the current document. That is, each page in the two-page layout becomes a separate page. This makes it easier to navigate in documents, as each page in the file corresponds to one page in the book, not two.

If you insert a scan while using two-page mode, both pages are inserted before the current page. If you replace a page with two-
page mode enabled, the two new pages replace the current page and the page after it.

**Language Setting**

Kurzweil 1000 recognizes many languages. While it’s possible to indicate that you are scanning text that could be in any of several languages, it’s best to indicate just the languages that are actually used in the document. The fewer languages you identify for recognition, the more accurate and the faster the recognizes is likely to be.

The languages available to you depend on the speech recognition engine you are using.

**To specify the Language setting:**

1. From a **Settings** tab, open the **Recognition** tab (ALT+C). Then press **L** to go to the **Language** check-box list.

   Each language has a check box. If that box is checked, the recognizer presumes that at least some of the text that you are trying to recognize is in that language.

2. Use the **UP/DOWN ARROW** keys to go through the list.

   The system tells you if the language is checked or unchecked.

3. When you hear one that you want, press the **SPACEBAR** key to select it. You can select multiple languages.

   **Note:** If a language is already checked, pressing the **SPACEBAR** unchecks and deselects it.

   To find out what languages are checked, press **CONTROL+Y**.
Chapter 12. Working with Settings

**Speckle Removal Setting**

The speckle removal filter removes isolated dots from a document. It's designed to allow recognition of text overprinted on backgrounds of small, coarse dots, or text printed on speckly paper, like newspaper.

The speckle removal filter may impair recognition of very small text, may reduce the system’s ability to identify actual half-tone pictures, and adds slightly to the recognition time.

**Text Quality Setting**

You can provide information about the quality of the printed text on the pages that you're scanning. This lets the system work harder for poor quality text, or use standard recognition techniques for high quality text. There are three text quality settings:

- **Normal** is for standard, publication-quality documents with clear type.
- **Degraded** is for documents with substandard type quality. In some cases, this setting can severely impair recognition accuracy. Try this setting only if you cannot get satisfactory results by changing the brightness value while using the Normal text quality setting.
- **Draft Quality Dot Matrix** is for documents produced using economy/draft settings on dot matrix printers.
**Partial Columns Setting**

*Partial Columns* has two values, *Kept* and *Ignored*, where Kept is the default value. If this feature is set to *Ignored*, then columns whose left or right edge overlaps the scanner glass, and whose width is less than two inches, are not be recognized. This setting is not recommended if you are scanning a normal page with narrow columns, as a column might be too close to the edge and consequently lost. This feature is very useful, however, if you are scanning something that has a wider width than the scanner.

**Suspicious Regions Setting**

*Suspicious Regions* has two values, *Kept* and *Ignored*, where Ignored is the default value. The default behavior causes Kurzweil 1000 to analyze the quality of each word on the page, and identify clusters of poorly recognized text that lie outside of rectangular regions of well recognized text. If the text clusters are near the edge of the page, Kurzweil 1000 removes them.

You might want to select *Kept* if you are scanning documents that contain information near the page margins that consists of one or more sparsely placed characters. An example of this might be a full page outline.

**Note:** The Suspicious Regions option is particularly useful with the FineReader OCR engine.

**Engine Setting**

The *Engine* setting has three options: *FineReader Engine*, *ScanSoft Engine (Fast)* and *ScanSoft Engine (Accurate)*. When you choose an engine, the Language list view updates to display the languages supported by the selected engine.
Reading Settings

The **Reading** tab contains the following settings:

- **Reading Unit** list (U). Select **Line**, **Sentence**, or **Paragraph**.
- **Echo** list (mnemonic E). Select **Characters**, **Words**, or **Both**, or **Disabled**. This setting applies to document editing and typing in dialogs. If you type quickly, you will not hear all of your typing echoed.
- **Header Avoidance** list (mnemonic A). Choose **Disabled**, **Carefully** or **Thoroughly**. If you enable the feature, by choosing either Carefully or Thoroughly, Kurzweil 1000 ignores page headers and footers to either a lesser (Carefully) or greater (Thoroughly) degree, during continuous reading. For more information Go to the *More About Reading Settings* further along in this chapter.
- **Punctuation Level** list (mnemonic P). Select **Some**, **All**, or **None** of the punctuation spoken aloud during reading.
- **Numbers** Pronunciation list (mnemonic N). Lets you determine how Kurzweil 1000 pronounces numeric values. Select **Full Numbers** or **Single Digits**.
- **Language Identification** list (mnemonic L). Lets you opt to have Kurzweil 1000 evaluate a document to see if it contains a different, supported language **Per Page** or **Per Paragraph**. You can also choose **Disabled**.
- **Duration** text box (mnemonic D) Lets you establish a timer for continuous reading. If the value is non-zero, continuous reading stops at the next paragraph end after the specified time. Type a value in minutes, or use the **UP/DOWN ARROW** keys or **PAGE UP/PAGE DOWN** keys to change the value.
• **Table Reading** list (mnemonic T). Select **Enabled** or **Disabled**. If a page contains text which has been marked by recognition, or, in the case of a word processing document, by the author, as a table, then Kurzweil 1000 can read it if this feature is enabled.

• **Line Endings** list (mnemonic I). Allows you to set the treatment of the original line endings in a document. Choose **Ignored** to ignore line endings, causing text within paragraphs to flow freely from line to line, or **Respected**, where each line is treated as though it were a single line paragraph.

• **Emphasized Text** list (mnemonic M). Choose **Enabled** to have Kurzweil 1000 distinguish between bolded, italicized and underlined words from words in regular font. Choose **Disabled** to direct Kurzweil 1000 to read through text using the normal Reading Voice.

• **Browse Method** list (mnemonic B). Specify how you want to browse or preview a document: by **First Sentence**, **Last Sentence**, or **Both First and Last Sentences**.

• **Pause for Paragraphs** list (mnemonic S). This allows you to control whether or not Kurzweil 1000 should introduce a pause at the end of all paragraphs that do not also end sentences. Enabling this setting improves the reading of documents that contain, for example, single line headings which do not end with a period. Disable it if the document does not properly differentiate between lines and paragraphs.
More About Reading Settings

This section explains some important reading settings in more detail. Reading settings enable you to adjust many aspects of reading, such as voice and pitch, speed and volume, the units by which you want Kurzweil 1000 to read. From the Reading Settings, you can also disable the system default Emphasized Text feature.

Reading Unit Setting

The reading unit determines increments of words by which you can move within a document. Possible reading units are **Line**, **Sentence**, and **Paragraph**.

You can use the **F6** key on the keyboard to move backward by unit, or **F8** to move forward by unit.

Kurzweil 1000 remembers the original layout of a page, although lines may wrap differently on screen. When you choose Line as the reading unit, Kurzweil 1000 uses the lines in the original document.

Header Avoidance Setting

By default, the Header Avoidance setting (mnemonic **A**) is **Disabled**, causing Kurzweil 1000 to ignore page headers and footers during continuous reading.

There are two other options for this setting: **Carefully** and **Thoroughly**. If set to Carefully, Kurzweil 1000 recognizes headers and footers that contain up to three lines of text. It checks for matching text up to two pages before or two pages after the current page to determine if text is a header/footer. The system takes into account that page numbers differ, and ignores minor differences caused by misrecognition.

If set to **Thoroughly**, Kurzweil 1000 recognizes any text within the
header and footer areas of a document as potential headers and footers.

If you are scanning two pages at a time, be sure to use Two Page mode. The Header Avoidance feature will not work properly if the pages in the open document contain multiple scanned pages.

Note: This feature skips page headers and footers, but does not actually remove them from the file. If you would rather remove them, use the Remove Page Headers and Footers menu item from the File Utilities menu.

Even if you enable Header Avoidance, Kurzweil 1000 does not skip headers and footers when it begins reading at the top of a page after you use the Go To Page command.

**Punctuation Level Setting**

There are three punctuation levels:

- **Some** sends all punctuation marks to the speech synthesizer, which treats them using its own settings.
- **None** sends only those punctuation marks that are important to sentence structure (comma, period, semicolon, colon, question mark, exclamation mark, upside down question mark, and upside down exclamation mark). All other punctuation marks are removed.

At the **All** level, those punctuation marks that are important to sentence structure are expanded so that their names are sent to the speech engine, followed by the actual punctuation mark. For all other punctuation marks, just the names are sent.
Numbers Pronunciation Setting

There are two numbers pronunciation options:

- **Full Numbers** pronounces numbers using their full names; that is, 14 is pronounced “fourteen.”
- **Single Digits** pronounces numbers digit-by-digit, so 14 is pronounced “one-four.”

Language Identification Setting

The Language Identification feature determines how often Kurzweil 1000 checks to see if a different language has been scanned.

Language Identification settings are **Per Page** and **Per Paragraph**. The Per Paragraph setting may not always provide perfect results. Because there is less text on which to base a decision, the system is more likely to decide on the wrong language.

Language identification is not available if the system does not support speech for multiple languages.

Duration Setting

Kurzweil 1000 can be used to record audio tapes. A common problem, though, has to do with the limited capacity of the tape. You can use the **Duration** feature to indicate how long you would like Kurzweil 1000 to read continuously. This is specified in minutes. Kurzweil 1000 will try to stop at a paragraph boundary, so the actual amount of time that it will speak is approximate. When it stops, the cursor will be positioned at the beginning of the first unread word. You can change tapes, start recording, and press the read button to continue the recording.
Table Identification Setting

Documents sometimes contain tables, and Kurzweil 1000 is able to read them as a table, allowing navigation by cell, and automatically reading the appropriate headings for the cell. If the table formatting was not identified correctly, this can occasionally be problematic. You can, as a consequence, disable this feature here. Note that if you modify a page that contained a table when this feature is disabled, and you later save the document, when you read it later it will no longer have a table, even if this setting has been re-enabled.

Line Endings Setting

The Line Endings feature determines what the Kurzweil 1000 editor does with the original line endings in a scanned document. They may be Respected or Ignored.

If Line Endings are ignored, then paragraphs are used to determine how text is positioned in an editing window. The number of lines in a paragraph becomes a function of the width of the editor window, the size of the font, and the length of the words. When a word won’t fit because it is too close to the right margin, it becomes the first word on the next line.

This approach is normal for word processors, because it is very convenient when you are composing or editing.

If you change the setting so that line endings are Respected, the original line endings from the scanned document are used to establish the end of each line in the document. It no longer matters if the words don’t actually fit in the window, as the text will scroll horizontally in the window. From the perspective of the editor, each line is now also a single line paragraph. Each real end of paragraph mark is doubled, so that there is a blank line after the end of each paragraph. However, commands that would normally work on a
paragraph, such as paragraph editing, or forward/rewind by unit when the unit is set to a paragraph, will now behave as though each line was a paragraph.

You can change this setting whenever you wish and all open files will alter their behavior based on the setting.

Why would you want to do this? Because sometimes you might want to pay careful attention to the original line endings. You might find this appropriate when you scan and read Poetry, computer code, or forms.

The effect of this command varies depending upon the type of file you are reading. Word processor documents such as Word, Word Perfect, and RTF, don't contain end of line information. Each paragraph will end up stretched on a very long line, wrapping only when it hits the maximum width of the editor itself.

Text documents, on the other hand, usually have either end of line information or end of paragraph information, but not both. Use of this feature for most text documents will give you pretty much what you would get if you were to open the text document in a text editor, such as Notepad or Wordpad.

Scanned documents (KES files), typically contain both line endings and paragraph endings, both from the original scanned document.
**Emphasized Text Setting**

Emphasized Text is a default Reading setting. Kurzweil 1000 uses an emphasis method to read italicized, bolded, or underlined text, and to announce your position within tables, allowing you to focus on important words. The emphasis method may be either the use of a different voice or a change in pitch of the current reading voice.

Select **Disabled** to disable Emphasized Text, and **Enabled** to use the feature.

For more information on specifying an emphasis method, refer to the **Voices Settings** section detailed earlier in this chapter.

**General Settings**

The **General** tab contains the following settings:

- **Page Numbers** list (mnemonic B). Select **Operator Defined** or **System Defined**.

- **Automatic Corrections** list (mnemonic C). Choose **Enabled** or **Disabled**.

- **Fix Hyphens** list (mnemonic Y). Choose **Enabled** or **Disabled**. When enabled, this feature removes end of line hyphens whenever Kurzweil 1000 applies corrections, either automatically or manually.

- **Keep Images** list (mnemonic I). Select **Enabled**, **Poorly Recognized**, or **Disabled**. When enabled, Kurzweil 1000 retains and associates images with recognized text while recognition is in progress. As long as you are using the .KES file format, Kurzweil 1000 saves the images. Selecting **Poorly Recognized** allows you to save images of poorly recognized pages for recognition later.
• **Keep Layout Information** list (mnemonic **O**). Enable this feature to retain the position and size of each word and each region while recognition is in progress. As long as you are using the .KES file format, Kurzweil 1000 saves the images. Note: You cannot disable this feature if you have enabled **Keep Images**.

• **Confidence Threshold** text box (mnemonic **T**). Enter a value from 0 to 100, including decimal values. This number tells Kurzweil 1000 what is an acceptable recognition threshold. Any value less than the threshold indicates that a page is poorly recognized and is reported in the **Poorly Recognized Pages** dialog, available from the **Tools** menu.

### More About General Settings

This section provides details on some important settings in the General tab.

**Page Numbers**

Page Numbers allows the system to report user-defined page numbers in a document. If you choose **Operator Defined**, Kurzweil 1000 uses the page numbers you have set for a particular document. Operator-defined page numbering is helpful if you are scanning specific chapters and want to keep the Kurzweil 1000 page numbers and the printed page numbers the same. If you choose **System Defined**, Kurzweil 1000 uses its own page numbers, even if you have defined your own.

**Maximum Line Length**

This setting determines a maximum line length, in characters, for text output only.
When **Maximum Line Length** is zero, Kurzweil 1000 keeps the original line endings from the scanned document. When the value is non-zero, Kurzweil 1000 ignores the original line endings, and adds line endings based on the system’s maximum length.

If you want each line to contain a single paragraph, use a very large number.

**Automatic Corrections**

If enabled, this feature automatically applies the current corrections list to each page you scan. After recognizing a page, Kurzweil 1000 applies the substitutions you’ve specified. When it reads the page, you’ll hear the corrected text.

**Fix Hyphens**

When words are split between two lines in the same paragraph, a hyphen is typically used to indicate that this has been done. This hyphen is somewhat ambiguous, as a hyphen could also be used to indicate a compound word which just happens to have been broken into multiple words. The Kurzweil 1000 always attempts to remove end of line hyphens when the next line is part of the same paragraph, when each word is, by itself, not in a dictionary, and when the combined word, once the hyphen is removed, is in the dictionary. If you enable this feature, end of line hyphens will be removed and words will be reconnected more aggressively. This activity will occur when corrections are applied.

**Keep Images**

Recognition consists of a conversion of page images into formatted text. By enabling this feature, you can keep a copy of the image in the KES file, associated with the page it was used to recognize.
Chapter 12. Working with Settings

Kurzweil 1000 first rotates the image, if necessary, to match the text orientation, and then deskews it.

When this is done, a number of additional features become available to you. You can, for example, Rerecognize the page at some later point. This can be very useful. For example, suppose that you scan a page containing a table, and you later find, when you read the page, that the table has been separated into columns, making it difficult to understand. You can disable column identification, and then rerecognize the page. Not having to find the original page to rescan it can be quite convenient.

You can also use the Show Image feature from the Tools Image Display submenu, which will bring up an image of the current page on the screen. This image can be magnified, you can move around in it, and you can have text read and highlighted while the image is displayed. This is obviously useful if you have some vision. It can also be useful if you have access to sighted assistance on occasion. If you are having a difficult time getting a good scan, someone is more likely to have an accurate diagnosis of the problem if they look at the scanned image than if they look at the original page. Even if you don’t have easy access to sighted assistance, you can use the Extract Image item in the File Utilities menu to create a TIFF file, which you can then forward to someone else (including those of us at Kurzweil Educational Systems) for assistance.

In addition, this feature has the option of keeping Poorly Recognized images. This is a handy option if your main use for images is to rerecognize pages later.

Naturally, keeping images increases the size of the KES file. You can later remove an image from a page, or remove all images from a file by using the File Utilities submenu.
Keep Layout Information

Kurzweil 1000 can keep the location and size of each word, and of each text and image region in a KES file. This information can only be kept in a KES file - when you save a file in any other format, layout information is lost.

If you keep this information, a number of additional features become available. You can use the Explore Layout item in the Tools menu to get detailed information about each region of the page, and even to reorder the text regions. You can move from one text region to another with SHIFT+F6 and SHIFT+F8. You can also find out about the precise location of any word by pressing CONTROL+ F1. Note also that layout information is needed if you wish to use the Show Image feature from the Tools Image Display submenu, so layout information is always kept if you are keeping images.

Layout information adds to the size of a KES file. If you find that you are not using it, you can reduce the size of that file by removing layout information. Use the Remove Layout Information from File item in the File Utilities menu to do this.
Display Settings

For partially sighted users, Kurzweil 1000 provides a number of display settings. You can customize these settings to make on-screen reading and editing easier.

The Display tab contains the following settings:

- **Tracking** list (mnemonic T). Select **Disabled, Word** or **Line**. Tracking highlights each word or line that Kurzweil 1000 is currently reading. If you are scanning and reading documents at the same time, the system may recognize scanned documents faster if you disable tracking. If you use a refreshable Braille display but also use active speech, tracking by **Line** can be useful.

- **Color** Area contains the following list boxes:
  - **Text** (mnemonic X) controls the document’s text color.
  - **Highlight** (mnemonic H) controls the highlight color used for tracking.
  - **Background** (mnemonic B) controls the window background color.
  - **Block Highlight** (mnemonic K) controls the highlight color used for background highlighting of the current word during reading.

If you set the text and background lists to the same color, the text you type will not be visible on the screen. Note, however, that some words will be visible during reading if you choose a different Highlight color and enable Tracking.

- **Single Font** list (mnemonic S). Choose **Enabled** or **Disabled**. Enable this feature so you can choose a single display font for both scanned text and text you type. Scanned documents use
fonts suggested by the document itself. Do not enable this feature if you intend to edit font.

- **Font** Area (available only if Single Font is enabled) contains the following list boxes:
  - **Name** (mnemonic N) lets you select a font family from those installed on your system.
  - **Size** (mnemonic Z) lets you choose a font size.
  - **Bold** (mnemonic L) and **Italic** (mnemonic I) let you enable or disable these styles.

If the Single Font setting is disabled and you are using the TAB key to move through the items in the dialog, you will skip this section altogether.

- **Magnification** list (mnemonic M) (available only if Single Font is disabled). When you magnify text, Kurzweil 1000 automatically changes the length of each line so that all the words remain visible on screen. Type the desired value, or use the **UP/DOWN ARROWS** to change the value.

- **Word Spacing** list (mnemonic W). Type a value from 0 to 10 inclusive, or use the **UP/DOWN ARROWS** to select a value for the amount of spacing you want displayed between words. Just above this list is a read-only text box containing the words, "Alpha, Beta, Gamma." As you change the word spacing value, use this text box to see how the amount of spacing you selected affects the text, and to test for the spacing you want.
Chapter 12. Working with Settings

Scanner Margins Settings

The Set Margins feature lets you specify margins for scanned documents. When you set margins, the area of the glass outside the margin boundaries during scanning is ignored. The scanner sees only that part of the page that is inside the margins you've specified.

You can set Back, Front, Left, and Right margins. The definition of back, front, left, and right differs from scanner to scanner. Back is the end of the scanner which is the light bar’s home position. For some scanners, this is also the end of the scanner at which the lid is hinged. For other scanners, however, the back position, and all other positions, are reversed. In this case, the top of the page lies at the end of the scanner opposite the lid hinges.

If you want the system to determine margin sizes, use the Auto Size option. Auto Size attempts to determine appropriate margins, and applies them to each page you scan.

The Scanner Margins tab contains the following scanner margin settings:

- **State** setting list (mnemonic S). Select Enabled, Disabled, or Auto Size margin recognition.

- **Back, Front, Left, and Right Margins** settings are text boxes (mnemonics B, F, L, and R, respectively). Type the desired margin value.
Auto Size Margins: How Do They Work?

When you first enable Auto Size margins, the scanner scans the entire platen for the next two scans. Kurzweil 1000 determines where the text region is for each page, and selects margins that encompass this region. Once the system figures out the margins, it always stops scanning one inch after the bottom of the text region, which speeds up scanning. The text region can become larger, but never smaller, with subsequent scans.

You can use this feature to find out where text is on a page. Simply enable Auto Size, perform two scans, then return to the Margins tab, and check the margin sizes that the system has found.

When using Auto Size, it is important that the first two pages you scan contain a representative amount of text.

If you’ve used Auto Size for a number of pages and you want to recalculate the text region for a different page size, open the Margins tab and disable this feature. Press ENTER to close the dialog box, then open the Margins tab again. Re-enable Auto Size. The system will again scan the entire platen twice to determine a text region. Auto Size also resets if you close the active document.

**Note:** The unit of measure the system uses for this feature is determined by the Units setting in the Configuration tab page. Go to the section on *Configuration Settings* in this chapter.
Configuration Settings

Configuration settings are settings that apply globally and that you don’t change frequently. The Configuration settings tab contains the following:

- **File Dialog** list (mnemonic F). You can choose Microsoft Windows Common file dialog instead of the default Kurzweil 1000 dialog for file-related functions such as File Open and File Save As.

- **Online Cache** list (mnemonic C). You can request Kurzweil 1000 to download the latest list of available material from featured Web sites, **Always Refresh**, or on a 7 Days or 30 Days basis.

- **Units** (mnemonic U) list. You can select **Inches** or **Centimeters**.

- **Shortcuts** list (mnemonic S). Allows you to choose between two groups of shortcuts. Select Kurzweil 1000, or **Emphasize Format Editing**. This setting affects shortcuts for Spell, Insert Bookmark, Go to Bookmark, Left align paragraph, Right align paragraph, and Bold.

- **Keypad Commands** list (mnemonic K). Choose **Enabled** or **Disabled**, or select the **ScreenReader** Keypad. If you disable Keypad Commands, Kurzweil 1000 no longer accepts keypad input.

- **Numeric Keypad Layout** list (mnemonic N). Select **Telephone** or **Calculator**. From the **Settings** keypad layer, press the third key in row 1.

- **Hot Key for Scanning** text box (mnemonic H). Allows you to choose a key combination that initiates Kurzweil 1000 scanning, no matter what application you are in at the time.
• **AutoLoad** list (mnemonic L). You can enable or disable this feature.

• **Active Speech** list (mnemonic A).
  
  Choose among **Enabled** (the default), **Disabled**, **Reading Only** and **Messages Only**.
  
  When **Enabled**, Kurzweil 1000 reads all document text and system messages aloud. When **Disabled** Kurzweil 1000 does not read either document or message text aloud.
  
  Select **Reading Only** to disable the Message Voice, so that you only hear document text read aloud. Select **Messages Only** to disable the Reading Voice, so that you only hear system messages read aloud.

• **Hot Key to Start K1000** text box (mnemonic Y). Type the desired hot key combination beginning with either the CONTROL or the ALT key. The default is CONTROL+ALT+K.

• **Start K1000 Automatically** list (mnemonic T). Select **Enabled** or **Disabled**. Enabling this feature can be handy if Kurzweil 1000 is your primary application and if no one else uses your computer.

• **Linking Documents and Settings**, (mnemonic I). You can link scanning and certain other settings to documents. There are four options: Enabled, Disabled, Scanning Settings Only and Most Settings.
  
  With this setting enabled, Kurzweil 1000 creates a settings file whenever you close an existing document or whenever you change settings. Disabled is the default.
  
  The **Scanning Settings Only** option loads scanning, recognition and scanner margin settings whenever you open a document.
Chapter 12. Working with Settings

The **Most Settings** option loads the settings associated with the Scanning Settings Only option, in addition to Voice, Reading, General and Verbosity settings whenever you open a document or whenever you switch from one active file to another.

- **Grayscale Image** (mnemonic G). This setting allows you to keep images in .KES format as is or with image compression. Choose **Keep As Is** or **Threshold**. In Keep As Is mode, the file size can be large. In Threshold mode, Kurzweil 1000 dynamically compresses the image, making it smaller, however, the quality of the compressed image diminishes. The compressed image can be re-recognized.

### More About Configuration Settings

This section provides details on some important Configuration settings.

**File Dialog Settings**

Those of you who are well-versed in standard operations in Microsoft Windows may want to use familiar file dialogs within the Kurzweil 1000 environment.

The **File Dialog** option lets you select Windows **Common** File dialog instead of default **Kurzweil 1000** dialog for file-related functions such as File Open and File Save As.

**Note:** By choosing the **Common** setting, you won’t be able to change the sort order of file lists, spell file names with **CONTROL+L**, or listen to the list of names with **CONTROL+Y**.

In addition, when you save files in another format, you will have access only to the conversions that are in your preferred list and that have known extensions.
In the Common File mode, commands that require folder names, such as Delete Folder and Change Folder, as well as Move and Copy File, use the Traditional Kurzweil 1000 File dialog.

**Online Cache Setting**

Kurzweil 1000 provides direct access to certain online material, such as electronic books, that are of interest to the Kurzweil 1000 user community. This functionality features links to the Internet Web sites from which you can search and retrieve the material.

The **Online Cache** is a background function that tracks downloadable items available from the currently available Web sites. When that list of items is large enough, Kurzweil 1000 downloads it, and caches or saves and stores it on your computer. The next time you run an online search from the Kurzweil 1000 program, it looks in this online cache, saving you search and retrieval time.

You can request Kurzweil 1000 to perform the cache function **Always**, or when the list is older than **7 Days** or **30 Days**. The default is 7 days.

**Units Setting**

This setting determines which unit of measure, **Inches** or **Centimeters**, applies throughout the Kurzweil 1000 program. The default is Inches. Select whichever one you are most comfortable using.

Whenever the system needs to use a unit of measure, for instance in determining the margins for the Auto Size option, it uses the selection you specified here.
Chapter 12. Working with Settings

Shortcut Keys for Settings

Some of the shortcut keys traditionally used by Kurzweil 1000 for spelling and bookmarks conflict with shortcut keys commonly used by word processors for format editing. This setting lets you choose which approach to use for shortcuts. When you select Traditional shortcuts, you can use the following keys and functions.

**CONTROL+SHIFT+B** turns the bold setting for text on and off.

**CONTROL+F12** aligns a paragraph to the left.

**CONTROL+SHIFT+R** aligns a paragraph to the right.

**CONTROL+B** inserts a bookmark.

**CONTROL+L** spells the current word.

**CONTROL+SHIFT+L** spells mnemonically.

**CONTROL+R** takes you to a bookmark.

When format editing is emphasized, you can use the following keys and functions:

**CONTROL+B** turns the bold setting for text on and off.

**CONTROL+L** aligns a paragraph to the left.

**CONTROL+R** aligns a paragraph to the right.

**CONTROL+SHIFT+B** inserts a bookmark.

**CONTROL+F12** spells a word.

**CONTROL+SHIFT+F12** spells mnemonically.

**CONTROL+SHIFT+R** takes you to a bookmark.
Hot Key for Scanning

The Hot Key for Scanning setting allows you to choose a key combination that initiates Kurzweil 1000 scanning, no matter what application you are in at the time.

The default hot key combination is CONTROL+ALT S. Use these keys if you have not defined your own hot key combination setting.

It is best to avoid common shortcut key combinations when you define a hot key for scanning. For example, if you use the combination, CONTROL+S, you are unable to use this combination to save files in any other program while Kurzweil 1000 is running.

AutoLoad Setting

When AutoLoad (Automatic Document Loading) is enabled, Kurzweil 1000 does not check if files need to be saved when you exit the application. Your original copies of the file are not updated (saved), but only a temporary system copy. The original files are updated only when you perform a save.

If you enable AutoLoad, you should save your settings in the default settings file so they can take effect on startup. (Go to the section Saving Your Settings for details.) In this case, the feature automatically opens all files that were open when you previously exited Kurzweil 1000. The system begins reading with the last file you opened.

AutoLoad is useful if you are using the product to scan or read a long book over a number of sessions. It is also useful for novice users who are new to file management.

You should disable this setting in multi-user environments that are not protected by separate Windows passwords, as it gives any user easy and automatic access to everyone else’s documents.
Active Speech Setting

Normally Active Speech is enabled so Kurzweil 1000 can read text and speak messages. If you disable Active Speech, Kurzweil 1000 uses quiet mode, disabling the speech engine so a screen reader can take over.

If Active Speech is enabled, minimizing the Kurzweil 1000 window can cause the application to stop speaking. Speech is re-enabled when you maximize the window. This, together with the scanner hot key feature, allows you to work in another application with a screen reader while scanning and recognizing in Kurzweil 1000.

Verbosity Settings

The Verbosity feature allows you to tailor Kurzweil 1000 messages to your preferences. You can choose from over two dozen Kurzweil 1000 events for which you want prompting, extra auditory assistance, a reminder, or messaging turned off completely. In addition, you can use your own sound files or edit the messages to further customize the responses.

The Verbosity settings tab contains the following settings:

- **Event** list (mnemonic E). Select the event for which you want to change the message or chime. In the next subsection, Verbosity Events, you’ll find more information about the events.

- **Signal** list (mnemonic G). This list controls the response to and can vary depending on the selected event. Typically, you can choose between speaking a Message, hearing a Chime, or Disabling responses to the event.

- **Message** area (ALT+M) consists of two parts: a text box and a command. If the event you selected has a message, it displays in the text box. You can edit or change the message. The
**Restore Default** command (mnemonic ALT+R), available if you selected Message as the Signal, restores the original system message.

**Note:** When listening to messages in the Verbosity dialog, you may hear Kurzweil 1000 say "percent." This is a place holder for a value that the system plugs in. For example, for the Event called Mnemonic, the message text you hear is "The mnemonic is ALT+%%." When you are working with Kurzweil 1000 and you hear this message in context, the %% is substituted with an alphabetical letter. So the message you hear would be: "The mnemonic is ALT+T."

- **Sound** area (mnemonic S) consists of three parts: a text box, and two commands. If the signal for the event you selected is a chime, the **Sound** text box displays the full path and file name of the Wave file being used. You can type the path and file name of another existing Wave file or use **Browse** (mnemonic B) to open a **Find** dialog from which you can locate and select the desired file. **Test** (mnemonic T) lets you hear the newly selected sound.

**Verbosity Events**

This subsection lists all of the Verbosity Events in the order in which they appear. Remember that you can edit messages and select any Wave file on your system for the Chime where applicable.

The Signal options for the following events are: Disabled, Message and Chime.

**Starting Kurzweil 1000.** Message is the default signal.

**Exiting from Kurzweil 1000.** Disabled is the default signal.
Switching Focus to Kurzweil 1000. This event occurs when you switch focus from another application back to Kurzweil 1000. Message is the default signal.

Leaving the Menu Bar. This event occurs when you exit from the menu bar without also bringing up a dialog. The default signal for this event is Disabled.

Closing a Dialog Box. The default signal is Disabled.

Moving to a Dialog Control. When you reach a control in a dialog box, Kurzweil 1000 can tell you what type of control it is, for example, if it is a text box, a list box, or a command. Select Message Before Specific Text or Message After Specific Text to hear the control type before or after the contents of that control. The default signal is Disabled.

Reaching a Blank Line. This event occurs when the cursor moves to a blank line in the editor. The default signal is Message.

Reading Past the Start of a Paragraph. This event occurs when the cursor moves past the beginning of a new paragraph during continuous reading. The default message is "New Paragraph" and the default chime is the same as that for a blank line. To enable this event, select either the Message or Chime option.

Top of a List. This event occurs when Kurzweil 1000 reaches the first item in a list view or a non-circular list, and is particularly helpful when using the Find dialog or the Bookmarks dialog. The default signal is Message. This event also applies to lists in Kurzweil 1000 applications.

Bottom of a List. This event occurs when Kurzweil 1000 reaches the last item in a list view or a non-circular list, and is particularly helpful when using the Find dialog or the Bookmarks dialog. The default signal is Message. This event also applies to lists in Kurzweil 1000 applications.
Position of an Item in a List. Enabling this event causes Kurzweil 1000 to announce the numerical position of the currently selected selected item in the list followed by the total number of items in the list that are at that level. For example, the message “6 of 19” would indicate that your cursor is located in the sixth item in a list of 19 items. This Event is Disabled by default. This event also applies to lists in Kurzweil 1000 applications.

Position of an Item in a Treeview. Enabling this event causes Kurzweil 1000 to announce the Level number of the Treeview item in which your cursor is located, followed by that item’s numerical position in the level, followed by the total number of items in the level. The level number you hear is in descending order, that is, the top level container in the treeview would be Level 1. Folders contained in a Level 1 folder would then be considered Level 2 items; folders within Level 2 would be Level 3 items, et cetera. So for example, suppose your cursor is in the Folder treeview in the File Open dialog and your cursor is on the Favorites folder, and that folder is under “C:\Documents and Settings\Annie,” the message you’d hear would be “Level 4. Item 3 of 5.” This indicates that the “Favorites” folder is the third item of five and that it is a subfolder three folders deep. In other words, it’s a folder within the folder named, “Annie,” which in turn is a folder in “Documents and Settings,” which in turn is a folder within the “C” drive. This Event is Disabled by default.

Selecting an Item Containing other Items. This event occurs when Kurzweil 1000 reaches an item such as a folder, which contains other folders or files. It is particularly helpful when using the File dialog or the Bookmarks dialog. The double per cent signs in the sample message are replaced by either the word "bookmark" or "folder" depending on which dialog you’re using. The default signal is Message.
Scanner Progress. Progress messages occur at the following points in the process: One Quarter, Half, and Three Quarters. The default signal is Message.

Scan Complete. The default signal is Message.

Camera Image Capture. This indicates completion of an image capture from a camera. The default wave file plays a camera click.

Recognition in Progress. Progress messages occur at the following points in the process: One Quarter, Half, and Three Quarters. The default signal is Message.

Recognition Complete. The default signal is Message.

Page Orientation. This event causes Kurzweil 1000 to announce whether the top of the page is at the Back, Front, Left, or Right or the scanner. The default signal is Message.

Confidence Level Information. This event causes Kurzweil 1000 to announce the Confidence Level value for the most recently recognized page when the value falls below the Confidence Threshold value specified in the General Settings tab. The default signal is Message.

Mnemonics. This event occurs when you reach a menu item or a dialog control that has a mnemonic. The default signal is Disabled.

Shortcut Keys. This event occurs when you reach a menu item that has a shortcut key. The default signal is Message.

Menu Items Which Open Dialogs. The default signal is Message.

Menu Items with Submenus. The default signal is Message.

Turning Pages While Reading. While reading continuously, you can have Kurzweil 1000 prompt you when it is moving to the next page. The default signal is Disabled.
Going to a Page. Kurzweil 1000 tells you the new page number when you go to a page using any of the page navigation methods. The default signal is Message.

For the following Verbosity Events, the available Signals are Chime, which is the default, and Disabled.

Reading Past a Chiming Bookmark.

Reading Past a Note.

Reading Past a Link.

Reading Past a Link to an Article.

Reading Past a Link to a Web Site.

Reading Past a Form Field.

Completion of a Long Recognition Task.

Completion of Audio File Creation.

Conversion Settings

This dialog contains settings for how you want files in particular formats to open and/or to be saved. There are two main controls: Action, mnemonic A and Format, mnemonic F. In the Action list, select Opening Documents or Saving Documents. In the Format list, the selections for Opening Documents are Text, RTF, Other, and for Saving Documents, the list consists of Text, Braille and Other.

Subsequent controls depend on the selections you make for the Action and Format. The following controls and their associated mnemonics are organized by the different Action/Format combinations:
Chapter 12. Working with Settings

**When Opening Text Documents**, the settings are:

Split Long Page, mnemonic P. Select Enabled or Disabled. Enabled is the default which inserts page breaks.

Paragraph Analysis, A. Select Enabled or Disabled. Enabled is the default which evaluates whether each end of line mark should be treated as a space or as an end of paragraph. When disabled, each end of line mark is treated as an end of paragraph.

**When Opening RTF Documents**, there is only one setting: Split Long Page, mnemonic P. Select Enabled or Disabled. Enabled is the default which inserts page breaks.

**When Opening PDF Documents**, the settings are: Emphasis, mnemonic E. You can choose to emphasis the recognition of images or the extraction of text. When images are recognized, the recognition engine is likely to trust its recognition results more than trusting any text embedded in the document. This can be better when the PDF file has not been thoroughly tagged. When extraction of text is emphasized, the embedded text, if any, is trusted more than the recognition results.

**Extract Bookmarks**, the settings are Enabled or Disabled, mnemonic X. Enabled is the default, which extracts bookmarks from PDF files automatically.

**When Opening Documents with the Other option**, there is only one setting: Use Microsoft Office for Conversions, mnemonic M. Select Enabled or Disabled. The default is Enabled, which uses Microsoft Office, if it is on your system, to convert certain types of documents to RTF, which Kurzweil 1000 then converts to .KES format. In the Disabled state, when the file has not been thoroughly tagged. When extraction of text is emphasized, the embedded text, if any, is trusted more than the recognition results.

Extract Bookmarks, the settings are Enabled or Disabled, mnemonic X. Enabled is the default, which extracts bookmarks from PDF files automatically.

**When Opening Documents with the Other option**, there is only one setting: Use Microsoft Office for Conversions, mnemonic M. Select Enabled or Disabled. The default is Enabled, which uses Microsoft Office, if it is on your system, to convert certain types of documents to RTF, which Kurzweil 1000 then converts to .KES format. In the Disabled state, in the disabled state, Kurzweil 1000 looks for other available converters to perform the conversion. In some circumstances, it may not be able to properly convert and open the file.
**When Saving Text Documents**, the settings available are:

Add a Blank Line after each paragraph, mnemonic B. The default is Disabled, which adds blank lines only if they are present in the original document. To add blank lines, select Enabled.

Indent the first Line of each paragraph, mnemonic I. The default is Disabled, which adds indents only if they are present in the original document. To add indents, select Enabled.

Spaces used for a First Line Indent, mnemonic S. If you opted to add indents in the previous setting, type a value from 0 to 10 for the number of spaces you want for the indents. Zero is the default, and it adds a tab space.

Line Endings, mnemonic L. Select Preserve, Remove, or Wrap to Fit. The default, Preserve, retains the length of the text line that is in the original page scanned in Kurzweil 1000. Remove directs Kurzweil 1000 to make each text line equal to a paragraph. Wrap to Fit allows you to ensure that no text line will exceed a certain number of characters, by inserting line endings between words within paragraphs as necessary.

Maximum Width of each Text Line, mnemonic M. If you opted to have Line Endings Wrap to Fit, in the previous setting, type a value from 30 to 250. The default is 80.

**When Saving Braille Documents**, the settings available are:

Type of Braille, mnemonic T. Select Grade 1 or Grade 2.

Language, L. Choose Default or a language from the list. Left on Default, Kurzweil 1000 uses the language supported by the currently selected Reading Voice to associate with the Braille document.

**When Saving Documents with the Other option**, there is only one setting: Use Microsoft Office for Conversions, mnemonic M.
Select Enabled or Disabled. The default is Enabled, which uses Microsoft Office to convert certain types of documents. In the disabled state, Kurzweil 1000 looks for other available converters to perform the conversion. In some circumstances, it may not be able to properly convert and open the file.

**Default Settings**

The settings you choose remain in effect only until you shut down the system, unless you save them as described in the next section.

The following is a list of Settings and their default values.

**Default Voices Settings**

- **Role** is set to **Reading Voice**.
- **Language** is set to **English**.
- **Speech Speed** is set to **170** for the Reading Voice. For the System Voice, the speed value depends on the engines installed.
- **Volume** is set to **100** which is the loudest setting.

**Default Scanning Settings**

- **Mode** is **Scan and Recognize**.
- **Page Orientation** is **Automatic**.
- **Thresholding** is **Dynamic**.
- **Brightness** is **50** for most scanners.
- **Delay Between Scans** is **5 seconds**.
- **Resolution** is set to **300 dpi**.
Scanner Source depends on scanners connected to your system.
The Batch Scanning Prefix box is empty.
Document Feeder is set to Automatic.
Duplex Scanning is Disabled.
Hold Scanner is set to the scanner’s Default setting.
Brightness Uses Threshold is set to the scanner’s Default setting.

Default Recognition Settings
Identify Columns is Enabled.
Two Pages is set to One Page.
Speckle Removal is Disabled.
Text Quality is set to Normal.
Partial Columns is set to Kept.
Suspicious Regions is set to Ignored.
Blank Pages is set to Ignored.
Engine is FineReader Engine.
Language is set to English.
Table Recognition is Enabled.

Default Reading Settings
Reading Unit is Sentence.
Echo is set to Characters.
Header Avoidance is Disabled.
Punctuation Level is set to Some.
Numbers is set to Full Numbers.
Language Identification is Per Page.
Duration is set to 0 minutes.
Table Reading is Disabled.
Line Endings is Ignored.
Emphasized Text is set to Enabled.
Browse Method is set to First Sentence.
Pause for Paragraphs is Disabled.

Default General Settings
Page Numbers is set to Operator Defined.
Automatic Corrections is Enabled.
Fix Hyphens is Enabled.
Keep Images is Disabled.
Keep Layout Information is Enabled.
Confidence Threshold is set to 95.
Read Newly Recognized Pages is Disabled.

Default Display Settings
Tracking is Disabled.
Color for Text is White, Highlight is Yellow, Background is Black, Block Highlight is Blue.
Single Font is Disabled.
Font is Arial, 14 Point, with Bold and Italic Disabled.
Magnification is set to 1.
Word Spacing is set to 0.
Default Margins Settings

Margin State is Disabled.
Back, Front, Left and Right Margins are set to 0 inches.

Default Configuration Settings

File Dialog is set to use Kurzweil 1000 traditional file dialog.
Online Cache is set to 7 Days.
Units is in Inches.
Shortcuts is set to Kurzweil 1000.
Keypad Commands is set to Kurzweil 1000.
Numeric Keypad is set to Calculator.
Hot Key for Scanning is set to CONTROL ALT S.
AutoLoad is Disabled.
Active Speech is Enabled.
Hot Key to Start K1000 is set to CONTROL ALT K.
Start K1000 Automatically is Disabled.
Link Documents and Settings is Disabled.
Grayscale Image is set to Threshold.

Default Verbosity Settings

Event selection is on Starting Kurzweil 1000.
Signal is set to Message.
Message depends on the event, and is user-modifiable.
Sound setting depends on the event, and is user-modifiable.
Linking Documents and Settings

You can link scanning and certain other settings to documents. With this setting enabled, Kurzweil 1000 creates a settings file whenever you close an existing document or whenever you change settings.

To enable Link Documents and Settings:

Open the Configurations Settings dialog (ALT+T+F).

In the dialog, go to Link Documents and Settings by pressing ALT+I. The options are as follows:

- Disabled, which is the default.
- Scanning Settings Only, which loads scanning, recognition and scanner margin settings whenever you open a document.
- Most Settings, which loads the settings associated with the Scanning Settings Only option, in addition to Voice, Reading, General and Verbosity settings whenever you open a document or whenever you switch from one active file to another.

Saving and Working with Settings Files

Kurzweil 1000 lets you create files that contain your preferred settings. You can reload a settings file at any time to make sure the system uses the settings you like best. Each settings file contains values for the settings listed in this chapter in the section entitled, Default Settings. Note, though, that each file actually contains more settings than just those. Property dialog boxes associated with features such as File Send To, File Print, and MP3 File Creation also contain settings which are saved in settings files.

If you are using the menu system, you can create more than one settings file. This is helpful if you want to create different settings
files for different kinds of documents. If more than one person uses the system, you can create a separate settings file for each person. When you decide you no longer need a certain settings file, you can delete it.

If you are using the keypad, you can only save to a single, default settings file. You cannot create multiple, named settings files.

**Saving Your Settings Using Menus**

To save your current settings in a file:

1. Open the **Settings** menu and choose **Save Settings** (mnemonics ALT+T+V).
   
   A dialog opens, and your cursor is positioned in a box containing the name of the last settings file saved, or the default if nothing has been saved.

2. Use the **UP/DOWN ARROW** keys to choose the desired settings file. Or you can type the name of the file, without the full path name, as all settings files are saved to the same directory.

3. Press **ENTER**.

To cancel from this dialog, press **ESCAPE**.

When you first start Kurzweil 1000, it will look for a settings file named default. If it does not find this file, it will construct a default settings file. You can save your own settings to the default file, causing Kurzweil 1000 to use your settings automatically at startup.

Kurzweil 1000 does not save the Scan Mode when you overwrite the Default file.
Saving Partial Settings

There may be certain settings, say, a particular speech engine, that you like and want available throughout Kurzweil 1000. It's possible to save this setting so that it is available regardless of other settings files you have loaded or might load in the future.

Save Partial Settings is accessible from the Settings menu. It has a dialog that contains a Settings Category list box and a Settings Files list view. First select the category, then select one or more settings files for which you want to apply the partial settings.

**Note:** If you have linked settings files, they will be included in the Settings Files list.

**To save partial settings:**

1. From the Settings menu, choose Save Partial Settings (mnemonic P) to open the dialog.
   
   Your cursor is in the Settings Category list. The selected settings category is the one you last modified, or if this is the first time you are accessing this dialog, the selection is Miscellaneous.

2. Use the UP/DOWN ARROW keys to select a category:
   
   Voices, Scanning, Recognition, Reading, General, Display, Margins, Configuration, Launch Items, Miscellaneous or Conversion.

3. Use the TAB key to go to the Settings Files list and select one or more files.
   
   To hear the current selection in the list: press CONTROL+Y.
   
   To select all items in the list: press CONTROL+A.
   
   To move through the list without altering your selection, press CONTROL+UP/DOWN ARROW keys.
4. Press ENTER.

**Deleting Settings Files**

To delete a settings file:

1. Open the Settings menu and choose **Delete Settings** (mnemonics **ALT+T+T**).
   
   A dialog opens and your cursor is in a list of settings files.

2. Use the **UP/DOWN ARROW** keys on the keyboard to scroll through the file names. You can delete either one file at a time or multiple files.

You can also delete the default settings file in this way. If you delete the default settings file, Kurzweil 1000 creates a new settings file when you start the application again. This settings file contains the settings listed in this chapter in the section entitled, **Default Settings**. Creating a new settings file is helpful if you unintentionally saved settings that you don’t want.

**Loading Settings Files**

You can load a Kurzweil 1000 settings file at any time during a session.

To load settings from a named file using menus:

1. Open the Settings menu and choose **Load Settings** (mnemonics **ALT+T+L**).
   
   A dialog opens and your cursor is in a list of the settings files you have created.

2. Use the **UP/DOWN ARROW** keys on the keyboard to move through the file names.
Chapter 12. Working with Settings

3. When you hear the name of the settings file you want to load, press ENTER.

**Backing Up and Restoring Settings**

If you’ve used Kurzweil 1000 over time, there may be many settings files you’ve customized and prefer to work with. In addition, you’ve probably customized your correction, word dictionary and pronunciation files, your favorite files and favorite folders lists, and your KESI Virtual Printer extensions list.

When you upgrade your computer system, what happens to these files? Kurzweil 1000 lets you make a backup of, and preserve, all your settings files, then later restore them to your new computer.

The **Backup Settings** and **Restore Settings** commands are accessible from the **Settings** menu. Both features use the **File** dialog. Select or type in the name of the folder from or to which you want to backup or restore settings.

**Note:** When backing up settings, the folder you specify need not exist, because it’s the one to which you are writing the files. When restoring settings, however, the folder must exist, as the system expects to find the files you are restoring in there.

**To backup or restore a settings file:**

1. From the **Settings** menu, choose **Backup Settings** (mnemonic B) or **Restore Settings** to open the **File** dialog.
   
   Your cursor is in the **File Name** text box.

2. Type the name of the folder to which you want to backup the files, or from which you want to restore the files.
   
   Alternatively, press the **TAB** key until your cursor is in the Folder tree view box. Use the **ARROW** keys to select the desired folder.
3. Press **ENTER** or **TAB** to the **OK** command button.

**Settings Status**

Settings status includes the following information:

- The name of the reading voice.
- The name of the system voice.
- The page orientation.
- The keypad layout (telephone or calculator).
- The progress message setting (enabled or disabled).
- The threshold setting (enabled or disabled).
- The scanner brightness.
- The current scan mode.
- The scanning margins.
- The automatic corrections setting (enabled or disabled).
- The partial columns setting (kept or ignored).
- The punctuation level setting (some, none, or all).
- The number pronunciation setting (full numbers or single digits).
- The recognition language.
- The automatic document loading setting (enabled or disabled).
- The software version and technical support number.
- The selected Dictionary.
- The selected Thesaurus.
Chapter 12. Working with Settings

**Getting Settings Status**

To display and hear status information related to Kurzweil 1000 settings, open the Help menu and choose Settings Status (mnemonics ALT+H+S). To stop the status information, press ESCAPE on the keyboard.
13 Files and Folders

This chapter contains the following topics:

Working with File Formats.
File Management Tasks.
File and Folder Names.
Types of File Formats.
Accessing File and Folder Commands.
The File Dialog.
Basic File Management.
Advanced File Management.
Shortcut Keys for File Management.
Working with More Than One Document.
Changing the Default Folder.
Working with File Utilities.
Restoring a File.
Working with Zip Files.
Writing Files to a CD.
Working with Files and Folders

In Kurzweil 1000, you can choose how you want to work with files on your system. In making that determination there are a few questions to consider:

Do you want to learn how to save, close, and open files manually, or do you want all files that are open when you exit the system to reload automatically upon restarting?

Are you the only one using the system, or are there other users? Will you be creating documents that you do not want other users to freely access?

If you want documents to load automatically upon starting the system, you can enable the **AutoLoad** feature. This is often a good choice for new users, as it simplifies file management. In this case, you will not need to save files upon exiting. This also means, however, that your documents are freely accessible to anyone who starts Kurzweil 1000 on your system, unless your system has multiple user accounts and passwords.

If you do not use AutoLoad, you must save, close, and open files manually. If you try to exit when files are open, the system asks if you want to save any files that have unsaved changes. Your files will not load automatically when you start Kurzweil 1000 in this case; you must open each file individually. For more on the AutoLoad feature, go to Chapter 12, *Working with Settings*. 
File Management Tasks

If you’ve decided not to use AutoLoad, you’ll probably be using the following functions most often:

**File Save.** When you save a file, you are keeping the document for later use. You typically save a document after you’ve scanned or typed it. As you work in a document, you periodically save it to keep any changes you’ve made, including bookmarks or formatting you’ve added.

**File Open.** You can open any file that you’ve previously created or saved. This includes files that you’ve typed or scanned using Kurzweil 1000, as well as documents created in other applications. Once you’ve opened a file, you can read it, add to it by scanning more pages, or edit it by typing.

**Notes:**

When opening a non-encrypted PDF file, Kurzweil 1000 collects the file’s bookmarks, allowing you to go to the bookmarked page. If the bookmark description matches text on the page, Kurzweil 1000 opens to the first instance.

When opening a multipage image file, Kurzweil 1000 allows you to recognize a subset of the file.

When opening a file that has bookmarks, you can go directly to a bookmarked location.

**File Close.** When you are done working with a file, you can close it to keep it from cluttering your workspace. If you’ve made changes that you haven’t saved, Kurzweil 1000 warns you before you close the file. Closing a file without saving causes you to lose all of your changes.

**File Print.** You can print a file to either a standard printer or a Braille embosser.
Changing folders. You can move around within folders on your system. Kurzweil 1000 provides the following folders:

- Articles.
- Books.
- General.
- Letters.
- Magazines.
- Manuals.
- Online.
- Recipes.
- Temporary.

These folders are normally located in the folder named, "Kurzweil Educational Systems" under your "My Documents" folder.

You do not need to use these folders. You can choose to store documents in any folder you like, and you can create new folders as you work.

As you get practice with file management, you’ll also be performing these tasks:

- Deleting files and folders.
- Copying and moving files and folders.
- Creating new folders.
- Creating and managing lists of favorite files and folders.

Kurzweil 1000 lets you maintain lists of favorite files and folders. When you perform file management tasks, you can limit your selection range to just your favorites list, instead of going through all the files and folders on your system.
File and Folder Names

File names can include letters, numbers, and spaces. They cannot include the following characters:

- Forward or backward slash.
- Question mark.
- Asterisk.
- Colon.
- Quotation mark or apostrophe.
- Less than or greater than sign.
- Straight line (SHIFT+BACKSLASH).

You cannot use the colon and backslash characters as part of a folder name. However, you can use the colon as part of the drive specification, and the backslash to separate the names of folders in a hierarchy.

Types of File Formats

If you are unsure how to choose a file format, consider how you’ll be using the documents you create. You can usually pick the best format based on the kinds of applications you use to open and edit documents. The guidelines here describe three formats, although many other formats are available for opening and saving files.

**KES Format**

If Kurzweil 1000 is your primary document handling application, save files in the default Kurzweil 1000 KES format. Kurzweil 1000 always converts documents to this format before opening them. Using KES lets you open files as quickly as possible. Additionally,
KES is the only format that preserves bookmarks, images, and layout information. A KES file has a name followed by a period and the letters KES, such as Report.kes.

**RTF Format**

If you often use a word processor or desktop publishing package to edit or format documents, you may want to save them in the format specific to that application. You can save files in a variety of word processing formats. If you distribute documents to people who use different word processors, a good choice is **RTF** (Rich Text Format). RTF files have embedded information about fonts, styles, and end of paragraph markers. Most kinds of word processors can create or open RTF files. An RTF file has a name followed by a period and the letters RTF, such as Present.rtf.

**Text Format**

If you want to open your documents in other applications but are not sure what format to use, the best choice may be plain **ASCII** text. An ASCII text file contains just unformatted characters. This is a good choice if, for example, you want to run the file through a text-to-Braille conversion program, or paste the text of the document into an e-mail message. You can also open ASCII files in most word processors, although such files do not have any formatting information. An ASCII file has a name followed by a period and the letters TXT, such as Mineral.txt.
Chapter 13. Files and Folders

**HTML Format**

Hypertext Markup Language (HTML) is the file format used for World Wide Web pages. There are couple of situations in which you may want to save your file in this format:

If you intend on using the file for Web access.

Or as a study tool or a dynamic table of contents if you have embedded multi-level bookmarks in the document. In this case, when you save the file in HTML format, Kurzweil 1000 extracts the bookmark descriptions and converts them into live links. By selecting the link, you can go directly to the text which has been bookmarked.

For more information about multi-level bookmarks, go to Chapter 5, *Document Navigation Tools and Methods*.

An HTML file has a name followed by a period and the letters HTM, such as Story.htm.

**DAISY Format**

DAISY is the leading international standard format that libraries for the disabled use. It supports digital text, recorded speech, indexing and bookmarking. DAISY file names are followed by a period and the letters OPF.

When you download DAISY files to Kurzweil 1000, the program preserves page bookmarks for your navigation convenience. You can have Kurzweil 1000 read downloaded DAISY files, but you cannot edit or overwrite them.

You can also save any type of file as a text-only DAISY (version 3.0) file. Kurzweil 1000 preserves text along with Bookmarks, Links, Notes and tables.
Note: You can also save documents as DAISY audio files using the Create Audio File utility. To use this utility, choose Utilities from the File menu, and then choose Create Audio File (ALT+F+U+T). For more information, go to Chapter 14, File Portability.

**ePub Format**

Electronic Publication (ePub) is a free and open e-book standard by the International Digital Publishing Forum. Files have the extension .epub. Epub documents can be optimized for different display devices; eBooks that use this format can be read on a wide variety of eReaders, from dedicated hardware to desktop software to online based readers.

**Other Available Formats**

In addition to the formats described in the previous section, Kurzweil 1000 supports the following formats:

- Braille, Grade 2.
- MS Word for Windows.

To hear additional file formats, select Other in the File dialog’s Format box.
Accessing File and Folder Commands

You can access file and folder commands using the menu bar, shortcut keys.

You can also access file and folder commands from the keypad. For more information, you can either download the document, *Using the Keypad to Access Kurzweil 1000*, from the Kurzweil Educational Systems website—www.kurzweiledu.com—or refer to Appendix E, *Using the Keypad to Access Kurzweil 1000*, in the Online Manual.

The File and FolderMenus

You can perform file management tasks using the File and Folder menus. File is the first menu in the menu bar. The Folder menu appears to the right of the File menu when no document is open, or to the right of the Edit menu when a document is open for reading. All items in the File and Folder menus have mnemonics, and some items in the File menu have keyboard shortcuts.

To access the File menu, press ALT+F. To access the Folder menu, use ALT+L.
The File Dialog

Kurzweil 1000 provides two user interfaces for the File dialog:

Traditional Kurzweil1000.

Microsoft Common File Dialog. To use this interface, you must select the Common File dialog option in the Configuration Settings. For details, go to Chapter 12, Working with Settings.

Refer to Microsoft documentation for information about the Common File Dialog.

Notes:

When using the Common File Dialog interface, you won’t be able to: change the sort order of file lists, spell file names using CONTROL+L, nor listen to the list of names you selected using CONTROL+Y.

When you save files in another format, you’ll have access only to the conversions that are in your preferred list and that have known extensions.

Commands that require folder names, such as Delete Folder and Change Folder, as well as Move and Copy File, use the Traditional Kurzweil 1000 File dialogs.

The Kurzweil 1000 File Dialog

Most file management tasks use the same File dialog. This dialog has the following components:

A tree view of folders on your system (mnemonic ALT+I).

A list view of files in the current folder (ALT+L).

A text box to enter file names or paths (ALT+N). You can use question marks and asterisks as wildcards in this box. You can
also use CONTROL+E for immediate expansion of files and folders in this text box.

A format list (ALT+T), containing various types of files. This list is available only when you are saving a file.

A Sort By list (ALT+S).

OK (ALT+O) and Cancel (ALT+C) commands.

The position of your cursor when you first open the File dialog depends on the task you are performing.

If the response for the task is the name of an existing file, your cursor will be in the list view of files.

If the response is a name for a new file, your cursor will be in the text box.

If the response is a folder name, your cursor will be in the tree view of folders.

The number of files you can select at one time also depends on what you are doing. For example, you can select multiple files at once for deletion.

Notes:

• It’s possible to copy listview or treewview contents to the clipboard by using Control+C.

• Enabling the Verbosity event called Position of an Item in a List allows you to identify an item within a file list more easily. This event is located on the Event list box in the Verbosity Settings tab (ALT+T+Y).

• By default Kurzweil 1000 does not announce your position within treeviews. If desired, you can enable this event, called Position of an Item in a Treeview, in the Event list box of Verbosity Settings tab (ALT+T+Y).
**File Dialog Tasks**

You'll access the file dialog for all of the following tasks:

**File Open.** In this case, you are in the file list (the second control) when you first access the dialog. When opening a file, you can use this dialog to select as many files as you wish.

Pressing the Right Arrow key on a file name tells you if the file has bookmarks. If it does, you can use Bookmark navigation to open the file directly to a bookmarked page.

**File Delete.** In this case, you are in the file list (the second control) when you first access the dialog. You can specify as many files for deletion as you wish.

**File Save (and Save As).** In this case, you are in the text box (the third control) when you first access the dialog.

**Folder Change.** In this case, you are in the folder tree (the first control) when you first access the dialog. You can specify the single folder to which you are changing.

**Folder Delete.** In this case, you are in the folder tree (the first control) when you first access the dialog. You can specify as many folders for deletion as you wish.

**File Copy, Move, and Merge** utilities. In this case, your cursor is in the folder tree and you can specify source and destination files or folders.

**Using the File Dialog**

Most of the components in the File dialog are found elsewhere in the Kurzweil 1000 interface. For example, the file list works in the same way as any other list, except that it is not circular. That is, after
selecting the last item in the file list, the DOWN ARROW does not bring you back to the first item.

The Sort list and folder tree, however, require further explanation.

**The Sort By Command**

The **Sort By** command sorts the order of the files in the **Files** list. Available options are:

- **Name** (Ascending)
- **Name** (Descending)
- **Modification Date** (Ascending)
- **Modification Date** (Descending)
- **Extension** (Ascending)
- **Extension** (Descending)
- **Size** (Ascending)
- **Size** (Descending)

Pressing **CONTROL+S** from within the **File** list causes the **Sort** list to cycle through its options.

Changing the sort order causes any selections in the file list, as well as your cursor position in the list, to be lost. Sort order is a saved setting.

**Navigating the Folder Tree**

The Folder Tree works differently than other kinds of lists because it presents folders in a level-based "tree view," where subfolders are "indented branches."

When you first enter the folder tree, the current folder is selected.

**To go to the first subfolder of the current folder:**
Use the **RIGHT ARROW** key. The **ENTER** key may also work, but only if a folder name cannot be a valid response for the task that you are doing.

**To go to the folder containing the current folder:**

Use the **LEFT ARROW** or **BACKSPACE** key.

**To go to the previous or next folder at the current level:**

Use the **UP/DOWN ARROW** keys which move your cursor to the previous or next folder that shares the same containing folder, in other words, that is the same level as that of the current folder. If you are at the top of a given level, you’ll hear, “top of list.” In this case, use the **LEFT ARROW** to move up to the container level.

**To go to the first or last item at the same level:**

Use the **HOME** or **END** key.

**To go to the first or last item in the tree view:**

Use **CONTROL+HOME** or **CONTROL+END**.

**To navigate by typing a letter:**

Type a letter to move to the first folder whose name begins with that letter. Tap the letter to move through all the folders on the current device whose name begins with that letter.

---

**Making Selections in the File Dialog**

**To select a folder:**

Navigate to the desired folder, then press the **ENTER** key.

**To select one or more files within a folder:**

1. Navigate to the desired folder, then press the **TAB** key.
   
   Your cursor is in a list view that contains all the files in the currently selected folder.
2. Use the **UP/DOWN ARROW, PAGE UP/PAGE DOWN, HOME**, and **END** keys to move in the list, or type the first letter of a name to move to the file.

**To select multiple contiguous files:**

Press the **SHIFT** key and a movement key to add to the current selection.

**To select multiple folders or files in any order:**

Hold down the **CONTROL** key as you move through the list. When you hear an item to add to the selection, press the **SPACEBAR**.

**To specify folders or files using the text box:**

You can type a file or folder name into the text box. You can use wildcard characters, where an asterisk matches zero or more characters, and a question mark matches exactly one character.

Press **CONTROL+E** to expand the contents of the box. You can enter multiple file or folder names by separating them with semicolons.

**Shortcut Keys for the File Dialog**

**CONTROL+C** to copy the selected folder or file.

**CONTROL+X** to cut the selected folder or file.

**CONTROL+V** to paste the selected folder or file you just copied or cut.

**CONTROL+A** to select all of the files in the file list.

If you would like to look at the properties of a file or a group of files, select them, then type a Question mark, or press **ALT+ENTER**.

The folder tree view and the file list view each contains a context menu. To bring up the context menu, press your keyboard’s Menu key, or press **SHIFT+F10**. You can create new folders, cut, copy,
paste, delete, rename, and get file properties using the context menu.

Basic File Management

Opening a File

With Kurzweil 1000, you can open the following kinds of files without using a conversion process:

Text-based formats: KES, OPF (Daisy 3), RTF, BRL, BRF, BFM, TXT, DSY, HTM, HTML, XML.

Image or compound formats using OCR: TIFF, JPG, PCX, DCX, PNG, PDF, GIF, DJVU.

Audio formats: MP3, WMA, WAV, ncc.html (Daisy 2).

In addition, if you have Microsoft Word, Kurzweil 1000 can use Word’s conversion functionality to convert various other file formats into RTF, and then directly open them.

General steps for opening a file:

1. Open the File dialog using one of the following methods:
   - Choose Open from the File menu (mnemonics ALT+F+O).
   - Or press the shortcut keys CONTROL+O for File Open.
   - The File dialog appears with your cursor in a list of all the files that are in the current folder.

2. Select a file using one or a combination of the following methods:
   - Press the UP/DOWN ARROW keys to move through the list. When you hear the name of the file you want to open, press
**ENTER.** You can also use the **SHIFT+UP/DOWN ARROW** keys to select multiple files for opening.

If you want a file in another folder, press **SHIFT+TAB** or **ALT+I** to move to the folder tree view. Select the desired folder, then press **TAB** to go to the file list in the selected folder.

If you prefer, you can press **ALT+N** to go directly to the File Name text box and type the file name.

**Notes:**

To have the system try to complete a path for you, type the partial path name followed by **CONTROL+E**. For example, if you type `C:\My`, the system would probably complete the name as `C:\My Documents\`. The cursor is positioned after the last backslash in the path.

Kurzweil 1000 opens PDF files automatically. If the PDF file is not encrypted, Kurzweil 1000 collects its bookmarks, allowing you to go to a bookmarked page or position.

**Opening Non-Supported File Formats**

If you try to open a file with a format other than those it understands based on their extensions, Kurzweil 1000 attempts to determine the format. If it is unable to do so, a dialog box appears with your cursor in a list of possible format converters.

Use the **UP/DOWN ARROW** keys to move among the format converters. When you hear the name of the desired converter, press **ENTER**. To close the dialog box without choosing a format converter, press **ESCAPE**.

The format converter list is available only if you are using the menu method.
Opening Large Files

Very large files in formats other than KESI may take a long time to open. While waiting for a file to open, you can press any keyboard key to hear how many pages have been converted to KESI. You can stop the conversion and read only the already converted pages by pressing the **ESCAPE** key.

Opening Grade 2 Braille Files

Kurzweil 1000 can perform reverse braille translation on Grade 2 Braille files. The conversion is performed automatically when you open a file with any of these extensions: BRL, BRF, and BFM.

**Note:** If the **Active Speech** setting in the **Configuration** tab page is set to either **Disabled** or **Messages Only**, as it might be if you are using a Braille screen reader, Kurzweil 1000 prompts you as to whether or not you want to perform the conversion.

Opening Multiple Image Files

Kurzweil 1000 can open multiple image files, that is, files with extensions of PCX, DCX, or TIFF. If you select a number of these files to open, Kurzweil 1000 recognizes each one as a separate page in a single document. This is true only if all of the selected files are image files. If at least one is not an image file, then the program opens each of the files as a separate document.

Opening a Range of Pages

This feature may be handy for recognizing a subset of an image file, such as a chapter.

When opening a multipage image file, typically PDF or TIFF, a Range dialog opens. You can opt either to open all pages or specify a range of pages to open.
To open all pages, press Enter in the Range dialog. All Pages is the default.

To specify a range of pages, in the Range dialog, select Pages, then change the From Page Number and/or the To Page Number, and press Enter.

If you choose to not start with the first page of the file, the page number you use will be automatically set as a user page number for the first page in the resulting KES file.

It's possible to suspend recognition and later resume it. For more information, go to “Interrupting and Saving Recognition” on page 126.

Opening a File Using the KESI Virtual Printer™

There are file formats that the Kurzweil 1000 is unable to convert. If, however, you have an application on your system that understands a file format that the Kurzweil 1000 does not understand, and if that application can print, then Kurzweil 1000 may be able to open it using the "KESI Virtual Printer."

Although accessible from the Print menu, the KESI Virtual Printer is a print driver which, instead of printing a file, creates an image file.

There are two ways in which you can use this print driver.

To open a file automatically:

Simply open any file, for example, a PDF file. Kurzweil 1000 attempts to launch the application that, according to your system’s registry, can print that file. Usually that application is Adobe Acrobat.

Once the application is open, it automatically prints the entire file, using the KESI Virtual Printer. When printing is complete, Kurzweil
1000 automatically begins recognizing the image file. When done, it deletes the image file.

**To open the file using the KESI Virtual Printer and a screen reader:**

There is a second way to use the KESI Virtual Printer.

1. Using a screen reader, run the application that understands the file that you want to read in Kurzweil 1000.

2. Using the **Print Setup**, **Print Properties**, or **Print** dialog, select the **KESI Virtual Printer** option as the printer. Then print.

Kurzweil 1000 automatically opens, if it isn’t already, creates the image file, recognizes it, then deletes it.

**Notes About the KESI Virtual Printer**

Kurzweil 1000 uses a file called CvtToTiff.dat, which is in the same folder as your settings files, to help determine what files the Virtual Printer can open. By default, this file contains a list of image format extensions, and PDF. Lines beginning with semicolons are comments.

You can add more image format extensions to the CvtToTiff.dat file. However, you must have an application on your system that controls the printing of files with the extension you add.

**Opening Recently Opened Files**

Kurzweil 1000 keeps track of up to 10 of the files you have opened in a session. Their file names appear in the **Recently Opened** submenu from the **File** menu (**ALT+F+Y**), and their mnemonics are 1 through 9, 1 being the most recently opened file. The number one is also designated for the tenth item.

**Note:** Kurzweil 1000 updates the list every time you open or save a file. If a file no longer exists or is still open, its name will not appear on the list.
Chapter 13. Files and Folders

Finding and Opening a File

There may be times when you are unable to remember where you placed or how you named a file. There may be other times when you want to locate all files in your system that pertain to a particular topic.

For these situations, there is the Find and Open feature on the File menu. This opens the Find and Open dialog.

In general, you specify words you want to search, specify the folder in which you want to conduct the search, and specify other criteria, such as searching through the contents or file names. You then press ENTER to run the search. When complete, the resulting files appear in the Results list along with checkboxes for you to select the files you want to open. Press ENTER to close the dialog and open the checked files.

The contents of the Find and Open dialog are:

- The Words to Search for combo box. Type any keywords or a partial file name. Do not enter common words, such as “and,” or “the.” The box also contains a list of up to ten keywords from previous searches. Use the UP and DOWN ARROWS to retrieve a word or phrase from the list.

- The text box, Look Under. Here, type the path name of the folder in which you want to search. If you are not sure where the folder is located, type a question mark. A folder tree appears in which you can navigate and select the desired folder. If you are unsure of the exact folder names, you can use an asterisk or press CONTROL+E. Kurzweil 1000 attempts to complete the name for you.

- The list box, Look at. Select Contents to search for the keywords in the contents of files. Select File Name to find the keywords in the file names.
• The **Case Sensitivity** list box. Select **Enabled** to have Kurzweil 1000 find only those files that contain the words that match the exact case you specified for the search. For instance, if you request a search for the verb march with no capital letters, and you enable Case Sensitivity, Kurzweil 1000 will return files that contain that word, but not ones that contain the month March with a capital M.

• The **Match Requirements** list box. Select **All** to search for files that match all the words you specified. Select **One or More** to match one or more of the words.

• The **Results** checkbox list. After the search, the resulting files are listed here with checkboxes. Select the checkboxes of the desired files.

You can cancel a search and exit from this dialog any time by pressing **ESCAPE**. If a search has begun, the first press of the ALT key cancels the search. To exit the **Find and Open** dialog, press **ESCAPE** again.

**Note:** The Find and Open feature does not search in ZIP files or folders.

**Opening a File at a Bookmark Location**

When you use the File Open (Control+O) command, you can directly open the file to a bookmarked page.

**To go to a Bookmark from File Open:**

1. Press Control+O to access the File Open dialog.
2. Navigate to the desired directory in the Folder list.
3. Tab to the File list and find the file you want to open.
4. Press the Right Arrow key to determine if the file contains bookmarks or not.
If the file has bookmarks, a second window with the Bookmark List opens.

5. In the Bookmarks List, you can use the Up/Down arrow keys to move through the bookmark descriptions.

6. When you hear the one you want, press Enter to open the file to the selected bookmark.

To return to the File List from the Bookmark List without selecting a bookmark, press the Left arrow key.

Unlike the Go to Bookmarks dialog, Search and Sort Bookmark features are not available in the Bookmark List.

Pressing the Escape key while in the Bookmark List closes both the Bookmark List and the File Open dialogs.

**Notes About Opening Files**

- If you have Microsoft Word for Windows installed on your computer, Kurzweil 1000 uses Word’s file converters to open unsupported file types. If Word does not have a converter for the file type you are trying to open, the internal converters are used.

- If you are opening a multi-page document, you can stop the recognition process by pressing ESCAPE. You can later resume recognition by pressing F9. When you suspend recognition, you cannot use the Rerecognize, Insert or Rescan functions until you have either closed the document or resumed recognition.

- Kurzweil 1000 opens Adobe PDF files automatically. If you are using the FineReader 7 engine, you will have to provide a password.

- You can only open password-protected PDF files if the FineReader OCR engine is selected in the Recognition Settings tab page.
• When opening a non-encrypted PDF file, Kurzweil 1000 collects the file’s bookmarks, allowing you to use them to go to a bookmarked page. If the bookmark description matches text on the page, Kurzweil 1000 will take you to the first instance of that text.

Closing a File

1. Do one of the following:
   Open the File menu and choose Close (mnemonics ALT+F+C).
   Or press the F4 key.
   If you haven’t changed the file, it closes immediately. If there are changes, Kurzweil 1000 asks if you want to save them.

2. Press ENTER to save the changes and close the file. Press TAB to go to No, then press ENTER to close the file without saving. To Cancel the close request and return to the document, press ESCAPE.

Saving a New Document as a File

To perform a simple file save:

1. While in the open document, do one of the following:
   Open the File menu and choose Save (mnemonics ALT+F+S).
   Or use the shortcut CONTROL+S.
   The File dialog appears with your cursor in a text box that lets you enter a file name. Kurzweil 1000 suggests a default name based on a phrase at the beginning of the document. At the end of the file name is the default file format .KES.

2. You can either type a new name or leave the default, then press ENTER.
Chapter 13. Files and Folders

To save the file in a folder other than the current folder:

1. Open the File menu and choose Save As (mnemonics ALT+F+A).
2. In the File dialog, do one of the following:
   Type the entire path name in the File Name text box.
   Or press SHIFT+TAB to go to the Folder tree and navigate to the desired folder.
3. Press ENTER when you are done.

To specify a particular file format for the document:

1. Open the File menu and choose Save As (mnemonics ALT+F+A).
2. In the File dialog, go to the Current Format list (ALT+T).
3. Use the UP/DOWN ARROW keys to hear the available file formats, and stop when you reach the desired one to select. Or you can jump to a particular format by typing the first character of its name.

   The File dialog contains the most commonly used formats (such as Braille Grade 2, DAISY, HTML, KES, MS Word, RTF, and Text) and the option, Other.

   Selecting Other and pressing ENTER opens a separate dialog with a list of formats. Select the desired format. Press ENTER or CONTROL+O to apply your selection and return to the File dialog.
4. Press ENTER when you are done with the File dialog.
Saving an Existing File with its Name and Format

After saving a file for the first time, you can save changes to the file without using the File dialog.

To save an existing document with its current name and format:

Open the File menu and choose **Save** (ALT+F+S). Or use the shortcut, **CONTROL+S**, for **Save**.

Saving an Existing File with Another Name or Format

After saving a file for the first time, you can access the File dialog box again to save the file with a new name or format. The older file version with its original name and format remains on the system.

If you save an existing document to its original name and file type, the file is saved to its original folder. This is not necessarily the current folder. If you change the name or file type, check the Folder tree list to be sure that the appropriate folder is selected.

You can save files in the following formats:

- Braille, Grade 2.
- DAISY (3.0).
- ePub.
- HTML.
- HTML.
- HTML 3.
- KES.
- MS Word 2007.
- MS Word for Windows 14.
- RTF.
Text.

Other. Select this option to hear and choose other file formats. In the Select a Format list use the UP/DOWN ARROW key.

To save an existing file with a new name or format:

1. With the cursor in the desired document, open the File menu and choose Save As (mnemonics ALT+F+A).
   The File dialog opens. Your cursor is in the File Name text box, containing the current name and format for the document.

2. Type a new name and/or different extension. You can also go to the Current Format list (ALT+T) to select a different extension.

3. Press ENTER.

Saving Partial Documents

You can save selected text or a range of pages in a document.

To save selected text as a new document:

1. With the desired document open, select the text you want to save.

2. Open the File menu and choose Save Partially (ALT+F+T).
   The Save Partially dialog opens and indicates that you want to save the selection.

3. Press ENTER to confirm the selection.
   The File dialog opens with your cursor in the File Name text box.

4. Type a new name and/or different extension. You can also go to the Current Format list (ALT+T) to select a different extension.

5. Press ENTER.
To save a range of pages as a new document:

1. With the cursor in the desired document, open the File menu and choose Save Partially (ALT+F+T).

   The Save Partially dialog opens with the cursor in the From page range box. The From and To boxes display the first page number of your document and the last page, respectively. By default, Kurzweil 1000 saves all of the pages.

   Note: If you have user-defined page numbering, such as preliminary pages, in your document, Kurzweil 1000 uses the user page number for the first page of the new document.

2. Type the page number From which you want to begin the partial save.

3. TAB to the To box and type the ending page number.

4. Press ENTER to confirm the selection.

   The File dialog opens with your cursor in the File Name text box. The default file format for the new document is the Kurzweil 1000 .KES file format.

5. Type a new name. To hear the current file format and/or to select a different file format, press ALT+T.

6. Press ENTER.

Notes About File Formats and Extensions

If you select a format from the Other format list, that format is automatically added to the File dialog that appears when you use the Save As feature.

You can delete any item from the Current Format list, except Other by using the DELETE key on the keyboard. KES or TXT, are
Kurzweil 1000 system standards. If you delete them, they reappear the next time you open the File dialog.

If you type a file name without an extension in the File Name text box, Kurzweil 1000 updates it to include an extension when you select a file format in the File Format list.

If you type a file name with an extension, the system uses the extension to save the file, regardless of any format choice you make using the Format list.

If you change the file format in the Format list, but do not change the file extension in the File Name text box and the extension matches the original file format, the system saves the file in the format you selected in the Format list, and ignores the extension in the text box.

Printing a Document

To open the Print dialog and print a document:

1. With the cursor in the desired open document, open the Print dialog using one of the following methods:
   
   Open the File menu and choose Print (mnemonics ALT+F+P).
   
   Or use the shortcut CONTROL+P.
   
   The Print dialog opens with your cursor in the Printer list. If there is more than one printer connected to the system, you can use this list to select one.

2. Press ENTER.

Notes:

By default, Kurzweil 1000 prints to Fit Image to Paper. The resulting image is slightly smaller. You can disable this option by
pressing Alt+F in the Print dialog. Disabling the option may result in loss of parts of the image, along the bottom and right edges.

By default, Kurzweil 1000 prints All the pages in the document, however, you can specify a range of pages.

To specify a range of pages:
1. In the Print dialog, go to the Print Range list (ALT+G).
2. Use the UP/DOWN ARROW keys to select Pages.
3. Go to the From box (ALT+F) to specify the first page to print.
4. Go to the To box (ALT+T) to specify the last page to print.
5. Press ENTER if you are done.

To specify a selection of text:
1. In the desired document, select the text you want to print.
2. Open the Print dialog.
3. Go to the Print Range list (ALT+G), the Selection option is selected.
4. Press ENTER if you are done.

To print a page including its images:
1. Open the Print dialog, and go to the Use Images list (ALT+I).
2. Press the UP/DOWN ARROW key to select Yes.
3. Press ENTER if you are done.

Note: Printing images, unlike printing recognized text, can decrease the legibility of your document, and may slow down the scanning and printing processes.
To print multiple copies:

1. Open the Print dialog, and go to the Number of Copies text box (ALT+C).
2. Type a number from 1 to 99, inclusive.
3. Press ENTER if you are done.

Modifying Printer Properties

The Printer Properties dialog contains properties that may be important to you when you are printing a document. These include changing the font size and page margins, or specifying paper source and page orientation.

Once set, you can save these properties in a settings file, so you should not have to visit this dialog very often.

To access the Printer Properties dialog:

1. Open the File menu and choose Print (ALT+F+P).
2. Be sure Braille Conversion is disabled in the Print dialog.
3. Go to the Properties option (ALT+R).
4. Make the desired modifications and press ENTER to apply your changes and return to the Print dialog.
5. Press ENTER again to close the Print dialog.

You can also press ESCAPE to Cancel changes and/or cancel the print task.

To specify the print font for the document:

The first component in the Printer Properties dialog is the Single Font list (ALT+S).

1. Use the UP/DOWN ARROW keys to enable or disable this option.
If you enable **Single Font**, you can select the print font for the document. By default, it is disabled and Kurzweil 1000 uses the fonts that match those specified in the document being printed.

2. In **Single Font Enabled** mode, press **TAB** to go to the first of the **Font** controls, the **Name** list from which you can select the typeface to use for printing.

3. Press **TAB** again to go to the **Size** list to select the print size, in points.

4. Press **TAB** again to go to the **Bold** list, and **TAB** again to the **Italic** list box. Use the arrow keys to enable or disable bold or italic text.

**To modify magnification:**

**Note:** This option is available only when Single Font is Disabled.

When you magnify text, Kurzweil 1000 changes the size of all of the text being printed.

1. In the **Printer Properties** dialog **TAB** to **Magnification** (mnemonics **ALT+M**).

2. Use the **UP/DOWN ARROW** keys on the keyboard to select a magnification value from 1 to 8, or type the value you want.

**To change print margins:**

1. In the **Printer Properties** dialog **TAB** to the desired margin. mnemonics **ALT+L** for **Left margin**, **ALT+T** for **Top**, **ALT+R** for **Right**, and **ALT+B** for **Bottom margin**.

2. Type units in inches or in centimeters, depending upon the units setting in the **Scanner Margins** dialog.

   The default values are 1.0 for top and bottom, 1.25 for left and right.
To change print orientation:

In the Printer Properties dialog TAB to the Orientation list box (ALT+O). Then, select Portrait or Landscape.

To select the paper source or paper size:

In the Printer Properties dialog TAB to Paper Source (ALT+P), Paper Size (ALT+I). The contents of these lists depend on the selected printer.

To change the line spacing:

In the Printer Properties dialog TAB to Line Spacing (ALT+A). Select between single spacing, 1.5, and double spacing.

Changing the Current Folder

The current folder is the default folder that Kurzweil 1000 uses when saving files. To change folders, choose Change from the Folder menu (mnemonics ALT+L+C). The File dialog opens with your cursor in the Folder tree. Use the arrow keys on the keyboard to move among the folder names. When you hear the name of the folder you want, press ENTER.

Changing the Home Document Folder

The Kurzweil 1000 considers one folder on your computer to be its Home Document Folder.

You can find out what the Kurzweil 1000 is using as your home folder, and potentially change it. This feature is available only if no files are open.

To find your Home Document folder and change it:

1. Close all open documents.
2. Select **Document Home** from the **Folder** menu (mnemonics ALT+L+H).

   A dialog opens, and the system voice tells you the path name for your document home and asks if you want to change it.

3. If you want to change the document home, press **ENTER** for Yes. Otherwise, press **ESCAPE** to cancel and close the dialog.

   If you answered Yes, the **File** dialog box opens with your cursor in the **File Name** text box.

4. Type in the name of a new folder, or select an existing folder by pressing **SHIFT+TAB** until your cursor is in the **Folder tree**. Navigate to the desired folder name.

5. Press **ENTER**.

   Once you have done so, Kurzweil 1000 creates a new folder if that's what you specified. If the folder you selected has not been used before as a home folder, the various subfolders that Kurzweil 1000 normally provides are created beneath it, and the manuals are copied into the Manuals folder.

   **Note:** If you are on a computer that allows for multiple users, and has different logins for each user, each user can have his or her own document home.

**Obtaining File Management Status**

File management status includes the name of the current folder and the name of the open file.

**To display and hear status information related to file management:**

Open the **Help** menu and choose **File Management Status** (mnemonics ALT+H+F).
To stop the status information:
Press the ESCAPE key.

Advanced File Management

Creating a New Folder

1. Open the Folder menu and choose New (mnemonics ALT+L+N).
   A dialog opens with the cursor in a text box.
2. Type the desired name for the folder, then press ENTER.
   When you are typing in this box, you can use:
   - Question mark to speak text you’ve entered so far.
   - CONTROL+L to spell text you’ve entered so far.
   - F7 to speak the contents of the text box.
Kurzweil 1000 places the new folder under the current folder.
To cancel without creating a folder, press TAB until you hear “Cancel,” then press ENTER.
Note: You can also create a new folder while you are in any file dialog by using the context menu.

Deleting a Folder

Kurzweil 1000 lets you delete any folder except the current folder, or folders on a CD-ROM. (If the folder is not empty, you will be warned before the deletion occurs.)

To delete a folder:
1. Open the Folder menu and choose Delete (ALT+L+D).
The File dialog opens with the cursor in the Folder tree, which describes the directory structure.

2. Use the ARROW keys on the keyboard to move among the folder names.

3. When you hear the name of the folder you want to delete, press ENTER.

4. Press ENTER again at the confirmation message to delete the folder.

Note: You can also delete folders from within any File dialog by selecting the folder or folders and doing one of the following:

To send the folder(s) to the Recycle Bin for possible recovery, press the DELETE key.

To permanently delete the folder(s), press SHIFT+DELETE.

Deleting a File

You can delete one or more files.

To delete a file:

1. Open the File menu and choose Delete (ALT+F+D).
   
   The File dialog opens with the cursor in a list that contains all valid files in the current folder.

2. Use the UP/DOWN ARROW keys on the keyboard to move among the file names.

3. When you hear the name of the file you want, press ENTER.

4. Press ENTER again at the confirmation message to delete the file.
To delete multiple adjoining files:

1. Open the File menu and choose Delete (ALT+F+D).
2. Select adjoining files by holding down the SHIFT key while you use the arrow keys to move through the files you want to select. Releasing the SHIFT key selects these files. Pressing an arrow key after releasing the SHIFT key deselects the files, except the current one.
3. Press ENTER.
   A confirmation message tells you how many files you have selected for deletion.
4. Press ENTER again to delete the files.

To delete non-adjacent files:

1. Open the File menu and choose Delete (ALT+F+D).
2. Select a file, then hold down the CONTROL key while you use the arrow keys to move in the list. This lets you move without adding to the selection.
3. When you hear a file you want to add to the selection, press the SPACEBAR. Continue to move and select in this manner until all the files you want are selected.
   To hear the names of all selected files, press CONTROL+Y.
4. Press ENTER.
   A confirmation message tells you how many files you have selected for deletion.
5. Press ENTER again to delete the files.

Note: You can also delete files from within any File dialog by selecting the file or files and doing one of the following:
To send the file(s) to the Recycle Bin for possible recovery, press the DELETE key.

To permanently delete the file(s), press SHIFT+DELETE.

**Working with Favorites Lists**

You can create a custom list of favorite files and folders, and then select from this favorites list when you open files or change directories. This lets you avoid navigating through the file system to find the files you use most often.

**To add a folder to the Favorite Folders list:**

Make sure the folder you want to add is the current folder. Open the Folders menu and choose Add to Favorites (mnemonics ALT+L+A).

**To add a file to the Favorite Files list:**

Open the file you want to add. Choose Add to Favorites from the File menu (ALT+F+V).

**To open multiple files from the Favorite list:**

Use the SHIFT key selection method to select contiguous files in the Favorite list. To select files in any order, hold down the CONTROL key as you move through the list and press SPACEBAR when you hear the name of the file you want. Then press ENTER.

**To open a file using your Favorites list:**

When opening a document, you can narrow your choices to files in your Favorites list.

1. Open the File menu and choose Favorites (ALT+F+F).
   
   A dialog opens with your cursor in your Favorite Files list.

2. Use the UP/DOWN ARROW keys on the keyboard to move among the file names.
3. When you hear the name of the file you want to open, press ENTER.

4. To close the dialog box without choosing a file, press ESCAPE.

To change folders using your Favorites list:

1. Open the Folder menu and choose Favorites (ALT+L+F).
   
   A dialog opens with your cursor in your Favorite Folders list.

2. Use the UP/DOWN ARROW keys to move among the folders.

3. When you hear the name of the folder you want, press ENTER.

4. To close the dialog without choosing a folder, press ESCAPE.

To delete a file or folder from the Favorites list:

1. Open the Favorites dialog from the File or Folder menu. Press ALT+F+F to remove a file. Press ALT+L+F to remove a folder.

2. Select the item you want to remove. Press the DELETE key on the keyboard, or press TAB until you hear “Delete.”

3. Press ENTER. This action does not remove the file or folder from your system, just from the Favorites list.

Accessing File Properties

The File Properties dialog enables you to read, and sometimes change, certain file properties. It tells you the size of the document, the date and time it was last modified, and statistics such as page, word and character count. In addition, you can specify whether or not you want others to be able to read and edit it or just read it.

There are two ways to access the File Properties dialog, from an open document or from the File dialog.
To access File Properties in an open document:

Open the **File** menu and select **Properties** (mnemonics **ALT+F+R**).

**To access File Properties from the File dialog:**

1. With no documents open, choose **Open** from the **File** menu (**ALT+F+O**).
   
   Your cursor is in the **Folder** tree view.

2. If the file you want is not in the currently selected folder, use the arrow keys on the keyboard to navigate to the folder you want.

3. Use the **TAB** key to go to the **File** list view and use the **UP** or **DOWN ARROW** key to select the desired file name.

4. Press question mark on the keyboard to open the **File Properties** dialog for this file.

   If you use this method, you’ll still be in the **File** dialog after you close the **File Properties** dialog.

**The File Properties Dialog**

The **File Properties** dialog has the following components, as well as the **OK** and **Cancel** command buttons.

The **Size** text box (mnemonic **S**), is read only. This is the file size in bytes. If the selected file is in a ZIP folder, this is the uncompressed file size. When you first open the **File Properties** dialog, your cursor is in this box.

The **Date and Time** text box (mnemonic **T**), is read only, and contains the date and time of the last modification.

The **Description** text box (mnemonic **P**), is available only for files that have been saved in KES format. You can type in an optional description for the file if you want.
Chapter 13. Files and Folders

**Note:** If you change this box for an open file, Kurzweil 1000 saves the description only if you save the file.

The **Attribute** list box (mnemonic A). Select **Normal** to enable editing in the file or select **Read Only** to disable editing in the file.

The **DOS Name** text box (mnemonic D), is read only. It contains the file’s DOS name (eight characters plus a three-character extension).

The **Statistics** boxes follow. You can get the count for **Pages** (ALT+P), **Words** (ALT+W), **Paragraphs** (ALT+R), and **Characters** (ALT+C).

**Note:** The **Statistics** boxes are only available when you open the **File Properties** from an open document.

Remember that you can use the **TAB** key or the mnemonic keys to move around in the dialog. Pressing **ENTER** applies any changes, pressing **ESCAPE** cancels changes and both close the dialog.

**Accessing Folder Properties**

There are a couple of ways to access the **Folders Properties** dialog:

**To obtain information about the current folder**, open the **Folder** menu and select **Properties** (ALT +L +R).

**To obtain information about any folder in your file system**, open the **File** dialog, navigate to and select the desired folder, then type a question mark.

The **Folder Properties** dialog provides you with the following information:

- **Size** (mnemonic S) in bytes of all the contents in the folder.
- The number of files it **Contains** (mnemonic N).
Attribute (mnemonic A) which tells you whether the folder is a normal or read-only folder. You can select Normal to enable editing in the file or select Read Only to disable editing in the file.

The DOS Name (mnemonic D) for the file.

**Shortcut Keys for File Management**

CONTROL+SHIFT+O to open a text file from a floppy disk.

CONTROL+SHIFT+S to save the current document as a text file onto a floppy disk.

CONTROL+SHIFT+D to delete a text file from a floppy disk.

CONTROL+SHIFT+A to open a KES file from the current folder.

CONTROL+SHIFT+H to save the current document as a KES file into the current folder.

CONTROL+SHIFT+T to save the current document as a text file into the current folder.

CONTROL+SHIFT+E to delete a KES file from the current folder.
Working with More Than One Document

You can open more than one document file at a time either by choosing Open from the File menu.

When you open multiple documents, you can read or edit only one document at a time, the active document. In addition, you can scan into only one document at a time, the scanning document. The active document and the scanning document can be the same document, or different documents. This allows you to scan and read in separate documents at the same time.

If you exit with multiple documents open, the system checks for documents that need to be saved, and asks you about them one by one (unless AutoLoad is enabled). If you use the keyboard shut down or power off commands, the system will warn you if you should save any open documents. If the system crashes while multiple documents are open, a restore operation will restore all of them with their correct names and formats.

Moving Among Documents

The Window menu, located immediately to the left of the Help menu, enables you to move among documents. The mnemonic for the Window menu is ALT+W. The items on this menu are:

Next Document. There are two shortcuts you can use for this command: CONTROL+F6 or CONTROL+TAB.

Previous Document. You can also use (shortcut CONTROL+SHIFT+F6 or CONTROL+SHIFT+TAB).

File list, containing all the documents you have open. The mnemonic for each document name is its number in the list, so the first document has the mnemonic 1, the second has the mnemonic
2, and so on. The names appear in the order in which the files were opened.

As you move among documents, Kurzweil 1000 announces the name of the current active document.

**Changing the Default Folder**

When Kurzweil 1000 starts for the first time, its default folder is the General folder beneath the Kurzweil Educational Systems folder, in My Documents. When you save a settings file, Kurzweil 1000 also saves the path of the current folder. Because it uses that path only at startup time, the folder setting will have an effect only when it is in the default settings file.

To have Kurzweil 1000 always come up in a particular folder, make that folder the current folder. Save settings, specifying default as the settings file name. When you start from then on, it will be in that folder. For details on saving settings files, go to Chapter 12, *Working with Settings*.

**Working with File Utilities**

The File menu’s Utilities submenu (mnemonic U) has three items if no files are open, eight additional items if files are open. The three that are always available are listed first:

- **Copy** (mnemonic C).
- **Move** (mnemonic M).
- **Merge and Open** (mnemonic G).
- **Extract Image** (mnemonic E).
- **Extract All Images** (mnemonic X).
Chapter 13. Files and Folders

Remove Image from Page (mnemonic R).
Remove All Images from File (mnemonic I).
Remove Layout Information from File (mnemonic L).
Remove Page Headers and Footers (mnemonic H).
Create Audio Files (mnemonic T).
Audio Spooler Monitor (mnemonic O).
Convert Bookmarks to Notes (mnemonic V).

This section provides information for all but the last three items on the Utilities submenu. For information about audio files and the Audio Spooler Monitor, go to Chapter 14, File Portability. For more on converting bookmarks to notes, go to Chapter 5, Document Navigation Tools and Methods.

Copying Files

Copy lets you specify any number of files, or a single folder, to be copied (the source). It then presents the File dialog box for you to select a destination. If you are copying a single file, you can specify a file name, or a folder into which the file should be copied. If you do not specify an extension for the destination file, the extension of the source file is used.

If you are copying multiple files, or a folder, you must specify a folder as the destination. The folder need not exist; Kurzweil 1000 will create it if necessary.

As the copy proceeds, the system tells you if a file will be overwritten, and asks if you’d like to continue. You can answer Yes, No, All, or Cancel by tabbing to the appropriate button or by pressing its mnemonic.
If you choose No (mnemonic N), the copy continues without overwriting that particular file.

If you choose Yes (mnemonic Y), the file is overwritten.

If you choose All (mnemonic A), the file is overwritten, and you will not be asked again if some other file exists which will be overwritten by the same operation.

If you choose Cancel (mnemonic C), the operation stops, although some files may have already been copied.

Any file error, such as trying to copy a read-only file, a read-only disk, or a full disk, will terminate the copy operation with an error message.

This Copy utility is more powerful than the DOS copy operation, in that you can copy folders, and all of the subfolders under a folder, in one operation. You could copy everything under C:\My Documents to another folder, for example. You can even copy everything on a particular disk to a second disk, providing you have sufficient room on the second disk.

Note: You can also copy files using the context menu in any file dialog.

Moving Files

Move lets you move files or folders to other folders on the same disk, to other disks, or to have different names under their current folders. If you do not specify an extension for the destination file, the extension of the source file is used. Note that on some command line systems, this behaves like RENAME in some circumstances, and like MOVE in others.

Note: You can also move and rename folders from within any File dialog by using the context menu.
Chapter 13. Files and Folders

Extracting Images

There may be circumstances where you wish to create image files that correspond to the pages in a particular document. You can do so with either Extract Image for a single page or with Extract All Images for all pages in the file.

For either command, be sure you have Keep Images enabled in General Options before scanning so that there is an image associated with each page.

With the desired file open, choose Extract Image or Extract All Images from the File Utilities submenu, mnemonics ALT+F+U and letter E or letter X. In the File dialog, specify a name for the file or folder in which the image should go. Kurzweil 1000 stores the images as TIFF files. If you used Extract All Images, the individual files are named using the first five characters from the document name, followed by a four-digit page number, with leading zeroes, if necessary. Once Kurzweil 1000 completes creating the files, it will notify you.

Merging Files

The Open and Merge Utility lets you select two or more files and merge them together. The files you select must be in formats that do not require recognition, such as .KES or .TXT. PDF and TIF are examples of formats that would not work.

Note: The formats of the files you select do not need to match.

To open and merge files:

1. Open the File menu, then the Utilities submenu, and choose Merge and Open, or press ALT+F, then U, then G.

The File dialog opens and the system asks you to select two or more files to merge. To select non-contiguous files, select the
first file, hold down the **CONTROL** key and use the **DOWN ARROW** until you reach the second file, press **SPACEBAR** and release the **CONTROL** key, then press **ENTER**.

2. Select the files and press the **ENTER** key.

The **Reorder Files** dialog opens. This dialog allows you to arrange the files in the order you want them to appear in the merged file. The dialog has one list box, which displays the selected files, and four buttons: **Up**, **Down**, **Enter**, and **Cancel**.

3. To change the order of a file, select it and do one of the following:

   Press **CONTROL+UP ARROW**, or **CONTROL+U** to move the selected item up in the list, swapping it with the item that appears just before it.

   Press **CONTROL+DOWN ARROW**, or **CONTROL+D** to move the selected item down in the list, swapping it with the item that appears just after it.

4. Press **ALT** to combine the files and open them into a new merged document, or **Cancel** to close the dialog without making any changes.

   The merged document opens with the contents of the topmost document from the ordered list displayed first, followed by the contents of the other documents.

**Removing an Image from a Page**

Obviously keeping images in a .KES file makes that file larger. You may have a file that has some pages that have images you want to keep, and others you do not. Use this menu item to remove the image associated with the current page.
Removing All Images from a File

If you no longer need the images associated with the open file, you can use this menu item to significantly reduce the size of the file. All of the images embedded in the file will be removed.

Removing Layout Information from a File

Layout Information can be retained in .KES files, depending upon the state of the Keep Layout Information setting in the General Settings tab page. If you find that you have no use for this information, that you no longer need to explore the layout of the pages in the file, or identify the location of any words, then you can use this item to significantly reduce the size of your file. Note that layout information cannot be removed from a page that contains an image, so you may want to remove images first.

It happens that layout information was written into .KES files beginning with Version 5 of Kurzweil 1000, although that information was not usable in that version, nor is it usable in Version 6 or 7, as the information was incomplete. However, you can use this feature to remove it.

Removing Page Headers and Footers

Page headers and footers contain repetitive information which tends to interrupt the flow of a document while you are reading. If you are planning to read a document within the Kurzweil 1000, you can simply enable avoidance of headers and footers. However, you may plan to read the document elsewhere, in a product that does not have that feature. If so, this option gives you the ability to remove, rather than simply skip, the repetitive text for the current document.
Restoring a File

You can restore open files if Kurzweil 1000 terminates in an unexpected way. To restore files, restart Kurzweil 1000. After its standard greeting, you will hear:

"Note that the last file was not properly saved. If you would like to restore it, press Accept."

Press ENTER on the keyboard to restore the file. The file is restored with its correct name and format.

If you enabled AutoLoad, any files you had open at the time of an unexpected system failure will automatically re-open.

Working with ZIP Files

Kurzweil 1000 treats files with a .ZIP extension as though they were folders. You can access Zip files through the menu system. You can also use the File Management Keypad. For more information on the File Management Keypad, you can either download the document Using the Keypad to Access Kurzweil 1000 from the Kurzweil Educational Systems website—www.kurzweiledu.com— or refer to Appendix E, Using the Keypad to Access Kurzweil 1000 in the Online Manual.

If you change folders to a Zip folder, you can access all the files, folders and subfolders it contains. You can list, open, move, delete, or copy files and folders within Zip folders.

To create a Zip file:

Open the Folder menu and select New. Type the name of the new folder, specifying the extension .ZIP at the end.
To decompress files from an existing Zip folder:

Use the Copy utility to copy the desired file to another folder.

**Note:** When opening a password-protected Zip file, Kurzweil 1000 asks for the password. Be sure you ask the Zip file’s creator for the password.

To compress a file:

Copy it to a folder that has a .ZIP extension. Use the standard File Open and Save operations to open or save a file within a Zip folder.

To find the size of a compressed Zip file:

Select the desired file, open its Files Properties dialog and go to the File Size box.

Writing Files to a CD

If your system has a CD burner and is running Windows 2003, Windows XP or a more recent operating system, you can find the CD Writing Tasks submenu from the Tools menu by pressing ALT+O+C.

In addition to adding and writing files to CD, you can check the status, remove files, erase the CD and write a folder directly to the CD bypassing the queue, which is a timesaver when copying CDs.

The general procedure follows:

1. Be sure you have a writable CD in the CD burner.

2. If you have multiple CD drives that can write CDs, press L from the CD Writing Tasks submenu to Select a Drive, otherwise go to the next step.
3. Add Files to the queue by pressing A from the CD Writing Tasks submenu. In the File dialog, select the desired folder, file or files.

4. Lastly, Start Writing the files to the CD by pressing W from the CD Writing Tasks submenu.

To obtain status before you begin writing to CD, press S from the CD Writing Tasks submenu. You may hear some or all of the following information: total size of the files, whether or not a CD is in the drive, and how much free space is available on the CD.

To remove files from the queue, press R from the CD Writing Tasks submenu.

To erase all the files from a CD, press E.

To write directly to the CD, press D, then select the folder whose contents you want to write directly to the CD.

**Note:** the selected drive is a saveable setting. For information on Saving Settings, go to the subsection entitled Settings Menu in this guide.
This chapter contains the following topics:

Overview.
Creating and Playing Audio Files.
Sending Documents to Other Devices.
Devices the Send To Feature Supports.
Setting Up a User Device to Send To.
Sending Documents to an E-Mail Recipient.
Printing to a Braille Embosser.
Command Line Support for File Names.
Overview

Being able to carry around and listen to your reading material while in transit or while away from your Kurzweil 1000-based computer, can mean flexibility and efficient use of your time.

Kurzweil 1000 provides you with access to your reading material through numerous portable devices from Book Port to RoadRunner. In addition, you can print your files to the Braille Embosser for portable Braille pages.

This chapter contains information about and procedures for the following:

- Converting files from Kurzweil 1000 into portable file formats, such as MP3.
- Playing audio files in Kurzweil 1000.
- Placing audio files on playlists.
- Saving MP3 and WAV files to DAISY 2.02 format.
- Sending files directly through e-mail and to different devices.
- Printing files to the Braille Embosser.

Reviewing the previous chapter on Files and Folders would be helpful in performing the operations covered in this chapter. This chapter assumes that you know how to:

- Access file and folder commands.
- Navigate the file and folder system.
- Manage files, create them, save them, rename them, copy them, and so on.
- Choose a file format.
Creating and Playing Audio Files

Kurzweil 1000 allows you to save all or part of an open document in the following formats: WAV, MP3, or Audio DAISY files.

You can create DAISY 2.02 audio files, as described in this section, or you can use the Save As command to save any file as a DAISY (3.0) text file. Once an audio file is created, you can play them on various players as well as directly in Kurzweil 1000.

Kurzweil 1000 lets you open and play DAISY Audio 2.02 books, MP3, WAV, and Windows Media (WMA) files. If there are human voice(s) and/or music used on the original recording, that's what you'd hear.

While in these files, you can use typical reading shortcuts, such as:

- F5 key or Right Control key to start/stop.
- F6 or Left Arrow to rewind.
- F7 to repeat current unit.
- F8 or Right Arrow to fast forward.

Because Kurzweil 1000 does not discern lines, sentences and paragraphs in audio files, when you use Rewind and Fast Forward, it uses 15 second intervals if the reading unit is line or sentence, and 30 second intervals if the reading unit is paragraph. As usual, F11 and F12 increase and decrease, respectively, the "word per minute" speed.

If the DAISY audio book has page numbers, you can use the Page keys for navigation.

It’s also possible to add Bookmarks or Notes in MP3, WAV and WMA files, but for audio DAISY files, you must add them before the conversion.
**Note:** Not every reading voice supports this feature. In general, hardware speech engines will not work.

**To create a WAV, MP3 or DAISY Audio File**

Ensure that you have Internet access on your system. If your system does not have an MP3 encoder, Kurzweil 1000 will use its encoder from the Web.

1. If you want to use a text selection in the open document, select the text.

2. From the **File** menu, open the **Utilities** submenu and choose **Create Audio File** or press **ALT+F+U+T**.

   If your system and your reading voice support this feature, a dialog opens with your cursor in the **Range** list box.

3. Specify the range of the text that you want encoded.

   The options are **All**, **Pages**, or **Selection**. The **Selection** option is available only if text in the open document has been selected. If you select the **Pages** option, the next two boxes, **From** and **To**, allow you to specify the starting and ending page number.

4. Go to the **Audio Format** box by pressing **TAB** or **ALT+R**, then specify the type of file you want to create: **WAV**, **MP3**, **DAISY with MP3 Files** or **DAISY with wave Files**.

5. If you have bookmarks in the document, there are two associated boxes:

   **Bookmarks as Separators** list box (**ALT+B**). Select **Enabled** if you want to use bookmarks to separate the document into more manageable chunks.

   **Bookmark Level** list box (**ALT+V**) is available if you have multi-level bookmarks in the document. Select the number of levels, from 1 to 6, that you want to use.
6. To specify the number of pages you want per audio file, go to the Pages per Audio File text box (ALT+P) and type a number from 1 to 999. Use the UP/DOWN ARROWS to increase or decrease the value by increments of one. Use SHIFT+UP/DOWN ARROWS to change the value by larger amounts.

Keep in mind that a smaller number is more manageable to navigate and requires less disk space.

Note: This option is only available when Bookmarks As Separators is disabled.

7. If you selected MP3 or DAISY with MP3 format, you can go to the Audio Quality list box (ALT+A), to select a quality value of Low, Medium, or High.

The lower the quality, the smaller the output file.

8. Specify the Bit Rate (Alt+I) if you want to override defaults set by the Audio Quality setting. The rates go from 16 to 256. The higher the number, the higher the quality, but the size of the file will also be larger.

9. Select the Sample Rate (Alt+S). The default is to use the Same rate as the audio source, which is highly recommended, as rates that are not a multiple of that rate will introduce some distortions. Other rates you can choose go from 8000 to 56000.

10. Next specify the Destination Folder (ALT+D) in which you want to place the audio file. You can enter a fully qualified folder name in the text box, or TAB to the Browse command and press ENTER.

For Audio DAISY: You must save each of your Audio DAISY files to a different folder, to prevent important file-specific information from being overwritten.
Choosing **Browse** opens the **File** dialog. Select a folder, or specify a new folder. When done, press **ENTER** to return to the Create Audio File dialog.

11. **Add to a Playlist.** If you selected MP3 or WAV for the audio format, you will have the option of adding the file to either the **iTunes Playlist (Alt+T)**, if you have it on your system, or to the **Windows Media Player (Alt+W)**. Kurzweil 1000 adds an entry on the playlist for any newly created files. If a playlist does not exist, Kurzweil 1000 creates one for you. Leave these fields blank if you do not want a playlist modified.

12. Press **ENTER**.

13. Kurzweil 1000 checks to see if you have an MP3 Encoder on your system. If you do not, a button labeled, "Get MP3 Encoder," becomes available in the Create Audio File dialog. Tab to the button and press Enter to activate the command and complete the audio file creation.

**Note:** You can monitor the progress of the audio spooler by using the Audio Spooler Monitor feature. Refer to the next section for more information.

**Using the Audio Spooler Monitor**

Use the Audio Spooler Monitor to track audio file creation. **Audio Spooler Monitor** is available from the **Utilities** submenu from the **File** menu. The Audio Spooler Monitor dialog opens presenting the following contents:

**Current Job** list (mnemonics **ALT+U**) displays the name of the output file and the time you sent it to the queue.

**Pending Jobs** list (**ALT+P**) shows the names of the output files and the time you sent them to the queue.
**Completed Jobs** list (ALT+C) contains the names of the completed output files, the time you sent them to the queue and the time the jobs were completed.

**To Delete a current job:**

In the Audio Spooler Monitor dialog, from the Current Job box, press TAB to go to the Delete button and press Enter.

**To Delete a pending job(s):**

1. Check a job or jobs in the **Pending Jobs** list.
2. Press TAB to go the **Delete** button, then press **ENTER**. Or, press ALT+D.
3. Kurzweil 1000 asks if you are sure. Press Y for Yes, N for No.

**To Delete all pending jobs:**

Press ALT+E.

**To Clear a completed job(s) or to Clear All:**

1. Check a job or jobs in the **Completed Jobs** list.
2. Use the TAB key to go the **Clear** button, then press **ENTER**. Or, press ALT+L.
3. Kurzweil 1000 asks if you are sure. Press Y for Yes, N for No.

**Note:** Clearing a completed job item does not delete the completed audio file.

**To Clear All completed jobs:** Press ALT+A.

**To obtain the latest Spooler information:** Press ALT+R for Refresh.
Sending Documents to Other Devices

There are many devices that allow you to port documents. Kurzweil 1000 automatically converts files, if necessary, to an appropriate format, and then transmits them to these devices. The transmission happens in the background, so that you can continue to use the Kurzweil 1000 for other purposes. Supported devices include the Braille Note, RoadRunner, and Freedom Scientific’s various portable devices. You can also send files to devices that emulate a drive on a PC by using the User Device feature.

Kurzweil 1000 offers many options for sending files. You can send the current open document or multiple documents. You can send the entire document or a range of pages.

Before You Send to a Device

Ensure that you’ve got the device into which you intend to load content, the necessary cabling, and the required PC software. We assume that you already have the device communicating with your computer. If you don’t, please consult the documentation that came with our device for information on setting up and configuring your device and its accompanying software.
Chapter 14. File Portability

The devices that are supported have limited amounts of storage. Please verify that you have enough storage space on the destination device to hold the files that you wish to send. Note that if those files are not already in the format that is required for the transmission, it will not be obvious how much space each file will require. In general, Grade 2, text, and RTF files are all significantly smaller than KES files. You can determine the size of files you’ve selected by bringing up the properties dialog in the file selection screen.

**Help and Status During Conversion and Transmission**

Once transmission has begun, you can check its status by selecting **Reading Status** from the **Help** menu, by pressing the **Help and Status** key on the keypad, or by returning to the **Send To** item in the **File** menu.

You can also check status by pressing the **Help and Status** key on the keypad. For more information, you can either download the document, *Using the Keypad to Access Kurzweil 1000*, from the Kurzweil Educational Systems website—www.kurzweiledu.com—or refer to Appendix E, *Using the Keypad to Access Kurzweil 1000* in the Online Manual.

**The Send To Procedures**

**To send the current document to another device:**

1. From the **File** menu, open the **Send To** submenu and choose **Send Current Document** (mnemonic **ALT+F+E**, then **C**).

   The **Device** dialog opens with your cursor in the **Page Range** list.
2. Use the **UP/DOWN ARROW** keys to select an option. To send the entire document, pick **All** and go to step 4. To send a range of pages, select **Pages**.

3. If you select Pages, press the **TAB** key to place your cursor in the **From** box. Type in the desired page. **TAB** again to place your cursor in the **To** box. Type in the desired page.

4. **TAB** once more to go to the **Device** list and select the one you want.

5. Press **ENTER** to start conversion and transmission. This closes the **Device** dialog.

To send other document or documents to another device:

1. From the **File** menu, open the **Send To** submenu and choose **Send Other Documents** (**ALT+F+E+O**).
   
   The **File** dialog opens with your cursor in the **Files** list.

2. Select one or more files you want to send.
   
   If the files are in a different folder, press **SHIFT+TAB** to go to the **Folder tree**. Navigate to the desired folder. Press **TAB** to go back to the **Files** list. Of course, you can also type the path and file name of the document in the text box.

3. Press **ENTER** to apply the selection.
   
   This closes the **File** dialog and opens the **Device** dialog. Your cursor is in the **Device** list on the first option.

4. Select the device.

5. Press **ENTER** to start conversion and transmission. This closes the **Device** dialog.
Devices the Send To Feature Supports

This subsection provides information about all the device selections, except Send To An Email Recipient, which follows in the next subsection.

Each device has its own unique properties. We list the properties in the device descriptions that follow. You can view and modify the properties in the Properties dialog.

To open a device’s properties:

1. Open the Device dialog and select the desired device.

2. TAB to the Properties option.

   The device’s Properties dialog opens.

   Note: All of the properties, as well as the device chosen, are saveable settings.

Book Courier

Book Courier is a portable reading device from Springer Design, Inc. As with other devices that you use with Kurzweil 1000, you attach this device to your PC’s USB port.

You can send a single file or multiple files from Kurzweil 1000 using the same File Send To command (ALT+F+E) that you use with other devices.

After indicating the current file or selecting a file from the file system, Kurzweil 1000 presents the Send To dialog.

In the Send To dialog do the following:

1. Select the range of pages.

2. TAB to the list of devices and select the desired device name.
3. Go to the **Properties** option (**ALT+R**), then press **ENTER** to open the **Properties** dialog.

In the **Properties** dialog do the following:

1. Specify the **Destination Folder** (**ALT+L**) where you want the file placed. You can do this by typing the full path name of the file or by typing a question mark to browse the file system.

2. **TAB** to go to the **File Format** box (**ALT+F**). This is where you could change the file format for the file you are sending.

   **Note:** Currently Book Courier supports the KES file format only.

3. Press **ENTER** when you are done. Your cursor is back in the **Send To** dialog.

4. In the **Send To** dialog, press **ENTER** to send the file.

**Book Port**

Book Port, from American Printing House for the Blind, offers large storage capacity, long battery life and easy-to-use portability. You can transfer text and MP3 files to Book Port. If you want to specify a location on Book Port where you want to store the file or to store the file in a different format, use the **Properties** dialog from the **Send To** dialog.

**Note:** This feature does not work with Windows 95 or Windows 98 systems.
The BrailleNote is a Windows CE device developed by Pulse Data International. It communicates with your computer via Microsoft’s ActiveSync which is included on a CD-ROM with your BrailleNote. In order to download from Kurzweil 1000 you must initiate a connection between your computer and the BrailleNote. This should work as you’ve come to expect, but with an addition. Normally, when initiating this connection you hear the BrailleNote indicate that the connection has been established via an audible tone. Next you hear Windows indicate that the connection has been established via an audible signal. Now that Kurzweil 1000 is set up to communicate with BrailleNote, you should hear a third audible signal. Note that you’ll hear Kurzweil 1000’s notification whether or not you are running Kurzweil 1000.

The following properties are available in the Send To Properties dialog:

**Destination Folder** (mnemonics ALT+I). The BrailleNote has several storage devices, each of which can have numerous directories and subdirectories. At this time we are providing access to **Books**, which is the "\Flash Disk\My Books" folder, and **General**, which is the "\Flash Disk\General" folder.

**File Format** (ALT+F): We support the following file formats: Text, Grade 2 Braille, Microsoft Word, and RTF.

Should you run out of space on your BrailleNote, the transfer will not complete. All files that were successfully transferred will remain on the BrailleNote. If a file is not completely downloaded, the portion of the file that is downloaded will be left on the BrailleNote. If this is a Microsoft Word or RTF file you should probably delete it. If, on the other hand, it is a Braille of Text file, you will be able to read the portion of the file that was successfully transferred.
Maestro from HumanWare

When sending to Maestro, first dock the device and verify connection. Choose Send To from the File menu. In the File dialog, select the desired files and press ENTER. Next select Maestro from the Devices list, then press ALT+R to go to Properties. In the Properties dialog, TAB to the Files Format list, and select a file format. Press ENTER two times to start transmission.

Note: The DAISY file format is for DAISY 3 documents. To send Audio DAISY files, copy the files from outside of Kurzweil 1000.

PAC Mate

PAC Mate is a portable notetaker and reading device from Freedom Scientific. As with other devices that you use with Kurzweil 1000, you attach this device to your PC’s USB port. Follow the instructions for sending a file to Book Courier.

Notes: You can change the file format for PAC Mate to one of the following: Text, Braille, MS Word, RTF and MP3. Use the MP3 option to send files already saved in MP3 format. Kurzweil 1000 does not perform the conversion process during the Send To operation.

RoadRunner

The RoadRunner is a small reading device developed by Ostrich Software. The device has a keypad much like a touchtone telephone, and two one-eighth-inch jacks for headphones and a serial cable.

Kurzweil 1000 uses components of the RoadRunner Downlink software in order to communicate with the RoadRunner. Therefore, it is necessary that you install the RoadRunner Downlink software prior to utilizing this feature. Kurzweil 1000 requires that you have
at least version 1.1.3 of the RoadRunner Downlink software installed. This can be found in the extras folder of your Kurzweil 1000 CD-ROM. The filename is RRSetup130.zip.

There are no special properties for this device.

RoadRunner is a serial communications device, and hence is attached to your computer via the computer’s serial port. Many computers have more than one serial port, hence it is necessary to tell the RoadRunner Downlink software which serial port the RoadRunner is attached to. If you do not perform this setup step properly, the Kurzweil 1000 will be unable to detect your RoadRunner, and will report an error when you begin the download procedure. Please be sure to use the RoadRunner Downlink software to configure RoadRunner. Check your RoadRunner documentation for information on how this is done.

RoadRunner has a limited amount of memory. If you attempt to download too much data into the RoadRunner, you will be notified of this shortly after starting the transfer. If you receive such a notification, try downloading fewer files.

**Braille ’n Speak, and Similar Devices**

In the late 1980’s, Blazie Engineering released the Braille ’n Speak, a notetaking device with a Braille keyboard for input, and a speech synthesizer for output. In the following years numerous similar devices have been released, including Braille Lite, Type ’n Speak, and TypeLite. Each of these devices has a long history of firmware upgrades and minor hardware variations. They are all serial communication devices. Many of these products permit communication with a computer via standard serial communication protocols. YModem is the most common of these protocols, and thus Kurzweil 1000 uses YModem to download files into these devices. Similarly, the Kermit protocol is popular, and Kurzweil 1000
supports it for users who need it. Generally YModem is recommended.

Since there is such variety in the Braille 'n Speak product family, it is difficult to describe a single procedure that works equally well for all of the products. Therefore, we will outline a general procedure that we feel will work for a majority of devices, and suggest some variations you should consider if the general procedure causes you trouble.

Several communications parameters control how your Blazie notetaker communicates with your computer. Both the notetaker and the computer allow you to modify these parameters, but the two devices must agree with each other.

Since different Blazie notetakers have different possible settings for some of these parameters, you should view the following settings as suggestions only. You will find them in the Properties dialog, once you have selected the device and activated the Properties button.

**Baud Rate:** Try 38,400. This controls the speed of the transfer. If your notetaker doesn’t support this value, try the highest value that it does support.

**Parity:** Try None. This controls the use of an extra binary signal per character for error checking purposes.

**Data Bits:** Use 8. This indicates how many binary signals each character contains. All Blazie notetakers should support this value.

**Stop Bits:** Use 1. This indicates the length of the space between characters. All Blazie notetakers should support this value.

**Handshake:** Use hardware. Handshaking allows the computer and notetaker to control the rate at which characters are transferred. Hardware handshaking is especially useful at higher baud rates,
though your cable needs to be wired appropriately for its use. Software handshaking (also called xon/xoff) is fine for lower baud rates.

**Protocol:** Use YModem.

For the Format property, you can select text or Braille. Files sent to your notetaker as text will be larger than those sent as Braille. Files sent as Braille, though, may mask some scanning errors and thus be harder to read. Whether you use text or Braille is a matter of personal preference. Many notetakers with Braille displays have a "view in grade two" feature that will enable the user to read a text file in Grade 2.

When you have specified the properties in Kurzweil 1000, you press **ENTER** to begin transmission. You then need to tell the notetaker to begin receiving files. How you do this depends on the notetaker you have and the protocol you’ve selected. For example, on the Braille 'n Speak you can select **Option** (o-chord), **File** (f), **Transmit** (t-chord), **Receive** (r), **YModem** (y). Some notetakers have a shorthand for this, such as option (o-chord), file (f), and then the 1-2-3-4-6 chord. The notetaker will now begin receiving files from the Kurzweil 1000.

With all the possible communication parameters, the most common source of failure is a mismatch between those parameters on the two different devices. Check the parameters on the notetaker, and compare them to those you have specified in the Kurzweil 1000. You can also try using other communication software to verify that your parameters and your cabling are correct. Try Freedom Scientific's Windisk or PCDisk, or Microsoft's Hyperterminal.
Setting Up a User Device to Send To

Most of the devices being manufactured today can emulate a disk drive on a PC. When they are plugged in to your computer and turned on, they appear as a drive. Kurzweil 1000 allows you to send files to these devices after you set it up.

To set up a user device:

1. Plug the device in to your computer.

2. Open the Send To dialog by pressing Alt+F+E, then your choice of C for sending the current document or O for other document on your system.

3. When the Send To dialog opens, press Alt+N to go to the button entitled "New." The Device dialog opens with the cursor in the Device Name box.

4. Enter the name of the device. The mnemonic for the Device Name box is Alt+N.

5. Specify the formats that the device supports. Press Tab to go to the Supported Formats or press Alt+F. Check those formats that the device supports.

6. Specify the default format. Press Tab to go to the Default Format list or press Alt+E. This list contains the formats you selected in the Supported Formats list. If the file you are sending is not in any of the supported formats, Kurzweil 1000 will use this default format to convert the file.

7. Select the drive associated with the device. Press Tab to go to the Drive list or press Alt+D. If the device could be assigned variable drive letters depending on what else you have on your computer at the time, select the question mark and Kurzweil 1000 will determine the correct disk drive.
8. Specify the folder or file where Kurzweil 1000 should look when attempting to determine the correct drive. Press Tab twice to go to the Browse button of the Contains box. The mnemonic for the Contains box is Alt+C. Navigate to the folder or file.

9. Next specify the Folder that should be used when a file is sent. Press Alt+L to go to the Folder box. Tab to use its Browse button. Navigate to the desired folder.

10. Indicate whether you want to create a new folder for the file you are sending. Press Alt+W to go to New Folder. By default this option is set to No and Kurzweil 1000 places the file in the folder specified in the Folder box. Press the Down Arrow key to select Yes if you want to create a new folder to contain the file. In this case, Kurzweil 1000 creates a new folder with a name based on the name of the file you are sending.

11. Press Enter to create the device. Kurzweil 1000 closes the Device dialog and returns you to the Send To dialog.

The new device name appears at the top of the Send To dialog's Device list. As with all the supported devices, you can modify the properties for, delete and restore your user-specified devices.

Notes:

- You can list DAISY 2.02 as the default format for a user device. If the file you are sending is not in that format, Kurzweil 1000 uses the audio spooler to perform the conversion. Do not remove the device until the audio spooler is done.

- You may find multiple user devices created for one device. Victor Reader Stream, for example, uses different folders for different formats so if you wish to support sending multiple formats to that device, you will find that more than one user device will be created for it.
Sending Documents to an E-mail Recipient

In addition to sending files to RoadRunner and numerous other devices, Kurzweil 1000 lets you send files directly to a recipient if you have an electronic mail program on your computer system.

Note: If you are using PMMail from Blueprint Software, please be sure you have the latest version of the product.

The **Send To** feature is accessible from the **File** menu, and is available whether or not a file is open. It provides a number of options including:

- Sending multiple documents.
- Sending a range of pages.
- Attaching documents to the message.
- Attaching documents as zipped files.
- Including the document contents as text in the message.
- Even converting the file format to one that the recipient can open; these include: Braille, HTML, KES, Microsoft Excel or Word, RTF, Text or WordPerfect.

In general, this is how this feature works: You specify the file or files you want to send, select the sending method, change the file format, if necessary, specify one or more e-mail recipient addresses, then start the process. Your e-mail program opens if it isn’t already. If you selected one of the attachment options, the subject line contains the name of the file(s) you are attaching. The message body includes one line telling the recipient that the file is attached. Both the subject and the message lines are editable. If you opted to have the file’s contents be part of the message body, the message body will contain that text. You can add additional text to the message if you want, and your message is ready to send.
To send the current document to an e-mail recipient:

1. In the document you want to send, open the Files Send To submenu and choose Send Current Document. To use mnemonics, press ALT+F, then E, then C.

   The Device dialog opens with your cursor in the Page Range list box. Sending All pages is the default.

2. To specify a range of pages, use the UP/DOWN ARROW key to select the Pages option.

   If you select Pages, TAB to type in the first page in the range, TAB again to type in the last page.

3. TAB to go to the Device list and press the UP/DOWN ARROW key to go through the list.

4. Stop when you hear An Email Recipient to select it. Press Enter.

   Kurzweil 1000 opens your email window with the cursor in the To box.

   Type the address of your recipient, add a message and send.

   By default, Kurzweil 1000 uses the MAPI approach to send the email. If you find that approach does not work, go to To change Send To options: on page 336.

To send a file or files from the File dialog to an e-mail recipient:

1. Do one of the following:

   If you have a document open, open the Files Send To submenu and choose Send Other Document. To use mnemonics, press ALT+F+E+O.

   Or if you don’t have any open documents, open the Files menu, and choose Send To. To use mnemonics, press ALT+F+E.
In either case, the **File** dialog opens with your cursor in the **Files** list.

2. Use the **UP/DOWN ARROW** key to select a file that you want to send.

   If you need to go to a different folder, press **SHIFT+TAB** to go to the **Folder** tree, which presents the folders in your system. Use the arrow keys to navigate to the desired folder, **TAB** to go back the **Files** list.

3. Press **ENTER**.

   The **Device** dialog opens with the **Email Recipient** option already selected.

4. Press **ENTER**.

   Kurzweil 1000 opens your email window with the cursor in the To box.

   Type the address of your recipient, add a message and send.

   By default, Kurzweil 1000 uses the MAPI approach to send the email. If you find that approach does not work, go to To change Send To options: on page 336.

**To change Send To options:**

In the Device dialog (which opens when you initiate the Send To process from the File menu), press **Alt+R** to go to Properties button, then press Enter to open the Properties dialog.

The following are options you can change in the Send To Properties dialog:

- **Send Method** (**Alt+S**) other than the default Attachment.
- **File Format** (**Alt+F**).
Recipient’s email **Address** (**Alt+R**) for sending to one or more recipient addresses.

**Email Client Approach** (**Alt+E**). By default Kurzweil 1000 uses the **MAPI** sending approach. If you find that approach does not work, try the alternative **Mail To Protocol**.

**Notes about the Mail To Protocol:**

This option is less robust and may not support email attachments. Kurzweil 1000 does capture the name of the current document so that you could easily Paste it into the attachment line and try to send it.

In addition, Mail to Protocol is valid only for the current Send To process; however, you can save the setting. For information on Saving Settings, go to Saving and Working with Settings Files on page 255.

When you are finished with the Properties dialog, press Enter to return to the Device dialog. Press Enter again to initiate the Send To process.
Printing to a Braille Embosser

If you enable Braille Conversion in the Print dialog, you can output documents to a Braille embosser. Kurzweil 1000 automatically converts the document or selection to Grade 1 or Grade 2 Braille and sends it to the embosser.

About Braille Embossing

This Braille translation technology comes from a freeware distribution called nfbtrans, written under the direction of the National Federation of the Blind. You can find the configuration file for this program, nfbtrans.cnf, in the common files directory for Kurzweil Educational Systems products (usually C:\Program Files\Kurzweil Educational Systems\Common Files.) If you are familiar with nfbtrans, you can modify the configuration file to alter various properties of the conversion. The translator supports a number of languages, and the document is converted using the encoding appropriate for the language associated with the reading voice. The full freeware version of nfbtrans is available in the Kurzweil 1000 Extras directory.

If you do not currently have a Windows driver installed for the Braille embosser, you must install one before using this option.

Guidelines for Installing a Windows Driver

You will need a screen reader to perform this installation.

These instructions assume the following:

- You have a local printer attached to the printer port.
- You will use a generic driver.
- You are not using Microsoft Windows XP operating systems.
To install a Windows Driver:

1. Use the Windows button or press CONTROL+ESCAPE to open the Start menu.

2. Press S to open the Settings submenu, then P to open the Printer dialog.

3. Press the SPACEBAR to select the Add Printer icon. In some cases, you may have to use the arrow keys to move through additional controls before reaching this.

4. Press ENTER to open the dialog box for the Add Printer Wizard. Press ENTER a second time to get past the introductory screen.

5. Use the arrow keys to select either the Local Printer button or the Network Printer button. (In most cases, you'll want the Local Printer option.) Press ENTER.

6. Press letter G to highlight the word Generic in the manufacturer's list. Press ENTER.

7. You are now in a list of possible ports, with LPT1: selected. This is the local printer port, so in most cases you will choose this one. Press ENTER.

8. You are now in the Printer Name text box. The default is Generic/Text Only. Type a new name if desired. Press TAB.

9. Use the arrow keys to make the embosser the default printer (Yes) or not (No). Press ENTER.

10. Use the arrow keys to choose No (no sample page will be printed). Press ENTER.
11. Insert the Windows CD when prompted, then press ENTER.

12. If you are using the original CD used to set up the system, using the same device number, the right files automatically install. If not, you will need to specify the appropriate device, directory, and file name.

13. The Wizard dialog closes. To close the Printer dialog, press ALT+F+C.

To print to a Braille Embosser:

1. If you want to output selected text, select it now.
2. Open the Print dialog.
3. After selecting the desired Printer and Print Range options, press TAB to go to the Braille Conversion list.
4. Select Grade 1 or Grade 2. By default, Braille Conversion is Disabled.
5. To specify the Number of Copies, press ALT+C, then type the desired number.
6. Press ENTER when you are done.

The system automatically converts the document or selection to Grade 1 or Grade 2 Braille and sends it to the embosser.

To modify Braille Embosser properties:

1. Open the File menu and choose Print (ALT+F+P).
2. Be sure you have selected Braille Conversion in the Print dialog.
4. Your cursor is in the **Cells per Line** text box (mnemonics **ALT+P**). Type the desired number of cells per line. The default is 40.

5. **TAB** to the **Lines per Page** box (**ALT+L**). Type the desired lines per page. The default is 25.

6. **TAB** to the **Page Break** list (**ALT+B**). Select **Form Feed**, **Vertical Tab**, **Blank Lines Program Specified**, or **Blank Lines User Specified**. If you pick the last option, another text box is presented, allowing you to enter the number of blank lines that should be issued at a page break. The last item is a list box for Interpoint, which can be enabled or disabled.

**Command Line Support for File Names**

If the name of an existing file is passed as an argument in the command line for Kurzweil 1000, the application attempts to open that file provided:

- There are no temporary files that need to be restored.
- There are no files which must be opened by the AutoLoad feature.

Because Windows lets you associate actions with particular kinds of files, this feature allows you to use Kurzweil 1000 as a viewer for supported documents. Kurzweil 1000 will not automatically create a file association for KES files. You can create a file association in Windows Explorer.
This chapter contains the following topics:
Kurzweil 1000 Online Features.
Accessing Online Features.
General Search and Download Process.
Managing Downloaded Files.
Searching for and Downloading Books.
Looking Through Online Bookshelves.
Searching for and Downloading Magazines.
Searching for Books from the Classic Literature CD.
Obtaining News from Kurzweil.
Obtaining Kurzweil Product Updates.
Kurzweil 1000 Online Features

The main objective of Kurzweil 1000 online features is to provide you with direct access to up-to-date material from a variety of sources. Kurzweil 1000 online access is easy, central, and virtual. Without leaving your computer, Kurzweil 1000 lets you get a wide range of electronic text, such as the following:

Books and electronic text from free and subscription-based digital library Web sites, and from the free Kurzweil 1000 Classic Literature CD.

Lists of most or all of the items available from a digital library.

Magazines from free and subscription-based Web sites.

Articles from online encyclopedias.

Note: Although the Use an Encyclopedia feature is in the Online menu, its details are in Chapter 6, Reference Tools.

News from Kurzweil Educational Systems Inc.

Translations find details about this feature in Chapter 6, Reference Tools.

Updates for the Kurzweil 1000 product as they become available from Kurzweil Educational Systems Inc. You can keep the material download for your personal use, have Kurzweil 1000 read it and/or convert it into portable formats. For more information about portable file formats, go to Chapter 14, File Portability.

The next few subsections provide general information and procedures that are common to all online search and download functions, including file management for downloaded files. In later subsections, you’ll find instructions specific to each type of search.
Chapter 15. Online Material

Your Internet Connection

The first requirement for online access from Kurzweil 1000 is an Internet connection. The speed with which you are able to search and download material depends on the type of connection you have. For instance, accessing the Internet on a T1 connection at work would be markedly faster than having a telephone line.

If you are using a dial-up connection, you should connect to the Internet before you attempt to use these features.

Live Web Sites

When you request an online search, you are reaching live Web sites. While many sites included on the Sites list in the Search Online Books dialog (ALT+N+S) are available to anyone, some sites provide material only to those who are eligible and registered with the appropriate organizations.

From time to time, Kurzweil Educational Systems adds new Web sites. The following are sample Web sites that are part of the list Kurzweil 1000 uses. For a complete list, go to Appendix C, Searchable Web Sites.

Bookshare, at www.Bookshare.org, is an online book-sharing community that provides its members with access to copyrighted, scanned books on a subscription basis. Also, just after this selection on the Sites list, is the related Bookshare.org New Books, which lets you search for new Bookshare.org releases.

Project Gutenberg, at www.gutenberg.net, is an online repository of electronic text and books.
Web Braille. When you use the online magazine or online book search features, you are searching the Web Braille Web site, a service of the Library of Congress. Eligible individuals and institutions have access to electronic text from a variety of sources that the service has put into Braille format. The Web Braille site is password protected.

Guidelines for Using Online Material

Kurzweil Educational Systems provides online access as a convenience to and as a source of enjoyment for customers, but keep in mind that the material you download should be used within the guidelines of copyright laws.

Accessing Kurzweil 1000 Online Features

Online options and commands are accessible only through the menu interface.

The Online menu is located to the right of the Tools menu in the Kurzweil 1000 menu bar, and contains selections that enable you to search for books and magazines, text from the Classic Literature CD, as well as for news from Kurzweil Educational Systems and for Kurzweil 1000 product updates.
General Search and Download Process

Selecting a search from the Online menu opens a Online Search dialog. Each type of search has its own Search dialog with unique options as well as common elements that they all share. Refer to the last several sections in this chapter for specific details about each Search dialog.

While the system performs the search, the Online Status dialog provides you with ongoing audible status.

The Online Status dialog contains five components:

- **Status** box (mnemonic ALT+S) announces the status when Kurzweil 1000 completes searching the first site and then again after the last site, or when there’s an error. You can press any key during the search process to hear the current status.

- **Items available for download** box (ALT+I) follows. When the search is complete, a checkbox list of books available for downloading is presented in this box. Use the UP/DOWN ARROW keys and the SPACEBAR to select any number of items.

  You can also search the list of books by pressing CONTROL+F. In the find dialog that opens, type in a word or partial word, then press ENTER to search the list. Kurzweil 1000 reads the first item it finds. Press F3 to hear the next matching item, and SHIFT+F3 to hear the previous matching item.

- **Search Again** (ALT+A) is active only if you have chosen not to download any items. Choose this command to go back to the Online Search dialog with the selections and entries you just used for this search.

- **OK** and **Cancel**. You can also use the ENTER key to OK the download. When you OK a download, Kurzweil 1000 downloads
the materials in the background so that you can continue to use other functions and applications.

You can download multiple files. If there are multiple file formats, you can select the format you want. This is especially helpful for downloading Braille versions of BookShare documents.

Once downloaded, you can open and read the file or files.

Notes:

- Certain sites, like Bookshare.org, are subscription- or member-based, and require a user name and password when downloading and opening files.

- Bookshare.org also grants institutional accounts. With this type of account, an employee of the institution logs on, and downloads books on behalf of members, such as students. Each downloaded book needs to be associated with the member who gets it.

  If you log onto Bookshare with an institutional account and attempt to download a book, Kurzweil 1000 asks you to select the appropriate member from a list of members associated with the account.

Unexpected Search Results

If you don’t get the results you expected, or nothing is found, check your search parameters and try another search strategy. It could also be that the material you are looking for is not available at the site(s) you specified.

Also, because the Web sites are live, you may encounter problems when they change their content.
Exiting Kurzweil 1000 During a Download

If you try to exit from Kurzweil 1000 while a download is in progress, you’ll hear a warning. If you continue, Kurzweil 1000 stops the download.

Managing Downloaded Files

You can find downloaded files in the Download folder in the Kurzweil Educational Systems folder, or you can automatically open files you have recently downloaded.

Opening Downloaded Files

1. Open the File menu and choose Open or press ALT+F+O. Kurzweil 1000 asks if want to open the recently downloaded file or files.

2. Press ENTER.

Notes:

If you want to open an older downloaded file, find it in the Download folder.

Depending on the size of the file, it may take a few minutes to open. If you are opening an encrypted Bookshare.org document, the system asks you to enter your password again.

It’s a good idea to rename the downloaded files after you open them and place them in another folder. Consistently organizing your files can help you find them quickly at a later time.
Using Online Cache to Store and Update Site Access

For some Web sites, Kurzweil 1000 downloads a complete list of the site’s contents when you begin a search. You can specify how frequently the program refreshes that list. A frequent refresh of a site’s contents guarantees your access to new materials on the site. However, it can slow down your search time.

**Online Cache** is available in the **Configuration Settings** tab page. You can request Kurzweil 1000 to perform the cache function **Always**, or if the list is older than **7 Days** or **30 Days**. The default is 7 days.

**To configure the online cache option:**

1. Open the **Settings** menu and select **Configuration**.
   The **Configuration Settings** tab page opens.
2. Use the **TAB** key or **ALT+C** to go to the **Online Cache** list box.
3. Use the **UP/DOWN ARROW** keys to select **7 Days**, **30 Days** or **Always Refresh**.
4. Press the **ENTER** key.
Searching for and Downloading Books

To access the **Online Search for Books** dialog, do one of the following:

- Open the **Online** menu and choose **Search for Books**.
- Or press **ALT+N+S**.
- Or press the **ENTER** key as this is the default menu selection.

**The Online Search for Books Dialog**

The **Online Search for Books** dialog contains the following components along with the **OK** and **Cancel** commands:

- **Search** list box (mnemonics **ALT+S**) lets you indicate search by **Title** or by **Author**.

- **Contains** combo box (**ALT+C**) in which you type the title or author name.

Depending on what you chose in the **Search** list box (**Author** or **Title**), the box also contains a list of up to either your last ten Author or Title searches. Use the **UP/DOWN** arrows to retrieve a name or title from the list.

- A list box from which you can select the conjunction **and** or **or** to combine conditions to help you hone in your search. Go to the subsection **Performing Complex Searches and Refining Searches** for more information.

- Another **Search** list box with another **Contains** text box below it for your combination search. These two boxes are available only when you specify a conjunction.

- **Query** text box (**ALT+Q**). When you finish specifying your search parameters, they appear in this box and you'll hear the contents. You can edit the contents of this box to refine your search and
perform power searches. Go to the subsection *Refining Searches and Performing Complex Searches* for details.

**Sites** box (ALT+T) lists available Web sites for your search. Each item has an associated check box.

By default, all sites are checked. To check or uncheck an item, use the UP/DOWN ARROW keys to go to the desired one, then press SPACEBAR. Kurzweil 1000 uses the message voice for checked items, and the reading voice for unchecked items. Pressing CONTROL+Y lets you hear whether or not an item is checked.

You can use the **Save Settings** feature to save your preferred search sites. For example, if you know you don’t want to search the Baen site every time, you can deselect it, save and load the setting to eliminate the need to deselect it each time you run a search.

**Performing a Simple Search for Books**

1. Open the **Online Search for Books** dialog.
2. Specify whether you want to search by title or author in the **Search** list box.
3. Type all or part of the title or author in the **Contains** combo box.
4. TAB to the **Sites** checkbox list.
5. Press the **SPACEBAR** to uncheck the Web sites you don’t want to search. By default all the sites are checked.
6. Press **ENTER**.

The **Online Status** dialog opens. As Kurzweil 1000 searches the sites based on your search condition, you’ll hear the status. When the search is finished, available books you can download appear in the **Items available for download** checkbox list, and your cursor is now in the first item of the list.
7. Use the **UP/DOWN ARROW** keys to navigate the list and the **SPACEBAR** to select each desired item when you hear its name.

You can also search the list of magazines by pressing **CONTROL+F**. In the find dialog that opens, type in a word or partial word, then press **ENTER** to search the list. Kurzweil 1000 reads the first item it finds. Press **F3** to hear the next matching item, and **SHIFT+F3** to hear a previous match.

To get more information about any item in the list, press **F7**.

8. Choose the **OK** command.

   Kurzweil 1000 downloads the materials in the background and lets you know when the download is complete.

9. If the book you selected to download is from the Bookshare.org Web site, and this is the first time you are requesting to download from the site during this work session, a dialog appears requesting your user name and password. If you are not a member of Bookshare.org, you will not be able to download the book.

   Certain books from Baen Books also require prior registration with the Web site. In those instances, Kurzweil 1000 asks for your user ID and password before downloading.

   The mnemonic, **ALT+U**, takes you to the user name text box; **ALT+P** to the password text box. When typing in your password, the system voice echoes each character with "asterisk."

   **Note:** You can save the user name in a settings file to save time. Go to *Saving Your Settings* in Chapter 12, *Working with Settings* for details.

10. **OK** or **Cancel** the download.
Performing Complex Searches

Performing searches can be a bit of an art. To get the results you want, you very often have to refine your search. There are two ways you can do this: by using combined conditions and/or by specifying a complex query.

Using Combined Search Conditions

Following are examples of combinations of search parameters that you can use in the Online Search for Books dialog:

Part of a title and/or another part of a title. Suppose all you remember are the words "adventures" and "Crusoe" in the title and cannot recall the author. By specifying "adventures," selecting the conjunction "and," then specifying "Crusoe" also for the title, you should get results with "The Further Adventures of Robinson Crusoe by Daniel DeFoe" in the list.

Part of a title and/or part of an author's name. What if you remember a book by Oliver Wendell Holmes and its title contains the word "breakfast?" By specifying "breakfast" as part of the title, selecting the conjunction "or," then entering "holmes" for the author, you would get a list of books by Holmes with the word "breakfast" in their titles.

Part of an author's name and/or part of another author's name. If you remember only the authors' names but not the book they wrote, you can specify one of their names; try "jackman." Select the conjunction "and." Then specify the other author's name, "russell." The results would include the title "Flying Machine."
Using Complex Queries

In the Online Search for Books dialog, the Query text box follows the second set of title and author boxes. You can use ALT+Q to go directly to it.

Whatever you specified in the simple or combined conditions in the Online Search dialog appears in the Query area.

You can edit the text already in the Query area or bypass the other conditions and type your complex query directly into the Query box, following the correct syntax.

Kurzweil 1000 query syntax is subject-verb-object. The subject is either "title" or "author." The verb is always "contains." The object is the text string you provide. Kurzweil 1000 presents the object within quotation marks.

Complex queries are strings of combined conditions in this syntax. To combine the conditions, you use the conjunction "and," which you denote with the ampersand character (SHIFT+7 keys), and the conjunction "or," which you denote with the vertical line (SHIFT+\ keys).

An example of a complex query is:

```
title contains "A" & title contains "B" & author contains "X" | author contains "Y"
```
Looking Through Online Bookshelves

Access to Online Book Repositories has always been through a search mechanism, but sometimes it’s nice to simply look through a list of all of the available items. This can be done with most, but not all, repositories.

About the Look Through Bookshelves Dialog

The Online Search for Books dialog contains the following components along with the OK and Cancel commands:

Sites list box (mnemonic ALT+T) presents most of the Web sites for online books, as well as the Classic Literature CD. But unlike other Kurzweil 1000 Web site lists, you can choose only one site.

Status box (ALT+A) provides progress on the process.

Items available for Download (ALT+I) is a checkbox list, sorted by title then author.

Sort by list box (ALT+S or the shortcut CONTROL+S) lets you re-sort the list between Title and Author.

To view and download a bookshelf:

1. Do one of the following:

   Open the Online menu and choose Look through the Bookshelves.

   Or press ALT+N+L.

   This opens a dialog. The cursor is in the Sites list box.

2. Use the UP/DOWN ARROW keys to select one site.

3. Press ENTER to start the download.
Kurzweil 1000 tells you the progress of building the bookshelf. To hear this message again, press \texttt{ALT+A} to go to the Status box.

When Kurzweil 1000 is done building the list of files available for download, it reads the first item in the list. Each item has a checkbox.

4. Use the \texttt{UP/DOWN ARROW} keys to go through the list, or press a letter key to go to the items beginning with that letter. Use the \texttt{Spacebar} to select a particular item for download, or to deselect an item that has already been selected. Use \texttt{F7} for more information.

You can also search the list by pressing \texttt{CONTROL+F}. In the Find dialog that opens, type in a word or partial word, then press \texttt{ENTER} to search the list. Kurzweil 1000 reads the first item it finds. Press \texttt{F3} to hear the next matching item, and \texttt{SHIFT+F3} to hear a previous match.

\textbf{Note}: The list is initially sorted by title, and the text for each item contains the title, and then the author. If you prefer to sort the list by Author, press \texttt{CONTROL+S}. The list resorts. The text for each item changes to author followed by the title. Any item you have checked remains checked, and the item that is currently selected remains selected. The \texttt{CONTROL+S} shortcut toggles between sort by Title and Author.

5. When you are done, press \texttt{ENTER} to download the selected file or files.
Searching for and Downloading Magazines

To search for magazines:

1. Open the Online menu and choose Search for Magazines or press the mnemonics ALT+N+M.

   This opens the Online Search for Magazines dialog which contains seven components, along with the OK and Cancel commands.

2. In the Title Contains combo box (ALT+C), type part or all of a title.

   The box also contains a list of up to ten words from prior searches. Use the UP/DOWN arrows to retrieve a word or phrase from the list.

3. In the From list (ALT+F), select the starting month for the searches.

4. TAB to the next box in which you type the starting date’s year.

5. In the To list (ALT+O), select the ending month for the search.

6. TAB to the next box in which you type the ending date’s year.

7. When you finish specifying your search parameters, they appear in the Query text box (ALT+Q) and you’ll hear the contents.

8. In the Sites list box (ALT+T) find the available Web sites for your search. Each item has an associated check box.

   By default, all sites are checked. To check or uncheck an item, use the UP/DOWN ARROW keys to go to the desired one, then press SPACEBAR. Pressing CONTROL+Y lets you hear whether or not an item is checked.
9. When you are ready to download, press ENTER. To cancel, press ESCAPE.

Kurzweil 1000 returns a list of available magazines. Use the space bar to select the files you want to download.

You can also search the list of magazines by pressing CONTROL+F. In the Find dialog that opens, type in a word or partial word, then press ENTER to search the list. Kurzweil 1000 reads the first item it finds. Press F3 to hear the next matching item, and SHIFT+F3 to hear the previous matching item.

**Searching the Classic Literature CD**

The Classic Literature CD Version 4 contains a collection of electronic texts including literary classics, historical documents and religious texts. You can search for a specific book or author from this CD in much the same way as searching for books from Web sites. The dialog you use is nearly identical to the Search for Books dialog, except that the Web site list and combination searches are not available.

**To search for books on the CD:**

1. Place the CD in your PC’s CD drive.

2. Open the Online menu and choose Search the Classic Literature CD (ALT+N+C).

   The Search the Classic Literature CD dialog opens with the cursor in the Search list box.

3. Use the UP or DOWN ARROW key to specify search by Title or Author. To go back to the Search list box, use ALT+S.

4. In the Contains combo box (ALT+C), type the author’s name or title in whole or in part.
Your query appears in the **Query** text box.

If you want to type a query or edit one, press **ALT +Q** to go to the **Query** text box.

Depending on what you chose in the **Search** list box (**Author** or **Title**), the box also contains a list of up to either your last ten Author or Title searches. Use the **UP/DOWN ARROW** keys to retrieve a name or title from the list.

5. When you’re done, press **ENTER**.

Kurzweil 1000 returns a list of available books. As in searching for books from Web sites, use the space bar to select the files you want to download.

You can also search the list of books by pressing **CONTROL+F**. In the Find dialog that opens, type in a word or partial word, then press **ENTER** to search the list. Kurzweil 1000 reads the first item it finds. Press **F3** to hear the next item, and **SHIFT+F3** to hear a previous item.

Automatic concatenation occurs when there is more than one chapter or section in a book, or when a file is especially long, and the chapters or sections have been placed in separate files on the CD. Kurzweil 1000 links these files together in sequential order, allowing you to read them in correct order through the chapters or sections when you open them.

**Notes:**

- When searching for books on the CD, Kurzweil 1000 looks for the CD in the first CD drive on your system. If it is unable to locate the CD there, it asks if you want to specify a different location. If you know the exact location, press **Y** for Yes to open the File dialog; here you can navigate and select the location. If
you press N for No, the system prompts you to insert the CD and try again.

• It’s possible to copy the contents of the CD to your hard drive, making it easy for Kurzweil 1000 to find every time.

• You can save the location in a settings file, eliminating the need to tell Kurzweil 1000 where to find the CD; the system will automatically know where to look.

Obtaining News from KESI

News from KESI is a convenient way to read company announcements and articles of interest to the Kurzweil 1000 user community, among other information.

To download news from KESI:

1. Open the Online menu and select News from KESI or press ALT+N+N.

   The Online Status dialog opens.

2. Select from the list of available news items, then press ENTER to download.

3. If no news is available, you can opt to read older items by exiting the dialog and pressing ENTER.

   The Online Status box opens again with a list of older items, sorted by date with the most recent article at the top of the list. Select from this list.
Obtaining Kurzweil Product Updates

From time to time, Kurzweil Educational Systems provides eligible customers with product updates and patches. From the Online menu, it’s possible to automatically apply a product patch that you select and download directly from the company Web site.

To download product updates from Kurzweil:

1. Open the Online menu and select Updates or press ALT+N+U. The Online Status dialog opens.
   In the Items available for download checkbox list, you’ll find product patches and information applicable to the version of Kurzweil 1000 you are running.

2. Select from the list, then press ENTER to download.

3. Once the download completes, exit the Kurzweil 1000 program at your convenience to automatically apply the patch.
A: Kurzweil 1000 Applications

This chapter contains the following topics:
Applications from the Launch Menu.
Launching and Exiting Applications.
Help in Applications.
Navigating in Applications.
Appointment Calendar.
Calculator Application.
Photocopier Application.
Fax Application.
Managing Your Applications with the Launch Menu.
Working with Applications You’ve Added.
Applications from the Launch Menu

There are many applications you may find that complement the Kurzweil 1000 program. Kurzweil 1000 includes several easy-to-use ones: an Appointment Calendar, a set of Calculators, a Photocopier and FAX.

You can also add applications from other sources. Go to the sections, *Working with Launch Utilities* and *Working with Applications You’ve Added*, in this chapter for more information.

**Note:** Kurzweil Educational Systems supports only those add-on applications that we supply.

Launching and Exiting Applications

The commands for applications are in the *File* menu under *Launch*.

To launch an application:

Open the *File* menu and choose *Launch* (ALT+F+L), then select the desired application:

**Appointment Calendar** (mnemonic A).

**Calculator** (mnemonic L).

**Photocopier** (mnemonic P).

**FAX** (mnemonic X).

If you’ve added other applications, their names also appear here.

To exit an application:

Press ALT+F+X.
Help in Applications

All add-on applications developed by Kurzweil Educational Systems have a Help menu in the application window’s menu bar. From the Help menu select About (mnemonics ALT+H+A).

You can navigate around this Help document with the usual ARROW, HOME, END, PAGE UP/DOWN keys. The F5 key lets you resume reading where you left off.

To hear more about any control in the application, go to the control and press F1.

To hear the currently selected item in a list box, or the contents of a text box, press F7.

You can repeat any message announced by an application by pressing SHIFT+F2.

Navigating in Applications

You can navigate among the controls in applications by pressing TAB, SHIFT TAB, or by using shortcut keys, if available. To select an item in a list, use the UP/DOWN ARROW keys. To select a checkbox item, press SPACEBAR. The ALT key takes you to the menu bar.
Appointment Calendar Application

The Kurzweil Appointment Calendar is a simple-to-use application that allows you to create and receive appointment reminders. Once you have launched Appointment Calendar and have created your appointments, reminder dialogs display at the specified dates and times, alerting you to the up-coming event. You will also be able to find the application in the Windows Task Tray. By using the Right-Click method in the Windows Task Tray, you can access the following Appointment Calendar commands and features: Show or Hide the application, New Event, Preferences, Help and Exit.

The Appointment Calendar application also provides a set of templates, such as Anniversary, Appointment, Birthday and Phone Call, which have appropriate default options already selected, making it easy to quickly create similar events. For details, go to the section entitled, The Add and Edit Dialog Boxes.

To launch the application and open the main application window:

There are two ways to launch the Appointment Calendar application. You can select Appointment Calendar from the File Launch submenu, mnemonics ALT+ F+L+M, or use the shortcut keys CONTROL+ALT+A. This opens the main application window.

Note: it's possible to change this default shortcut in the Tools Preferences dialog; go to Assigning a Hot Key for Launching Appointment Calendar.

After you launch this application, it continues to run in the background automatically every time you restart your computer, if there are appointments.
To close the main window without stopping the application:

Use the **ESCAPE** key.

To stop the application from running:

From the **File** menu, choose **Exit** or use the mnemonics **ALT+F+X**. Bear in mind that once you exit the application, you will not be able to get reminders until you start the application again. You can also use the Right-Click method and choose **Exit**.

**The Main Appointment Calendar Window**

When you launch the Appointment Calendar application, the main window displays. If there are existing events, Kurzweil 1000 announces the selected event's name, time and date.

Like the other Kurzweil 1000 applications, the window contains three menus: **File**, **Tools**, and **Help**. From the **File** menu, you can **Add**, **Edit**, **Delete**, **Close** the window without stopping the application, and **Exit** which closes the window and stops the application. The **Tools** menu contains two items: **Preferences** which lets you set the **Startup Hot Key** option and **Select Notify Sound** which enables you to select sound files from your system for the reminders.

**The Add and Edit Dialog Boxes**

The **Add** and **Edit** dialog boxes contain several lists, boxes and other controls: **Name**, **Recurrence**, and **Comment** boxes, the **Remind** before the event check box, the minutes before reminder list and box, and the **OK** and **Cancel** buttons. Depending on the type of Recurrence, the dialogs present additional check boxes, text and list boxes for **Time**, **Month**, **Date**, **Week** day.
Within the Add or Edit dialog box, you can use the following shortcuts for navigation and to obtain information.

- To go to the Name combo box, press ALT+N. This box lets you type a name for the event as well as provides a list of templates from which you can choose a type of event that is closest to the event you want to create. Find the complete list of templates at the end of this subsection.
- To go to the Recurrence list, press ALT+R. The list of Recurrence includes: One Time, Daily or Weekly, and Monthly or Yearly.
- To go to Time, press CONTROL+H.
- To go to Date, press ALT+D.
- To go to Recurrence information, press CONTROL+E.
- To go to the Comment text box, press ALT+T.
- To go to the Reminder option, press CONTROL+R.
- To hear the current time and date, press CONTROL+T.
- To hear the selected event time and date, press CONTROL+D.
- To hear the selected event comment, if any, press CONTROL+M.

The templates that are accessible from the Name combo box are:

- Anniversary: This selection has the Monthly or Yearly Recurrence setting.
- Appointment: This selection has the One-Time Recurrence setting.
- Birthday: This selection has the Monthly or Yearly Recurrence setting.
• Daily Event: This selection has the Daily or Weekly Recurrence setting.
• Holiday: This selection has the Daily or Weekly Recurrence setting.
• Meeting: This selection has the One-Time Recurrence setting.
• Monthly Event: This selection has the Monthly or Yearly Recurrence setting.
• Phone Call and Reminder have the One-Time Recurrence setting.
• Weekly Event: This selection has the Daily or Weekly Recurrence setting.
• Yearly Event: This selection has the Monthly or Yearly Recurrence setting.

Creating, Editing and Deleting Appointments

There are two ways of accessing the Add and Edit Event dialogs. You can:
• You can use the Right-Click method to choose New Event for adding a new event, or Show and Select for editing an existing event.
• You can also use the menu method as presented in the next procedure.
To add or edit an event:

1. Open the main Appointment Calendar window by using the default shortcut keys CONTROL+ALT+A, or hot keys that you may have set.

   The cursor is in the Events box.

2. Do one of the following: press CONTROL+N to Add a new event, or press CONTROL+E to Edit an existing event.

   The Add Event or Edit Event dialog opens, and the cursor is in the event Name box.

3. If you are adding an event, use the UP/DOWN ARROW to go through the list of templates and select the one that is most similar to the type of event you want to create.

4. Specify, enter or change the appropriate information.

5. Press ALT+O to OK.

6. When you are done, close the main Appointment Calendar window by pressing the ESCAPE key.

To create a new event by copying an existing one:

1. Open the main Appointment Calendar window by using the default shortcut keys CONTROL+ALT+A, or hot keys that you may have set.

2. Use the UP/DOWN key to find the event you want to copy, and press CONTROL+C.

3. Press the ENTER key to edit the duplicate event.

   The Add Event or Edit Event dialog opens, and the cursor is in the event Name box.

4. Rename the event and change the appropriate information.
5. Press ALT+O to OK.
6. When you are done, close the main Appointment Calendar window by pressing the ESCAPE key.

To delete an event:
   Select it from the Events list in the main Appointment Calendar window, then press the DELETE key to remove it.

Working with the Reminder Dialog
   When you get a reminder, the Reminder dialog opens and Kurzweil 1000 tells you the event name, the event details, if any, and the event time. To hear the message again, press F7.

   In the Reminder dialog, there is a Remind Again check box, which is unchecked by default. Somewhat akin to the "Snooze" button on your clock alarm, you can check the Remind Again box, then select the timeframe, minutes, hours, or days, in which you want to be reminded again. If you OK without checking the Remind Again box, Kurzweil 1000 removes it from the event list if it's a one time event. If it's a repeating event, the event will stay in the list and the reminder will occur again based on your specifications.

Appointment Calendar Preferences
   The Appointment Calendar Preferences dialog is accessible from the Tools menu, mnemonics ALT+T+P, or by using the Right-Click method and selecting Preferences. There is one item in the Preferences dialog: Hot Key option enables you to reset the default CONTROL+ALT+A for opening the main application window to another letter key in the list.
Calculator Application

The Calculator application is accessible from the File Launch menu (mnemonics ALT+F+L+L). This application provides several types of calculators: Scientific, Statistics, Standard, and Business.

Important: Before using any calculator, please read its Help file for in-depth information about its usage and, in the case of the Business Calculator, for example problems with extensive step-by-step procedures. And remember, at any time, you can obtain details about any function or button in a calculator by pressing the F1 key.

The General Calculator Window

All Calculator windows consist of the File, View, and Help menus. They also contain a number of controls, as well as operation and number buttons.

The File menu allows you to Exit from the application and return to the main Kurzweil 1000 window.

The View menu lets you select the calculator you want: Scientific, Statistics, Standard, which is the system default view, or Business.

From the Help menu, you can access About KESI Calculator Application. Select Calculator hot keys for a list of hot keys you can use within the application. When you are using the Scientific calculator, there is a third option in the Help menu, Calculator Inverse Functions, which lists inverse functions.

When you first access a Calculator window, Kurzweil 1000 tells you which calculator is open. The cursor is in the Current Value box, and Kurzweil 1000 announces the current value. This could be the last number entered, or the result of a calculation or an operation.
Below the Current Value box, each calculator has its own set of functions, buttons and number buttons, and each control has a hot key. However, the Scientific, Standard and Business calculators contain the following standard functions:

**Backspace.** Its hot key is BACKSPACE.

**CE** for Clear Entry. Hot key is DELETE.

**C** for Clear All. Hot key is ESCAPE.

**MC** for Clear Memory. CONTROL+L.

**MR** for Return Memory. CONTROL+R.

**MS** for Store Memory. CONTROL+M.

**M+** for Add to Memory. CONTROL+P.

**Note:** Settings, such as Reading Speed, are not adjustable in the Calculator application.

**General Procedures**

**To display a calculator:**

Do one of the following:

Press **ALT+V** for the View menu, then select **Scientific**, **Statistics**, **Standard**, or **Business**.

Or use the shortcut key for the desired calculator:

**F5** for Scientific.

**F6** for Statistics.

**F8** for Standard.

**F9** for Business.
Note: The calculator you last displayed is the calculator that opens when you next launch the application.

To obtain Help, use the following mnemonics or shortcuts:

ALT+H+A for About KESI Calculator Application.

F3 for a list of all the hot keys.

In the case of the Scientific calculator, F4 for a list of Inverse Functions.

F1 with your cursor on a control to hear its function or operation.

To hear the Current Value:

Press CONTROL+V.

To execute an operation:

TAB to its button and press ENTER or press its hot key.

The Standard Calculator

With the Standard Calculator, you can perform basic arithmetic operations. In addition to the Current Value box and operations buttons, its window contains the following:

- A read-only History text box that logs your current calculations. You can clear the history by using the Clear All button.
- Buttons for standard functions. For a list of standard functions, go to the section, Working with the General Calculator Window.
Procedures for the Standard Calculator

You can use the following Standard Calculator procedures in the Business and Scientific Calculators as well.

To perform a unary operation:

Enter the number to be acted on followed by the operator. Unary operators include: square root, percentage and plus/minus.

To perform a binary operation:

Enter the first number, the operator, and then the second number. Binary operators include: plus, minus, multiply, and divide.

To choose a memory function:

To **Clear Memory** press **CONTROL+L**.
To Return Memory press **CONTROL+R**.
To **Store Memory** press **CONTROL+M**.
To **Add to Memory** press **CONTROL+P**.

To Clear All:

Press the **ESCAPE** key. **Note:** This function is not available in the **Statistics** calculator.

To modify entries or operations:

To remove the most recently entered numbers digit by digit, use the **BACKSPACE** key.
To **Clear Entry** use the **DELETE** key.
To **Clear All** use **CONTROL+DELETE** or the **ESCAPE** key. This clears all the operations except the value in memory. **Note:** In the
Statistics calculator, these two shortcut keys are not available; use the Clear button to clear the data list.

The Scientific Calculator

The Scientific Calculator enables you to perform basic scientific, inverse, hyperbolic and trigonometric functions, as well as number-base calculations.

In addition to the Current Value box, the Scientific Calculator window contains the following items, presented in the order in which Kurzweil 1000 announces them when using the TAB key.

**Inverse** function checkbox. Its hot key is **CONTROL +I**.

**Hyperbolic** function checkbox (**CONTROL +H**).

**Number Base** list (**CONTROL +B**). Select a number base of **Binary**, **Octal**, **Decimal**, or **Hexadecimal**. When you change the Number Base, the number in the Current Value box immediately reflects the new-base value. The default Number Base is Decimal.

**Trig Mode** list (**CONTROL +T**). Select a mode of **Degrees**, **Radians**, or **Gradiens**. The mode affects the calculation of the trigonometric functions: sine, cosine, and tangent. The default is Degrees.

The remaining buttons are Scientific functions, and standard memory and arithmetic functions.
Procedures for the Scientific Calculator

The Scientific and the Standard calculators share a number of procedures. To find the steps for choosing a memory function or modifying entries or operations in the Scientific calculator, go to Procedures for the Standard Calculator.

To perform a unary operation:
Enter the number to be acted on followed by the operator. Unary operators include: square root, plus/minus, reciprocal, int, sine, cosine, tangent, not, factorial, x squared, x cubed, log, natural log, scientific notation, e to the x, exponent and rand.

To perform a binary operation:
Enter the first number, the operator, and then the second number. Binary operators include: plus, minus, multiply, divide, and, or, x or, modulo, x to the y and left shift.

The Statistics Calculator

The Statistics Calculator allows you to run statistics, such as Count, Sample Standard Deviation, and Population Variance, on a set of data that you either enter or import. In addition, you can calculate statistical reliability using KR20 and KR21. You may also perform dependent/independent t-value calculations using two data lists. The critical value for "t" will be calculated as well if you specify the degrees of freedom and the alpha level.

In the Statistics Calculator window, you'll find below the Current Value box, the following items presented in the order in which Kurzweil 1000 announces them when using the TAB key.
**Data List** box. Hot key **CONTROL +D**. Store and display the numbers in a data set.

**Ignore** checkbox (**Control +Z**). Ignore or use data points of zero.

**Add**. Hot key **A**. Add a number to the Data List.

**Remove**. Hot key **R**. Remove a selected number from the Data List.

**Clear**. Hot key **L**. Remove all the data list entries.

**Run**. Hot key **U**. Hear the statistical results of the current data set. The statistics results include the Count, Sum, Mean, Median, Maximum, Minimum, Range, Mode, Sample Variance, Sample Standard Deviation, Population Variance, and Population Standard Deviation.

Next are the standard **Backspace** and **Clear Entry**. Number buttons follow **Clear Entry**.

**Procedures for the Statistics Calculator**

**To enter data:**
1. Place your cursor in the **Current Value** box.
2. Enter a number.
3. Press **A** to add the number to the **Data List**.
4. Continue until you have entered the complete data set.

**To Import a data set:**
The file format for data you want to import should be text (.txt) format. The file should contain numbers only and each data point should be separated by a carriage-return.

1. Open the **File** menu and choose **Import Data List**.
2. In the **File** dialog, navigate to and select the desired text file.

3. Press **ENTER**.
   The data set is now in the **Data List** box in the Statistics Calculator window.

**To move from one data list item to another:**
Use the **UP** or **DOWN** key.

**To Remove any item in the list:**
Select the item in the list, then press **R**.

**To Run the data set you just entered:**
Press **U**.
A Statistics Result window appears and Kurzweil 1000 immediately begins reading the results. Use the **HOME**, **END**, **PAGE UP** and **PAGE DOWN** keys to navigate among the results. Press the **F5** key to read from the current cursor position.

**To Clear a data set:**
Press **L**.

**The Business Calculator**
With the Business Calculator you can find answers to a variety of financial problems such as monthly loan payments, annuity rates, amortization schedules, and discounted cash flows.

This calculator offers Five Basic Financial Registers: Number of Periods, Interest Rate, Present Value, Payment Per Period, and Future Value.
In the Business Calculator window, you'll find the Current Value box. Numbers are formatted using two decimal places.

Listed below are items that follow the Current Value box and are presented in the order in which Kurzweil 1000 announces them when you use the TAB key.

**Simple Interest Basis** list box. Hot key CONTROL+B. Select 360 or 365 days.

**Payment Mode** list box (CONTROL+T). Select End or Begin.

**Odd Period Interest** list box (CONTROL+D). Select Compound or Simple.

The Five Basic Registers follow: **Number of Periods**, hot key N. **Interest Rate**, hot key I. **Present Value**, hot key P. **Payment Per Period**, hot key T and **Future Value**, hot key F. Entering number(s) and pressing one of these register keys stores the number in that register. To calculate the numbers you enter, you must press hot key K.

Additional Registers and calculation functions follow:

**Begin Date**. Hot key G. Store a calendar date as the beginning of a period. Enter Month followed by a decimal, then day and year.

**End Date**. Hot key E. Store a calendar date as the end of a period. Enter Month followed by a decimal, then day and year.

**Days in Between**. Hot key W. Calculate the number of days between two given dates.

**Bond Price**. Hot key is the dollar sign. Calculate bond price.

**Yield to Maturity**. Hot key Y. Calculate yield to maturity.

**Cash Flow Index**. Hot key J. Recall the index of the cash flows entered.
Number of Consecutive Cash Flows. Hot key Q. Store the number of consecutive cash flows.

Cash Flow Zero. Hot key O. Store initial investment as a negative number.

Cash Flow J. Hot key H. Store cash flows occurring at regular intervals.

Net Present Value. Hot key V. Calculate net present value.

Internal Rate of Return. Hot key U. Calculate internal rate of return.

Simple Interest. Hot key S. Calculate simple interest.

Date. Hot key D. Calculate past or future date.

Percent of Total. Hot key is the exclamation point. Calculate percent.

Percent Difference. Hot key is the pound sign. Calculate percent difference between two numbers.

Declining-Balance Depreciation. Hot key B. Calculate depreciation using the declining-balance method.

Straight-Line Depreciation. Hot key A. Calculate depreciation based on straight-line method.

Sum-of-the-Years Depreciation. Hot key C. Calculate depreciation using the sum-of-the-years method.

Amortization. Hot key Z. Calculate amount applied toward principal and toward interest from a single or multiple loan payment(s).

Exchange. Hot key X. Hear associated values for a certain financial operation.
Multiply by Twelve (CONTROL+N). Multiply a given number by twelve.

Divide by Twelve (CONTROL+I). Divide a given number by twelve.

Store (CONTROL+O). Modify a cash flow amount in the Cash Flow J index.

Recall. Hot key L. Recall any value in any register.

Calculate. Hot key K. Calculate the value of any of the Five Basic Registers.


**General Procedures for the Business Calculator**

In the Business Calculator, there are a number of Standard Calculator procedures you can perform. To find the steps for choosing a memory function or modifying entries or operations, go to *Procedures for the Standard Calculator*.

**The general procedure for using the Business Calculator:**

1. Clear the Register by pressing CONTROL+F.
2. Enter or store a number.
3. Specify the desired Register.
4. Repeat Steps 2 and 3, where appropriate.
5. Calculate. You can do this in one of two ways:
   - If you are using one of the Five Basic Registers, press the hot key K, followed by the desired Register hot key.
   - Otherwise, press a desired calculation-based hot key.
To recall the number(s) stored in a register:

Press L for Recall, then press the hot key for the desired register.

To enter consecutive cash flows of equal amounts:

1. Enter the cash flow, press the cash flow hot key J.
2. Enter the number of times to repeat this amount.
3. Press Consecutive Cash Flow hot key Q.

To store cash flows occurring at regular intervals:

Enter the amount of a cash flow followed by the hot key H. Repeat until the last cash flow.

To modify a cash flow amount in the Cash Flow index:

1. Enter the desired index by pressing hot key O.
2. Enter the new amount.
3. Press CONTROL+O, followed by O.

Photocopier Application

The Photocopier application scans a page, then copies and prints it in whatever quantity you specify, eliminating the need to stand at a physical photocopier.

The general steps for using this application are: launch the application, set the Photocopier options, set the printer options, then make copies. If you set many of the options the first time you launch this application, you may not need to do it again for subsequent photocopying jobs.
When you launch **Photocopier** you open the Copy Utility dialog box. There are two menus in this dialog box, **File** and **Help**, along with 11 other settings.

**Note:** You can set a button on your scanner to directly scan and open this application. For details, go to *Configuring Scanner Buttons* in Chapter 8, Scanning and Recognition.

**To specify or modify Photocopier options:**

An ideal time to set the **Photocopier** options is when you launch the application for the first time. While you would want some of the options to change with each job, there may be some, such as Type and Resolution, that you can keep constant. Once you set the options you want for the first job, Kurzweil 1000 saves and presents these settings for subsequent jobs.

In the **Copy Utility** dialog you can do the following:

- Type the desired **Number of Copies** (mnemonic **ALT+N**). The default is 1.
- **Set the Brightness (ALT+B)**. Type a value between 0 and 100. The default is 50.
- Specify the scanning **Type (ALT+T)**: Black and White, Gray, or Color. The default is Black and White.
- Specify the **Resolution (ALT+T)**: 200 or 300 dots per inch. The default is 300.
- Select the **Original Size (ALT+O)** of the document: Letter, A5, Legal, Executive, A5, B5, Envelope #10, Envelope DL, or Custom Page Size. For Custom Page Size, specify Page Width (ALT+W) and Page Height (ALT+H).
Indicate the **Copy Size** (**ALT+S**): Match the Original Size of the document or expand the size to Fit the Printed Page. The default is Match to Original Size.

You are ready to specify printer settings and make copies.

You can also apply your changes and exit the Photocopier application without making copies at this point.

**To specify printer settings:**
1. From the **File** menu in the **Copy Utility** dialog, select **Print Setup** (**ALT+F** then **S**).
2. In the **Printer Setup** dialog that opens, you can do the following:
   - Select the printer from the **Printer** list (mnemonic **P**).
   - Set the **Page Orientation** (mnemonic **O**) to **Portrait** or **Landscape**.
   - Select **Paper Source** (mnemonic **S**) and **Paper Size** (mnemonic **Z**). These options depend on your printer:
3. When you are done, press **ENTER** to apply the settings and return to the **Copy Utility** dialog where you can change the Photocopier options and make copies.

**To make copies:**

Choose the **Make Copies** command from one of two places:

- In the **Copy Utility** dialog, by using the **Make Copies** command (mnemonic **M**) or by pressing the **F9** key.
- From the **File** menu in the **Copy Utility** dialog (**ALT+F+M**).

To cancel the process and close the dialog, use the **Cancel** command (mnemonic **C**) or press **ESCAPE**.
Fax Application

The Fax application faxes a file or pages you scan to a recipient. It can also receive incoming faxes. In case of a busy signal, the application automatically resends based on a user-specified number of retries. It’s also possible to save your fax to send later.

Where can you find the faxes you’ve received or sent? Find incoming faxes in the Received subfolder, and all completed fax jobs in the Sent subfolder. Both subfolders are in the Fax folder in the Kurzweil 1000 document Home folder.

There is also an Address Book. Each time you fill out a fax cover sheet, the application saves the new contact information in the address book. In the Address Book, you can add, edit, or remove contacts, as well as select a contact to whom you want to send a fax.

Note: You can set a button on your scanner to directly scan and open this application. For details, go to Configuring Scanner Buttons in Chapter 8, Scanning and Recognition.

To fax:

Ensure that you have a modem and telephone connection.

There are three ways to fax:
  - Send just a cover page.
  - Send a document that you scan in.
  - Send a file from an application.

For the first two options, select Fax from the File Launch submenu (ALT+F+L then letter X).

When you launch the Fax application, its window opens, containing two menus, File and Help, along with a status message box.
If you intend to fax a file from another application, open the file in the application and select **KESI FAX** printer from the application’s **Print** menu. This opens the Kurzweil 1000 **Fax** application dialog box, in which you can specify a recipient and send the document.

**Specifying Your Fax Preferences**

The first time you use this application, it’s a good idea to set your preferences and some of the constant information you’ll use for faxing. This includes your name and phone number.

**To specify your Fax preferences:**

In the **Fax** application, open the **File** menu and select **Preferences** (ALT+F+P). In the **Preferences** dialog, you can do the following:

- Type your Name (ALT+N), your Company Name (ALT+C), your Fax Number (ALT+F), and your Phone Number (ALT+P).
- Set the desired **Scanner Margins**: Back (ALT+B), Front (ALT+O), Left (ALT+L), and Right (ALT+I).
- Set the **Prefix for Dialing** (ALT+X). This can be the number needed for an outside line, for instance.
- Set the number of **Automatic Retries** you want the application to perform when it receives a busy signal. The default is 5 retries.
- Set the number of rings in the **Receive Fax** list box (ALT+E). You can set the application to answer the phone upon 1 to 6 rings, or set it to not receive faxes at all by selecting **Disable**. The default is 2 Rings. By setting the number of rings, you also enable the application to receive incoming faxes.
- Set the **Status Interval** (ALT+S) that you want Kurzweil 1000 to use to announce status messages for the current Fax job. The
default is **Disabled**. Use the **UP/DOWN ARROW** keys to select an interval of either every 5, 10, 30 or 60 seconds. In the disabled state, you can press the **SPACE** bar to hear the current status message.

**Modifying and Sending a Fax Cover Page**

You can include a cover page for any of your faxes or send it alone. When you send an open file or a document that you are scanning, the cover page is not necessary.

**To modify and send a Cover Page:**

1. Select **New** from the **Fax** application **File** menu (**ALT+F+N**) to open the **Cover Page** dialog.

2. In the **Cover Page** dialog, you can do the following:

   Type the **Recipient** name (**ALT+R**). The Fax application tracks the last 20 recipient names. If you have existing recipients, you can use the **UP/DOWN ARROW** keys to select one from the list.

   Select **Yes** in the **Use Cover Page** (**ALT+U**) box.

   Type the **Number to Call** (**ALT+N**). If you select an existing recipient, Kurzweil 1000 fills in this information for you.

   Type the recipient’s **Company** name (**ALT+P**). If you select an existing recipient, Kurzweil 1000 fills in this information for you.

   Type the **Subject** (**ALT+S**) and the **Message** (**ALT+M**). The Message is required if all you are sending is the cover page.

   **Note:** Your message can have multiple lines. Use the **ENTER** key to go to the next line. When you are done, press the **TAB** key to go to the **OK** command.
If you want, you can spell check the cover page. For more information, review the next procedure, To spell check a cover page.

Press ENTER the key.

3. Choose Send from the Fax File menu (ALT+F+D) or press the F8 key.

When a job is done, you'll hear "Send Complete."

**Note:** You can also use Address Book from the Tools menu when sending a fax. Go to the subsection, Using the Address Book for details.

**To spell check a cover page:**

In the Fax Cover Sheet dialog, open the Spell Check dialog (ALT+T+C).

When the Spell Check dialog opens, your cursor is in the replacement box which lists any possible replacements for the first unknown word the spell checker encounters. Press the **UP/DOWN Arrow** keys to move through the list of replacements. In some cases, there may not be a suggested replacement.

In addition to the replacement box, this dialog contains seven commands: Replace, Replace All, Spell Word, Ignore, Ignore All, Add to Word List and Cancel.

**Notes:**

- The FAX spell checker uses the spelling properties (Prefix, Capitalized, and so on) as set in the Kurzweil 1000 Spell Check Properties dialog. There is no Properties button in the FAX Spell Check dialog. There is also no Read Context button as there is in the Kurzweil 1000 Spell Checker.
• The spell checker checks only the content in the Message, and it checks all of the content regardless of the initial position of the cursor.

• The Replace All command affects only the current cover sheet, and replacements are not added to the list of permanent corrections.

For more information on spell checking, go to Using the Spell Checker in Chapter 9, Editing.

Faxing a Document that You are Scanning

1. In the Fax application, choose Scan from the Fax File menu (ALT+F+S) or press the F9 key.

   Note: When you scan using the Fax application, Kurzweil 1000 uses your default scanning settings. Once the send command is successful, the system deletes the scanned files.

2. In the Cover Page dialog box that opens, you can do the following:

   Specify the Recipient name (ALT+R).

   Select Yes or No in the Use Cover Page (ALT+U) box. When faxing a document that you are scanning, it’s not necessary to use a cover page.

   Specify the Number to Call (ALT+N). This is a required setting. If you select an existing recipient, Kurzweil 1000 fills in this information for you.

   Specify the recipient’s Company name (ALT+P).

   Type the optional Subject (ALT+S) and/or Message (ALT+M). From the Message box, press the TAB key to go to the OK command.
Appendix A. Launching Applications

Press ENTER.

3. Choose Send from the Fax File menu (ALT+F+D) or press the F8 key.

When a job is done, you'll hear "Send Complete."

Faxing a File from Another Application

You can fax documents from other applications, Kurzweil 1000 or Microsoft Word, for example.

1. In the application, open the file you want to fax.

2. Choose Print from the application’s File menu, then select KESI FAX.

3. In the Cover Page dialog box that opens, you can do the following.

   Specify the Recipient name (ALT+R).

   Select Yes or No in the Use Cover Page (ALT+U) box. When faxing a file, it's not necessary to use a cover page.

   Specify the Number to Call (ALT+N). This is a required setting.
   If you select an existing recipient, Kurzweil 1000 fills in this information for you.

   Specify the recipient’s Company name (ALT+P).

   Type the optional Subject (ALT+S) and/or Message (ALT+M).
   From the Message box, press the TAB key to go to the OK command.

   Press ENTER.

4. Choose Send from the Fax File menu (ALT+F+D) or press the F8 key.

   When a job is done, you'll hear "Send Complete."
Hearing the Status of a Fax in Progress

Press the SPACEBAR key.

Receiving Incoming Faxes

You can have the Kurzweil 1000 Fax application accept incoming faxes by setting the number of rings in the Fax Preference dialog. For instructions, go to Specifying Your Fax Preferences.

When there’s an incoming fax, the program answers the phone in the number of rings you specified. It then receives and converts the pages into a TIFF file and places it in the Received subfolder of the Fax folder.

To enable Kurzweil 1000 to receive incoming faxes:

1. Open the File menu and select Preferences (mnemonics ALT+F, then P).
2. Specify the number of rings in the Receive Fax list box (ALT+E) to 1, 2, 3, 4, 5, or 6 rings.

To open and read received faxes:

1. Choose Open from the Kurzweil 1000 File menu (ALT+F+O).
2. Press SHIFT+TAB and use the ARROW keys to go to the "Fax" folder in the Kurzweil 1000 Home folder.
3. Use the TAB key to find and select the fax you want.
4. Press ENTER.

Kurzweil 1000 begins reading.
Saving a Fax Job for Sending Later

Choose Exit from the File menu (ALT+F+X). Kurzweil 1000 asks if you want to save the job. If you answer in the affirmative, the next time you open the Fax application and try to scan or send a fax, the system asks if you want to send the saved faxes. To open the saved job, choose Edit from the Fax File menu (ALT+F+E).

Cancelling a Fax Job

You can use the DELETE key to cancel a fax.

Using the Fax Address Book

The FAX address book lets save important contact information, and make it easily available during FAXing.

To open the Address Book dialog:

In the Fax Application window, open the Tools menu and select Address Book. The mnemonics is ALT+T+A. Or press the shortcut key, F3.

Your cursor is in the Address List.

To add new contact information:

In the Address Book dialog, press CONTROL+N. This shortcut selects the New option from the File menu.

The Fax Address Record dialog opens. Enter the desired Contact name, Fax Number and Company name. Then press ENTER.

The application adds the new contact information to the Address List.
To edit existing contact information:

1. In the Address list of the Address Book dialog, go to the contact you want to edit.
2. Press CONTROL+E. This shortcut selects the Edit command from the File menu.
3. In the Fax Address Record dialog that opens, you can use the TAB and SHIFT+TAB keys to go to the field you want to edit. You can also do any of the following: press ALT+T for the Contact field, ALT+F for the Fax Number field, or ALT+P for the Company name field.
4. Press ENTER.

To delete a contact:

1. In the Address List in the Address Book dialog, go to the desired contact.
2. Press CONTROL+DELETE. This shortcut selects the Delete command from the File menu.

To sort the Address List:

Be sure your cursor is in the Address Book.
To sort by ascending alphabetical order for contacts: press F3.
To sort by descending order for contacts: press F4.
To sort by ascending order for companies: press F5.
To sort by descending order for companies: press F6.
Appendix A. Launching Applications

To search for a specific contact:

In the **Address Book** dialog, go to the **Contact or Company Contains** box. Type in the desired information, then **TAB** to the Address List.

To send a fax to an Address Book contact:

Do one of the following:

- From the **Address Book** dialog, press **CONTROL+S**. This opens the **Cover Sheet** dialog with the contact information in the Recipient, Number to Call and Company fields already filled out. Proceed to send the fax.
- Or if you have the **Cover Sheet** dialog open, press **F3** to open the **Address Book**. Select the desired contact from the **Address List**. Press **ENTER**. The application automatically fills in the desired contact information into the Cover Sheet. Proceed to send the fax.

Managing Your Applications with the Launch Menu

You can set up the Launch menu to include the applications you use most often. The mnemonic for the Launch menu is **L**. The items on this menu are:

- **Add** (mnemonic **A**).
- **Change** (mnemonic **C**).
- **Delete** (mnemonic **D**).

A variable-length list of items corresponding to all the applications you have added.
Adding an Application

1. Choose Add from the Launch menu. A dialog appears, and you are positioned in the Launch Menu Name text field (mnemonics ALT+M).

2. In the Launch Menu Name text field, type a name that references the application. This name will appear on the Launch menu.

   Make sure you include an ampersand before the letter you’d like to use as the mnemonic for the name. For example, to include an item called WordPad, using a mnemonic of P, you would type Word&Pad.

3. TAB to move to the Program Name box (mnemonic ALT+P).

   In the Program Name box, you can type the full path for the application, including the drive designator. For the WordPad example, the path might be:

   C:\Program Files\Accessories\WordPad.exe

   As with other file name text fields, you can type an asterisk or press CONTROL+E to complete the next level of the path.

Searching for the Application to Add

You can also search your system to find the application you’d like to add. To search for an application, enter its name in the Program Name field and press ALT+S.

For example, if you want to search for Notepad, enter either notepad or notepad.exe as the Program Name, and then press ALT+S. When Kurzweil 1000 finds the first occurrence of that file name on your system, and the entire path for the application appears in the Program Name field.
You can also use the Program Name control as a list and select the name of the program on your system. The list contains the names of a few widely used applications. Each item contains a description for the application, followed by its executable name in parentheses. You can select the application you want from this list, and then press ALT+S to search for the application.

To browse, type **ALT+B** or activate the **Browse** button. The file dialog opens with a list of executable files only (.EXE, .COM, and .BAT files). You can select only one such file, using the folder tree if needed, to switch directories. Once you select a file, control returns to the Launch dialog, and the Program Name text field contains the entire path for the executable.

Once you have set up the Program Name field, TAB to the **Command Line Arguments** text field (mnemonic **ALT+A**). You can enter any command line arguments for the application here.

If you specify that a document is required for the application, as described below, the document name will be appended to the command line automatically, unless you specify a wildcard for the document name. The wildcard for the document name is **$1**.

For example, if the application requires a document and you specify `-c` as the command line argument, the actual command line might be `-c my_doc.txt`. If you enter something like `-F$1 -c` in the Command Line Arguments field, the actual command line might be something like `-Fmy_doc.txt -c`.

TAB again to move to the Document Required list (mnemonic **ALT+D**). Enable this feature if Kurzweil 1000 will pass the current document to the launched application.

If you enable the Document Required feature, the application will appear on the Launch menu only if a document is open. If you do
not enable it, the application will always appear on the Launch menu.

Tabbing again brings you to the Minimize on Launch list (mnemonics ALT+Z). Enable this feature if you want Kurzweil 1000 minimized when you launch the application. If you are using a screen reader, or if the launched application uses speech, it’s best to enable it to avoid speech conflicts. In this case, you’ll need to press Control Tab to return to Kurzweil 1000 when you’re done with the application you’ve launched. If you disable this feature, Kurzweil 1000 maintains control of the text to speech engine, and it will be the current application when you exit from the application you’ve launched.

If the Document Required option is enabled, then two other options are also available: Convert if necessary and Format.

If enabled, Convert if necessary (mnemonic C) checks to see if the current file matches a specific format. If not, the system performs an automatic Save As, using the same document name and folder, but an appropriate extension. The application is then launched, passing the new and converted file name as an argument.

The second item, Format, is active only if Convert if necessary is enabled. This specifies the format to convert to, using the short format list set up in the Save As dialog.

If a document is converted, a rewritten version of the document is created in the same folder as the current document. When you close the launched application and return to Kurzweil 1000, the open document is the converted one, not the original.
Appendix A. Launching Applications

Changing Applications

To change the setup for an application you’ve already added to the Launch menu, open the Launch menu and choose Change (mnemonic C). This brings up a list of applications you have added. Choose the application you want to change and the Launch dialog again appears, allowing you to change the settings for that application.

Deleting Applications

To delete an application from the Launch list, open the Launch menu and choose Delete (mnemonic D). This brings up a list of applications you have added. Select the application you want to delete, then press ENTER.

Working with Applications You’ve Added

Once you’ve added an application, you can launch it by selecting its name from the Launch menu. If a document is required, Kurzweil 1000 checks whether the active document should be saved. If you saved previously, the system saves it again automatically. Otherwise, the Save As dialog appears, allowing you to select a file name and format. Be sure to use a format that the application you are launching understands.
B: Speech Engines and Devices

This chapter contains the following topics:

Software Speech Engines.
Hardware Speech Synthesizers.
Software Speech Engines

When you run Kurzweil 1000, it automatically detects the presence of any software speech engines you may have on your system, and lists all of the supported voices for each engine.

Supported Software Speech Engines

Kurzweil 1000 supports the proprietary interface used by DECtalk™ Access 32.

Microsoft SAPI (Speech Application Programming Interface) versions 4 and 5, which enables you to use the growing number of next-generation SAPI-compliant speech engines as they become available.

However, because SAPI is a complex and evolving standard, we cannot guarantee flawless support for every engine while in the Kurzweil 1000 environment.

Hardware Speech Synthesizers

The following is a list of the hardware speech synthesizers Kurzweil 1000 supports. We expect the list to grow. Please contact us if you want to use one that may not be part of this list.

Via e-mail: support@kurzweiledu.com

Via phone: 1-800-894-5374
Appendix B. Speech Engines and Devices

**Supported Hardware Speech Synthesizers**

**SSIL-Compliant Devices**

If you are using the Microsoft Windows 95, Windows 98 or Windows ME operating system, the Kurzweil 1000 installation process lets you choose an SSIL-compliant engine. Simply follow the instructions you hear as the installation proceeds. Refer to the *Installation and New Features Guide*.

**Important Notes:**

You should have a software speech engine correctly installed before performing the SSIL installation for Kurzweil 1000. This lets you use Kurzweil 1000 even if the SSIL device fails.

You must have the device connected correctly before installing Kurzweil 1000.

**DECTalk™ Express, DoubleTalk™, TripleTalk™ and DECTalk USB**

DECTalk Express, DoubleTalk and TripleTalk support is available for Kurzweil 1000 on Microsoft Windows NT, Windows 2000, Windows XP operating systems.

If you are using TripleTalk, you may need to upgrade TripleTalk firmware to version 0x0201 or later. Use the program that comes with the TripleTalk called TTUInfo to find the version number. If it isn't current, contact Access Solutions ([www.axsol.com](http://www.axsol.com)) for a free upgrade. Speech will not work reliably with older versions. Note that you will need to update the DLLs, go to Access Solutions' Web site ([www.axsol.com](http://www.axsol.com)) for details.

For DECTalk USB, once the device is connected to your system, it will be available from the Engine list in the Voices Settings tab page. **Note:** For the DECTalk USB device to work properly with Kurzweil...
1000, the firmware version must be dated 11/19/2004 or later. Updates are available from Access Solutions.

For both DECTalk Express and DoubleTalk, you must configure the device connection once in Kurzweil 1000. TripleTalk users do not have to do this, as Kurzweil 1000 is able to get this information automatically.

**To configure DECTalk Express or DoubleTalk in Kurzweil 1000:**

Before you proceed, be sure:
- You have installed and connected the device.
- There is a screen reader on your system.
- You know which communication port the synthesizer is plugged into.

1. Navigate to C:\Program Files\Kurzweil Educational Systems\Diags and open the HWSpeech program icon.
2. Specify the device you have installed.
3. Select the COM port it's on, then press the **ENTER** key.
C: Searchable Web Sites

This chapter contains the following topics:

Introduction.
Search for Books.
Search for Magazines.
Introduction

Using Kurzweil 1000, you can access electronic books, text, magazine articles from a variety of Web sites. For general information and procedures for searching and downloading files from these Web sites, go to Chapter 14, *Online Material*.

This appendix lists the current Web sites available for searches in Kurzweil 1000, along with more information about each site.

Search for Books

**Accessible Book Collection**, a subscription-based site that provides a large selection of electronic books in HTML format to qualified persons with disabilities. For more information or to subscribe, go to www.accessiblebookcollection.org.

**Baen Free Library**, www.baen.com, offers select science fiction titles, in several electronic formats, direct from the authors.

**Bookshare.org**, subscription-based, is an online book-sharing community for U.S. residents with visual and other print disabilities. Members have access to copyrighted, scanned books in DAISY digital talking book and BRF Braille digital formats. To subscribe, go to www.bookshare.org.

**International Braille Research Center** offers electronic Braille books of over 1,000 titles from world literature in ASCII text format, Grade II English Braille. You can port the downloaded e-Braille books to Braille notetakers and other devices.

**Project Gutenberg**, at www.gutenberg.net, is an online repository of electronic text and books.
Web Braille, a password-protected service of the Library of Congress, provides eligible individuals and institutions access to electronic text from a variety of sources that the service has put into Braille format.

Italian-based Fondazione Ezio Galiano and Progetto Manuzio.

Search for Magazines

**AFB Access World**, from the American Foundation for the Blind at www.afb.org, is a monthly magazine which focuses on assistive technology.

**ACB Braille Forum**, at www.acb.org, is the monthly periodical from the American Council of the Blind.

**NFB Publications**, at www.nfb.org, is the newsletter from the National Federation of the Blind. This site includes issues from the Braille Monitor, Voice of the Diabetic and Future Reflections.

**Talking Newspaper UK**, a subscription-based vendor of U.K. national and local newspaper and magazine services for visually impaired and people with disabilities. For more information or to subscribe, go to www.tnauk.org.uk.

**Web Braille**, a password-protected service of the Library of Congress, provides eligible individuals and institutions access to electronic text from a variety of sources that the service has put into Braille format.

**Bookshare.org Newsline**, a periodical service provide by Bookshare.org. Magazines such as the Economist, New Yorker, and USA Today are available to all Bookshare.org subscribers.
This chapter contains the following topics:

Command Line Options.
Command Line Options

If you want to use command line options, the following lists the ones Kurzweil 1000 supports.

-in: filename Allows you to specify the input file’s name. If there are spaces in the name, enclose the entire name in quotation marks. If you don’t specify any other options, Kurzweil 1000 attempts to open the file.

-out: filename Allows you to specify an output file’s name. Use this option after you’ve specified an input file. Use Kurzweil 1000 supported file extensions for output files. These extensions include: .BFM, .BRF, .BRL, .KES, .RTF, and .TXT. Kurzweil 1000 opens the input file, saves it in the output file name and format.

-d Use this option to delete the input file. If you specify an output file, Kurzweil 1000 converts the input file into the output file, then deletes the input file.

-set: filename Allows you to specify the name of a settings file other than "default," which is the system default. Unlike the other file names that you specify in command lines, do not specify the complete path name or file extension for this option.

-x Use this option if you want Kurzweil 1000 to exit automatically after performing the specified command line tasks.
E: Using the Keypad

This chapter contains the following topics:

About the Keypad.
Finding Your Way Around the Keypad.
Keypad Layers.
Types of Keypad Commands.
Keys in the Keypad.
The Reading Keypad.
The File Management Keypad.
The Settings Keypad.
Performing Basic Keypad Functions.
Reading Navigation Functions.
Screen Reader Keys and Functions.
Reference Tool Functions.
Bookmark Functions.
Scanning Functions.
Editing Functions.
Modifying Settings.
File Management Functions.
Advanced File Management.
About the Keypad

You can operate Kurzweil 1000 through the numeric keypad on the right-most side of a standard Windows keyboard.

The keypad has five rows of keys. The top row has four small keys; the next three rows have three small keys; and the bottom row has one long horizontal key and one small key. The right side of the keypad has two long vertical keys below the first square key in the upper-right corner.

If you have a laptop computer, you can also use equivalent functionality on the keyboard. The keys you use may differ from system to system, so check your system’s documentation for details.

You will encounter the terms Press, Tap, and Hold Down, when this guide refers to keypad keys.

Press means to hit the key once, then release it.

Tap is generally used when talking about cycling through a list of items. It means to press and release a key repeatedly.

Hold Down means to press and continue holding down a key. In some cases, you must hold down one key as you press a second key.

You should always release a key after pressing it unless this guide specifies that you must hold it down.
Finding Your Way Around the Keypad

As reference points you can use the following keys located at the perimeter of the keypad:

Cancel is the key in the upper-left corner of the keypad. Pressing Cancel stops initiated tasks.

Accept is the small key in the upper-right corner of the keypad. Pressing Accept confirms initiated operations. Not every operation requires a confirmation.

Help and Status is the vertical key in the lower-right corner of the keypad. It provides information about each key in the keypad, and when used with the Shift key (the horizontal key in the lower-left corner of the keypad), it opens the online help manual.

To hear a key name, press the Help and Status key, and then press and release a keypad key; Kurzweil 1000 tells you the name of that key. For more detailed information about a keypad key, press the Help and Status key, then hold down the key you want described.

Almost all the keys have additional functions when used with the Shift key. To hear more about a key's shifted function, press the Help and Status key, and then hold down the Shift key and the key you'd like described.

Start and Stop Scanning is the vertical key located immediately above the Help and Status key. It initiates a scan, or cancels a scan in progress.

Start and Stop Reading is the long horizontal key in the lower-left corner of the keypad. This key lets you start or stop reading, and doubles as a Shift key for keypad functions.

These five keys do not change their function regardless of the current keypad layer.
Keypad Layers

Kurzweil 1000 uses keypad layers to provide access to a wide array of functions and features. There are three main layers: Reading, File Management and Settings.

Switching between layers:

Hold down the Shift key (the horizontal key in the lower-left corner of the keypad) and tap the Accept key (the small key in the upper-right corner of the keypad) until you hear the name of the layer you want. Keep holding down the Shift key as you cycle through the layers.

In addition, each keypad layer has a sub layer, or Shifted layer, with additional functions. To access a keypad sub layer, hold down the Shift key and a key on the keypad. For instance, after you press the Shift Accept combination to get to the File Management main keypad, press Shift and the number 2 key to get to its sub layer; this key combination saves your file in export format.

Layer 1: The Reading Keypad

The Reading keypad is the default layer when you start up Kurzweil 1000, and is the keypad you use for scanning, reading and moving around in a document. With this keypad, you can change the reading speed or volume and access the dictionary and thesaurus.

This keypad has two configurations: Kurzweil 1000 and a Screen Reader compatible one. Both provide access to many reading commands, as well as document navigation functions and dictionary lookup. If you prefer to use the Screen Reader keypad, you must select the ScreenReader option in the Configuration Settings tab page first, then press SHIFT+Accept from the keypad until you hear, "ScreenReader Keypad."
Layer 2: The File Management Keypad

Use the File Management keypad to create and delete the folders that store your Kurzweil 1000 documents, and to move between folders. You can open, close, and delete document files, and save files in other formats.

Layer 3: The Settings Keypad

The Settings keypad lets you customize the Kurzweil 1000 environment. In this keypad layer, you can change the reading voice for documents, or change the system voice that reads prompts and messages. You can also change some scanning options.

Types of Keypad Commands

There are three different types of keys in the Kurzweil 1000 keypad:

Command keys - Let you carry out a specific action. For example, the Start and Stop Scanning key is a command key. It starts or stops a scan. It performs the action independently of other buttons and does not require a confirmation.

Other command keys, such as Delete Folder, require you to confirm the action of the key by pressing the Accept key. You can cancel such actions by pressing Cancel or Escape before you press Accept. This prevents you from accidentally making deletions or implementing other changes that you don't want.

Option keys - Allow you to choose from a list of possible settings. The first time you press an option key, you'll hear the current setting. Tap the same option key to cycle through the list of other possible settings.
The Scan Mode key is an example of an option key. The first time you tap it, you'll hear the current setting. Tap again to cycle through other possible settings. Stop when you hear the desired setting. You do not need to press Accept.

List keys - Let you search through a list quickly by narrowing the choices to those that begin with a letter or letters that you type.

For example, the Open File key (the first key in row 3) in the File Management keypad is a list key. Let's say you're looking in the current folder for a file called License. Press the Open File key, type L, then tap the Open File key until you locate your file. Using this method narrows the list to contain only files that begin with L. If you type L I instead of L, this would narrow the list further, to only files beginning with L I. Then cycle through the list of file names by tapping the Open File key.

Once you have found the desired file, press the Accept key to confirm. You must always use Accept to confirm a choice made with a list key.

You can also use List keys the same way as Option keys, by tapping and cycling through every file until you hear the name of the file you want to open.

To go backward in the list press Shift with the list or option key.
Keys in the Keypad

The following subsections present the keys and their functions for each of the different keypad layers and shifted layers.

Notes:

The key setup presented throughout this section reference the keypad located on the right side of the standard computer keyboard.

If the functions you get in the Reading or Reading Shifted, or the Screen Reader or Screen Reader Shifted do not match what is presented here, your keypad may not be configured correctly in the Configuration Settings tab.

The Reading Keypad

The Reading keypad is the default layer when you first start Kurzweil 1000. This keypad has two configurations: one for Kurzweil 1000 Reading and the other for Screen Reader.

Both provide access to many reading commands, as well as document navigation functions and dictionary lookup. If you prefer to use the Screen Reader keypad, you must select the ScreenReader option in the Configuration Settings tab page first, then press SHIFT+Accept from the keypad until you hear, "ScreenReader Keypad."

Note: Some reading features accessible through menus are not available from the keypad.

The Kurzweil 1000 Reading Keypad

To use this keypad the Keypad Command in the Configuration Settings tab must be set to Kurzweil 1000.
The keys in the top row, from left to right, are:
Cancel, Erase Text, Dictionary, and Accept.
The second row from the top has three small keys and a large vertical key spanning the second and third rows. These keys are:
Volume Up, Speed Up, Reading Mode and Start and Stop Scanning.
Note: pressing Shift+Up arrow or the 8 key changes the currently active document.
The third row contains, from left to right:
Volume Down, Speed Down, and Multiple Columns.

The fourth row has three small keys, and then one large vertical key which span the fourth and bottom rows. These keys are:
Rewind, Fast Forward, Go to Page, and Help and Status.
The bottom row has two keys:
A large horizontal key for Start and Stop Reading, which doubles as a Shift key when used with another keypad key.
And a small key for Delete.

**The Kurzweil 1000 Reading Keypad, Shifted**

To use this keypad the Keypad Command in the Configuration Settings tab must be set to Kurzweil 1000, and you must hold down the Shift key while pressing the desired function key.
The keys in the top row, from left to right, are:
No Function, Paste Page, Thesaurus, and Change Keypads.
The keys in the second row are:
Recognize Currency, No Function, Accuracy or Speed of Recognition Engine, and the Rescan or Insert Scan key.

The keys in the third row are:
No Function, Create Bookmark, and Two Page Mode.

The fourth row keys are:
Rewind by Unit, Forward by Unit, Go to Bookmark, and the Help and Status key.

The bottom row keys are:
Shift and Spell with Alpha.

**The Reading Keypad Configured for Screen Reader**

To use this keypad the Keypad Command in the Configuration Settings tab must be set to Screen Reader Keypad.

The keys in the top row, from left to right, are:
Cancel, Erase Text, Dictionary, and Accept.

The second row from the top has three small keys and a large vertical key spanning the second and third rows. These keys are:
Go to Start of Line, Go to Previous Line, Page Up, and the Start and Stop Scanning key.

The third row contains, from left to right:
Read Previous Character, Read Current Character, Read Next Character.

The fourth row keys are:
End of Line, Next Line, Page Down, and the Help and Status key.

The bottom row contains:
The Start and Stop Reading, and the Delete keys.
The Reading Keypad Configured for Screen Reader, Shifted

To use this keypad the Keypad Command in the Configuration Settings tab must be set to Screen Reader Keypad, and you must hold down the SHIFT key while pressing the desired function key.

The first key in the top row has no shifted function. The remaining keys are:

Paste Page, Thesaurus, and Change Keypads.

The keys in the second row are:
Read from Start of Line, Read Current Line, Read to End of Line, and the Rescan or Insert Scan key.

In the third row are:
Read Previous Word, Read Current Word, and Read Next Word.

In the fourth row, the keys are:
Go to End of Line, Go Down One Line, Page Down, and the Help and Status key.

The bottom row contains the Start and Stop Reading, and the Delete keys.

The File Management Keypad

The top row of this keypad, from left to right, contains:

The Cancel key, Go to Favorite Folders, Go to Favorite Files, and the Accept key.

The second row has three small keys, then one large vertical key which spans the second and third rows. These keys are:

Change Folder, Make New Folder, Delete Folder, and Start and Stop Scanning.
Appendix E. Using the Keypad

The third row contains:
Open File, Close File, and Delete File.
The fourth row has three small keys, and one large vertical key
which span the fourth and bottom rows. These keys are:
Save File, Save As, Export File Format, and Help and Status.
The bottom row has two keys:
A large horizontal one, Start and Stop Reading.
A small one with no function.

**The File Management Keypad, Shifted**

To use this keypad you must hold down the SHIFT key while
pressing the desired function key.
The first key in the top row has no shifted function. The remaining
keys are:
Delete Favorite Folder, Delete Favorite File, and Change Keypads.
The keys in the second row are:
Change to Folder Under Current Folder, No Function, No Function,
and the Rescan or Insert Scan key.
All the third row keys have no shifted function.
In the fourth row, the keys are:
no function, Save in Export Format, no function, and Help and
Status.
The bottom row contains:
The SHIFT key, and a small key with no shifted function.
The Settings Keypad

The top row of this keypad, from left to right, contains:
The Cancel key, Page Orientation, Number Layout, and the Accept key.
The second row from the top has three small keys, then one large vertical key which spans the second and third rows. These keys are:
Reading Voice, System Voice, Progress Messages, and the Start and Stop Scanning key.
The third row contains:
Dynamic Thresholding, Scanning Mode, and Partial Columns.
The fourth row has three small keys, and then one large vertical key which span the fourth and bottom rows. These keys are:
Punctuation Level, Recognition Languages, AutoLoad, and Help and Status.
The bottom row has:
A large horizontal key for Start and Stop Reading.
A small key for Save or Restore settings.
The Settings Keypad, Shifted
Most of the keys in the settings keypad have no function when used with the SHIFT key. The exceptions are the first key in row three, which controls the Brightness setting, and the first key in row four, which handles the Pronunciation of Numbers.
Performing Basic Keypad Functions

This section provides information on performing Kurzweil 1000 functions with the various keypad layers and their related keys.

Basic Reading Functions

This section provides keypad-based instructions for basic reading operations.

Be sure to activate the Reading keypad layer. On the keypad, hold down the Shift key and tap Accept until you hear "Reading keypad." By default, the system presents the Kurzweil 1000 Reading keypad layer.

Using the Screen Reader Reading Keypad

If you prefer to use the Screen Reader keypad, you must select the ScreenReader option in the Configuration Settings tab page first, then press SHIFT+Accept from the keypad until you hear, "ScreenReader Keypad."

In using the Screen Reader keypad, it's helpful to remember the following:

All the top and right keys have the same functions as the Kurzweil 1000 Reading keypad.

Most of the functions are navigational, placing the cursor at specific locations in the text.

We note functions that are available from both Reading keypads in the subheadings. Where there is no notation, that function is available only in the Kurzweil 1000 Reading keypad.
Starting and Stopping Reading (Kurzweil 1000, ScreenReader)

To stop or start reading at the cursor position, press the Start and Stop Reading key, the rectangular key in the lower left corner of the keypad.

Adjusting Reading Speed

Tapping the speed keys changes the speed by a little; holding them down changes the speed more noticeably. If the system is reading when you hold down one of these keys, it continues reading at the current speed until you release the key. It then stops reading and announces the new speed in words per minute. To start reading at the new speed, press the Start and Stop Reading key.

The exact amount by which the speed changes depends on the speech engine you are using.

To increase the reading speed, use the Speed Up key, the second key in row 2.

To decrease the reading speed, use the Speed Down key, the second key in row 3.

Adjusting Reading Volume

To increase the reading volume, press Volume Up, the first key in row 2. The longer you hold down the key, the louder the voice becomes.

To decrease the reading volume, press Volume Down, the first key in row 3. The longer you hold down the key, the softer the voice becomes.

When you reach the highest or lowest possible volume, the system may beep.
Appendix E. Using the Keypad

Reading Navigation Functions

This section describes how to use the keypad to move and read by units, as well as how to move among a document's pages.

Be sure to activate the Kurzweil 1000 or ScreenReader Reading keypad layers.

**Moving by Reading Unit (Kurzweil 1000)**

By default, Kurzweil 1000 reads by sentence unit.

To move backward or forward by a single word, press Rewind, the first key in row 4, or Forward, the second key in row 4. Kurzweil 1000 reads the word.

To move by one unit, hold down the Rewind or Forward key until you hear a beep. You can also use the keypad SHIFT+Rewind keys or SHIFT+FORWARD keys to move back or forward, respectively, by a unit. The system reads the unit and then stops.

To move by page, hold down the Rewind or Forward key. You'll hear five beeps then Kurzweil 1000 announce each page number through which it moves. When you release the key, reading begins at the new location.

Kurzweil 1000 remembers the original layout of a scanned page, although lines may wrap differently on screen. When you select Line as the reading unit, Kurzweil 1000 uses the lines in the original document.

**Selecting a Reading Unit (Kurzweil 1000)**

To change the unit setting, press the Read Mode key, the third key in row 2. The first time you press Read Mode, you'll hear the current unit. Tap the key to hear all the possibilities. Stop when you hear the unit you want. You do not need to press Accept.
Going to a Page (Kurzweil 1000)
1. Press the Go to Page key, the third key in row 4.
2. Type a page number, using either the numeric keypad or the numeric keys on the keyboard.
3. Press Accept.
Kurzweil 1000 goes to the page, announces the page number, and begins reading.

Obtaining Reading Status (Kurzweil 1000)
To display and hear status information about reading, hold down the Help and Status key, the rectangular key in the lower-right corner of the keypad. Release the key to stop.

Screen Reader Keypad Keys and Functions
To move the cursor to the first position in the current line:
In the Screen Reader keypad, press the Home/7 key, which is the left-most key in row 2.
To move the cursor to the last position in the current line:
In the Screen Reader keypad, press the End/1 key, the left-most key in row 4.
To move the cursor to the nearest character in the previous line:
In the Screen Reader keypad, press the Up Arrow/8 key, the middle square key in row 2.
To move the cursor to the nearest character in the next line:
In the Screen Reader keypad, press the Down Arrow/2 key, the middle square key in row 4.
To move the cursor back one character and read that character:
In the Screen Reader keypad, press the Left Arrow/4 key, the left-
most key in row 3.

To move the cursor forward one character and read that character:
In the Screen Reader keypad, press the Right Arrow/6 key, the 
right-most square key in row 3.

To move the cursor back one word and read that word:
In the Screen Reader keypad, press SHIFT+Left Arrow/4 key, the 
left-most key in row 3.

To move the cursor forward one word and read that word:
In the Screen Reader keypad, press SHIFT+Right Arrow/6 key, the 
right-most square key in row 3.

To read the character at the cursor position:
In the Screen Reader keypad, press the 5 key, the middle square 
key in row 3.

To read the word closest to the cursor position:
In the Screen Reader keypad, press Shift+5 key, the middle square 
key in row 3.

To read the text of the line the cursor is on:
In the Screen Reader keypad, press SHIFT+Up Arrow/8 key, the 
middle square key in row 2.

To move to the beginning of the previous page (Page Up):
In the Screen Reader keypad, press the Page Up/9 key, the right-
most square key in row 2.
To move to the beginning of the next page (Page Down):
In the Screen Reader keypad, press the Page Down/3 key, the right-most square key in row 4.

To read the text from the beginning of the line to the current cursor position:
In the Screen Reader keypad, press SHIFT+Home/7 key, the left-most key in row 2.

To read the text from the current cursor position to the end of the line:
In the Screen Reader keypad, press SHIFT+Page Up/9 key, the right-most square key in row 2.

Reference Tool Functions

Both the Kurzweil 1000 and the Screen Reader Reading Keypad Layers provide you with access to dictionary lookup. There is no keypad function for encyclopedia searches.

Using the Dictionary (Kurzweil 1000, ScreenReader)

To hear the definition of a word, find the word you want to define, then press the Dictionary key, the third key in row 1. Kurzweil 1000 tells you how many definitions are available, and reads the first one. Use the Forward key (second key in row 4) or the Rewind key (the first key in row 4) to move to the next or previous definition.

To leave definition mode, press the Cancel key. Use the Start and Stop Reading key to begin reading again.
Appendix E. Using the Keypad

**Using the Thesaurus** *(Kurzweil 1000, ScreenReader)*

Find the word you want to look up, then press Shift and the Dictionary key, the third key in row 1. Kurzweil 1000 tells you how many synonyms are available, and reads the first one. Use the Forward key (second key in row 4) or the Rewind key (the first key in row 4) to move to the next or previous synonym.

To leave thesaurus mode, press the Cancel key. Use the Start and Stop Reading key to begin reading again.

**Spelling a Word** *(Kurzweil 1000)*

Find the word to spell, then press the Spell key, the square key to the right of the rectangular Start and Stop Reading key in the lower-left corner of the keypad. Kurzweil 1000 says the word and spells it.

To hear the word spelled using a word alphabet (alpha, bravo, and so on) press the Shift and Spell keys.

**Bookmark Functions**

You can create and go to bookmarks using the Reading keypad. The Reading keypad is the default layer when you first start Kurzweil 1000.

To go to the Reading keypad from one of the other layers:

Hold down the SHIFT and Accept keys until you hear "Reading Keypad." The SHIFT key is in the lower-left corner; the Accept key is in the upper-right corner of the keypad.

**Creating a Bookmark**

Position the cursor in the sentence where you'd like to insert the bookmark. Press the SHIFT key and the Speed Down key in the
Reading keypad. Speed Down is the second key in row 3. If you select text, the text becomes a bookmark description; you don't have to use the whole sentence option.

**Going to a Bookmark**

To go to a bookmark, press SHIFT and Go to Page in the Reading keypad. Go to Page is the third key in row 4 of the keypad. Tap Go to Page to go through the list of bookmarks. The list is sorted by page number. Each time you press the key, Kurzweil 1000 reads the next entry in the list. To move through the list backward, use the SHIFT and Go to Page keys.

When you hear the description you want, press Accept. Accept is the key in the upper-right corner of the keypad. You can leave the list without selecting any bookmarks by pressing the Cancel key. Cancel is the key in the upper-left corner of the keypad.

**Deleting Bookmarks**

To remove all the bookmarks from a page, you can cut the page from the document, then paste it back in. To cut the page, go to the page that contains the bookmarks and press the Erase key in the Reading keypad, then the Accept key. Erase is the second key in row 1. To paste the page back in, press SHIFT+Erase without moving the cursor from its current position.

This technique does not work if you remove the last page from a document, as SHIFT+Erase always pastes a page before the current page.
Appendix E. Using the Keypad

Scanning Functions

Keypad users can perform many scanning operations, such as starting or stopping a scan, rescanning a page, and recognizing currency.

Starting Scanning

Press the Start and Stop Scanning key, the long, vertical key below the square Accept key in the upper-right corner of the keypad.

Canceling a Scan in Progress

Press the Start and Stop Scanning key again.

Rescanning a Page

1. Place the new page face down on the scanner and close the scanner lid.
2. Press Shift and the Start and Stop Scanning key in the Reading keypad.
3. Press Accept to confirm the rescan.

If you are using Two-Page mode, rescanning replaces both the current page and the page after it.

Inserting a New Scanned Page Before the Current Page

1. Place the new page on the scanner and close the scanner lid.
2. Press Shift and the Start and Stop Scanning key.
3. At the prompt, press Start and Stop Scanning again.
4. At the next prompt, press Accept to confirm.
If you are using Two-Page mode, Kurzweil 1000 inserts two pages before the current page.

**Using a Document Feeder**

1. Place the pages on your feeder.
2. Press the Start and Stop Scanning key on the keypad.
3. When the system completes the stack, turn it over to scan the other side of the pages, or put the next stack on the feeder.
4. Press Start and Stop Scanning again.
5. Press Accept to continue scanning in single-sided mode, or press Start and Stop Scanning again followed by the Accept key to scan and collate the document in double-sided mode.

To stop scanning, press the Cancel key.

**Recognizing Currency**

1. Place a bill on the scanner near the light bar's home position. The long side of the bill must line up with the top edge (the short side) of the scanner glass.
2. Press SHIFT and the Volume Up key (first key in row 2) in the Reading keypad.

**Batch Scanning**

1. Change to the Settings keypad. If you are currently in the Reading keypad, hold down the SHIFT key, press the Accept key twice, and then release SHIFT. Accept is the key in the upper-right corner of the keypad.
2. Tap the Scan Mode key until the system says "Scan to image." In the Settings keypad, the Scan Mode key is the second key in
row 3, and it has a raised indicator. The scan to image mode
scans without recognizing the text. The system saves each
scanned document as an image file in the folder called Images.

3. Change to the Reading keypad using the SHIFT and Accept
   keys.

4. Scan to image files using the Start and Stop Scanning key.
   Scan documents. Instead of scanning to documents that you
can read, the system is scanning to image files.

   When you have finished scanning to image files, you can
   perform any other tasks that you wish. You can change keypads,
read documents, and even leave the Kurzweil 1000 altogether.
   However, you cannot read the image files until the system has
   recognized them, as described in the next step.

5. Change to the Settings keypad and choose Recognize Image
   File using the Scan Mode key.

   Press SHIFT and the Accept key to change to the Settings
   keypad. Scan Mode is the second key in row 3. The first time you
   press this key, the Kurzweil 1000 reports the current scan mode.
   When you hear "Recognize image file," do not tap the key again.

6. Change to the Reading keypad.

7. Recognize the image files.

   Press the Start and Stop Scanning key. The system starts
   recognizing the image files in the Images folder, one after
   another. As each image file is recognized, it is deleted. Press
   Start and Stop Scanning again at any time to stop recognition.

   If you stop recognizing at any point, you should save the current
   file. You can later reopen the saved file, return to Recognize
   Image File mode, and begin recognizing again from that point.
Editing Functions

To cut the current page using the keypad:

1. Place the cursor in the page you want to cut.
2. Press the Erase key (second key in row 1) in the Reading keypad, then press the Accept key in the upper-right corner of the keypad.

To erase all the pages in a document using the keypad:
Press the Erase key twice, followed by Accept. To cancel the erase operation, press any key other than Accept.
You cannot undo this action.

To paste a single page back into the document using the keypad:
Press the Shift key and the Erase key.
You can cancel the search by pressing the ESCAPE key on the keyboard or the Cancel key in the upper-left corner of the keypad.

To cancel or end spell checking, press ESCAPE on the keyboard or Cancel on the keypad.
Cancel the operation by pressing the ESCAPE key on the keyboard or the Cancel key, the small key in the upper-left corner of the keypad.
Modifying Settings

You can modify Kurzweil 1000 settings from the Reading and Settings keypad layers. However, not all settings are accessible from the keypad.

In the keypad, the Settings layer contains more advanced settings, while the Reading layer contains frequently changed settings. This design means that the keypad setup doesn't correspond to the layout of the Settings tab. It is intended, however, to make the Reading keypad layer as useful as possible, especially for beginning and intermediate users.

Additionally, you can save settings you use frequently in default files or user-named files, then load them when desired.

Configuration settings are settings you do not change often. They include: Scanner Margin Units, Shortcuts, Keypad Commands, Numeric Keypad Layout, Hot Keys for Scanning, Active Speech and Online Cache.

In using the keypad keys, keep in mind the following standard keypad operations:

To hear the current setting, press the setting key once.

To cycle through and select from a list of settings, tap the key until you hear the one you want.

To use the Shift key on the keypad with a setting key: The first time you press the keys, you'll hear the current setting. To cycle through and select from the list, hold down the SHIFT and tap the setting key until you hear the one you want.
The Reading and Settings Keys

Both the Reading and Settings keypad layers contain keys that let you change Kurzweil 1000 settings.

The Reading keypad provides access to these settings:


Reading Unit.

The Settings keypad provides access to the following settings:


Modifying Settings from the Reading Keypad

Speech Speed. To change the speech speed, use the Speed Up and Speed Down keys in the Reading keypad (the second keys in rows 2 and 3, respectively). If you use different speech engines for the reading and system voices, the speed you choose will be mapped to accommodate both as well as possible.

Volume. To change the volume, use the Volume Up and Volume Down keys in the Reading keypad (the first keys in rows 2 and 3, respectively).

Reading Unit. The reading unit determines the section size when you move around in a document. To choose a reading unit, use the Read Mode key in the Reading keypad. Read Mode is the third key in row 2. Select Line, Sentence, or Paragraph as the reading unit.
Identify Columns. To change the column identification setting, press the Column Identification key, the third key in row 3 in the Reading keypad.

Two Pages. To change the current two-page setting, press the Shift and the Column Identification keys in the Reading keypad. Column Identification is the third key in row 3.

**Modifying Settings from the Settings Keypad**

Reading Voice. To change the reading voice, press the Reading Voice key in the Settings keypad. Reading Voice is the first key in row 2. Press this key once to hear the current voice. Each time you tap the key, you'll hear a different voice. If you accidentally go beyond the voice you want, hold down Shift while tapping the Reading Voice key to go through the voices backward. When you hear the voice you want, don't tap the key again.

System Voice. Select a system voice using the System Voice key in the Settings keypad. System Voice is the second key in row 2. This key works in the same way as the Reading Voice key, described above.

Mode. To choose a scanning mode, tap the Scan Mode key in the Settings keypad. Scan Mode is the second key in row 3. Choose Scan and Recognize, Scan to Image File, or Recognize Image Files.

Page Orientation. To change page orientation, use the Page Orientation key in the Settings keypad. Page Orientation is the second key in row 1.

Dynamic Thresholding. To enable or disable dynamic thresholding, use the Dynamic Thresholding key in the Settings keypad. This is the first key in row 3. In the disabled mode, Kurzweil 1000 uses Static thresholding. If you want to scan with Grayscale setting,
please use the menu method. For more information about Thresholding, refer to Chapter 8, Scanning in either the Kurzweil 1000 Reference Guide or the Kurzweil 1000 Online Help.

Brightness. To set the scanner brightness, press Shift and the Thresholding key in the Settings keypad. Thresholding is the first key in row 3. When you tap the Thresholding key you move through the values in increments of five. To go through the list backward, hold down Shift and tap the key.

Punctuation Level. To change the current Punctuation Level setting, use the Punctuation Level key in the Settings keypad. Punctuation Level is the first key in row 4.

Number Pronunciation. To change the current Number Pronunciation setting, press Shift and the Pronunciation Level key in the Settings keypad. Pronunciation Level is the first key in row 4.

Language. To change the language setting, press the Language key in the Settings keypad. Language is the second key in row 4.

Partial Columns. To change the current Partial Columns setting, use the Partial Columns key in the Settings keypad. Partial Columns is the third key in row three.

Progress Reports. To select a progress message mode, press the Progress key in the Settings keypad. Progress is the third key in row 2. Select Spoken, Chimed, or Disabled.

Configuration Settings

Configuration settings are settings that apply globally and that you don't change frequently. These settings are located in the Configuration tab of the Kurzweil 1000 Settings dialog. You can modify the following Configuration settings with the Settings
Appendix E. Using the Keypad

keypad: Keypad Commands, Numeric Keypad Layout and AutoLoad

The Keypad Command setting lets you opt to Enable or Disable the default Kurzweil 1000 Reading keypad, or to select the ScreenReader keypad.

The ScreenReader option works only in an open document, and is based on the Kurzweil 1000 Reading keypad. The keys that are different are:

Home or 7. Moves the cursor to the first position on the current line. Use with the Shift key to hear the text from the beginning of the line to the current cursor position.

Up Arrow or 8. Moves the cursor up to the nearest character on the previous line. Use with the Shift key to hear text on the line that the cursor is on.

Page Up or 9. Like Page Up, places the cursor at the first character of the previous page. Use with the Shift key to hear text from the cursor to the end of the line.

Left Arrow or 4. Moves the cursor back one character and reads it. Use with the Shift key to move the cursor back one word and hear the word.

5. Press 5 to hear the character at the cursor position. Use with the Shift key to hear the word closest to the cursor position.

Right Arrow or 6. Moves the cursor forward one character and reads it. Use with the Shift key to move forward one word and hear that word.

End or 1. (With or without the Shift key) moves the cursor to the last position on the current line.
Down Arrow or 2. (With or without the Shift key) moves the cursor to the nearest character on the next line.

Page Down or 3. (With or without the Shift key), like Page Down, repositions the cursor at the first character of the next page.

Delete. (With or without the Shift key) deletes the next character or selected text.

The Numeric Keypad Layout setting lets you choose between two possible keypad layouts:

Calculator, the default layout, uses the small keys in row 2 of the keypad to represent the digits 7, 8, and 9. Row 3 represents 4, 5, and 6, where the key with the raised indicator is 5. Row 4 represents 1, 2, and 3. The small key in the bottom row of the keypad is 0.

Telephone layout uses the small keys in row 2 of the keypad to represent the digits 1, 2, and 3. Row 3 represents 4, 5, and 6, where the key with the raised indicator is 5. Row 4 represents 7, 8, and 9. The small key in the bottom row of the keypad is 0.

In both cases, the large horizontal key in the bottom row, which is zero for most programs, can also be used as zero in Kurzweil 1000.

**Saving Your Settings**

To make your settings the defaults by using the keypad keys:

1. Make sure that you are in the Settings keypad layer.

2. Press the Save and Restore Settings key, then press Accept. Save and Restore Settings is the small key to the right of the rectangular Start and Stop Reading key at the bottom of the keypad. Accept is the key in the upper-right corner of the keypad.
To cancel the save settings operation, press the Cancel key before pressing Accept. Cancel is the key in the upper-left corner of the keypad.

Kurzweil 1000 does not save the Scan Mode even if you press Save and Restore Settings.

To load a settings file using the keypad:
1. Make sure that you are in the Settings keypad layer.
2. Press the Save and Restore Settings key twice, then press Accept. Save and Restore Settings is the small key to the right of the rectangular Start and Stop Reading key at the bottom of the keypad.

If you have not explicitly saved your settings, Kurzweil 1000 restores the default settings.

**Getting Settings Status**

To use the keypad to display and hear status information related to Kurzweil 1000 settings, hold down the Help and Status key in the Settings keypad. Help and Status is the rectangular key in the lower-right corner of the keypad. Continue to hold down the key. To stop the status information, release the key.

**File Management Functions**

You can use the File Management keypad to perform various operations such as opening and saving files.

The File Management keypad layer provides access to all file and folder commands. You can even use this layer to enter file and folder names as described in the subsection, Naming Files and Folders Using the Keypad.
To access the File Management keypad, press SHIFT+Accept until you hear "File Management Keypad." Accept is the small key in the upper-right corner of the keypad.

While waiting for a file to open, you can press any keyboard key to hear how many pages have been converted to KESI. You can stop the conversion and read only the already converted pages by pressing the ESCAPE key, or the CANCEL key on the keypad.

**Opening a File**

When you open a document, Kurzweil 1000 automatically begins to read it.

1. Press the Open File key, the first key in row 3, in the File Management keypad.

   Each time you tap this key, Kurzweil 1000 reads the name of the next saved file in the current folder, in alphabetical order. To move backward through the list, hold down the Shift key while you tap the Open File key. You can narrow the file list by typing one or more characters on the keyboard, then pressing Open File again.

2. When you hear the file you want to open, press Accept. Accept is the key in the upper-right corner of the keypad.

3. To cancel the open file operation, press the Cancel key. Cancel is the key in the upper-left corner of the keypad.

   You may want to return to the Reading keypad to make full use of all reading capabilities.

**Opening Large Files**

Very large files in formats other than KES may take a long time to open. While waiting for a file to open, you can press any keyboard
Appendix E. Using the Keypad

key to hear how many pages have been converted to KES. You can stop the conversion and read only the already converted pages by pressing the ESCAPE key on the keyboard, or the Cancel key on the keypad.

**Saving a New Document as a File**

If you are using the keypad, there are three basic ways to save files: as a Kurzweil 1000 .kes file, ASCII .txt file, or as a file in a desired export format.

To save a document as a KES file:

Press the Save File key (first key in row 4) in the File Management keypad.

To save a document as a text file:

Press the Save As key (second one in row 4).

To save a document in the export format you have selected:

Press the SHIFT key and the Save As key (the second key in row 4). If you have not chosen a format using the Export Format key, the default save format is RTF.

Press Accept to accept the default name that the system suggests for the file. Accept is the small key in the upper-right corner of the keypad. The default name is based on a phrase at the beginning of the document.

To rename the file using the letter keys:

Press the same Save key you used to initiate the file save. By default, Kurzweil 1000 saves scanned documents in the current folder, so use the keyboard to specify a full path if you want to save to a different folder.
Go to the subsection, Naming Files and Folders, further along in this document for information about entering a file name using the keypad.

**Selecting an Export Format**

To select a file format using the keypad, use the Export Format key in the File Management keypad. This is the third key in row 4 of the keypad. The first time you press this key, it reports the current format that Kurzweil 1000 uses when you press Shift Save As. Each subsequent press of the Export Format key moves you to the next format in the list. Narrow the list by typing the first few characters of a format. When you hear the format you want, press the Accept key. Accept is the small key in the upper-right corner of the keypad.

**Saving a File with its Name and Format**

To save a document with its current name and format, press Save File (first key in row 4) in the File Management keypad, and press Accept to confirm the file save.

Saving a File with another Name or Format

To save a file in Kurzweil 1000 format:

Press the Save key (the first key in row 4) in the File Management keypad. The first time you press Save, Kurzweil 1000 prompts you to press the Accept key to save the file with its current name, or to press the Save key again to rename the file. Press the Save key, then use the keypad or keyboard to enter any file name you want.

Go to the subsection, Naming Files and Folders, further along in this document for information about entering a file name using the keypad.

To save a document as a text file:
Appendix E. Using the Keypad

Press the Save As key (the second key in row 4). Save As also allows you to rename the file.

The Save As key saves the file to the current folder. To save to a different folder, change folders before saving.

To save a document in the export format you have selected:
Press SHIFT+Save As key (second one in row 4). If you have not chosen a format using the Export Format key, the default save format is RTF. These keys also allow you to rename the file.

**Naming Files and Folders**

When you save or rename a file, or when you create a folder, you must supply a name. You can use the keypad to enter the name without any need for typing on the full keyboard.

Certain keypad keys correspond to letters and digits. Across row 2, the first key represents the letters A through E, the next key represents F through J, and the third key represents K through O. Across row 3, the keys represent P through T, then U through Z, then 0 through 4. Across row 4, the keys represent 5 through 9, Space, and Backspace. Tap a key repeatedly to cycle through its range of characters. It is important to note that you must press the Accept key after each letter you want the system to recognize. If you make a mistake while you are entering a file name, press the Backspace key (the third key in row 4), then Accept, to backspace over letters. For each letter you add, Kurzweil 1000 reads the name to that point.

If you are using the numeric keypad on a standard keyboard, you can use the keyboard's alphanumerical and editing keys to help you enter a file or folder name. If you press the Change Folders button on the keypad, you can type a partial path, and then press TAB to have the system complete the name to the end of the current folder.
name. If you type C:\My, then TAB, the system may complete the partial folder name as My Documents. You can then continue typing. If there is more than one folder name that matches your typing, the system lists them. You can then type more characters to identify a particular folder. If no folder matches the characters, you'll hear a message. You can then Backspace over the characters you typed. The TAB key also tries to complete file names if you are opening or deleting files.

Press SHIFT+TAB on the keyboard to erase all characters to the previous backslash. If you have not yet typed anything, press SHIFT+TAB to move up to the parent directory. When you finish entering the name, press Accept. Accept is the key in the upper-right corner of the keypad.

**Narrowing File or Folder Name Lists**

You can narrow file or folder name lists when you perform any of these tasks:

- Open a file.
- Delete a file.
- Change the current folder.
- Delete a folder.

If you know part of the file or folder name, press the appropriate keypad function key (such as Open File), type the character or characters you know on the standard keyboard, then press and release the keypad function key again. You can then tap to hear names whose first characters match the characters you have typed. Press Accept when you hear the name you want. If you know the full name, you can press the appropriate keypad key, type the name, then press Accept.
Closing a File

To close the current file, press the Close File key (the second key in row 3) in the File Management keypad. If you have opened a file but have not changed it in any way, Close File closes the file immediately. You do not need to press Accept.

If you have changed the file, you'll hear a warning message and you must press Accept to close the file. To avoid losing your changes, press Cancel, then use one of the Save keys.

Changing the Current Folder

Whenever you save a document without specifying a folder, Kurzweil 1000 automatically places it in the current folder. When you first start the system, the current folder is General. You can change the default startup folder, as described later in this document.

The first time you press the Change Folder key in the File Management keypad, Kurzweil 1000 speaks the name of the current folder. Change Folder is the first key in row 2. If you press the key again, it speaks the name of the folder that follows the current folder in alphabetical order. Keep tapping to hear all the folders under \My Documents\Kurzweil Educational Systems, as well as Diskette and C:\Export. When Kurzweil 1000 completes the list, it cycles through the three most recently used folders, then through the full alphabetical list again.

If you hold down the SHIFT key the first time you press Change Folder, you will begin stepping through the folders under the current folder, rather than those under \My Documents\Kurzweil Educational Systems.

You can narrow the folder list by typing one or more characters on the keyboard, then pressing Change Folder again. You can type
part of a complete path specification, for example, C:\. You can use
TAB to complete a partial folder name, SHIFT+TAB to erase
characters to the previous backslash, and so on.

When you hear the name of the folder you want to open, press
Accept.

To move backward through the folder list, hold down the Shift key
while you tap the Change Folder key.

**Obtaining File Management Status**

File management status includes the name of the current folder and
the name of the open file.

To display and hear status information related to file management,
hold down the Help and Status key in the File Management keypad.
Help and Status is the rectangular key in the lower-right corner of
the keypad. The status information stops when you release Help
and Status.

**Advanced File Management Using the Keypad**

**Creating a New Folder**

To create a new folder, press the Make New Folder key in the File
Management keypad, then type a folder name. Make New Folder is
the second key in row 2. If you use the keypad keys to specify the
folder name, Kurzweil 1000 creates the folder under your
Document Home folder. If you need to specify a complete path that
includes the colon and backslash characters, use the keyboard.
You can use TAB to complete a partial folder name, SHIFT+TAB to
erase characters to the previous backslash, and so on.
Appendix E. Using the Keypad

**Deleting a Folder**

You can delete any empty folder except the current folder, or folders on a CD-ROM.

Press the Delete Folder key in the File Management keypad. Delete Folder is the third key in row 2. Each time you tap the Delete Folder key, Kurzweil 1000 reads the name of the next folder in its home directory in alphabetical order. To move backward, press Shift and the Delete Folder key. You can narrow the folder list by typing one or more characters on the keyboard, then pressing Delete Folder again. This can be part of a complete path specification, for example, C:\Memos. You can use TAB to complete a partial folder name, SHIFT+TAB to erase characters to the previous backslash, and so on.

**Deleting a File**

Press the Delete File key in the File Management keypad. Delete File is the third key in row 3. Each time you tap the Delete File key, Kurzweil 1000 reads the name of the next saved file in the current folder, in alphabetical order. To move backward, hold down the Shift key while you tap the Delete File key. You can narrow the file list by typing one or more characters at the keyboard, then pressing Delete File again.

When you hear the file you want, press Accept in the upper-right corner of the keypad. To cancel the delete file operation, press Cancel in the upper-left corner of the keypad.

If you delete a file that is still open in Kurzweil 1000, you can resave the file contents. Because the copy you are working in still exists, you can use Save on the File menu or the Save File key in the keypad to save the current copy to your system.
Deleting Image Files

Image files take up a great deal of system space. If there are image files in the Images folder, the first press of the Delete Files key asks you if you want to delete them all. In addition, the system automatically deletes each image file after it recognizes the file. For details on creating and recognizing image files, refer to Chapter 8, Scanning.

Working with Favorites Lists

Kurzweil 1000 enables you to create a custom list of favorite files and folders. You can then choose from this list of favorites when you open files or change directories. This lets you avoid navigating through the file system to find the files you use most often.

To add a folder to the Favorite Folders list:

Make sure the folder you want to add is the current folder. Press and hold down the Favorite Folders key in the File Management keypad until you hear, "Folder name has been added to the Favorites list."

Favorite Folders is the second key in row 1.

To add a file to the Favorite Files list:

Open the file you want to add. Press and hold down the Favorite Files key in the File Management keypad until you hear, "Filename has been added to the Favorites list."

Favorite Files is the third key in row 1.

To open a file from the Favorites list:

Select a document from the Favorites list by tapping the Favorite Files key in the File Management keypad. Favorite Files is the third key in row 1. This key works in the same manner as the Open File
key. When you hear the name of the file you want, press Accept in the upper-right corner of the keypad. Or press Cancel in the upper-left corner to cancel the operation.

To change folders using your Favorites list:

Choose a folder from the Favorites list by tapping the Favorite Folders key in the File Management keypad. Favorite Folders is the second key in row 1. This key works in the same manner as the Change Folder key. When you hear the name of the folder you want, press Accept in the upper-right corner of the keypad. To cancel the operation, press Cancel in the upper-left corner.

To delete a file or folder from the Favorites list:

Press Shift and Favorites Folders or Favorites Files in the File Management keypad. Favorite Folders is the second key in row 1. Favorite Files is the third key in row 1.

Tap Favorites Files or Favorites Folders until you hear the name you want to delete, then press Accept in the upper-right corner of the keypad. To cancel the operation, press Cancel in the upper-left corner.

Press ENTER on the keyboard or Accept on the keypad to restore the file. Accept is the key in the upper-right corner of the keypad. The file is restored with its correct name and format.

Kurzweil 1000 treats files with a .zip extension as though they were folders. You can access Zip files through the menu system or by using the File Management keypad keys such as Change Folder, Make New Folder, Delete Folder, Open File, Save File, and Delete File.
F: Configuring Scanner Buttons

This chapter contains information on configuring scanner buttons so that you can initiate Kurzweil 1000 scanning process from your scanner.
Configuring Scanner Buttons

For most scanners, you can use your scanner buttons to start a Kurzweil 1000 Scan, start the Kurzweil 1000 Photocopier and/or start the Kurzweil 1000 FAX.

To configure Kurzweil 1000 Scan, press the desired scanner button, then select Scan with Kurzweil. If you have both Kurzweil 1000 and Kurzweil 3000 applications on your system, and both are currently running or neither are running, you will have to specify with which of the two you want the Scan function associated.

To set the next button for either Scan and Print or Scan and Fax, press the desired button and select the desired option.

Once configured, you can press the button to perform the designated function. For Scan, Kurzweil 1000 begins scanning and its window opens if it isn't already. For Scan and Print, the Kurzweil 1000 Photocopi application window opens and you can specify the number of copies and complete the Make Copies process. For Scan and Fax, the Kurzweil 1000 Fax application window opens and you can specify a recipient and complete the Send process.

If you want to reconfigure the buttons, use the ScanConf application in the Diags folder in the Kurzweil Educational Systems folder in your Program Files.
Systems Code Worksheet

If you are installing and registering Kurzweil 1000 from multiple machines, and are using the phone registration option, completing the worksheet provided on the next page before calling Customer Service can help to expedite the process.

As you go through the installation process note these numbers for each machine. They are necessary for obtaining a corresponding unlock code, which you will then need to activate each installation of the software.

Space is also provided on the worksheet for the location of each machine, and for the corresponding unlock code which the Customer Service representative will provide to you.

For complete details and instructions on product registration, and specifically, Registering by Phone, go to Installation and Registration at the front of this Guide.
Table 1: Systems Code Worksheet

<table>
<thead>
<tr>
<th>Machine Location</th>
<th>Serial Number</th>
<th>Systems Code</th>
<th>Unlock Code</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Machine Location</td>
<td>Serial Number</td>
<td>Systems Code</td>
<td>Unlock Code</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Machine Location</td>
<td>Serial Number</td>
<td>Systems Code</td>
<td>Unlock Code</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
INDEX

accessing editing commands 142
electronic/online material 344
file and folder commands 271
File Properties 301
Folder Properties 303
lookup tools 82
menus 27
menus from menu bar 26
reference tools 82
settings 204
technical support 22
activating Links 78
active document 106
Active Speech setting 243
adding applications 396
audio files to playlists 320
signature to a document 185
signature to a form 192
Address Book in Fax application 393
adjusting reading speed 41
anagrams for lookup word 84
anagrams for word 87
annotations overview 96
applications adding 396
Appointment Calendar 366
Calculator 372
changing 396, 399
deleting 399
exiting from 364
Fax 386
Help About 365
launching 364, 395
navigating in 365
overview 364
Photocopier 383
searching for 396
Appointment Calendar Add and Edit dialogs 367
adding, editing, deleting appointments 369
hot key assignment 371
main window 366, 367
overview 366
Preferences 371
Reminder dialog, working with 371
audio files adding to playlist 320
creating 318
creating and playing 317
monitoring progress 320
playing in Kurzweil 1000 317
Audio Spooler clearing job(s) 321
deleting a job 321
Monitor 320
refreshing 321
Auto Size Margins setting 236
AutoLoad setting 242, 243
Automatic Corrections setting 230
automatic document feeder 113
Automatic Page Orientation 213
B
backing up Settings files 259
batch scanning
  overview 132
Batch Scanning setting 215
bilingual dictionaries 83
Book Courier 325
Book Port 326
Bookmarks
  adding in MP3, WAV, WMA, DAISY files 317
  and HTML files 97
  as study tools 97, 101
  canceling changes to 76
  commands, accessing 68
  converting to Links 97
  converting to Notes 99
  deleting 75
  editing descriptions 74
  generating from key words 69
  Go to Bookmark dialog 70
  going to 71
  in PDF files 68, 71, 265
  multi-level, creating 69
  navigating descriptions 74
  open file to 67, 71, 265
  overview 66
  saving edits made 76
  searching in descriptions 72
  selecting multiple 75
  single level, creating 68
  sorting 73
Bookshare 345
Braille ’n Speak 329
Braille embosser 338
Braille file
  conversion controls for saving 250
  opening 280
Braille nfbtrans 338
BrailleNote 327
brightness
  optimizing 122
Brightness setting 213
  tips for 123
browsing
  as method of studying 97
  in a document 54
  using format 97
C
Calculator
  Business 373
  Business, general procedures 382
  Business, overview 379
  displaying a view 373
  executing operation 374
  general procedures 373
  hearing Current Value 374
  overview 372
  Scientific 373
  Scientific, overview 376
  Scientific, procedures 377
  Standard 373
  Standard, overview 374
  Standard, procedures 375
  Statistics 373
  Statistics, overview 377
  Statistics, procedures 378
  window 372
Calendar application 366
CD
  writing files to 313
Certificate of Ownership 1, 2
changing
applications 399
folders 266, 274, 295
checkbox list 32
Classic Literature CD 359
Look through the Bookshelves 356
clearing
  Audio Spooler job(s) 321
closing
  file 265, 286
color scanning 126
Color setting 233
combo boxes 34
command buttons 30
command line
  options 410
  support 341
commands
  Bookmark 68
  document navigation 62
  document overview 54
  editing 142
  file system 271
  Links 96
  Notes 96
  online search 346
  reading 40
  reference tools 82
  scanning 109
  study tools 96
compress image 239
Configuration Settings
  defaults 254
  overview 203
  tab 237
conversion controls
  for opening documents 249
  for opening PDF documents 249
  for opening RTF documents 249
  for opening text documents 249
  for saving Braille documents 249
  for saving documents 250
  for saving text documents 250
Conversion Settings 248
converting Bookmarks to Notes 99
copying
  file 274, 307
  list contents to clipboard 32, 33
  page 151
corrections
  applying 182
  applying automatically 183
Corrections list
  choosing 183
  creating 183
  editing 184
creating 183
  audio files 317
  Internal Links 77
  multi-level Bookmarks 69
  new file 143
  new folder 297
  Notes 98
  single-level Bookmarks 68
currency, scanning and recognizing 114
Customer Service 1, 5
customization 10
cutting
  page 151
  text or object 150
D
DAISY
  convert from MP3 or WAV 316
  file format 269
playing audio file 317  
Dectalk USB 403  
default folder 306  
default settings 251  
definitions  
anagrams for word 84, 87  
copying 85  
looking up 84, 85  
placing into document 90  
pronounce lookup word 87  
pronounce word 84  
deleting  
a Note 99  
aplications 399  
Audio Spooler job 321  
Bookmarks 75  
files 274, 298  
folder 274, 297  
Links 78  
settings files 258  
devices  
Book Courier 325  
Book Port 326  
Braille 'n Speak 329  
BrailleNote 327  
Maestro 328  
PAC Mate 328  
RoadRunner 328  
Sending Files to 322  
setting up a user device for Send To 332  
supported for Send To 325  
Diags folder 21  
dialog box  
combo boxes 34  
command buttons in 30  
from menus 29  
getting help in 30  
grid views, working with 35  
lists 30  
navigating in 18, 27, 29  
overview 18, 27  
text boxes, working with 34  
using 29  
dialog box, searching lists in 33  
dictionaries, bilingual 83  
dictionary 84  
anagrams for word 84  
pronounce word 84  
dictionary, supplied 83  
Display Image 51  
Display Settings  
Color 233  
defaults 253  
overview 203  
tab 233  
displaying  
images 51  
document  
active and scanning 106  
applying corrections throughout 182, 183  
browsing in 54  
conversion controls for opening 249  
conversion controls for saving 250  
determining your place in 43  
exploring layout 56  
linking settings to 255  
moving among multiple 305  
navigating in 62  
printing 291  
saving partially 289  
selecting entire 147  
sending current 323
sending multiple to e-mail 335
sending to e-mail 334
spell checking 167
summarizing 55
working with multiple 305
document camera 12
document feeder 113
document navigation
by Bookmarks 66, 70, 71
by cursor 66
by page 63
commands, accessing 62
going to a page 65
going to last cursor position 66
Links 76
overview 62
setting and unsetting page numbers 63
shortcut keys 78
specifying preliminary pages 65
document overview methods
Browsing 54
Layout Exploration 54, 56
shortcut keys 59
Summarization 54, 55
downloaded files
overview 349
downloading
electronic files 347
Kurzweil product updates 362
Duration setting 225

E
Edit Corrections 184
Edit Pronunciation 180
editing
a Note 99

Bookmark descriptions 74
commands, accessing 142
copying text or object 150
Corrections list 184
cutting and pasting pages 151
cutting text or object 150
cutting, copying and pasting text 149
font 152
format 152
Link descriptions 78
making corrections throughout document 182, 183
overview 142
paragraph format 155
pasting text or object 150
permanently replacing text throughout Kuzweil 1000 167
Pronunciation list 181
Ranked Spelling list 175
replacing text throughout document 167
searching for and replacing text 160, 165
shortcut keys 150, 186
Spell Checker list 173
spell checking 167
undoing changes 159
using Corrections lists 183
using editing keys 148
word pronunciation 180
editing copying and pasting pages 151
electronic material
accessing 344
downloading 347
from the Web 9
e-mail
sending file(s) to 335

Kurzweil 1000 Reference Guide 463
emphasize method 38, 48
Emphasized Text setting 228
encyclopedia
    lookup 91
Engine setting 220
engine, optimizing 123
exit
    menus 27
Explore Layout 56
extension, file 16
Extract Bookmarks from PDF files 249
Extras folder 21

F
Favorites lists
    adding files and folders to 300
    changing folders 301
    deleting files or folders 301
    opening files and folders 300
Fax
    Address Book 389
    Address Book, adding a contact 393
    Address Book, deleting a contact 394
    Address Book, editing a contact 394
    Address Book, opening 393
    Address Book, searching for a contact 395
    Address Book, sorting address list 394
    and scan a document 390
    cancelling 393
    file from another application 391
    modifying and sending cover page 388
    overview 386
    receiving and reading 392
    saving to send later 393
    sending to an Address Book contact 395
    setting preferences 387
    status 392
file
    adding to Favorites list 300
    audio, creating and playing 317
    audio, monitoring creation process 320
    Braille, opening 280
    closing 265, 286
    commands, accessing 271
    compressing ZIP file 313
    copying 274, 307
    creating 143
    creating audio file 318
    creating ZIP file 312
    decompressing ZIP file 313
    definition 15
    deleting 274, 298
    deleting from Favorites list 301
    extension 15, 16
    extracting image 309
    finding and opening 283
    format 16
    images, opening 280
    KES format 16
    large, opening 280
    merging 274, 309
    moving 274, 308
    names 267
    opening 265, 274, 278
    opening from another application 281
    opening from Favorites list 300
    opening recently opened 282
    path name 15
INDEX

portability, overview 316
printing 265, 291
properties, accessing 301
removing headers and footers from 311
removing image(s) from 310
removing layout information from 311
restoring 312
Save As 274
saving 265, 274, 286
saving existing 288
saving in another format 288
saving partially 289
saving with a new name 288
sending multiple to e-mail 335
sending to devices 322
sending to e-mail 334
Settings, overview 255
utilities 274, 306
with different format, opening 279
ZIP 312
File dialog
navigating in Folder tree 275
overview 272
selecting files and folders 276
shortcut keys 277
tasks 274
using 274
File Dialog setting 239
file formats 268
ASCII text (TXT) 268
Braille 270
DAISY 317
DAISY (OPF) 269
hearing Kurzweil 1000 supported formats 270
hypertext markup language (HTM) 269
Kurzweil 1000 (KES) 16, 267
Kurzweil 1000 supported 270
MP3 317
MS Word 270
notes 290
overview 267
WAV 317
WMA 317
file management
overview 264
shortcut keys 304
status, obtaining 296
tasks 265
using menus 278
using the File and Folder menus 271
File Open to a Bookmark 67, 71
file opening to bookmark 265
file portability
audio files 10
send to devices 10
File Properties
accessing 301
overview 302
file system
file extension 16
file/folder hierarchy 15
overview 14
path names 15
File Utilities
Copy 307
menu 306
Merge and Open 309
Move 308
overview 306
files
downloaded from online source 349
to writing to CD 313
Files list
  sorting 275
finding
  and replacing text 163
  and replacing using regular expressions 163
  file 283
  tables 160, 162
  text 160, 161, 166
Fix Hyphens Setting 230
folder
  adding to Favorites list 300
  changing 266, 274, 295
  changing in Favorites list 301
  commands, accessing 271
  creating 297
  default 306
  deleting 274, 297
  deleting from Favorites list 301
  description 15
  names 267
  opening from Favorites list 300
  properties, accessing 303
  ZIP 312
Folder Properties
  accessing 303
Folder tree, navigating 275
font
  formatting 152
footers
  removing 311
format
  editing 152
  file 16
  using to browse or study 97
Format Exploration 56
formatting
  bolding font 153
  font 152
  font size 153
  font type 153
  hearing current format 157
  italicizing font 153
  paragraph 155
  searching for text 162
  underlining 153
forms
  adding signature to 192
  filling out by using Show Image 191
  filling out by using the Form Fill dialog 191
  printing and saving 193
  reading and navigating in 191
  scanning and recognizing 190
G
General Settings
  defaults 253
  overview 203
  tab 228
Go to Page 65
going to
  a bookmark 70, 71
  a preliminary page 65
  last cursor position 66
Grayscale Image setting 239
grayscale recognition 126
grid views in dialog box,
  working with 35
H
Header Avoidance setting 223
headers
  removing 311
hearing 90
  context of found text 163
  context of word while spell checking 169
  current format 157
Current Value in Calculator 374
Kurzweil 1000 supported file formats 270
  selected text 146
  time and date 43
  word spelled out while spell checking 170
help
  for registration 5
  from listserv 23
  from Quick Tour 8
  from Technical Support 22
  from www.kurzweiledu.com 8
  in dialog box 30
Help About 5
Home Document Folder 295
Hot Key for Scanning setting 242
hot keys
  for scanning 138
HTML file format 269
HTML files
  as study document 97
HumanWare Maestro 328

I
Identify Bookmarks
  recognition setting 216
Identify Columns setting 217
image
  extracting 309
removing from file 310
image compression 239
image files
  opening 265
images
  displaying and reading 51
  keep as is or compress 239
  opening file containing 280
Insert Page 111
inserting
  page while scanning 107
  signature in a document 185
  signature in a form 192
  table 196
  time and date into a document 43
Internet connection 345
iTunes 320

K
Keep Images Setting 230
Keep Layout Information Setting 232
KES file format 267
KESI Virtual Printer 281
keyboard
  layout 19
  using mnemonics 18
  using shortcut keys 18
keypad
  basics 17
KOCRUtil automatic file recognition 134
Kurzweil 1000
  and screen readers 16
  applications 10
  basics 17
  Customer Service contact 1, 5
  customization 10
default settings 251
diagnostic programs 21
Extras folder 21
games and utilities 21
important concepts 11
KES file format 16
keypad 17
listserv, signing up for 23
menu system 18, 26
overview 9
registering 1
registering by phone 5
registering online 3
starting and shutting down 22
study tools 9
use in academic setting 9
Kurzweil Product Updates 362

L
Language Identification setting 225
Language setting 218
Last Cursor Position 66
Launch Utilities
overview 395
layout exploration 56
layout information
removing from file 311
Line Endings setting 226
linking
documents to settings 238, 255
Links
activating 78
and Bookmarks 97
and HTML files 97
as study tools 97
converting Bookmarks to 97
creating Internal Links 77
descriptions, working with 78
overview 76
selecting 77
lists
checkbox in dialog box 32
contents of, copying to clipboard 32, 33
Corrections 183, 184
Favorites 300
Files 274
in dialog box 31
in dialog box, navigating 30
in dialog box, searching 33
Notes 99
Pronunciation 181
Ranked Spelling Corrections 175
Ranked Spelling misspelled words 176
Spell Checker 170, 173
tree view, working with 32
listserv, signing up for 23
loading
Settings files 258
looking through online bookshelves 356
looking up
information in encyclopedia 91
medical dictionary 91
quotations 91
switching between definitions and
synonyms 89
synonym(s) for word(s) 86
typed word 86
word(s) or phrase in dictionary 84
words, using parts of speech 83
words, using wildcard characters 88
Lookup dialog 83
lookup tools
accessing 82
Define a Word 84
from menus 83
shortcut keys 94
thesaurus 86
Use Encyclopedia 91

M
Maestro 328
margins
  auto size 236
Margins Settings
  defaults 254
  overview 203
  tab 235
Mark a Position
  for Link 77
  for selecting blocks of text 149
Maximum Line Length setting 229
medical dictionary
  Use Encyclopedia from Online menu
to look up 91
menu items, types of
  commands 28
  opens dialog boxes 29
  submenus 28
menu system
  navigating menus 26
  overview 18, 26
menus
  accessing from menu bar 26
  exiting 27
  File 271
  File Launch 396
  Folder 271
  items on 28
  mnemonics 18
navigating 26
  Navigation 63
  overview 26
  Read 40
  Scan 109
  selecting item from 27
  shortcut keys 18
  using for file management 278
merging files 274, 309
Microsoft Speech Platform 14
  installing 14
  operating system requirements 14
Microsoft Word
  scanning using Kurzweil 1000 from
  140
mnemonics
  definition 19
  hearing 19
  using 19
Mode setting 211
money, scanning and recognizing 114
moving
  among documents 305
  file 274, 308
  through text 143
MP3
  adding bookmarks or notes to 317
  convert to DAISY 2.02 format 316
  file format 316

N
navigating
  among menus 27
  Bookmark descriptions 74
  by Bookmarks 66, 70, 71
  by cursor 66
  by page 63
by region 45
  going to last cursor position 66
  in applications 365
  in dialog box lists 30
  in dialog boxes 18, 27, 29
  in documents, overview 62
  in tables 50
  in text 143
  Settings tabs 204
  the Folder tree in File dialog 275
  using Links 76
  while reading 43
Navigation menu 63
navigation tools
  determining your place in a document 43
  for documents 62
  for reading 43
new corrections list 183
New User Wizard 8
News from Kurzweil 361
nfbtrans 338
Note
  creating 98
  deleting 99
  editing 99
  reading 99
  searching for descriptions 99
  sorting list 99
Notes
  adding in MP3, WAV, WMA, DAI-SY files 317
  converting from Bookmarks 99
  overview 96, 98
Numbers Pronunciation setting 225

O
OCR
  overview 13
Online
  product registration 3
online
  accessing features 346
  complex search 354
  Kurzweil product updates 362
  looking through bookshelves 356
  news from Kurzweil 361
  search for books 351
  search for magazines 358
  simple search 352
Online Cache
  configuring setting 350
Online Cache setting 240
online material
  accessing 344
  magazines 358
  opening downloaded files 349
  searching and downloading 347
  usage guidelines 346
  Web sites 345
  Web sites for electronic books 406
  Web sites for electronic magazines 407
Online Search for Books 351
opening
  a file at a bookmark 67, 71
  Braille files 280
  documents 249
  downloaded files 349
  file 265, 274, 278, 283
  file from another application 281
  files with different formats 279
  image files 265, 280
large files 280
PDF documents 249
range of pages for image files 280
recently opened files 282
RTF documents 249
text documents 249
operating system
  Microsoft Windows 12
  overview 12
  user interface 12
optimizing recognition 127
optimizing scanner settings
  brightness 122
  engine 123
  overview 121
  resolution 123
  speckle removal 123
  text quality 123
  thresholding 122
outlines 96

P
PAC Mate 328
page
  automatic orientation 213
  copying and pasting 151
  cutting and pasting 151
  going
to a specific page 65
  inserting new scanned page 111
  rerecognizing 111
  rerecognizing all pages 111
  rescanning 110
  setting and unsetting page numbers 63
  specifying preliminary pages 65
Page Numbers setting 229
Page Orientation setting 212
paragraph
  aligning 156
  formatting 155
  hearing current format 157
  indenting 155
Partial Columns setting 220
pasting
text or object 150
path name 15
PDF bookmarks 68, 71, 265
PDF document
  conversion controls for opening 249
PDF files
  extracting bookmarks from 249
phone registration 5
Photocopier
  making copies 385
  overview 383
  specifying options 384
  specifying printer settings 385
playing
  audio files in Kurzweil 1000 317
playlists
  adding audio files 320
Preliminary Pages 65
printing 291
  document/file 291
  file 265
  form 193
to a Braille embosser 338
product registration 1
  by phone 5
  online 3
  preliminary steps 2
pronounce
  lookup word 84
pronounce lookup word 87
pronunciation
  adding a new pronunciation 182
  changing for a word 180
  editing list 181
Pronunciation list
  editing 181
proofreading 159
Punctuation Level setting 224

Q
quotations, looking up 91

R
range of pages
  when opening image file 280
Ranked Spelling
  creating list of misspelled words 176
  editing list 175
  overview 174
  reviewing and correcting misspellings in document 177
Read menu 40
  reading a Note 99
  adjusting speed 41
  commands, accessing 40
  images 51
  Message Voice 38
  moving by reading unit 44
  moving by region 45
  navigation tools 43
  newly recognized pages 47
  overview 38
  Reading Voice 38
  repeating what you’ve read 97
  selected text 42
shortcut keys 45
starting and stopping 41
status, obtaining 43
Table Reading setting 222
tables 47
tools and methods 39
using menus 41
voice settings 207
Reading Settings
defaults 252
overview 203
  tab 221
Reading Speed
  adjusting 41
Reading Status 40, 43
Reading Unit
  moving by 44
  selecting 44
Reading Unit setting 223
recognition
  Engine setting 220
  Identify Bookmarks setting 216
  Identify Columns setting 217
  interrupting and saving 126
  Language setting 218
  of currency 114
  optimizing 127
  Partial Columns setting 220
  Speckle Removal setting 219
  Suspicious Regions setting 220
  Table Recognition setting 216
  Text Quality setting 219
  Two Pages setting 217
Recognition Settings
default 252
overview 203
  tab 215

472
Recognition Statistics
  cumulative 130
  for last page 128
  overview 128
  poorly recognized pages 130
  viewing 128
Recognize Currency 114
recognized page
  reading 47
recognizing
  currency, money 114
  forms 190
reference tools
  accessing 82
  Define a Word 84
  from menus 83
  shortcut keys 94
  thesaurus 86
  translations 93
region, moving through text by 45
registering Kurzweil 1000 1
registration
  Certificate of Ownership 1, 2
  online method 3
  phone method 5
  serial number 1, 2
  who and why 1
regular expressions in Find and Replace 163
removing
  headers and footers 311
repeating what you’ve read as method of studying 97
replacing
  text 163, 165, 166
  text throughout document 167
  text throughout Kurzweil 1000 167
  using regular expressions 163
Rerecognize All Pages 111
Rerecognize Page 111
rerecognizing page while scanning 107
Rescan Page 110
rescanning a page 107
resolution, optimizing 123
restoring
  file 312
  Settings files 259
rich text format (RTF) 268
RoadRunner 328
RTF document conversion controls for opening 249
RTF file format 268
S
Save Partially 289
Save Recognition 126
saving
  a new file 286
  Braille documents 250
documents 250
  file 265, 274, 288
  file in another format 288
  file with a new name 288
  form 193
  partial document/file 289
  recognition 126
  settings files 256
  settings files, partially 257
text documents 250
Scan menu 109
Scan Repeatedly 112
scanner
description 11
margins, auto size 236
optimizing settings 121
scanner buttons
   configuring for scanning, faxing and photocopying 139
Scanner Margins Settings
   tab 235
scanning
   active and scanning document, descriptions 106
batch 215
batch, overview 132
color 126, 214
commands, accessing 109
currency 114
forms 190
from Microsoft Word 140
grayscale 214
hot keys, defining 138
inserting page 107, 111
optimizing recognition 127
optimizing scanner settings 121
overview 11, 104
process 13
repeatedly 108, 112
rerecognizing a page 111
rerecognizing all pages 111
rerecognizing page 107
rescanning page 107, 110
settings 209
shortcut keys for 137
signature files 118
speeding up process 120
starting and stopping 110
using a document feeder 113
using a hot key 138
using scanner buttons 139
while keeping Kurzweil 1000 in fore-
ground 108
scanning document 106
Scanning Settings
   defaults 251
   overview 202
   tab 209
screen readers
   overview 16
searching
   complex search 354
   for blank pages 165
   for books online 351
   for magazines online 358
   for Notes descriptions 99
   for special characters 164
   for tables 162
   for text 160, 161
   for text by formatting 162
   for text by using Bookmark descriptions 72
   simple search 352
   the Classic Literature CD 359
searching for text
   backwards (Find Previous) 161
selecting
   blocks of text 149
   entire document 147
   files and folders in File dialog 276
   Links 77
   menu item 27
   Reading Unit 44
text 145
text across multiple pages 147
Send To
   device 324
   Email Recipient 334
   user device 332
serial number 1, 2
Certificate of Ownership 1, 2
Set User Page Number 63
settings
accessing 204
Active Speech 243
AutoLoad 242
backing up 259
Color 233
Configuration 203
Configuration tab 237
Conversion control 248
defaults 251
deleting settings files 258
Display 203
Display tab 233
General 203
General tab 228
Hot Key for Scanning 242
linking to documents 255
loading Settings files 258
Margins for scanner 203
modifying 206
navigating Settings tabs 204
overview 202
Reading 203
Reading tab 221
Recognition 203
Recognition tab 215
restoring 259
Scanner Margins tab 235
Scanning 202
Scanning tab 209
Settings files, overview 255
shortcuts 241
status 260
Verbosity 203

Verbosity tab 243
Voices 202
Voices tab 207
Settings files
backing up 259
deleting 258
loading 258
overview 255
restoring 259
saving 256
saving partially 257
Settings tab page
making changes 206
shortcut keys
for contextual reading 45
for document navigation 78
for document overview 59
for editing 150, 186
for File dialog 277
for file management 304
for reference/lookup tools 94
for scanning 137
for text selection 146
shortcuts
overview 18
setting 241
Show Image 51
shutting down
Kurzweil 1000 22
your computer 22
signature file
adding to a form 192
inserting into a document 185
scanning and creating 118
skimming
as method of studying 97
sorting
  Bookmarks 73
  files in Files list 275
  Link descriptions 78
  Notes list 99
Speckle Removal setting 219
speckle removal, optimizing 123
Speech Options 14
Spell Checker list
  adding to 170
  editing 173
spell checking
  adding word to Spell Checker list 170
  editing list 173
  Fax cover sheet 389
  hearing context of word 169
  hearing word spelled out 170
  ignoring
    a word 170
    words with initial capitals 171
  ignoring numbers and letters 171
  ignoring suffixes and prefixes 172
  ignoring words 170, 171
  overview 167
  properties 171, 178
  replacing instance of word 168
  replacing word throughout document 169
  using Ranked Spelling 174
spelling of word 90
starting
  Kurzweil 1000 22
  reading 41
  scanning 110
Static Thresholding 125
status
  file management 296
for online search 347
for reading, obtaining 43
of fax 392
reading 40
settings 260
stopping
  reading 41
  scanning 110
storing and updating site access 350
study tools
  annotations 9
  Bookmarks 96
  bookmarks 9
  Bookmarks for building topic lists 101
  browsing 97
  browsing using format 97
  Links 97
  links 9
  lookup tools 9
  Notes 96
  online encyclopedias 9
  overview 96
  repeating what you’ve read 97
  skimming 97
  summarization 9
  Summarize 96
  topic lists, building 101
submenus 28
Summarize
  as study tool 96
  summarizing a document 55
  Suspicious Regions setting 220
synonyms 86
  anagrams for word 84
  placing into document 89
  pronounce word 84
<table>
<thead>
<tr>
<th>Index Entry</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>synthetic speech</td>
<td></td>
</tr>
<tr>
<td>overview</td>
<td>13</td>
</tr>
<tr>
<td>system requirements</td>
<td></td>
</tr>
<tr>
<td>hardware</td>
<td>22</td>
</tr>
<tr>
<td>T</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td></td>
</tr>
<tr>
<td>alignment</td>
<td>198</td>
</tr>
<tr>
<td>auto size row</td>
<td>197</td>
</tr>
<tr>
<td>cell width</td>
<td>198</td>
</tr>
<tr>
<td>convert text to</td>
<td>197</td>
</tr>
<tr>
<td>convert to text</td>
<td>197, 199</td>
</tr>
<tr>
<td>creating</td>
<td>196, 198</td>
</tr>
<tr>
<td>delete</td>
<td></td>
</tr>
<tr>
<td>row</td>
<td>196</td>
</tr>
<tr>
<td>delete entire table</td>
<td>197</td>
</tr>
<tr>
<td>delete row</td>
<td>197</td>
</tr>
<tr>
<td>editing</td>
<td>196</td>
</tr>
<tr>
<td>insert column</td>
<td>196</td>
</tr>
<tr>
<td>insert row</td>
<td>196</td>
</tr>
<tr>
<td>inserting</td>
<td>196</td>
</tr>
<tr>
<td>reading setting</td>
<td>222</td>
</tr>
<tr>
<td>recognition setting</td>
<td>216</td>
</tr>
<tr>
<td>row height</td>
<td>198</td>
</tr>
<tr>
<td>select</td>
<td>197</td>
</tr>
<tr>
<td>settings</td>
<td>197</td>
</tr>
<tr>
<td>Table Identification setting</td>
<td>226</td>
</tr>
<tr>
<td>Table Reading setting</td>
<td>47, 48</td>
</tr>
<tr>
<td>tables</td>
<td></td>
</tr>
<tr>
<td>reading</td>
<td>47, 48</td>
</tr>
<tr>
<td>reading individual cells</td>
<td>50</td>
</tr>
<tr>
<td>searching for</td>
<td>162</td>
</tr>
<tr>
<td>technical support</td>
<td></td>
</tr>
<tr>
<td>accessing</td>
<td>22</td>
</tr>
<tr>
<td>checklist</td>
<td>22</td>
</tr>
<tr>
<td>text</td>
<td></td>
</tr>
<tr>
<td>convert to table</td>
<td>197, 199</td>
</tr>
<tr>
<td>copying</td>
<td>150</td>
</tr>
<tr>
<td>cutting</td>
<td>150</td>
</tr>
<tr>
<td>cutting, copying and pasting</td>
<td>149</td>
</tr>
<tr>
<td>expanding or contracting selection of</td>
<td>146</td>
</tr>
<tr>
<td>navigating</td>
<td>143</td>
</tr>
<tr>
<td>pasting</td>
<td>150</td>
</tr>
<tr>
<td>replacing</td>
<td>165</td>
</tr>
<tr>
<td>replacing throughout document</td>
<td>167</td>
</tr>
<tr>
<td>replacing throughout Kuzweil 1000</td>
<td>167</td>
</tr>
<tr>
<td>searching for</td>
<td>160</td>
</tr>
<tr>
<td>selecting</td>
<td>145</td>
</tr>
<tr>
<td>selecting across multiple pages</td>
<td>147</td>
</tr>
<tr>
<td>selecting bloks of</td>
<td>149</td>
</tr>
<tr>
<td>selecting entire document</td>
<td>147</td>
</tr>
<tr>
<td>selecting using Mark a Position</td>
<td>147</td>
</tr>
<tr>
<td>text boxes in dialog box, working with</td>
<td>34</td>
</tr>
<tr>
<td>text document</td>
<td></td>
</tr>
<tr>
<td>conversion controls for opening</td>
<td>249</td>
</tr>
<tr>
<td>conversion controls for saving</td>
<td>250</td>
</tr>
<tr>
<td>Text file format</td>
<td>268</td>
</tr>
<tr>
<td>Text Quality setting</td>
<td>219</td>
</tr>
<tr>
<td>text quality, optimizing</td>
<td>123</td>
</tr>
<tr>
<td>thesaurus</td>
<td>86</td>
</tr>
<tr>
<td>pronounce word</td>
<td>84</td>
</tr>
<tr>
<td>Thresholding</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>214</td>
</tr>
<tr>
<td>Dynamic</td>
<td>214</td>
</tr>
<tr>
<td>Grayscale</td>
<td>214</td>
</tr>
<tr>
<td>Static</td>
<td>214</td>
</tr>
<tr>
<td>thresholding</td>
<td></td>
</tr>
<tr>
<td>optimizing</td>
<td>122</td>
</tr>
<tr>
<td>settings</td>
<td>124</td>
</tr>
<tr>
<td>Thresholding setting</td>
<td>213</td>
</tr>
<tr>
<td>Dynamic</td>
<td>125</td>
</tr>
<tr>
<td>Grayscale</td>
<td>126</td>
</tr>
</tbody>
</table>
Static tips for time and date

hearing translation

inserting into a document translations

tree view list, working with Two Pages setting

undoing edits Units setting

Unset User Page Number user device

utilities Launch

Verbosity Settings Verbosity Settings
defaults events overview tab

defaults events overview tab

Voices Settings Voices Settings
defaults overview tab

defaults overview tab

writing WAV

adding bookmarks or notes to convert to DAISY 2.02 format

Web sites 9, 345

for electronic books for electronic magazines

overview

wildcard characters looking up words, using Windows file system

Windows Media Player WMA

adding bookmarks or notes to file format

word changing pronunciation for definitions, looking up hearing spelling

look up using wildcard characters synonyms, looking up

writing files to CD

ZIP

compressing file creating file decompressing file

files and folders, overview